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Legal Notices

Warranty

The only warranties for HP products and services are set forth in the express warranty 
statements accompanying such products and services. Nothing herein should be construed as 
constituting an additional warranty. HP shall not be liable for technical or editorial errors or 
omissions contained herein.

The information contained herein is subject to change without notice.

Restricted Rights Legend

Confidential computer software. Valid license from HP required for possession, use or copying. 
Consistent with FAR 12.211 and 12.212, Commercial Computer Software, Computer Software 
Documentation, and Technical Data for Commercial Items are licensed to the U.S. 
Government under vendor's standard commercial license.

Third-Party Web Sites

HP provides links to external third-party Web sites to help you find supplemental 
information.  Site content and availability may change without notice.  HP makes no 
representations or warranties whatsoever as to site content or availability.

Copyright Notices

©  Copyright 2002 - 2009 Mercury Interactive (Israel) Ltd.

Trademark Notices

Intel® is a trademark of Intel Corporation in the U.S. and other countries.

Java™ is a US trademark of Sun Microsystems, Inc. 

Microsoft® and Windows® are U.S. registered trademarks of Microsoft Corporation. 

Oracle® is a registered US trademark of Oracle Corporation, Redwood City, California. 

UNIX® is a registered trademark of The Open Group. 
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Documentation Updates

This guide’s title page contains the following identifying information:

• Software Version number, which indicates the software version.

• Document Release Date, which changes each time the document is updated.

• Software Release Date, which indicates the release date of this version of the software.

To check for recent updates, or to verify that you are using the most recent edition of a 
document, go to:

http://h20230.www2.hp.com/selfsolve/manuals 

This site requires that you register for an HP Passport and sign-in. To register for an HP 
Passport ID, go to: 

http://h20229.www2.hp.com/passport-registration.html 

Or click the New users - please register link on the HP Passport login page.

You will also receive updated or new editions if you subscribe to the appropriate product 
support service. Contact your HP sales representative for details.
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Support

You can visit the HP Software Support web site at:

http://www.hp.com/go/hpsoftwaresupport 

This web site provides contact information and details about the products, services, and 
support that HP Software offers.

HP Software Support Online provides customer self-solve capabilities. It provides a fast and 
efficient way to access interactive technical support tools needed to manage your business. As 
a valued support customer, you can benefit by using the HP Software Support web site to:

• Search for knowledge documents of interest

• Submit and track support cases and enhancement requests

• Download software patches

• Manage support contracts

• Look up HP support contacts

• Review information about available services

• Enter into discussions with other software customers

• Research and register for software training

Most of the support areas require that you register as an HP Passport user and sign in. Many 
also require a support contract.

To find more information about access levels, go to:

http://h20230.www2.hp.com/new_access_levels.jsp 

To register for an HP Passport ID, go to:

http://h20229.www2.hp.com/passport-registration.html 
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Welcome to This Guide

Welcome to the HP Performance Center User Guide. 

Performance Center is HP’s Web-enabled global load testing tool, which is 
specially designed to streamline the testing process and increase the test 
efficiency for multiple concurrent load tests across multiple geographic 
locations.

Performance Center consists of the following modules:

➤ User Site. Used for conducting and monitoring load tests.

➤ Administration Site. Used for overall resource management, technical 
supervision, and for managing user and project access rights throughout 
Performance Center.

This guide covers the User Site. It describes how to use HP Performance 
Center to define and run load tests on your applications and to analyze the 
results of your test runs.

For information about Performance Center Administration, see the HP 
Performance Center Administrator Guide.

This chapter includes:

 ➤  How This Guide Is Organized on page 20

 ➤  Who Should Read This Guide on page 21

 ➤  Performance Center Online Documentation on page 21

 ➤  Additional Online Resources on page 23

 ➤  Documentation Updates on page 24
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How This Guide Is Organized

The HP Performance Center User Guide contains the following sections:

 Part I Understanding HP Performance Center

Introduces you to HP Performance Center. It describes the Performance 
Center e-service and its advantages, including overviews of Vuser scripts and 
the entire load testing process. It also describes the User site and how to 
navigate around the site, and explains how to use the Project Dashboard to 
understand load test transaction and drill down data.

 Part II Designing Load Tests

Describes how to create and configure a load test for your application.

 Part III Executing Load Tests

Describes how to execute a load test, and monitor your application’s 
performance application during the test. It also describes how to view load 
test results and analyze load test data.

 Part IV Working with Diagnostics

Describes Performance Center’s J2EE/.NET and ERP/CRM Diagnostics 
modules which help identify performance problems in J2EE, .NET, Siebel, 
Oracle, and SAP environments.

 Part V Configuring Vuser Script Run-Time Settings

Describes how to configure Vuser Script run-time settings to emulate 
different types of user activity.

 Part VI User Management

Describes how to view and manage your own personal user information, 
and view the other users in the Performance Center system.

 Part VII Troubleshooting

Provides troubleshooting tips and information for Performance Center 
problems.
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Who Should Read This Guide

[we need to decide what to include here - -or whether to include this section 
at all - this is what was in the last version)

This guide is for the following users of Performance Center:

➤ Performance Engineers

➤ Project Managers

This document assumes that you are moderately knowledgeable about 
enterprise application development and highly skilled in enterprise system 
and database administration.

Performance Center Online Documentation

Performance Center includes a complete set of documentation describing 
how to use the product. A comprehensive Documentation Library is 
available from the Help menu in the User and Administration Sites. PDFs 
can be read and printed using Adobe Reader, which can be downloaded 
from the Adobe Web site (http://www.adobe.com). Printed documentation is 
also available on demand.

Accessing the Documentation

You can access Performance Center documentation as follows:

➤ In the User and Administration Sites, click the Help link in the top right 
corner of the window. In the bookmarks on the left, click Home to open 
the Performance Center Documentation Library front page which 
provides quick links to the online Performance Center Documentation 
Library.

➤ Printable guides can be accessed from Start > Program 
Files > Performance Center > Documentation.

Getting Started Documentation 

➤ Readme. Provides last-minute news and information about Performance 
Center.

http://www.adobe.com
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➤ HP Performance Center System Configuration and Installation Guide. 
Explains how to install and configure the Performance Center 
components. Available in PDF format only. Accessible from the HP 
Installation DVD.

➤ HP Performance Center Quick Start. A self-paced guide showing you how 
to use Performance Center to create, run, and monitor load tests. 
Available in PDF format only.

Accessible from the General tab that is displayed when you open the User 
Site.

Performance Center User Guides

➤ HP Performance Center User Guide. Describes how to use Performance 
Center to create, schedule, run, and monitor load tests.

➤ HP Performance Center Monitor Reference. Describes how to set up the 
server monitor environment and configure Performance Center monitors 
for monitoring data generated during a load test run.

Performance Center Administration

➤ HP Performance Center Administrator Guide. Describes how to use 
Performance Center Administration Site for overall  resource 
management, site management, system configuration, technical 
supervision, and user privileges in Performance Center projects.

Troubleshooting

➤ HP Performance Center Troubleshooting Guide. Provides information 
for troubleshooting problems while working with Performance Center 
Available in PDF fomat only.

Standalone Applications

The following documentation is available only on host machines, and if 
standalone components are installed:

➤ HP Analysis User Guide. Describes how to generate graphs and reports to 
analyze your load tests after they have run.
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➤ HP Virtual User Generator User Guide. Describes how to create Vuser 
scripts through recording and programming.

Additional Online Resources

Troubleshooting and Knowledge Base accesses the Troubleshooting page on 
the HP Software Support Web site where you can search the Self-solve 
knowledge base. The URL for this Web site is 
http://h20230.www2.hp.com/troubleshooting.jsp.

HP Software Support accesses the HP Software Support Web site. This site 
enables you to browse the Self-solve knowledge base. You can also post to 
and search user discussion forums, submit support requests, download 
patches and updated documentation, and more. The URL for this Web site is 
www.hp.com/go/hpsoftwaresupport.

Most of the support areas require that you register as an HP Passport user 
and sign in. Many also require a support contract.

To find more information about access levels, go to:  
http://h20230.www2.hp.com/new_access_levels.jsp

To register for an HP Passport user ID, go to:  
http://h20229.www2.hp.com/passport-registration.html 

HP Software Web site accesses the HP Software Web site. This site provides 
you with the most up-to-date information on HP Software products. This 
includes new software releases, seminars and trade shows, customer support, 
and more. The URL for this Web site is www.hp.com/go/software.

http://h20230.www2.hp.com/troubleshooting.jsp
http://www.hp.com/go/hpsoftwaresupport
http://h20230.www2.hp.com/new_access_levels.jsp
http://h20229.www2.hp.com/passport-registration.html
http://www.hp.com/go/software
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Documentation Updates

HP Software is continually updating its product documentation with new 
information.

To check for recent updates, or to verify that you are using the most recent 
edition of a document, go to the HP Software Product Manuals Web site 
(http://h20230.www2.hp.com/selfsolve/manuals).

http://h20230.www2.hp.com/selfsolve/manuals
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1
Introduction

HP Performance Center is a global cross-enterprise load testing tool that you 
install on your organization’s own infrastructure. Performance Center 
enables you to manage multiple, concurrent load testing projects across 
different geographic locations without any need to travel between them. 
Performance Center administers all your internal load testing needs. With 
Performance Center, you manage all aspects of large-scale load testing 
projects, including resource allocation and scheduling, from a centralized 
location accessible through the Web. Performance Center helps streamline 
the testing process, reduce resource costs, and increase operating efficiency.

Performance Center generates load on your Web server or application using 
HP’s virtual user (Vuser) technology. Each Vuser follows a series of steps (for 
example, hyperlink steps, submit form steps, and so forth) that you define 
in a Vuser script. You design Vuser scripts to emulate typical user activity in 
your application. For details, see “About Vuser Scripts” on page 29. 

Vusers run on dedicated host machines. Each host machine runs many 
Vusers. When run concurrently, the Vusers create the same load as tens of 
thousands of individual human users. While Vusers run, Performance 
Center collects server response time data.

Performance Center analysis tools, which you access both during and after 
the load test, provide you with a clear and concise picture of your 
application's performance under load. 

Performance Center helps you pinpoint performance bottlenecks. It also 
allows you to determine the number of users your system can scale up to 
(this number is the “breaking point" after which your application's 
performance starts to degrade). This information gives clues as to what can 
be done to increase your application’s load capacity. 



Chapter 1 • Introduction

28

In addition, the information provided by Performance Center helps you 
analyze how the load on your system is affecting the service level 
agreements (SLA) or other performance thresholds that are important to 
your business.

Note: Although this guide generally refers to load testing Web sites, 
Performance Center can be used to load test a wide variety of non-Web 
applications. For details, see Chapter 7, “Managing Vuser Scripts.”

This chapter includes:

 ➤  The Load Testing Process on page 28

 ➤  About Vuser Scripts on page 29

 ➤  About the Controller on page 30

 ➤  System Advantages on page 30

The Load Testing Process

To conduct a load test of your application through the Internet, you 
perform the following steps from your Web browser:

 1 Access the Performance Center User site and log in. For details, see 
“Accessing HP Performance Center” on page 36.

 2 Upload Vuser scripts. For details, see “Managing Vuser Scripts” on page 123.

 3 Reserve a timeslot. For details, see “Reserving Timeslots” on page 91.

 4 Configure the load test. For details, see “Configuring Load Tests” on 
page 165.

 5 Set project options. For details, see Chapter 19, “Setting Project Options.”

 6 Configure Run-Time Settings. For more information on configuring run-
time settings, see “Configuring General Run-Time Settings” on page 549.

 7 Run the load test. For details, see Chapter 24, “Running a Load Test.”
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 8 Configure load settings during test run. For details, see “Configuring 
Schedule Settings from the Load Test Run Page” on page 364.

 9 View the running load test. For details, see Chapter 22, “Viewing Vusers 
During a Load Test.”

 10 Monitor online graphs. For details, see Chapter 25, “Online Monitor View.”

 11 View results of the load test using Performance Center summary reports. For 
details, see “Viewing Load Test Results” on page 417, and “Viewing the 
Analysis Summary Report” on page 423.

About Vuser Scripts

When you run a load test, virtual users (Vusers) access your application 
concurrently in order to put load on your server. The actual steps that the 
Vusers perform when accessing your application are represented in a Vuser 
script. Each Vuser performs the actions recorded in one Vuser script.

You design Vuser scripts to emulate typical end-user activities on your 
application. For example, if you are load testing a Web site, the Vuser script 
emulates a real user accessing URLs, clicking links, submitting forms, and 
so on. When you create a load test, you distribute your Vuser scripts among 
your Vusers. 

For example, in the case of load testing a Web site, you can specify that a 
portion of the Vusers run a Vuser script that emulates real users accessing 
your home page, a portion run a script that performs a search query, and a 
portion emulate the completion of an order form.

You obtain Vuser scripts by recording them using HP’s Virtual User 
Generator and uploading them to the Vuser scripts list. You can also create a 
simple URL-based Vuser script by listing a series of URLs. 

In addition to load testing Web sites, Performance Center can be used to 
perform load testing in non-Web environments. For example, you can load 
test WAP, Real, or Oracle NCA applications. For details of supported 
protocols, see the HP Virtual User Generator User Guide.
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About the Controller

The Controller is the manager of a load test. The Controller receives the 
scripts, their run-time settings, and a list of the load generators to use. The 
Controller issues instructions to the load generators including which scripts 
to run, how many Vusers to run per script, and the timing at which to start 
running the Vusers. During the load test, the Controller displays online 
monitoring information. At the conclusion of the test run, the Controller 
collates the data for analysis.

System Advantages

➤ Performance Center’s step-by-step process helps guide you through the load 
testing procedure.

➤ Performance Center enables remote testing by anybody, from anywhere, at 
any time, eliminating the need to travel.

➤ Performance Center enables multiple concurrent tests, replacing serial 
testing with parallel testing.

➤ Performance Center enables remote management from anywhere through a 
Web server.

➤ Performance Center is a complete system for managing load tests, scripts, 
and timeslots. Furthermore, Performance Center centralizes the testing 
environment, with no duplication of testing labs, keeping costs down and 
minimizing time.

➤ Performance Center enables you to take advantage of the power of the Web 
for supporting services such as remote consulting, online support, and so 
on.
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2
The User Site

The Performance Center User Site is structured so that you can navigate 
around the site to create, run, and perform actions on your load test. This 
chapter provides details on how to access and navigate the Performance 
Center User site.

This chapter includes:

 ➤  About the User Site on page 31

 ➤  Accessing HP Performance Center on page 36

 ➤  Select/Change Project Page on page 37

About the User Site

The Performance Center User site provides permanent buttons and links to 
access important information and move around the site. 

At the top of the page, Performance Center displays several links that are 
available throughout the User site:

➤ Help. Click to access the Performance Center online Help. Performance 
Center provides context-sensitive help which enables you to get specific 
information about whatever part of the User Site you are using at any given 
moment.

➤ About. Click for version and build number information.

➤ Log Out. Click to end the current Performance Center User session.
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In addition, Performance Center displays a navigation menu on the left-side 
of the page. This menu is available throughout the Performance Center User 
Site. The menus provide links to pages which help you create, run, analyze, 
and maintain your load tests. 

Projects

The Projects menu contains the following submenu links:

➤ Status. Click to return to the Dashboard and the General Status page. For 
details, see “Viewing the Dashboard” on page 41, and “The Status Page - 
General Tab” on page 40.

➤ Hosts. Click to open the Hosts page. From the Hosts page, you view, reboot, 
and check Performance Center hosts. For details, see “Understanding the 
Hosts Page” on page 58.

➤ Timeslots. Click to open the Timeslots page. From the Timeslots page, you 
view and reserve timeslots. For details, see Chapter 5, “Working With 
Timeslots.”

➤ Vuser Scripts. Click to view all existing Vuser scripts. From the Vuser Scripts 
page, you can view, upload, download, edit, or delete a Vuser script. You can 
also create a URL-based Vuser script. For details, see “Understanding Vuser 
Scripts” on page 124.

➤ Monitor Profiles. Click to open the Monitor Profiles page. From this page 
you can create new monitor profiles or select existing profiles, and add them 
to your project or copy them from one project to another. For details, see 
“Monitor Profiles Page at a Glance” on page 110.

➤ Autostart Viewer. Click to open the Autostart Viewer page. From this page 
you can view the start times and configuration details for all tests scheduled 
with the Autostart feature. For details, see Chapter 23, “Viewing Autostart 
Load Tests.”

➤ Options. Click to open the Project Options page. From this page you 
configure the monitors, load test run-time settings, timeout, general, and 
debug information options for all your load test projects. For details, see 
Chapter 25, “Online Monitor View.”

➤ Change Project. Click to view a a different project in Performance Center. 
This option in available to users who are assigned to more than one project.
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Load Tests

The Load Tests menu contains the following submenu links:

➤ Manage. Click to open the Load tests page. From this page you can create a 
new load test, or view a list of all existing load tests and runs. From the list 
of load tests, you can run, edit, and view results for tests, or view the Load 
Test Run page for a recently run or currently running load test. For details, 
see “About Creating and Configuring Load Tests” on page 165, and 
“Viewing Load Tests” on page 47.

➤ Search Results. Click to open the Search Load Test Results page. This page 
lists all load tests in the project that have run. For details, see “Searching 
Load Test Results” on page 51.

➤ Running. Lists load test that are currently running. Click the name of a 
running load test to monitor the load test run. For details, see “Monitoring 
Load Test Data” on page 318.

➤ Trend Reports. Click to open the Trend Reports main page. From this page 
you can create new and modify existing trend reports. For details, see 
Chapter 27, “Trend Reports.”

User Information

The User Information menu contains the following submenu link:

➤ Personal Details. Click to open the Personal Details page where you can 
view and manage your personal user details. 

➤ Users. Click to open the Users page where you can view and manage 
information about Performance Center users in your projects.

➤ Roles. Click to open the Roles page where you can view information about 
Performance Center roles.

➤ Projects. Click to open the Projects page where you can view information 
about Performance Center projects.

➤ Privilege Management. Click to open the Privilege Management page where 
you can view information about user-role assignments in your projects.

For details, see Chapter 37, “Introducing User Management.”
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Miscellaneous

The Miscellaneous menu contains the following submenu links:

➤ Downloads. Click to open the Downloads page. From this page you can 
download various applications. The Downloads page describes each 
application and explains how to download it. For more information, see 
“Downloads Page” on page 34.

➤ What’s New. Click to open the What’s New page. From this page you can get 
a brief description of all the new features in the Performance Center release, 
including links to video walkthroughs. For more information, see “What’s 
New Page” on page 35.

Downloads Page
The Downloads page enables you to download various applications. The 
Downloads page describes each application and explains how to download 
it. 

Note: Contact your system administrator if the download links are not 
available. 

The following downloads are available:

➤ Standalone Analysis. Click Standalone Analysis Download to install the full 
standalone version of HP LoadRunner Analysis that enables you to analyze 
load test data offline from any computer on which Analysis is installed. You 
use Analysis graphs and reports to organize and display load test results and 
summarize system performance. LoadRunner Analysis integrates with 
Performance Center to let you download result and session files for analysis, 
then upload the session files and reports to Performance Center to share the 
results with other users. 
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➤ Standalone VuGen. Click Standalone VuGen Download to install the full 
standalone version of HP Virtual User Generator (VuGen) for creating all 
types of virtual user (Vuser) scripts. Using VuGen, you record business 
processes into test scripts and customize the scripts according to defined 
user behavior. VuGen works together with Performance Center to provide 
an efficient method for uploading and downloading Vuser scripts to and 
from the Performance Center Web site script repository for Vuser script 
editing. 

➤ Standalone Load Generator. Click Standalone Load Generator Download to 
install a standalone version of the load generator. Instead of installing a 
Performance Center Host and then configuring it as a load generator, you 
can install a standalone version of the load generator.

➤ Snapshot Viewer. Click Snapshot Viewer Download to install the Snapshot 
Viewer which enables you to view snapshot on error pages captured from 
virtual Web users during load test runs. The viewer displays snapshots from 
files with .SOE and .INF extensions. A Snapshot on Error (.SOE) file is a 
zipped file containing one or more snapshots in .INF format.

➤ Monitor over Firewall Agent. The Monitor Over Firewall component is used 
to monitor servers that are located over a firewall. Before you can download 
this component from the Downloads page, you need to copy the setup file 
to the File Server. To do this, copy the monitors_over_fw.exe file from the 
<Performance Center installation disk>\Additional Components\Download 
Monitor Over Firewall directory and paste it in the File Server’s <installation 
directory>\LRFS\Downloads directory.

What’s New Page
The What’s New page provides a brief description of all the new features in 
the Performance Center release, including links to video walkthroughs. To 
view the videos, you must install the Codec file. Click the link to download 
the file.
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Accessing HP Performance Center

You access HP Performance Center using a supported Web browser, from any 
computer with a network connection (intranet or Internet) to the HP 
Performance Center servers. The level of access granted a user depends on 
the user's permissions. For details on granting user permissions, see the HP 
Performance Center Administrator Guide. 

For details on Web browser requirements, as well as minimum requirements 
to successfully view Performance Center, see the HP Performance Center 
System Configuration and Installation Guide.

Logging In to the Performance Center User Site

You log in to the HP Performance Center User Site from the login page.

To log in to the HP Performance Center User Site: 

 1 In your Web browser, type the following URL:

where server_name is the name or IP address of the HP Performance Center 
User Site server.

The HP Performance Center login page opens.

 2 Type the login parameters (login name and password). These credentials 
must be defined in the HP Performance Center system. 

 3 Click Log In. 

➤ If you belong to just one project, the Performance Center Project 
Dashboard opens. You can access the Dashboard at any time by selecting 
Project > Status from the navigation menu. For more information, see 
“Viewing the Dashboard” on page 41.

➤ If you belong to more than one project, the Select Project page opens 
displaying a list of all the projects to which you belong and an indication 
of each project’s status. The five most recently used projects appear in a 
separate list under Recent Projects. Click the name of the Performance 
Center project you want to enter. For more information, see 
“Select/Change Project Page” on page 37. 

http://<server_name>/loadtest
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Logging Out

To prevent unauthorized entry, when you have completed your session, you 
should log out of the User Site.

To log out:

➤ Click Log Out at the top of the page to exit and return to the Performance 
Center login page.

Select/Change Project Page

When you log on to Performance Center, if you belong to more than one 
project the Select Project page opens displaying a list of all the projects 
(up to 10 projects per page) to which you belong and an indication of each 
project’s status. The 5 most recently used projects appear in a separate list 
under Recent Projects.

Each project’s status is determined by the condition of the last run of all 
load tests in the project that were posted to the Dashboard. For more 
information, see “Viewing the Dashboard” on page 41.

A project can be assigned one of the following statuses:

To view a project, you can select it from the list. At any time, you can 
change the project you are viewing by selecting Projects > Change Project 
from the left navigation menu.

Icon Description

(green) Project achieved all load test performance targets.

(red) Project did not achieve all load test performance 
targets. If any load test fails to reach its targets, the 
project is assigned a red light.

(gray) No load test performance targets were defined for 
the project.
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To select/change a project:

 1 If the list of projects on the Select/Change Project page is a long list, type the 
name of your project in the search text box and click Filter to locate your 
project. The filter feature supports partial text look up.

To reshow the complete list of projects, 10 at a time, click Show all.

 2 Click the name of the Performance Center project you want to enter. The 
Dashboard of the elected project opens. For details, see “Viewing the 
Dashboard” on page 41.

If at any time during your session you want to change the project, you can 
return to the Change Project page by selecting Projects > Change Project 
from the left navigation menu.
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Project Status

The Dashboard provides an overview of your load test’s status, and has the 
drill-down capability to view individual load test performance. The status 
and performance data are relative to the goal criteria you establish for your 
application.

This chapter includes:

 ➤  Viewing Project Status on page 39

 ➤  The Status Page - General Tab on page 40

 ➤  Viewing the Dashboard on page 41

 ➤  Understanding Drilldown Data on page 43

 ➤  Creating a Project Dashboard on page 45

 ➤  Viewing Load Test Performance Targets and Results on page 47

 ➤  Publishing Load Test Performance Results on page 52

Viewing Project Status

The Status page displays the Dashboard and General tabs.

Using the Dashboard, you can monitor key performance data for the load 
tests in your project. The Dashboard includes the overall status of the most 
recent load test run, and provides drill-down analysis enabling you to view 
the performance of individual transactions. In addition, you can email a 
link to the Dashboard page.

Before you can view performance data in the Dashboard, you run the load 
test, and select which load test runs to publish to the Dashboard.
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The Dashboard tab displays the overall status of the most recent load test 
run. It also provides drill-down analysis of all included load tests when 
measured against the established performance criteria.

The General tab provides an overview of a project’s activities, including 
information on running load tests, recently run load tests, and timeslot 
reservations.

The Status Page - General Tab

The General tab of the Status page provides an overview of a project’s 
activities, including information on running load tests, recently run load 
tests, and timeslot reservations.

To open the General tab, select Projects > Status from the left-side menu, 
and select the General tab. 

The General tab displays:

➤ Currently Running Load Tests. If one or more load tests are currently 
running, they are displayed under this heading together with the test start 
time. Click the name of a running load test to monitor the load test run. For 
details, see “Monitoring Load Test Data” on page 318.

➤ Recently run Load Tests. The five most recently run load tests are displayed 
under this heading together with the test run date. Click the name of a load 
test to view results for the load test run. For details, see “Viewing Load Test 
Results” on page 417.

➤ Next reserved Timeslots. Timeslots that have been reserved for a load test 
are displayed under this heading. The load test start time, duration, and the 
number of Hosts (and Vusers) are displayed. For details, see “Reserving 
Timeslots” on page 91.
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Viewing the Dashboard

The Performance Center Dashboard displays the status of each load test in 
your project that has been published to the dashboard. The load test status 
is the overall status of the load test, determined by the condition of the last 
run of the load test.

A load test can be assigned one of the following status icons:

When you log on to Performance Center and select a project, the Dashboard 
for the project opens. For more information about posting load tests to the 
dashboard, see “Publishing Load Test Performance Results” on page 52.

To navigate to the Dashboard from a page within your project, select 
Project > Status, and click the Dashboard tab.

Icon Rating Description

(green) Succeeded Load test reached all its targets.

(red) Failed Load test did not reach all its targets. A load 
test receives a Failed status if any 
transaction within the test does not reach 
its performance targets.

(gray) No data No load tests targets were defined for the 
project.
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To send an email with a link that opens a view of the dashboard, click Send 
Dashboard link.

Note: The email recipient must have Network access to the server on which 
the User site resides.

Viewing Transaction Tables
You can view the status of individual transactions in a particular load test, or 
for all load tests in the Dashboard, from the load test transaction tables.

To view transactions for a particular load test:

➤ In the Load Tests Summary section, click a load test to open the transaction 
table for that load test. A transaction table opens in the Load Test Details 
section, displaying the individual transactions for that load test.
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The Load Tests Details section displays all the reported transactions for the 
selected load tests. The transaction status consists of a Succeeded or Failed 
rating. If a transaction has a Failed status, the table also provides a 
description of the load thresholds that caused the failure. If no targets were 
set for the load test, the No Data status is displayed. 

To view transactions tables for all load tests:

➤ In the Load Tests Summary section, click the Click here link. 

A transaction table for each load test opens in the Load Test Details section, 
displaying the individual transactions for each load test.

Understanding Drilldown Data

The transaction tables enables you to drill down to view performance graphs 
for all load test runs posted to the Dashboard. The graphs display the 
performance of transactions within an established threshold and display 
trend data. You create thresholds by specifying performance targets. For 
more information, see “Setting Performance Targets” on page 46. 

You can view the performance graphs for a particular transaction or for all 
transactions in the load test. 
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To display performance graphs for a particular transaction:

➤ On the Status page Dashboard tab, in the Load Tests Details section click a 
transaction to open the performance graph for that transaction. 

A transaction graph is displayed for the load test. The graph displays trend 
data for the various load test runs posted to the Dashboard. 



Chapter 3 • Project Status

45

The graph’s title bar provides the load test criteria and load value. For each 
transaction the actual performance is displayed as a bold line, while the 
defined goal is displayed as a dashed line in the same color. This allows you 
to evaluate trends and performance in your load tests.

Creating a Project Dashboard

Creating the initial dashboard for your project involves the following steps:

➤ Creating Benchmark Load Tests

➤ Setting Performance Targets

Creating Benchmark Load Tests
Using VuGen, create one or more scripts that emulate typical end-user 
activities running on your application. The scripts should be designed to 
include key performance transactions. For more details on recording scripts, 
see the HP Virtual User Generator User Guide. In the following procedure, you 
will establish transaction response time goals for the recorded transactions 
you designate.

To create a benchmark load test:

 1 Incorporate your scripts into a load test. By setting performance targets for 
the load test, you create benchmarks to measure your applications 
performance. For more details on creating load tests, see Part II, “Designing 
Load Tests.”

 2 Save the load test and follow the directions for setting performance 
thresholds in “Setting Performance Targets” on page 46.

Note: You can include a load test in the Dashboard and set performance 
targets for a saved load test at any time.
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Setting Performance Targets
After you record and save your load test, you set various load test 
performance targets using the SLA wizard. You should configure the targets 
to establish acceptable performance and time criteria.

Note: 

➤ Setting performance targets has no impact on the way your load test 
runs. After a load test run, Performance Center analyzes the results and 
compares them to the targets you set. For more information on load test 
analysis, see “Viewing Load Test Performance Targets and Results” on 
page 47.

➤ Performance targets are not copied when you clone a load test (by 
clicking Save As in the Load Test configuration pages).

For details on defining performance targets for your load test, see Chapter 8, 
“Defining Performance Targets.”

After you set performance targets, you can run the load test, and select 
which load test runs to publish to the Dashboard. 

Note: You must enable the load test to be published to the Dashboard before 
you can publish the load test results. For more information, see “Publishing 
Load Test Performance Results” on page 52.
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Viewing Load Test Performance Targets and Results

After a load test run, you can view load test results and targets and 
determine the runs you want to publish to the Dashboard. Performance 
Center analyzes the test run data and compares the performance targets to 
the actual results. You can view a full list of the load tests in the Load Tests 
page and performance targets and results in the Run Results page.

Viewing Load Tests
The Load Tests page displays all the load tests—up to 10 load tests at a 
time—that you have created to date, including load tests you ran or are 
currently running, load tests you saved, and load tests scheduled to run at a 
later date.

To open the Load Tests page, select Load Tests > Manage.

From the Load Tests page, you can do the following:

➤ View target analysis

➤ Create new load tests

➤ Perform actions on your load tests, including run load tests, delete load 
tests, set performance targets, and publish test results to the Dashboard

➤ Link to various pages relevant to a load test, including the Load Test 
configuration page (from the Load Test link) and the Load Test Results 
page (from the Status link)
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The Load Tests page is comprised of the following areas:

Filter Area

Enables you to filter the Load Tests table according to load test name or 
when the load test was last updated.

Load Test Table

Displays information about the load tests in the Performance Center system, 
and enables you to perform actions on the load tests.

The table contains the following columns:

Field Description

Name (# of 
Runs)

Displays the name of the load test and the number of runs for the 
load test. Click a load test name to edit that load test's settings. 
Click the "+" icon to view a run history of the load test, including:

➤ ID. The ID number assigned to each load test run.

➤ Date. The time and date of the load test run.

➤ Tester. The user who ran the load test.

➤ Duration. The duration of the load test run.

➤ Vusers. The number of Vusers that ran in the load test.

➤ Status. The status for each load test run. Click the status 
description to view and analyze the results of that run in the 
Load Test Results page. For more information on the run status, 
see “Collating and Analyzing Load Test Data” on page 412. 

Last 
Modified 
Date

Displays the date that the load test was last modified.

Status Displays the current status of the load test. Possible statuses are 
Valid and Invalid. If the status is Invalid, click the link to open the 
validation results. The validation results provide the problem level, 
the name of the tab and the location of where the problem 
occurred, and a description of the problem. Click Edit Load Test to 
open the Load Test configuration page for the invalid test. Fix the 
problem in the load test and click Save to validate the test. 
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You can click a column heading to sort the table by that field.

Note: Sorting settings are saved per user, per project. The next time the same 
user enters the Load Tests page in a specific project, the page displays the 
results based on the most recent sort order.

Working with the Load Tests Page
You use the filter area of the Load Tests page to locate specific load tests.

To view target analysis:

 1 Select Load Tests > Manage. The Load Tests page opens.

 2 To locate a specific load test, filter the list in the filter area at the top of the 
page. 

➤ To filter the load tests by name, in the Load Test Name box, enter the 
name of the load test (or part thereof). The page returns a list of all the 
load tests that have the specified string anywhere in their names. For 
example, if you entered te, the display list might include create1 and 
dftest(10).

Click the Publish Load Test to Dashboard button to enable you to 
add load test results to the Dashboard. Once enabled, you can 
select the load test run results you want to publish to the 
dashboard.

Click the Remove Load Test from Dashboard button to delete load 
test results or individual load test runs from the Dashboard.

Click the Set Load Test Performance Targets button to set load test 
thresholds using the Service Level Agreement Wizard.

Click the Run Load Test button to run a load test.

 Click the Delete Load Test button to delete a load test or particular 
run from the Performance Center database.
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➤ To show loads test that ran between specific dates, use the browse 
buttons adjacent to the Last Modified: From and To boxes to select the 
dates.

Click Filter to filter the list.

Note: Filter settings are saved per user, per project. The next time the same 
user enters the Load Tests page in a specific project, the page displays results 
based on the most recent filter.

 3 Click the "+" button adjacent to a load test to expand the list of load test 
runs. 

 4 Select the test run that you want to view, and click the link in the Status 
column. 

The Load Test Results page opens and displays the Files and Reports tab. The 
Files and Reports tab provides access to the information about the load test 
such as the default report, Vuser logs, and comments. For more information, 
see “Files and Reports Tab” on page 418. 

 5 To review the load test analysis information, select the Results vs. Targets 
tab. After you review this information, you can select the load test run 
results to publish to the Dashboard (see “Publishing Load Test Performance 
Results” on page 52). The run status (published/not published) is displayed 
below the table.
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Searching Load Test Results
In the Search Load Tests Results page, you can view a list of load tests which 
have already been run and which have load test results.

To search for a load test results of a particular load test:

 1 On the Performance Center left menu, select Load Tests > Search Results. 
The Search Load Tests Results page opens.

The page displays 15 load tests at a time.

To see more load tests, you can use the arrow buttons above the list to 
navigate between sets of 15 load tests.

 2 To locate a specific load test, filter the list in the filter area at the top of the 
page. 

➤ To filter the load tests by name, in the Load Test Name box, enter the 
name of the load test (or part thereof). The page returns a list of all the 
load tests that have the specified string anywhere in their names. For 
example, if you entered te, the display list might include create1 and 
dftest(10).

➤ To show loads test that ran between specific dates, use the browse 
buttons adjacent to the Run Date: From and To boxes to select the dates.
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➤ To filter the load tests by user notes, in the User Notes box, type an 
alphanumeric string that is included in the notes.

Click Filter to filter the list.

Note: Filter settings are saved per user, per project. The next time the same 
user enters the Search Load Tests Results page in a specific project, the page 
displays results based on the most recent filter.

 3 Click the Run ID number of the desired load test. The Load Test Results page 
opens and displays the Files and Reports tab. 

The Files and Reports tab provides access to the information about the load 
test such as the default report, Vuser logs, and comments. For more 
information, see “Files and Reports Tab” on page 418. 

Publishing Load Test Performance Results

When you run the load test, Performance Center measures the transaction 
response time and charts the success rate of the selected transactions for the 
established criteria. After reviewing the results of a load test run, you can 
select which load test runs to include in the Dashboard. 

You publish runs to the Dashboard from the Load Tests or Load Test Results 
page. You can publish the complete run, or part of a run—if, for example, 
you wanted to exclude the Start/Stop Vuser action.

Before you can publish a load test’s run results to the Dashboard, you must 
enable publishing the load test.
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To publish load test results to the Dashboard:

 1 On the Load Tests page, select the load test that you want to publish, and 
click the Publish to Dashboard button.

The button icon changes to Published. You can now publish run results for 
the load test to the Dashboard.

 2 Under the selected load test, select the run that you want to publish from 
the Load Tests page or the Load Test Results page.

➤ On the Load Tests page, select the load test run, and click the Publish to 
Dashboard button.

➤ On the Load Test Results page, select a load test run, click the Results vs. 
Targets tab, and click Publish.
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 3 In the Define Time Range dialog box that opens, select one of publishing 
options.

➤ Publish Complete Run. Publishes the complete run to the Dashboard 
(default option).

➤ Publish Part of Run. Allows you to publish part of the run to the 
Dashboard by defining the time range. This is useful, for example, if you 
want to exclude the Start Vuser action. Define the start and end time by 
specifying the number of minutes to wait after the run begins.

 4 Click OK. Performance Center publishes the results (or part of them) to the 
Dashboard. The Published button is displayed, indicating that the load test 
run has been published to the Dashboard.

Note: You can add a load test’s results to the Dashboard at any time from the 
Load Tests page.

To remove load test results from the Dashboard:

➤ On the Load Tests page, select the load test that you want to remove from 
the Dashboard, and click the Remove from Dashboard button. The load test 
results are removed from the Dashboard.
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To remove a load test run from the Dashboard:

 1 On the Load Test Results page select the load test run to remove.

 2 On the Results vs. Targets tab, click Remove from Dashboard.

Alternatively, on the Load Tests page, select the load test run that you want 
to remove from the Dashboard, and click the Remove from Dashboard 
button. 

The data for the load test run is removed from the drilldown performance 
graphs. If no other runs for the load test have been published to the 
Dashboard, the load test is removed from the Dashboard.
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4
Performance Center Hosts

Host machines are used for test runs. You manage the hosts in the 
Performance Center Administration site. In the User Site you can view the 
hosts that are assigned to your projects. You can check the status of selected 
hosts and reboot hosts when necessary.

This chapter includes:

 ➤  About Performance Center Hosts on page 57

 ➤  Understanding the Hosts Page on page 58

 ➤  Editing Host Details on page 65

 ➤  Viewing Host Details on page 66

 ➤  Rebooting Hosts on page 73

 ➤  Understanding Host Allocation on page 75

 ➤  Handling Resource Failure on page 76

 ➤  Checking Hosts on page 77

About Performance Center Hosts

The Administrator manages the information stored in the system about the 
hosts. Performance Center uses the information to allocate hosts to load test 
runs. 

When you design a load test, you specify how many hosts it requires and 
reserve the necessary number of hosts for a specific time period. 
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Since the availability of hosts is limited, Performance Center allocates 
specific time periods called timeslots. Reserving a timeslot, actually reserves 
the required hosts for the specified timeslot. When the user tries to reserve a 
timeslot, Performance Center allocates hosts according to parameters that 
you control from the Hosts page in the Administration site.

For more information about managing Performance Center hosts, see the 
HP Performance Center Administrator Guide.

Understanding the Hosts Page

The Hosts page displays information about the host machines in the 
Performance Center system, and enables you to reboot hosts, modify host 
details, and check host connectivity.

To access the Hosts page:

➤ On the Performance Center left menu, select Projects > Hosts. The Hosts 
page opens.

The Hosts page is comprised of the following areas:

➤ Filter area. Enables you to set the number of hosts displayed, and filter 
the Hosts table according to location, name, and run status criteria. For 
more information, see “Filter Area” on page 59.

➤ Hosts table. Displays information about the hosts in the Performance 
Center system, and enables you to perform actions on the hosts. For 
more information, see “Hosts Table” on page 60.

➤ Details for Host area. Displays more details about the hosts and enables 
you to edit host details. For more information, see “Editing Host Details” 
on page 65.
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Filter Area
The Filter area of the Hosts page enables you to customize the host 
information displayed. You can set the number of hosts displayed on the 
page, and filter the host display.

Setting the Number of Hosts Displayed

You can set the number of hosts that are displayed on the page. You can 
select to display 10, 20, 50, 100, or all hosts on a page.

To set the number of hosts displayed:

 1 In the Filter by section, in the Per Page list, select the number of hosts to 
display per page.

 2 Click Filter. The display updates according to the option you selected.

Filtering the Hosts Display

You can use the filter lists to display a specified subset of the hosts, 
according to location, name, and run status criteria.

To filter the display:

 1 From one or more of the filter lists, select the desired filtering options. 

➤ The Run Status options are:

➤ All Statuses. Displays all hosts regardless of status.

➤ Idle. Displays hosts in the following states: Finished, Run Failure, Failed 
Collating Results, Failed Creating Analysis Data, Deleting Temporary 
Results, Temporary Results Deleted. A short time after the run, it also 
displays hosts in the Collating Results, Creating Analysis Data, Before 
Collating Results, and Before Creating Analysis Data state.

➤ Run. Displays hosts in the following states: Ready, Running, Stopping. 
Immediately after the run, it also displays hosts in the Collating 
Results, Creating Analysis Data, Before Collating Results, and Before 
Creating Analysis Data state. 
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 2 Click Filter. The display updates according to the options you selected.

Note: Filter settings are saved per user, per project. The next time you enter 
the Hosts page in a specific project, the page displays results based on your 
most recent filter.

Hosts Table
The Hosts table displays the host details. You can sort the table by any of the 
columns. For instructions on sorting the table, see “Sorting the Hosts Table” 
on page 63.

The Host table displays the following information about the hosts:

➤ Status light. An indicator of the current system performance of the host, 
represented by a color. For more details about the host status indicator, see 
“Understanding Host Status” on page 63.

➤ Name. The host name that you assign when you add a new host. You can 
click the name to open the Host Details page for the host. 

➤ Purpose. The function the host performs in a test run. You define a host as a 
Controller, Load Generator, Controller + Load Generator, or Data Processor. 
The purpose of the machine is indicated by a series of icons, as described in 
the following table.

Icon Purpose Description

Controller The Controller host manages the load test. Each 
test requires one host as a Controller. 

Load Generator Load generator hosts run the Vusers in a load test. 
There can be any number of load generators in a 
given test. 
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➤ Pool. The host pool to which the host is assigned. Host pools allow you to 
control which hosts are allocated to which projects. When allocating hosts 
for a test, the system allocates hosts with the pool specified for the project in 
the project profile. For more information about host pools, see the HP 
Performance Center Administrator Guide.

➤ Location. Location of the host. For example, locations can be defined 
according to physical areas. The location also determines whether the host 
is located over a firewall.

➤ State. The state of the host. An indicator is displayed next to the host name, 
according to its current state. For more details about the host status 
indicator, see “Understanding Host Status” on page 63.

➤ Run Name. The name of the load test that is currently running on the host.

Controller + 
Load Generator 

Enables you to use the host as a Controller and a 
load generator. You can use the Controller as a 
load generator, and assign Vusers to run on the 
Controller. In general, this is not recommended 
practice and is only appropriate for load tests that 
have a very small number of Vusers.

Data Processor The data processor is used for publishing 
information to the Dashboard. Although it is 
possible to configure a machine as a Controller 
and a data processor, it is not recommended.

Over Firewall Used alongside the load generator icon to indicate 
that the load generator is located over a firewall. 

 SSL Used alongside the load generator icon to indicate 
that the load generator uses SSL to communicate 
with the Controller during run time. 

Icon Purpose Description
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➤ Run Status. The status of the load test that is currently running on the host. 
This field applies only to hosts that are in the Running state. Click the 
Running link to display information for the current run. The Last Run 
Information page contains data only if there is an active run.

➤ Run Time. The start time of the load test that is currently running on the 
host.

➤ Project. The name of the project that is currently running in the load test on 
the host.

➤ User. The name of the user that is currently running the load test on the 
host.

Below the Hosts table, you can perform the following actions:

➤ Reboot. Enables you to remotely reboot host machines from the User site. 
For more information, see “Rebooting Hosts” on page 73.

➤ Check Hosts. Enables you to check the connections between various host 
machines within your system. For more information, see “Checking Hosts” 
on page 77.
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To perform actions on all the Performance Center hosts, select all hosts by 
selecting the check box at the top of the check box column. To clear all 
check boxes at once, clear the check box at the top of the check box 
column.

Sorting the Hosts Table

You can sort the hosts according to the values in any column.

To sort the hosts:

Click the column heading of your choice. A downward facing arrow is 
displayed next to the column heading. The hosts are sorted in descending 
order of the values in that column.

When you click the heading again, the arrow reverses direction, and the 
hosts are sorted in ascending order of the values in that column.

Note: Sorting settings are saved per user, per project. The next time the same 
user enters the Hosts page in a specific project, the page displays the results 
based on the most recent sort order.

Understanding Host Status
Host status is an indicator of the current system performance of the host, 
represented by a color. A combination of the State and the SiteScope 
measurement determines the indicator color. A color other than green is a 
warning that the system performance is less than optimal and warrants 
investigation. 

System performance is assessed according to four parameters: CPU usage, 
memory usage, disk space, and running services. There is a threshold for 
each parameter. If a Performance Center service stops for any reason, the 
machine state turns red (Error). 
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The following table lists the possible states and the associated indicator 
color.

Indicator Host State SiteScope Status

Operational Host is operational.

Operational Some measurements are out of range, but the 
host is still operational.

Operational Indicates that at least one of the performance 
parameters is outside of its threshold, and the 
host is not recommended for running tests on.

Resource Failure Host is not operational. If the host is in the 
Resource Failure state, you should try to fix the 
problem, then change the condition back to 
Operational. If the system detects that the host 
is still not working, the condition reverts to 
Resource Failure.

Unavailable The user manually changed the host status to 
Unavailable.

Maintenance An installation is taking place.

Rebooting Host reboot is taking place. Displays the time 
(MM:SS) since the rebooting process started.

Transferring 
X%

A patch is being transferred from the File server 
to the host. The percentage shows the progress 
of the patch transfer.

Installing X% A patch installation is taking place. The 
percentage shows the progress of the patch 
installation.
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Editing Host Details

You can change the state of one or multiple hosts in the Details for Host area 
on the Hosts page.

Important: To change the state of a host in the User Site, users need to be 
assigned with Edit host (partial) project permissions. 

To change the state of a host:

 1 Select the desired hosts in the Hosts table. The selected hosts are displayed 
in the Details for host list.

 2 In the Details for Host area, select one of the following states from the State 
list: Operational, Unavailable, Resource Failure, or Maintenance. 
Additionally, temporary states of Rebooting, Transferring, or Installing are 
available while a machine goes through a rebooting or patch installation 
process. 

If the host is in the Resource Failure state, try to fix the problem, then 
change the condition back to Operational.

 3 Click Save to save changes to the hosts. Performance Center displays a 
message informing you that the details were successfully saved. If you move 
away from the page without saving the changes, the settings are not saved.
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Viewing Host Details

You can view and manage details about each host on the Host details page. 

You access the Host details page by clicking the name of any host in the 
Hosts page.

The Host details page includes the following tabs:

➤ Properties tab. Allows you to view host properties. See “Host Properties 
Tab” on page 67.

➤ Status tab. Allows you to view the host status and to perform host 
connectivity checks. See “Host Status Tab” on page 69.

➤ Processes tab. Allows you to view and end processes on a host. See “Host 
Processes Tab” on page 70.

➤ Logs tab. Allows you to view detailed information about the tasks 
performed on the host, the action status, and a description of any errors. 
See “Host Logs Tab” on page 71.

➤ Runs tab. Allows you to view runs on a specific host. See “Host Runs Tab” 
on page 72.
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Host Properties Tab
The Properties tab provides general information about the host.

The Host Properties tab displays the following details:

➤ Host Name. The host name that you assign when you add a new host.

➤ Host Logical Name. The logical name given to the host when it was added to 
the system. 

➤ OS Type. The host operating system.

➤ Installation. Indicates whether the host is a standalone load generator.

➤ Purpose. The function the host performs in a test run. You define a host as a 
Controller, Load Generator, Controller + Load Generator, or Data Processor.

➤ Comments. Any relevant information about the host.

➤ Priority. A rank assigned to the host. The higher the priority you give the 
host, the more likely the host will be allocated to a test. 
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➤ Location. Location of the host. For example, locations can be defined 
according to physical areas. The location also determines whether the host 
is located over a firewall.

➤ MI Listener. For hosts located over a firewall, the IP address or name of the 
MI Listener that enables data collection.

➤ Host Pool. The host pool to which the host is assigned.

➤ Allocation. The number of timeslot to which the host is allocated. 0 means 
the host is not allocated.

➤ State. The state of the host. The possible states are; Operational, 
Unavailable, Resource Failure, and Maintenance. Additionally, temporary 
states of Rebooting, Transferring, or Installing are assigned while a host goes 
through a rebooting or patch installation process.

➤  Login information.

➤ User Name. The user name of the host. 

➤ Password. The password of the host.

➤ Domain. The host domain.

➤ Installed Components. A list of components installed on the host, including 
version and patches.

➤ Security Mode. If the host is designated as a load generator, this field 
indicates whether the load generator is located over a firewall and whether 
it is using SSL to communicate with the Controller.

Note: 

➤ When the load generator is configured to use SSL, it uses SSL to 
communicate with the Controller during run time only. For non 
run-time functionality (including collating results), the load generator 
does not use SSL as the communication protocol.

➤ When Host Security settings enforce host communication over secure 
channels, SSL security is still supported.
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Host Status Tab
The Check Host area of the Status tab provides information about the 
connections between the selected host and various machines within your 
system. 

For more information about checking host connections, see “Checking 
Hosts” on page 77.

If SiteScope monitoring is enabled, the SiteScope Data table displays 
detailed information about the host, as collected by the SiteScope monitor. 
For more information, see the HP Performance Center Administrator Guide and 
the HP Performance Center System Configuration and Installation Guide. 

All functions are automatically performed when the tab is opened, the page 
is refreshed, or when you click the Check Host button.
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If you want the selected host to ping a remote site, type the URL address in 
the Ping to URL box and click Check Host. Performance Center displays the 
results in the Ping to URL Status field.

Note: To ping to a host or to a URL, the Performance Center system user 
must have administrator privileges.

Click the Hosts link at the top of the page to return to the Hosts page.

Host Processes Tab
The Processes tab provides detailed information about the processes and 
resource usage of the selected host. 
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To end a process, click the Kill Process button in the process’s Kill column.

Click the Hosts link at the top of the page to return to the Hosts page.

Note: Performance Center is unable to display processes and resource usage 
information for UNIX machines.

Host Logs Tab
The Logs tab provides detailed information about the tasks performed on 
the selected host, the action status, and a description of any errors. 

You can filter the information by a specific time frame, refresh the table to 
view the most current tasks, and clear the log. 

To view log files for the action, click the error description link.

Click the Hosts link at the top of the page to return to the Hosts page.
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Host Runs Tab
The Runs tab provides detailed information about load test runs performed 
on the selected host. 

You can filter the information by a specific time frame and refresh the table 
to view the most current tasks. You can also sort the information by clicking 
the header of any column in the table.

The Run Details table displays the following details about each test run: 

➤ Run ID. The identification number of the test run. This number is 
automatically generated by the system when the load test starts running.

➤ Date. The start date and time of the test run.

➤ Load Test. The name given to the test when it was created.

➤ Project. The name of the project running the test.

➤ User. The name of the user running the test.

➤ State. The state of the test run. If a test is stuck in a particular state, you can 
change it. For details, see the HP Performance Center Administrator Guide.

➤ Duration. The time the load test took to run.

Click the Hosts link at the top of the page to return to the Hosts page.
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Rebooting Hosts

Performance Center enables you to reboot hosts remotely from the User 
Site. 

Notes:

➤ You cannot reboot Controller and Load Generator hosts while they are in 
the Running state. You can only reboot these hosts when they are idle.

➤ You cannot reboot a UNIX host.

To reboot hosts:

 1 From the Hosts page, select the hosts you want to reboot.

 2 Click Reboot. The Reboot Hosts window opens.

If Performance Center is unable to reboot the host—for example, because 
the selected host is the Administration Site server or a task is running on the 
host—a message is displayed in the Message column.
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 3 Supply login information for all hosts that should be automatically logged 
on after the hosts reboot. If you leave the boxes empty, you must log on to 
these hosts at startup.

Note: If you supplied login information when the host was configured, it is 
displayed in the appropriate column.

 4 Click Reboot. 

You can follow the progress of the reboot from the Hosts page. During 
reboot, the state of the host changes to Rebooting and the time (MM:SS) 
since the rebooting process started is displayed.
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Understanding Host Allocation

When creating a test, the user specifies the number of hosts required for the 
test, and reserves a timeslot. To successfully reserve a timeslot, the required 
number of hosts needed for the test must be available.

When the user tries to reserve a timeslot, the system uses some of the 
information that is displayed on the Hosts page to determine if the required 
number of hosts, with the proper purposes, are available. If the required 
hosts are found, and are available for the requested time period, the timeslot 
is successfully reserved and the hosts are allocated. If the system cannot find 
suitable hosts to allocate for the requested time period, the timeslot cannot 
be reserved.

Each test requires one host as a Controller, one or more hosts that are load 
generators (it is possible to designate one host as a Controller + Load 
Generator), and one host for data processing. Performance Center uses 
different criteria to allocate hosts for each of these purposes, and out of all 
the hosts that meet the requirements, allocates those with highest priority. 
The two allocation methods are described below.

Allocating Controller and Load Generator Hosts
For load generation, Performance Center uses the following criteria for 
allocating hosts:

➤ Run ID. null means the host is not currently running.

➤ Allocation. 0 means the host is not allocated to the timeslot.

➤ State. Operational.

➤ Purpose. Controller, Controller + Load Generator, or Load Generator as 
indicated.

➤ Pool. The same pool as specified for the project for which the test is being 
run. For each project, Performance Center assigns hosts from a specific pool. 
This pool is specified in the project information page.

➤ Project. Either none or the name of the test’s project for which the test is 
being run. Priority goes to hosts already assigned to the project.



Chapter 4 • Performance Center Hosts

76

Allocating Data Processor Hosts
For data processing, Performance Center allocates a host with the following 
values:

➤ State. Operational.

➤ Purpose. Data Processor.

➤ Pool. The same pool as specified for the project for which the test is being 
run.

➤ Allocation. 0 - 5, because one host can be used for up to 5 concurrent 
operations.

Handling Resource Failure

If any of the hosts fail when Performance Center tries to run a test on the set 
of allocated hosts, the condition of the failed hosts changes from 
Operational to Resource Failure, and an error log describing the problem is 
sent to the main site.

You can try to fix the problem according to the description in the error log, 
then change the condition back to Operational. If the host is still not 
operational, the condition automatically returns to Resource Failure in the 
next test run. 

If you are using the Host Checkup Service (enabled from the General 
Settings of the Administration site), Performance Center automatically 
detects host resource failure and attempts to restore the host to the 
Operational state.
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Checking Hosts

You can check the connections between your project’s hosts and the various 
machines within your system. 

To check hosts:

 1 From the Hosts page, select the hosts that you want to check and click the 
Check Hosts button. The Check Hosts dialog box opens displaying the 
selected hosts together with an icon next to the host name indicating the 
host’s purpose. 

By default, all the selected hosts are enabled. If you not do want to check a 
specific host, clear that host’s check box.

Tip: Selecting or clearing the check box in the check box column header 
selects or clears all the check boxes respectively.

 2 If you want the selected hosts to ping a remote site, in the Ping URL column 
header, type the URL address.
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 3 Click Check Hosts. Based on the purpose of the host, Performance Center 
checks one or more of the following connections:

➤ Ping to Host. The Administration Site server pings the selected host.

➤ Over Firewall Status. For load generators over a firewall, Performance 
Center checks that the load generator is connected to an MI Listener.

➤ File Server. The selected host attempts to write, read, and delete from the 
File Server.

➤ Database. The selected host connects to the Database Server.

➤ Ping URL. The selected host pings the listed URL.

Note: To ping to a host or to a URL, the Performance Center system user 
must be a user with administrator privileges.

The Check Hosts table displays the success or failure of the actions.

The following table describes which connections Performance Center checks 
for each type of host. 

Host purpose
Ping to 
Host

Over 
Firewall 
Status

File 
Server

Database Ping URL

Regular load generator Yes N/A N/A N/A Yes

Unix Load Generator Yes N/A N/A N/A N/A

Standalone load 
generator

Yes N/A N/A N/A N/A

Load generator over 
firewall

N/A Yes N/A N/A N/A

Controller host Yes N/A Yes Yes Yes

Data processor Yes N/A Yes Yes Yes
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 4 Select a host to view the results of the host check. Details for each action are 
listed in the Result Status area.

 5 Click Close to return to the Hosts page.
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5
Working With Timeslots

To run a load test for your application, the number of load generators and 
Vusers required for running the test must be available. You can reserve 
resources so they will available for a test run. You can also have Performance 
Center automatically start running a test during the reserved timeslot 
period.

This chapter includes:

 ➤  About Project Resources and Reserving Timeslots on page 82

 ➤  The Timeslots Page at a Glance on page 83

 ➤  Viewing Timeslot Information on page 86

 ➤  Reserving Timeslots on page 91

 ➤  Scheduling Load Tests to Autostart on page 98

 ➤  Configuring Post-Run Analysis Settings on page 101

 ➤  Running Vusers on the Controller Machine on page 102

 ➤  Editing Timeslots on page 104
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About Project Resources and Reserving Timeslots

The Administrator manages project resources by defining the purpose of 
each host, controlling which projects can use which hosts, prioritizing the 
use of certain hosts over others, monitoring host performance, and 
following up on any operating problems.

When you create a load test, you specify the number of host machines 
required for the load test from the project resources available. The available 
resources are determined by the number of host machines, and the purpose 
assigned to each host. Each test requires one host as a Controller, one or 
more hosts to be load generators (it is possible to designate one host as a 
Controller + Load Generator), and one host for data processing. 

Note: Unless your project is allowed to use a Controller as a load generator 
(determined by the administrator), you cannot assign Vusers to run from 
the Controller machine. For best results, we recommend running Vusers on 
dedicated load generator machines only. Running Vusers on the Controller 
can overload the machine and affect load test results.

You use the Timeslots page to reserve a resources for your load test. To check 
there are sufficient resources available to run your load test, you can select a 
load test and view the timeslots that have adequate resources available to 
run the load test, or filter the timeslots by the required number of load 
generators (and Vusers). If the required number of load generators and 
Vusers are available, you can reserve the resources for a specific time period. 
You can reserve a timeslot even if you have not yet defined your load test.

In addition, if you want your load test to begin its run automatically, you 
can reserve the date and time of the timeslot using the Autostart feature. 
Performance Center automatically runs the test at the start of the timeslot it 
is associated with. 

You can perform the following actions from the Timeslots page:

➤ Check timeslot availability

➤ Reserve timeslots
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➤ View all of your currently reserved timeslots

➤ Schedule a load test to start running automatically

➤ Select the post-run analysis option

➤ Enable Vusers to run on the Controller machine

➤ Edit and delete timeslots

The Timeslots Page at a Glance

The Timesplots page displays reserved timeslots in either a calendar view 
(default) or a table view.  

Timeslot Inventory
The inventory section at the top right of the page displays the total 
resources available for the project. 

Resources 
availability

Inventory

Timeslots 
view
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The inventory provides project limits and host pool availability as follows:

Timeslots Views
You can view reserved timeslots either in the calendar view or in the table 
view. 

➤ Calendar view. (Default view) Provides access to timeslot information 
over a 12-month range (the six past and six future months). The 
Information is displayed over a 7-day period.

Project Limits Vusers The maximum number of Vusers a project can run 
at once. The total number of Vusers used by all the 
project's concurrent load tests must not exceed this 
number.

Runs The maximum number of concurrent runs allowed 
within a project.

Machines The maximum number of machines a project can 
use at once. The total number of machines used by 
all the project's concurrent load tests must not 
exceed this number.

Host Pool 
Availability

Load 
Generator 
(LG)

The number of machines available in the project’s 
pool on which Vusers are run during a load test.

Controller 
(C)

The number of machines available in the project’s 
pool that can be used to design and manage a load 
test.

C + LG (Controller + Load Generator) The number of 
machines available in the project’s pool that can 
serve as both a Controller and a load generator. 
These machines provide greater flexibility—
especially if resources are scarce—by allowing you 
to configure your load test to use the Controller as 
a load generator and run Vusers on the Controller 
machine.



Chapter 5 • Working With Timeslots

85

In the resource availability section of the calendar view, you can specify a 
date range and set load generator and Vuser criteria (if enabled) to filter 
the calendar and check timeslot resource availability. You can also show 
timeslots for a specific load test.

➤ Table view. Displays information about reserved timeslots in a tabular 
form. It displays information about who reserved the timeslot, the 
selected load test (if selected) and scheduled start time of the load test, 
how long the load test is scheduled to run, and the number of machines 
reserved for the load test.

In the resource availability section of the table view, you can specify the 
date range for which to view reserved timeslots. 

For more information, see “Viewing Timeslot Information” on page 86.
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Timeslot Information
The tabs displayed at the bottom of the Timeslots page provide information 
about the timeslot and timeslot options. You use this area to reserve 
timeslots and edit existing reservations.

For more information, see “Reserving Timeslots” on page 91.

Viewing Timeslot Information

You can view information for reserved timeslots in the calendar and table 
views of the Timeslots page, and resource availability information for all 
timeslots in the calendar view.

This section includes:

➤ “Checking Resource Availability in the Calendar View” on page 87

➤ “Checking Reserved Timeslot Information in the Calendar and Table Views” 
on page 90
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Checking Resource Availability in the Calendar View
You can check resource availability for all timeslots by specifying the 
number of load generators (and Vusers) that you require, or by specifying a 
particular load test, and having Performance Center display the available 
timeslots based on the number of load generators (and Vusers) required for 
that test.

To view resource availability in Calendar View:

 1 Open the Timeslots page (Project > Timeslots).

 2 In the resource availability section of the calendar view, in the Show 
timeslots for boxes, specify the date range for which you want to view 
timeslots.

Note: The calendar view options are limited to a twelve month range (the 
six previous, and the six future months). To view a wider range, use the table 
view.

 3 In the View availability for boxes, type the number of load generators (and 
Vusers) to view availability for.

Note: You can use the Controller as a load generator.

 4 Click Go. The timeslots are displayed as follows: 

Indicator
Timeslot 
Availability

Description

Current The current time.

Reserved by this 
project

The timeslot (and some resources) is 
reserved by the current project. There are 
enough resources to run an additional load 
test.
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To view a breakdown of available resources for a specific timeslot (where 
some resources are available), place the cursor over the timeslot. A tool tip 
appears displaying available resource information for that timeslot.

 5 To clear the filter and display the timeslot availability for the selected date 
range, click View Existing Timeslots.

Reserved by other 
projects

The timeslot (and some resources) is 
reserved by other projects. There are 
enough resources to run an additional load 
test.

Reserved by this 
and other projects

The timeslot (and some resources) is 
reserved by the current project and by 
other projects. There are enough resources 
to run an additional load test.

Available The timeslot is available and there are 
sufficient Hosts (and Vusers), and the 
number of concurrent runs is within the 
project’s limits.

No resources The timeslot is available but the requested 
number of Hosts (or Vusers) are not 
available, or the number of concurrent runs 
exceeds the project’s limit.

Indicator
Timeslot 
Availability

Description
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 6 To view resource availability for an existing load test, click More Options. 
The More Options dialog box opens.

Select the desired load test from the list.

If you intend to run Vusers on the Controller machine, select Run Vusers on 
Controller. Performance Center checks the availability of the specified 
number of load generator machines, assuming that one of the load 
generators is a Controller machine. If you do not select this option, 
Performance Center checks the availability of the specified number of load 
generator machines, plus an additional machine for the Controller. For 
more information, see “Running Vusers on the Controller Machine” on 
page 102.

 7 Click OK. The More Options dialog box closes and the number of load 
generators (and Vusers) required in the selected load test is displayed in the 
View timeslot availability section.

 8 Click Check Timeslots to check availability for the load generators (and 
Vusers) required in the selected load test.
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Checking Reserved Timeslot Information in the Calendar 
and Table Views
You can view information for reserved Timeslots in both the calendar view 
and the table view.

➤ To check a reserved timeslot in the calendar view, click a reserved 
timeslot in the timeslot grid.

➤ To check a reserved timeslot in the table view, click a timeslot in the 
timeslots table.

If only one timeslot is reserved, the timeslot information is displayed in the 
Timeslot Details tab. 

If more than one timeslot is reserved for this time, a table containing all the 
existing timeslots reserved for this time is displayed below the timeslot grid 
in calendar view and below the reserved timeslots table in table view.

If you select a row in the table, the corresponding timeslot is highlighted in 
the timeslots grid. To edit an existing timeslot, click the Edit link in the row 
of the selected timeslot. The Timeslot Details tab opens, displaying details of 
the selected timeslot.
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Note: The availability calculation is done according to the default project 
settings. By default, the Run Vusers on Controller option is unchecked and 
the calendar displays availability according to these settings. If your host 
pool contains only one host, and Run Vusers on Controller is not selected, 
the calendar displays a red X indicating there are not enough resources 
available. To change the default settings, click More options and select Run 
Vusers on Controller. Set the number of load generators required and click 
Go to refresh the view.

Reserving Timeslots

You reserve a timeslot for a load test from the Timeslots page. You configure 
the timeslot settings from the following tabs that are displayed at the 
bottom of the Timeslots page:

➤ Timeslot Details. Allows you to select the load test start time, duration, 
number of Vusers, and determine how your host machines are allocated. 
It also allows you to autostart your test so that it begins its run 
automatically.

➤ Options. Allows you to select the post-run analysis option and configure 
the load test to run Vusers on the Controller machine. For more 
information, see “Configuring Post-Run Analysis Settings” on page 101, 
and “Running Vusers on the Controller Machine” on page 102.

➤ Comments. Allows you to add comments about to the timeslot. Type 
comments in the Comments field and click Save to save the comments.

Note: When working with a double-byte language (Japanese, Chinese, 
Korean, or Vietnamese), you can use up to 160 characters.
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To reserve a timeslot:

 1 Check that the desired resources are available. For more information, see 
“Viewing Timeslot Information” on page 86.

 2 Select a starting date and time for your load test by doing one of the 
following:

➤ In the calendar view, click the cell that represents the desired starting 
date and time.

➤ In the Timeslot Details tab, click the Select Start Time link to open the 
calendar, and select the exact year, month, day, and start time. 

Notes:

➤ If you select your date using the calendar in the Timeslot Details tab and 
it does not fall within the currently displayed calendar view, you can 
manually change the display range to view your reservation.

➤ To clear the Timeslot Details tab at any time, you click New.

 3 Type the desired duration of the timeslot in the Duration box. You can only 
reserve durations in half and whole hour increments. Performance Center 
automatically adds an extra 15 minutes for processing results.
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 4 If you want the test to begin its run automatically, select Autostart and click 
Select Load Test. The Select Load Test dialog box opens.

From the list, select the test you want to autostart, and click OK. 

For more information on autostarting load test runs, see “Scheduling Load 
Tests to Autostart” on page 98.

Note: Only tests that are configured with scheduler settings and that have 
the Valid status are available from the list.

 5 In the Number of Vusers box, specify the number of Vusers you require.
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 6 Under Machine Selection, select one of the following options to determine 
how your load generator machines are allocated: 

➤ Automatic - Load Generators #. Instructs the system to assign your test to 
any available load generator. Specify the total number of load generators 
you require in the load test. Performance Center reserves the specified 
number of load generator machines, plus an additional machine for the 
Controller, unless the Run Vusers on Controller option is selected in the 
Options tab. For details, see “Running Vusers on the Controller Machine” 
on page 102.

Click Save to reserve the timeslot. A message at the bottom of the 
Timeslots page informs you whether the timeslot was reserved. 

➤ Manual. Allows you to assign specific load generators to your test. 
Continue with “Manually Selecting Host Machines” on page 96.

For more information about timeslot - load test host allocation, see 
“Relationship between Timeslot and Load Test Host Allocation” on page 95.
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Relationship between Timeslot and Load Test Host 
Allocation
The following table describes the relationship between timeslot and load 
test host allocation. For more information on load test host allocation, see 
“Load Generator Distribution” on page 180.

Load Test Timeslot Behavior

Machines specified 
by user

Machines Selected 
Manually 

➤ If the machines specified in the 
timeslot match the load test 
machines, Performance Center 
runs the test. 

➤ If the machines do not match, 
Performance Center does not run 
the test. Try allocating load test 
machines in the timeslot (if 
available), and releasing the 
specified machines.

Machines specified 
by user

Machines allocated 
automatically

➤ If the machines allocated in the 
timeslot match the load test 
machines, Performance Center 
runs the test.

➤ If the machines allocated in the 
timeslot do not match the load 
test machines, Performance 
Center tries to allocate the user-
specified machines. If those 
machines are unavailable, 
Performance Center does not run 
the test. 

Automatic machine 
selection

Machines Selected 
Manually

➤ Performance Center runs the 
test.

Automatic machine 
selection

Machines allocated 
automatically

➤ Performance Center runs the 
test.



Chapter 5 • Working With Timeslots

96

Manually Selecting Host Machines
You can assign specific Controller and load generator machines to your test.

To manually select the host machines for your load test:

 1 In the Timeslots page, click the Timeslot Details tab.

 2 Select Manual and click the Select Machine link. 

The Select Machines wizard opens displaying a list of available Controller 
machines.

To filter the list of machines, in the filter section, select the location or 
purpose of the machine, or type the machine name in the Name field, and 
click Filter.

The Purpose column identifies the machines as Controller or Controller + 
Load Generator.
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 3 In the C column, select the Controller machine that you want to reserve, 
and click Next. 

The Select Load Generator Machines dialog box opens.

The Purpose column identifies the machines as Load Generator and 
Controller + Load Generator. 

In the LG column, select the load generator machines that you want to 
reserve. 

Note: If Run Vusers on Controller is selected in the Options tab, the 
Controller machine is automatically assigned the load generator purpose as 
well.

 4 To save your selections and close the dialog box, click OK. To return to the 
Select a Controller page, click Back. To disregard the changes and close the 
dialog box, click Cancel. 

 5 In the Timeslots page, click Save to reserve the timeslot. A message at the 
bottom of the Timeslots page informs you whether the timeslot was 
reserved.
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Changing Duration or Start Time
When you manually specify machines after selecting a start time and 
duration, machines are guaranteed to be available for the load test. If you 
subsequently change the start time or duration, some of the machines may 
no longer be available. 

If there are insufficient resources available, Performance Center displays the 
following message: "If you change the start time/duration of the test, some 
of the machines will no longer be available, and you will have to reselect 
from the available machines. Do you want to proceed?"

Click OK to proceed. The Select Machines dialog box opens, and displays 
only those machines that are available at the new start time/duration. Select 
the machines as described in “Manually Selecting Host Machines” on 
page 96. 

Click Cancel to disregard the changes to the start time/duration.

Scheduling Load Tests to Autostart

You can configure a load test to automatically begin its run at the start of the 
timeslot that it is associated with. Autostarting tests allows you to maximize 
resource usage by enabling you to have your resources available around the 
clock.

For example, suppose a project has a total of eight hosts for allocation and 
the employees assigned to the project work a standard 9:00-5:00 day. The 
hours between 9:00-5:00 are peak hours of host usage, during which time all 
the hosts are usually reserved. In addition, there may be times during the 
day that some tests cannot be run because there are no available hosts. To 
extend host resource usage, employees may come in early or stay late to run 
tests. However, this only extends the peak usage by a couple of hours at the 
beginning and end of the day. In contrast, the non-standard work hours 
pass with very little host resource usage. 

This section includes:

➤ “Overview of Reserving and Viewing Autostart Timeslots” on page 99

➤ “Best Practices for Autostarting Load Tests” on page 100
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Overview of Reserving and Viewing Autostart Timeslots
To reserve, view, or manage a test with autostart, you must perform the 
following steps:

 1 Create a load test with scheduler settings defined.

Autostarting a test requires scheduler settings. Once you save a load test 
with scheduler settings, it becomes available on the Timeslots page. 

For more information, see Chapter 11, “Configuring Scheduler Settings.”

 2 Reserve a timeslot.

You reserve a timeslot, enable the Autostart feature, and select the test to 
autostart in the Timeslot Details tab of the Timeslots page. 

For more information, see “Reserving Timeslots” on page 91.

 3 View and manage reserved timeslots.

You can view Autostart load tests, access reports on tests that have run, and 
cancel tests that are scheduled to run from the Autostart Viewer. 

For more information, see Chapter 23, “Viewing Autostart Load Tests.”



Chapter 5 • Working With Timeslots

100

Best Practices for Autostarting Load Tests
Before scheduling a load test to Autostart, first run the test manually. This 
will give you an idea of how long the test takes to perform certain steps. This 
information can then be taken into consideration when reserving a timeslot 
for the test, and thereby avoid the need for troubleshooting at a later time.

➤ If the load test takes more than 15 minutes to stop, reserve a timeslot that 
will end at least 15 minutes after the Vusers are scheduled to finish exiting 
the load test.

➤ If the load test takes more than 15 minutes to collate run data:

➤ Reserve a timeslot that will end at least 15 minutes after the Vusers are 
scheduled to finish exiting the load test.

➤ Select Do not collate results from the Post-run analysis settings. You can 
collate and analyze results at a later point. For more information on Post-
run analysis settings, see “Configuring Post-Run Analysis Settings” on 
page 101.

➤ If the load test takes more than 15 minutes to generate analysis data:

➤ Reserve a timeslot that will end at least 15 minutes after the Vusers are 
scheduled to finish exiting the load test.

➤ Select Do not collate results from the Post-run analysis settings. You can 
collate and analyze results at a later point. For more information on Post-
run analysis settings, see “Configuring Post-Run Analysis Settings” on 
page 101.
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Configuring Post-Run Analysis Settings

You can configure the post-run analysis settings from the Options tab of the 
Timeslots page. By default, when a load test finishes running, Performance 
Center automatically collates the results from the load generator machines. 
You can change the setting to have Performance Center automatically 
collate and analyze the test data, or postpone collation to a later time. If you 
delay collating or analyzing data, you can always collate and analyze the 
data at a later time.

Note: If the Controller is collating and analyzing test data, it will not be 
available for another load test scheduled for the same time. The time 
required in the collating and analyzing process depends on the number of 
Vusers, length of test, and so on.

To configure post-run analysis settings:

 1 In the Timeslots page, click the Options tab. The Options tab opens.

 2 Select one of the following post-run analysis options:

➤ Collate and Analyze. Performance Center collates the run data from the 
load generators and generates analysis data. After data is collated, 
Performance Center automatically deletes the temporary results from the 
load generators and controllers. You can display the results using analysis 
tools such as graphs and reports, or download the results for analysis on a 
local machine. This option takes the most time.
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➤ Collate only. Performance Center collates the run data from the load 
generators. After data is collated, Performance Center automatically 
deletes the temporary results from the load generators. You can 
download the raw results from the Load Test Results page, or manually 
analyze results at a later point from the Load Test Results page. This is the 
default setting.

➤ Do not collate. Frees the machines immediately after the load test ends. 
You can collate and analyze results at a later point from the Load Test 
Results page.

Note: To allow manual deletion of temporary results from the load 
generators and controllers, deselect the Delete Temporary Results option 
in the General Settings page of the Administrator Site.

 3 Click Save to save the post-run analysis option. A message at the bottom of 
the Timeslots page informs you whether the option was saved.

Running Vusers on the Controller Machine

To provide greater flexibility, or if resources are scarce (for example, if you 
only have a single machine to run the test), you can configure your load test 
to use the Controller as a load generator. You configure Performance Center 
to run Vusers on the Controller machine when reserving the timeslot.

For best results, running Vusers on dedicated machines that are load 
generators only is recommended. Running Vusers on the Controller can 
overload the machine and affect load test results.
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To run Vusers on a Controller machine:

 1 In the Timeslots page, click the Options tab. The Options tab opens.

 2 Select Run Vusers on Controller. Performance Center reserves the number of 
load generator machines required for the load test. If your test requires three 
load generators, Performance Center reserves three load generator machines 
(one of the load generators will be a Controller as well).

If you do not select this option, Performance Center reserves the specified 
number of load generator machines, plus an additional machine for the 
Controller. Using the example above, Performance Center reserves four 
machines (three load generators and one Controller). 

Note: 

➤ The Run Vusers on Controller option may be unavailable if your 
administrator has chosen to prevent you from changing the predefined 
settings.

➤ If you manually select machines for the load test with the Run Vusers on 
Controller option selected, and specify a load generator that serves as a 
Controller, you cannot save the timeslot if you subsequently disable this 
option.

 3 Click Save. Performance Center reserves the timeslot for the number of load 
generators and Vusers, and the duration time required in the selected load 
test. Performance Center adds the scheduled test to the Autostart Viewer 
page.
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Note: Timeslot availability is calculated according to the default project 
settings. By default, the Run Vusers on Controller option is unchecked and 
the Calendar displays availability according to these settings. If your host 
pool contains only one host, and Run Vusers on Controller is unchecked, 
the calendar displays a red X indicating there are not enough resources 
available. For more information, see “Viewing Timeslot Information” on 
page 86. 

Editing Timeslots

You can edit a timeslot from the Calendar or Table view of the Timeslots 
page. If you select a timeslot to edit from the Calendar View and only one 
timeslot is reserved for the selected time, the timeslot information is 
displayed in the Timeslot Details tab. If multiple timeslots are reserved for 
the same time, a table containing all the reserved timeslots for this time is 
displayed below the timeslot grid.

Note: You cannot edit a past time, or a timeslot that is already in use in a 
running load test. 

To edit a reserved timeslot when Automatic machine selection is selected:

 1 In the Calendar view, select the timeslot to edit. The timeslot properties are 
displayed in the Timeslot Details tab.
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 2 To modify the timeslot reservation fields, click the Start Time link. A 
calendar opens displaying the date and time of the timeslot. Edit the 
calendar and click Set. The calendar closes.

 3 Edit the duration field if necessary.

 4 Edit the number of load generators (and Vusers) as required. To check for 
available resources, look in the Inventory section of the Timeslots page.

 5 Click Save. A message at the bottom of the Timeslots page informs you 
whether the timeslot was updated.

To edit multiple reserved timeslots when Automatic machine selection is 
selected:

 1 In the Calendar view, select the timeslot to edit. Where more than one 
timeslot is reserved for this time, a table containing all the reserved 
timeslots for this time is displayed below the timeslot grid.

You can sort the timeslots by clicking the column heading. An arrow 
appears next to the column heading indicating if the timeslots are sorted in 
descending or ascending order. 

To add a timeslot reservation, click New and type the timeslot details in the 
Timeslot Details tab.

To delete a timeslot reservation, select the timeslot row and click Delete.

Note: You can only edit or delete future timeslots.

 2 Click the Edit link in the row of the timeslot that you want to edit. The table 
closes and the timeslot properties are displayed in the Timeslot Details tab. 

 3 Continue with the configuration procedures for a reserved timeslot above.
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To update the edit fields when Host Selection: Manual is selected:

 1 Perform steps 1-4 of editing a reserved timeslot on page 104.

 2 If you change the Host Selection to Automatic, click Save. A message at the 
bottom of the Timeslots page informs you whether the timeslot was 
updated. 

 3 To change a host machine, click Select Machines, and follow the 
instructions in “Manually Selecting Host Machines” on page 96.

If the change in time does not effect the hosts that are currently assigned to 
the time slot, a list of available hosts is displayed and you may select from it 
as described above.

If you extend a timeslot, and the extended timeslot overlaps a different 
reserved timeslot, the original host may not be available for the duration of 
the timeslot. For example:

Timeslot "A" starts at 2:00 PM and runs for one hour. When it was originally 
reserved the available hosts where named "host1" and "host2". You reserved 
the timeslot with "host1" as the selected host.

Timeslot "B" starts at 4:00 PM and runs for one hour. When it was originally 
reserved the available hosts where named "host1" and "host2". You reserved 
the timeslot with "host1" as the selected host.

If you want to extend Timeslot "A" by an additional two hours, a conflict 
arises because "host1" is reserved for Timeslot "B" during the desired time. In 
this case, a message informs you that "host1" is unavailable for the 
(extended) timeslot. In order to extend the timeslot, you must select "host2" 
as your host.

 4 Click Save. A message at the bottom of the Timeslots page informs you 
whether the timeslot was updated.
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To delete a reservation:

 1 Select a timeslot row to delete.

 2 Click the Delete button at the bottom of the page to delete the timeslot.

Note: You can only delete a future timeslot, or release a timeslot up to the 
current time.
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6
Monitor Profiles

You monitor load test execution using the Performance Center online 
monitors. To monitor server resources, you must configure the monitor 
settings for a load test. You select the type of monitors to run, the servers 
whose resources you want to monitor, and add the measurements to 
monitor for each server. These monitor settings can then be saved as a 
monitor profile that can be used by any load test in your project.

You can manage monitor profiles from the Monitor Profiles page.

The Monitor Profiles page provides a list of monitor profiles that exist in a 
project. Along with the general information provided in the main table, you 
can view, edit, and copy existing monitor profiles, and create new profiles 
that can be used by any test within your project.

Note: When designing or running a load test, you select which monitor 
profiles to use in the load test. For more information, see “Selecting Monitor 
Profiles for a Load Test” on page 221 and “Creating or Modifying the 
Runtime Monitor Profile” on page 386.

This chapter includes:

 ➤  Monitor Profiles Page at a Glance on page 110

 ➤  Managing Monitor Profiles on page 111

 ➤  Adding Monitor Over Firewall Machines on page 118
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Monitor Profiles Page at a Glance

The Monitor Profiles page displays a list of all the monitor profiles in the 
Performance Center project.

From this page, you can:

➤ Create a new monitor profile

➤ Edit a monitor profile

➤ Duplicate a monitor profile within the project

➤ Import a monitor profile from another project

➤ Delete a monitor profile 

The page also displays the MI_Listener machine IP address/name (if 
configured during installation), and the Monitor Over Firewall machines 
selected for the project. You can add Monitor Over Firewall machines or 
delete them from the Monitor Over Firewall machines list. For more 
information, see “Adding Monitor Over Firewall Machines to the Monitor 
Profiles Page” on page 311.

To open the Monitor Profiles page, on the Performance Center left menu, 
select Project > Monitor Profiles.
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Managing Monitor Profiles

This section describes:

➤ “Creating Monitor Profiles” on page 111

➤ “Editing Monitor Profiles Settings” on page 114

➤ “Importing Monitor Profiles” on page 115

➤ “Duplicating Monitor Profiles” on page 117

➤ “Deleting Monitor Profiles” on page 117

Creating Monitor Profiles
The following section describes how to create monitor profiles in the 
Monitor Profiles page.

To create a monitor profile:

 1 In the Monitor Profiles page, click Add. 

 2 The New Profile dialog box opens. Type a profile name and description and 
click OK. 
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 3 The Add Monitor page opens. Select the monitor that you want to run and 
click Next.

 4 The Choose Server page opens. Type the name or IP address of the server 
whose resources you want to monitor and, where relevant, the user login 
name and password. Click Next. 
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 5 The Choose Measurements page opens.

Expand a measurement group to display the available measurements. Select 
the measurements or measurement groups that you want to monitor.

To remove a selection, clear the relevant measurement’s check box.

 6 Click Save.

 7 To add additional monitors or servers to the profile, click Add and repeat 
steps 3 - 6 for each monitor and server that you want to add to the profile.

Note: For information about setting up a specific monitor before 
configuring its measurements, see the relevant monitoring section in the HP 
Performance Center Monitor Reference.

 8 On the left menu, select Project > Monitor Profiles. The monitor profiles is 
displayed in the list.
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Editing Monitor Profiles Settings
This section describes how to edit monitor profile settings.

To edit a monitor profile‘s name and description:

 1 On the Monitor Profiles page (Project > Monitor Profiles), select a profile 
and click Edit Name to open the Edit Profile dialog box.

 2 Edit the profile name and description, and click OK. 

Note: You cannot give a monitor profile the same name as an existing 
monitor profile.

To modify a profile’s settings:

 1 On the Monitor Profiles page, select the profile you want to modify, and 
click the Edit profile button. The profile’s page opens. 

➤ To add another monitor to the profile, click Add. Provide the server 
information and select the measurements to monitor in the same way 
you would when creating a new profile. For details, see “Creating 
Monitor Profiles” on page 111.
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➤ To edit details of a monitor server in the profile, click the Edit button 
next to the relevant server, modify the measurement selection, and click 
Save.

➤ To delete a monitor server from the profile, click the Delete Server 
button next to the relevant server and click OK.

➤ To delete a monitor from the monitor profile, click the Delete Monitor 
button next to the relevant monitor and click OK.

 2 On the left menu, select Project > Monitor Profiles to return to the Monitor 
Profiles page.

Modifying Monitor Profiles During a Run

You can modify the monitor profile settings while a load test is running. 
These changes apply to the current run only. They are not saved for 
subsequent runs of the load test. For more information, see “Creating or 
Modifying the Runtime Monitor Profile” on page 386.

Importing Monitor Profiles
You can import a single or several monitor profiles, with all their data, from 
an external project into the current project. 

Note: Only users with the Create monitor profile permission in the current 
project can import monitor profiles.
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To import monitor profiles from an external project:

 1 On the Monitor Profiles page, click Import. The Import Monitor Profiles 
dialog box opens.

 2 In the Select Project list, select the project from which to import the profiles 
and click Go. The page displays all of the monitor profiles in the project you 
selected. 

You can sort the profiles in ascending or descending order by clicking the 
heading of the column by which you want to sort. Click the column 
heading again to reverse the sort order.

You filter the monitor profiles using the filter boxes below the column 
headings. The filter feature supports partial text look-up.

 3 Select the profiles to import.
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 4 Click Import. A message appears in the Messages box notifying you 
whether the profile was imported succeessfully or not. 

➤ If the import succeeded, click Close to close to Import Monitor Profile 
dialog box. The imported profiles appear on the Monitor Profile page. 

➤ If the import failed, check the event log in the Administration Site. For 
more information, see the HP Performance Center Administrator Guide.

Duplicating Monitor Profiles
You can duplicate a monitor profile, with all its data, within the current 
project. 

Note: Only users with the Create monitor profile permission in the current 
project can duplicate monitor profiles.

To duplicate a monitor profile within the project:

 1 On the Monitor Profiles page, select a profile to duplicate.

 2 Click Duplicate.

A duplicate of the selected profile appears on the Monitor Profiles page. 
Performance Center automatically assigns a default name to the monitor 
profile. To edit the name, select the monitor profile and click Edit Name. 

Deleting Monitor Profiles
You delete monitor profiles from the Monitor Profiles page. 
(Project > Monitor Profiles)

To delete a monitor profile:

 1 On the Monitor Profiles page, select the profile you want to delete.

 2 Click the Delete Profile button and click OK. The profile is deleted from the 
Monitor Profiles list.
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Adding Monitor Over Firewall Machines

On the Monitor Profile page, you manage the Monitor Over Firewall 
machines that can be accessed by load tests in this project. 

To add a Monitor Over Firewall machine to a project:

 1 On the Monitor Profiles page, click Modify machine names. 

The Monitor Over Firewall Machines dialog box opens.

 2 In the Machine name box, type the name of the Monitor Over Firewall 
machine. 

 3 Click Add. The Monitor Over Firewall machine is added to the list.
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 4 Click Close. The name of the Monitor Over Firewall machine now appears 
on the Monitor Profiles page.

To select the Monitor Over Firewall machines to monitor a load test, see 
“Selecting Monitor Profiles for a Load Test” on page 221.

To remove a Monitor Over Firewall machine from a project:

 1 On the Monitor Profiles page, click Modify machine names.

The Monitor Over Firewall Machines dialog box opens.

 2 Click the Delete Monitor button next to the Monitor Over Firewall machine 
that you want to remove from the project.

The machine is removed from the list.
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 3 Click Close. The machine no longer appears on the Monitor Profiles page.
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Designing Load Tests
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7
Managing Vuser Scripts

This chapter discusses Vuser scripts and how to work with them in 
Performance Center and VuGen. 

This chapter includes:

 ➤  About Managing Vuser Scripts on page 123

 ➤  Understanding Vuser Scripts on page 124

 ➤  Managing Scripts in the Vuser Scripts Page on page 125

 ➤  Managing Vuser Scripts in VuGen on page 139

About Managing Vuser Scripts

When you run a load test, Vusers access your application concurrently in 
order to put load on your server. The actual steps that the Vusers perform 
when accessing your application are represented in a Vuser script. Each 
Vuser performs the actions recorded in one Vuser script.

You create Vuser scripts using HP’s Virtual User Generator (VuGen). For 
more information, see the HP Virtual User Generator User Guide. You can also 
use Performance Center’s URL-based script generator (see “Creating URL-
Based Scripts in Performance Center” on page 134).

You upload the scripts to the Performance Center Vuser Scripts page. When 
you design a load test, you select one of the uploaded scripts as a basis for 
your test.
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You can upload and manage scripts using one of the following:

➤ The Performance Center Vuser Scripts page. See “Managing Scripts in the 
Vuser Scripts Page” on page 125.

➤ HP Virutal User Generator. See “Managing Vuser Scripts in VuGen” on 
page 139. 

Understanding Vuser Scripts

To have a better understanding of creating and configuring Vuser scripts, it 
is important to understand the way a script is stored and how it is accessed 
by a load test.

When you upload a script to the Vuser Scripts page, the script resides on the 
file server. The file server serves as a storage area for all uploaded scripts. The 
scripts can be used by multiple load tests. 

The run-time settings for the uploaded script are the ones in effect when 
you recorded your script using VuGen.

When you create a load test, you specify which scripts you want to include 
in your load test. A script can be included in a load test as is. During a run, 
Performance Center uses the run-time settings of the uploaded script.

Another possibility is to change the run-time settings of the script when you 
configure your load test. In this case, when you save the load test, the newly 
configured run-time settings are saved to the database server and are 
associated with the particular load test. During a run, Performance Center 
ignores the run-time settings of the script and uses the ones you created on 
the database server.

To summarize, there are two possible routes you can take when including a 
script in a load test. In route one, the script is included without changes to 
the run-time settings, while in route two the run-time settings are changed 
when you configure the load test.

In route one, when the load test runs the script, it is executed from the file 
server with the run-time settings found there.
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In route two, when the load test runs the script, it is executed from the file 
server with the run-time settings found on the database server.

Implications for Script Editing
As discussed, once a script is uploaded to the Vuser Script page, Performance 
Center stores any changes in the database. The script remains intact on the 
file server. It needs to stay the same on the file server because it is a shared 
resource.

Suppose you want to edit a script. After you download the script, you record 
additional steps and change some run-time settings. 

When you upload the script, the test you uploaded replaces the script on the 
file server. In the case of route one, the updated script is run including the 
changed run-time settings. In the case of route two, the updated script is 
run. However, the load test uses the run-time settings stored in the database.

To update the run-time settings in the database, you need to change them 
from the Load Test configuration page. For more information, see 
“Configuring General Run-Time Settings” on page 549.

This logic applies to any other load tests that access your edited script.

Managing Scripts in the Vuser Scripts Page

From the Vuser scripts page (Project > Vuser Scripts), you can upload scripts, 
view script content, download scripts to a local directory, import scripts 
from another project, duplicate existing scripts, and delete scripts.

This section includes the following topics:

➤ “The Vuser Scripts Page at a Glance” on page 126

➤ “Uploading Scripts to the Vuser Scripts Page” on page 130

➤ “Importing Scripts from Other Projects” on page 132

➤ “Creating URL-Based Scripts in Performance Center” on page 134

➤ “Duplicating a Script” on page 136
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➤ “Downloading Scripts from the Vuser Scripts Page” on page 137

➤ “Viewing Uploaded Scripts in the Vuser Scripts Page” on page 138

The Vuser Scripts Page at a Glance

The Vuser Scripts page displays all the stored Vuser scripts that are available 
in your project for use by Vusers during a load test. To access this page, on 
the Performance Center left menu, select Project > Vuser Scripts.

The Vuser Scripts page includes the following components:

➤ Scripts Table (see page 127)

➤ Scripts Details Pane (see page 128)

➤ Scripts Toolbar (see page 129)
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Scripts Table

Each row in the table represents a Vuser Script. You can select the amount of 
scripts to be displayed in the displaying <n> items per page list. 

The scripts table includes the following columns:

➤ Type. The Vuser script type.

➤ Script Name. The name of the Vuser script.

➤ Comment. Any relevant information about the script.

➤ Date Modified. The date on which the script was last updated.

Sorting and Filtering the Scripts

You can sort the scripts in the table in ascending or descending order by 
clicking the heading of the column by which you want to sort. Click the 
column heading again to reverse the sort order.

You filter the scripts using the filter boxes below the column headings. 

Note: Sorting and filtering settings are saved per user, per project. The next 
time the same user enters the Vuser Scripts page in a specific project, the 
page displays results based on the most recent sort order and filter.

To filter the scripts:

 1 In one of the filter boxes below the column headings, type the relevant text 
or select a value from the list. Press ENTER. 

The table displays scripts according to the selected filter option.

 2 You can filter these results further by entering additional filter values for 
other columns in the table. 
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Notes:

➤ The filter supports partial text entries. For example, if you entered th, the 
display list might include Seth, Thomas, and Anthony. 

➤ The filter does not support regular expressions or the following 
characters: : ; & * \ ' / # ~ , ? { } $ % | < > + = ` ^ [ ] !

Scripts Details Pane

When you select a script from the table, the script details are displayed in 
the details pane on the lower part of the page. You can edit the Script Name 
and the Comment field.

Note: To edit script details, you need to be assigned with Edit script details 
permissions.

The details pane includes the following fields:

➤ Script Name. The name of the Vuser script.

➤ Comment. Any relevant information about the script.

➤ Date Modified. The date on which the script was last updated.

➤ Date Uploaded. The date on which the script was first uploaded. 

To edit the Script Name or Comment field:

 1 Type the relevant information in the Script Name or Comment field.

 2 To revert back to the original user details that were displayed before you 
modified them, click Restore.

To save your changes to the user details, click Save.
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Note: You cannot give a script the same name as an existing script.

Scripts Toolbar

You use the toolbar buttons to perform the following actions.

Function Button Enables You To:

Upload Scripts Upload Vuser scripts saved in zip format to the Vuser 
Scripts page. See “Uploading Scripts to the Vuser 
Scripts Page” on page 130.

Import Scripts Import a Vuser Scripts from other projects into the 
current project. See “Importing Scripts from Other 
Projects” on page 132.

Create 
URL-based 
Script

Create a basic Vuser script that consists of simple 
links. See “Creating URL-Based Scripts in 
Performance Center” on page 134.

Duplicate 
Script

Duplicate a Vuser Script within the current project. 
See “Duplicating a Script” on page 136.

Download 
Script

Download scripts from the Vuser Scripts page and 
save them in a specified location. See “Downloading 
Scripts from the Vuser Scripts Page” on page 137.

View Script View the code for each action in the selected script. 
See “Viewing Uploaded Scripts in the Vuser Scripts 
Page” on page 138.

Delete Script Delete the selected script from the Vuser Scripts 
page.

Refresh Refresh the data on the page.
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Uploading Scripts to the Vuser Scripts Page
You upload Vuser scripts saved in zip format to the Vuser Scripts page. Before 
you perform the upload, check the following:

➤ the zip file is named after the Vuser script (.usr) file. For example, if the 
Vuser script file is oracle_test.usr, the zip file must be named oracle_test.zip.

➤ the zip file must contain the complete contents of the Vuser script folder, 
including the Vuser script file, and all related data files. The script files must 
be at the root of the zip file.

To upload a Vuser script from the Vuser Scripts page:

 1 On the Vuser Scripts page (Project > Vuser Scripts), click the Upload Scripts 
button. The Upload Vuser Script dialog box opens.  
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 2 Click the Browse button, and browse to the zip file containing the Vuser 
script you want to upload.

 3 Select the zip file, and click Open.

 4 Select Overwrite existing Scripts to replace a script that already exists in the 
Vuser Scripts list.

 5 Click Upload to upload the script and add it to the Vuser Scripts list.
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Importing Scripts from Other Projects
You can import a single or several Vuser Scripts, with all their data, from 
another project into the current project. The import feature is only available 
if you have Upload script permissions in the current project.

To import Vuser Scripts from another project:

 1 On the Vuser Scripts page (Project > Vuser Scripts), click the Import Scripts 
button. The Import Scripts page opens.

 2 Select the project from which to import the script from the Select Project 
drop down list. Then click Go. The page displays a list of all the scripts in 
the project you selected.
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You can sort the scripts in ascending or descending order by clicking the 
heading of the column by which you want to sort. Click the column 
heading again to reverse the sort order.

You filter the vuser scripts using the filter boxes below the column headings. 
The filter feature supports partial text look up.

 3 Select the scripts to import using the check boxes.

Tip: Selecting or clearing the check box next to the Script Name box, selects 
or clears all the check boxes respectively.

 4 Click Import. A message appears in the Messages window notifying you if 
the import succeeded or failed. 

➤ If the import succeeded, click Close to close the Import Scripts page. The 
imported scripts appear in the Vuser Scripts page.

➤ If the import failed, check the event log.
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Creating URL-Based Scripts in Performance Center
You can use the URL-based script generator to create a basic Vuser script that 
consists of simple links. For example, you can create a Vuser script that 
accesses your status page and links to other pages within your site.

You can create your script by manually typing the URL information.

To manually create a URL-based Vuser script:

 1 On the Vuser Scripts page (Project > Vuser Scripts), click the URL-based 
Script Generator link. The URL- based Script Generator dialog box opens. 

 2 Type a name for the Vuser script.

 3 Insert URLs into the Vuser script by either:

➤ Typing the address of the URL into the Insert URLs into the Vuser script 
box. Click Insert URLs. The URL appears in the Vuser script box. Repeat 
for all the URLs in the script.
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➤ Copying and pasting the URL address from the Web browser address 
window using the Copy/Paste View. Click Copy/Paste View to open the 
Web browser address window and recorder window.

Move through your Web site using the browser window, and copy and 
paste the URL into the recorder below. Click Insert URL. Repeat for all the 
URLs in the script. Click Exit Composing Mode to close the windows and 
return to the Create a URL based script dialog box. The URLs are 
displayed in the Vuser script box.

 4 To replace a URL in the Vuser script box, select it, type a new URL, and click 
Overwrite URL.

To delete a URL in the Vuser script box, select it, and click Delete.

To change the order of the URLs in the Vuser script box, use the Move Up 
and Move Down buttons to change the URL order.
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 5 Click Create Script to create the script and add it to the Vuser Scripts list, or 
Cancel to close the URL-based Script Generator dialog box without saving 
the Vuser script.

To modify a URL-based script:

 1 Select the script in the scripts table and click the View Script button. The 
Create a URL based script dialog box opens.

 2 Modify the script using the editing tools and methods described above.

 3 Click Save Script. The Vuser Scripts page is updated with the modified script.

Duplicating a Script
You can duplicate a Vuser Script, with all its data, within the current project. 
The duplicate feature is only available if you have Upload script permissions 
in the current project.

To duplicate a Vuser Script within the project:

 1 On the Vuser Scripts page (Project > Vuser Scripts), from the scripts table, 
select the script to duplicate.

 2 Click the Duplicate Script button.

A duplicate of the selected script appears in the Vuser Scripts page. 
Performance Center automatically assigns a default name to the script. You 
can edit the name in the scripts details pane.
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Downloading Scripts from the Vuser Scripts Page
You can download scripts from the Vuser Scripts page and save them in a 
specified location. You can use VuGen to edit the downloaded scripts and 
then upload them back on to your system.

To download a script from the Vuser Scripts page:

 1 On the Vuser Scripts page (Project > Vuser Scripts), from the scripts table, 
select the script to download.

 2 Click the Download Script button. Performance Center prepares the script 
for download and opens the Ready for Download dialog box.

 3 Click the Download link. The File Download dialog box opens.

 4 Click Save. The Save As dialog box opens.

 5 Choose a file name and the location into which to download the file. 

 6 Click Save to download the file.

You can use VuGen to open and modify the script. 
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Viewing Uploaded Scripts in the Vuser Scripts Page
You can open an uploaded script, and view the code for each action from 
the Vuser Scripts page.

To view a Vuser script:

 1 On the Vuser Scripts page (Project > Vuser Scripts), from the scripts table, 
select the script to view.

 2 Click the View Script button. The script opens in a read-only window.

 3 Select an action to view its code.

 4 To download the script, click Download Script and follow the instructions 
described in “Downloading Scripts from the Vuser Scripts Page” on 
page 137.



Chapter 7 • Managing Vuser Scripts

139

Managing Vuser Scripts in VuGen

VuGen works together with Performance Center to provide an efficient 
method for uploading Vuser scripts to the Performance Center script 
repository (Vuser Scripts page) and for editing scripts. 

This section includes the following topics:

➤ “Preparing VuGen to Work with Performance Center” on page 139

➤ “Connecting VuGen to Performance Center” on page 140

➤ “Uploading a Vuser Script from VuGen” on page 141

➤ “Downloading Vuser Scripts in VuGen” on page 144

➤ “Editing Vuser Scripts in VuGen” on page 146

➤ “Disconnecting VuGen from Performance Center” on page 147

Preparing VuGen to Work with Performance Center
To manage Vuser scrips in VuGen, perform the following steps:

 1 Check your version of VuGen is enabled to manage scripts.

 a Start VuGen, and open a new or existing VuGen script.

 b Open the Tools menu.

If the menu item Performance Center Connection is available on the 
Tools menu, your version of VuGen is enabled to manage scripts.

Note: If your version of VuGen is not enabled to manage scripts, or if you do 
not have VuGen installed on your machine, you need to install an updated 
version of VuGen. For installation information, see the HP Performance 
Center System Configuration and Installation Guide. 

 2 Connect VuGen to Performance Center.

To access a Performance Center project, you must first connect it to the Web 
server on which Performance Center is installed. For more information, see 
“Connecting VuGen to Performance Center” on page 140.
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Connecting VuGen to Performance Center
VuGen works together with Performance Center to provide an efficient 
method for uploading and downloading Vuser scripts to and from 
Performance Center. In order for VuGen to access a Performance Center 
project, you must first connect it to the Web server on which Performance 
Center is installed. You can then upload or download Vuser scripts.

To connect VuGen to Performance Center:

 1 In VuGen, select Tools > Performance Center Connection. The Configure 
Performance Center Connection dialog box opens.
 

 2 In the URL box, type the URL address of the Web server on which 
Performance Center is installed. The URL address should be in the format: 
http://<server_name>/loadtest

 3 Enter your user name and password. Contact your Performance Center 
administrator if you need assistance.

 4 To automate the login process, select Remember user name and password. 
The specified username and password are saved to the registry, and 
displayed each time you open the dialog box.

 5 To automatically open the connection to the Performance Center server 
when you start VuGen, select Auto connect on start. VuGen attempts to 
connect to Performance Center using the displayed login information.

 6 Click Connect. The Performance Center Connection dialog box displays the 
connection status.
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Once the connection is established, all the fields are displayed in read-only 
format.

Note: If the connection fails, a dialog box displays the reason for the 
connection failure.

You cannot be connected to Performance Center and Quality Center at the 
same time.

If VuGen is not connected to Performance Center, you can save the Vuser 
script files locally to the file system. Later, when VuGen is connected to 
Performance Center, open the script in VuGen and upload it to Performance 
Center as described below.

Uploading a Vuser Script from VuGen
Once VuGen is connected to the Web server on which Performance Center 
is installed (see “Connecting VuGen to Performance Center” on page 140), 
you can upload scripts directly to the Performance Center Web server. 

VuGen lets you select the extent of the uploading. Depending on your 
requirements, you can do a partial or a complete upload. The upload 
options are:
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➤ Upload run time files. Deletes all main script files (usr, c, cfg, and xml files) 
from the server. It does not delete data files or old recorded data. Next, 
VuGen uploads the script files, the run-time settings, and the parameter 
files.

➤ Upload all files. First VuGen deletes all script and data files from the 
server. VuGen then uploads the current script and data files, including 
the recording data and the replay result directories.

Uploading the run time files only is quicker since VuGen only uploads the 
script files—not all of the recording data and the replay results.

Note: If you previously downloaded the run time files, by default VuGen 
will only upload the files that were downloaded. If you want to upload 
newly created files, for example, snapshots generated after replay, you must 
specify Upload all files.

To upload a script to Performance Center from VuGen:

 1 Make sure that you are connected to Performance Center. Select Tools > 
Performance Center Connection.
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 2 Select File > Save As in VuGen. The Save script dialog box opens.

 3 In the Find Project box, type a name of a project or part of the name to 
locate the desired project. To begin the search, click the arrow to the right of 
the box. To move to the next match, click the arrow again.

 4 Select the project under which you want to save the script. In the File name 
box, type a name for the script. 

Note: File names can only consist of English letters, digits, or the underscore 
character, and cannot exceed 250 characters.

 5 Click OK. The Upload Script dialog box opens. Select one of the Upload 
Options, Upload run time files or Upload all files.

 6 Click OK to upload the files to the Performance Center server.
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Downloading Vuser Scripts in VuGen
Once VuGen is connected to the Web server on which Performance Center 
is installed (see “Connecting VuGen to Performance Center” on page 140), 
you can download scripts for editing. 

Depending on your requirements, you can do a partial or a complete 
download. The download options are:

➤ Download run time files. VuGen downloads the script files only, allowing 
faster downloads. This includes the script file, run-time settings, and 
parameter files.

➤ Download all files. VuGen downloads the script and data files, including 
the recording data and the replay result directories.

A partial download of run time files only is quicker since VuGen only 
downloads the script files. If you download all the script and data files, the 
transfer will take more time.

Once you are connected to the Performance Center server, you can 
download your script files to VuGen.
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To download a Vuser script from Performance Center:

 1 Make sure that you are connected to Performance Center. Look for the PC 
Connected button on VuGen’s the status bar.

 2 In VuGen, select File > Open. The Select Script dialog box opens.

 3 Search for the project containing the script you want to download. In the 
Find Project box, type a name of a project or part of the name to locate the 
desired project. To begin the search, click the arrow to the right of the box. 
To move to the next match, click the arrow again.

 4 Expand the project and select the script that you want to download. 
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 5 Click OK. The Download Script dialog box opens.

 6 Select a download option: Download run time files or Download all files.

 7 Click OK to download the files from Performance Center. The Downloading 
files progress bar opens. When the download is complete, the progress bar 
closes and VuGen displays the script.

Editing Vuser Scripts in VuGen
After you download a script, you can edit it in VuGen. 

By default, downloaded files are saved to your Temp directory. You can save 
the changes locally or upload the edited script back to the Performance 
Center server.

If you are connected to Performance Center, the Save operation 
automatically uploads the script to the Performance Center server.

Downloaded scripts whose source is the Performance Center server, appear 
in the File menu’s Recent Script list, with a [PC] prefix.

To save changes made to a downloaded scripts:

 1 To save the script on the Performance Center server, click Save. VuGen 
prompts you with the Upload options (provided that you are connected).

If you want to upload newly created files, such as snapshots generated after 
replay, you must specify Upload all files.

 2 To save the script locally, click Save As. The Save Script dialog box opens. 
Click Select from file system and browse for the desired location. Click OK.
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Disconnecting VuGen from Performance Center 
You disconnect VuGen from the Performance Center Web server using the 
Configure Performance Center Connection dialog box.

To disconnect VuGen from Performance Center:

 1 In VuGen, select Tools > Performance Center Connection. The Configure 
Performance Center Connection dialog box opens.

 2 Click the Disconnect button. VuGen disconnects from Performance Center, 
and the dialog box closes.



Chapter 7 • Managing Vuser Scripts

148



149

8
Defining Performance Targets

Service level agreements (SLAs) enable you to define performance targets or 
goals for your load test. During a load test run, Performance Center 
measures performance and collects data. This data is compared against 
thresholds defined in the SLAs.

This chapter includes:

 ➤  About Defining Service Level Agreements on page 150

 ➤  Defining an SLA Goal Measured Per Time Interval on page 151

 ➤  Defining an SLA Goal Measured Over the Whole Run on page 161

 ➤  Understanding the Service Level Agreement Window on page 163
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About Defining Service Level Agreements

When you design a load test, you can define goals or service level 
agreements (SLAs) for the performance metrics. When you run the load test, 
Performance Center gathers and stores performance-related data. When you 
analyze the run, Analysis compares this data against the SLAs and 
determines SLA statuses for the defined measurements.

Depending on the measurements that you are evaluating, Performance 
Center determines SLA statuses in one of the following ways:

➤ SLA status determined at time interval over a timeline. Analysis displays 
SLA statuses at set time intervals—for example, every 10 seconds—over a 
timeline within the run. For more information, see “Defining an SLA Goal 
Measured Per Time Interval” on page 151.

➤ SLA status determined over the whole run. Analysis displays a single SLA 
status for the whole load test run. For more information, see “Defining an 
SLA Goal Measured Over the Whole Run” on page 161.

Note: You can define and edit SLAs in Performance Center or in Analysis. 

For details about viewing SLA information in Analysis reports, see the HP 
LoadRunner Analysis User Guide.
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Defining an SLA Goal Measured Per Time Interval

For the Average Transaction Response Time and Errors per Second 
measurements, Analysis displays SLA statuses at set time intervals over a 
timeline within the run. 

That is, at each time interval in the timeline—for example, every 10 
seconds—Analysis checks if the measurement’s performance deviated from 
the threshold defined in the SLA.

When creating SLAs for these measurements, you can also specify which 
load criteria to take into account when comparing the data.

➤ To define SLAs for Average Transaction Response Time, see “SLAs for Average 
Transaction Response Time” below.

➤ To define SLAs for Errors per Second, see “SLAs for Errors Per Second” on 
page 156.

➤ To set the time intervals that Analysis uses for evaluating the SLA, see 
“Selecting a Tracking Period” on page 160.

Note: A transaction that contains the "@" symbol in its name will not 
display SLA results in the default report summary page. To view results, 
rename the transaction so that it does not contain this symbol.

SLAs for Average Transaction Response Time
This section explains how to define an SLA for evaluating the status of 
Average Transaction Response Time during the run. For Average Transaction 
Response Time, Performance Center evaluates SLA statuses at set time 
intervals within the run. 

Note: To set the time intervals that Analysis uses for evaluating the SLA, see 
“Selecting a Tracking Period” on page 160.
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To define an SLA for Average Transaction Response Time:

 1 In the Load Tests page, in the relevant load test row click the Performance 
Targets button or click Target at the bottom of the Load Test configuration 
page. 

The Service Level Agreement window opens.

 2 Click New SLA. The Service Level Agreement Wizard opens. 

 3 Click Next.

 4 Complete the SLA Wizard steps, as described in the following sections.

Measurement—Select a Measurement for Your Goal

For Average Transaction Response Time, SLA statuses are evaluated at set 
time intervals within the run.

Under SLA status determined at time intervals over a timeline, select 
Average Transaction Response Time. Click Next.

Transactions—Select Transactions

From the Available Transactions list, select the transactions that you want to 
evaluate as part of your SLA and click Add. 

The transactions you selected are displayed in the Selected Transactions list.

Click Next.
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Load Criteria—Set Load Criteria

Select load criteria for your goal and define appropriate load value ranges.

Note: In the next wizard step (Thresholds page), you will set different 
thresholds per each of these load value ranges.

 1 In the Load Criteria box, select the relevant load criteria that you want to 
use.

You can select the following load criteria:

➤ Running Vusers

➤ Throughput

➤ Hits per Second

➤ Transactions per second

➤ Transactions per second (passed)

To define an SLA without load criteria, select None in the Load Criteria box.
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 2 Define the Load Values.

➤ In the Less than box, set the lower load value range by entering a 
maximum value for this range. This range is between 0 and the 
maximum value you entered, but does not include the maximum value.

➤ To set in-between load value ranges, select Between and enter minimum 
and maximum values for the range. The minimum value is included in 
the range and the maximum value is not.

Note: You can set up to three in-between ranges.

➤ To set the upper load value range, select Greater than or equal to and 
enter the minimum value for this range. The minimum value is included 
in this range.

Note: Valid load value ranges are consecutive—there are no gaps in the 
range—and span all values from zero to infinity.

 3 Click Next.
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Thresholds—Set Threshold Values

Set maximum thresholds for each transaction that you are evaluating. 

➤ If you defined load criteria in the previous step, you set thresholds for 
each transaction per the defined load value ranges. 

➤ If you did not define load criteria, you set a single threshold for each 
transaction.

Type the relevant thresholds (per load criteria, if defined) in the first table 
on the page. 

Tip: If you want to apply one set of threshold values to all transactions, type 
the threshold values in the table displayed at the bottom of the page and 
click Apply to all transactions. These values are applied to all the 
transactions in the first table.

After you apply one set of threshold values to all transactions, you can 
modify the thresholds of individual transactions manually in the first table.

Note: If Average Transaction Response Time exceeds the maximum 
threshold value during a particular time interval during the run, Analysis 
displays an SLA status of Failed for that time interval.
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Finish

If you want to define another SLA after you save the current one, select 
Define another SLA. 

Click Finish to save the SLA.

Note: For details about viewing SLA information in Analysis reports, refer to 
the HP LoadRunner Analysis User Guide.

SLAs for Errors Per Second
This section explains how to define an SLA for evaluating the status of Errors 
per Second during the run. For Errors per Second, Performance Center 
evaluates SLA statuses at set time intervals within the run.

Note: To set the time intervals that Analysis uses for evaluating the SLA, see 
“Selecting a Tracking Period” on page 160.

To define an SLA for Errors per Second:

 1 In the Load Tests page, in the relevant load test row click the Performance 
Targets button or click Target at the bottom of the Load Test configuration 
page. 

The Service Level Agreement window opens.

 2 Click New SLA. The Service Level Agreement Wizard opens. 

 3 Click Next.

 4 Complete the SLA Wizard steps, as described in the following sections.
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Measurement—Select a Measurement for Your Goal

For Errors per Second, SLA statuses are evaluated at set time intervals within 
the run.

Under SLA status determined at time intervals over a timeline, select Errors 
per Second, and click Next.

Load Criteria—Set Load Criteria

Select load criteria for your goal and define appropriate load value ranges.

Note: In the next wizard step (Thresholds page), you will set different 
thresholds per each of these load value ranges.

 1 In the Load Criteria box, select the relevant load criteria that you want to 
use.

You can select the following load criteria:

➤ Running Vusers

➤ Throughput

➤ Hits per Second

To define an SLA without load criteria, select None in the Load Criteria box.
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 2 Define the Load Values.

➤ In the Less than box, set the lower load value range by entering a 
maximum value for this range. This range is between 0 and the 
maximum value you entered, but does not include the maximum value.

➤ To set in-between load value ranges, select Between and enter minimum 
and maximum values for the range. The minimum value is included in 
the range and the maximum value is not.

Note: You can set up to three in-between ranges.

➤ To set the upper load value range, select Greater than or equal to and 
enter the minimum value for this range. The minimum value is included 
in this range.

Note: Valid load value ranges are consecutive—there are no gaps in the 
range—and span all values from zero to infinity.

 3 Click Next.
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Thresholds—Set Threshold Values

In the Thresholds page you set a maximum threshold value for Errors per 
Second. 

➤ If you defined load criteria in the previous step, type threshold values per 
the defined load value ranges, in the table provided.

➤ If you did not define load criteria, type the maximum threshold value in 
the Threshold box.

Click Next.

Note: If Errors per Second exceeded the maximum threshold value during a 
particular time interval during the run, Analysis displays an SLA status of 
Failed for that time interval.

Finish

If you want to define another SLA after you save the current one, select 
Define another SLA. 

Click Finish to save the SLA.

Note: For details about viewing SLA information in Analysis reports, refer to 
the HP LoadRunner Analysis User Guide.
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Selecting a Tracking Period
When you define a service level agreement for measurements that are 
evaluated over a timeline, Performance Center determines SLA statuses at 
specified time intervals within that timeline. These time intervals are known 
as the tracking period of the load test.

To define the tracking period for the load test:

 1 In the Service Level Agreement window, click the Advanced button. The 
Advanced Options window opens.

 2 Select one of the following methods to determine the tracking period for the 
load test. 

➤ Internally calculated tracking period. 

Analysis sets the tracking period to the minimum value possible, taking 
into account the aggregation granularity defined for the load test. This 
value is at least 5 seconds. It uses the following formula:

➤ Tracking period of at least X seconds. 

Select a value (X) to determine the minimum amount of time for the 
tracking period. This value can never be less than 5 seconds.

Analysis sets the tracking period to the nearest multiple of the load test’s 
aggregation granularity that is greater than or equal to the value (X) that 
you selected. 

Assume, for example, that you select a tracking period of X=10, and 
assume that the aggregation granularity for the load test is 6. The 
tracking period is set to the nearest multiple of 6 that is greater than or 
equal to 10—that is, Tracking Period = 12.

For this option, Analysis uses the following formula:

 3 Click OK.

Tracking Period = Max (5 seconds, aggregation granularity)

Tracking Period = Max(5 seconds, m(Aggregation Granularity))

where m is a multiple of the load test’s aggregation granularity such that 
m(Aggregation Granularity) ≥ X
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Defining an SLA Goal Measured Over the Whole Run

For certain measurements—Total Hits, Average Hits, Total Throughput, and 
Average Throughput—Analysis displays a single SLA status for the whole 
load test run. This section explains how to define an SLA for these 
measurements.

To define an SLA that evaluates the status over a whole run:

 1 In the Load Tests page, in the relevant load test row click the Performance 
Targets button or click Target at the bottom of the Load Test configuration 
page. 

The Service Level Agreement window opens.

 2 Click New SLA. The Service Level Agreement Wizard opens. 

 3 Click Next.

 4 Complete the SLA Wizard steps, as described in the following sections.

Measurement—Select a Measurement for Your Goal

For the following measurements, Analysis displays a single SLA status for the 
whole load test run:

➤ Total Hits

➤ Average Hits (Hits per second)

➤ Total Throughput

➤ Average Throughput (Bytes per second)

Select SLA status determined over the whole run, select the relevant 
measurement, and click Next.
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Thresholds—Set Threshold Values

The measurement that you selected in the previous step is displayed in the 
Selected measurement box. 

In the Threshold box, type the minimum threshold value for your 
measurement. 

Click Next.

Note: If the measurement value falls below this minimum threshold value 
during the run, Analysis displays an SLA status of Failed for the entire run.

Finish

If you want to define another SLA after you save the current one, select 
Define another SLA. 

Click Finish to save the SLA.

Note: For details about viewing SLA information in Analysis reports, refer to 
the HP LoadRunner Analysis User Guide.
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Understanding the Service Level Agreement Window

The Service Level Agreement window includes the following options:

Function Button Enables You To

New SLA Define a new SLA. See:

➤ “Defining an SLA Goal Measured Per Time Interval” 
on page 151

➤ “Defining an SLA Goal Measured Over the Whole 
Run” on page 161

Details View the details of the SLA selected in the Service Level 
Agreement window. The Service Level Agreement - 
Goal Details box opens, displaying a summary of the 
details of the selected SLA.

Edit Edit the definitions of the SLA selected in the Service 
Level Agreement window. The SLA wizard opens with 
the details of the selected SLA.

Delete Delete the SLA selected in the Service Level Agreement 
window.

Advanced Adjust the tracking period for SLAs that are evaluated 
per time interval over a timeline. See “Selecting a 
Tracking Period” on page 160.
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9
Configuring Load Tests

After you add Vuser scripts to the Vuser Scripts list (see Chapter 7, 
“Managing Vuser Scripts”), you create a load test and configure its settings.

This chapter includes:

 ➤  About Creating and Configuring Load Tests on page 165

 ➤  Viewing Load Test Summary Details on page 167

About Creating and Configuring Load Tests

You create and configure a load test from the Load Test configuration page.

Creating a load test involves:

➤ Creating a load test

➤ Designing a workload for the load test
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➤ (Optional) Configuring monitor settings

➤ (Optional) Configuring diagnostic distribution settings

Creating a Load Test
When you create a load test, you give the load test a name and description. 

To create a load test:

 1 On the Performance Center left menu, select Load Tests > Manage. The 
Load Tests page opens, displaying all the load tests in the current project.

 2 Click the New Load Test button. 

The Load Test configuration page opens, displaying the General tab.

 3 In the Name and Description boxes, enter a name and description for the 
new load test.

 4 Click Save at the bottom of the Load Test configuration page to save the 
load test. 

The load test is saved but is invalid at this stage. To create a valid load test, 
you must design a workload for the load test, as described below. 

Designing a Workload for the Load Test
After you create a load test, you design a workload for the load test. 

When you start designing your load test, you create Vuser groups to run in 
the load test, and select a method for distributing load generators among 
the Vuser groups. You can create a schedule for running the load test, and 
configure other optional load test settings.

For more information, see Chapter 10, “Designing Load Test Workloads.”
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Configuring Monitoring Settings (Optional)
When designing the load test, you can define relevant monitors and 
monitor resources that will monitor the load test when it runs. You can 
select existing monitor profiles for the load test or create new ones. For 
details, see Chapter 12, “Configuring Load Test Monitor Settings.”

Configuring Diagnostic Distribution Settings (Optional)
You can enable diagnostics modules to collect diagnostics data about the 
load test. For details, see Chapter 13, “Configuring Diagnostics Settings.”

Viewing Load Test Summary Details

After you create and configure a load test, Performance Center displays the 
following information in the Load Test Details section of the General tab:

➤ No. Vusers. Total number of Vusers configured to run in the load test.

➤ No. Load Generators. Number of load generators configured in the load test.

➤ Diagnostics. The diagnostics servers and J2EE/.NET probes that are enabled 
in the load test.

➤ Monitoring. The monitor profiles used for monitoring the load test.

➤ Scripts. The Vuser scripts used in the load test.
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10
Designing Load Test Workloads

To run load tests on your application, you must design a workload that 
emulates groups of users running on the application. 

This chapter includes:

 ➤  The Workload Tab at a Glance on page 170

 ➤  Overview of Configuring Workload Settings on page 171

 ➤  Types of Workloads on page 173

 ➤  Selecting a Workload Type on page 175

 ➤  Creating Vuser Groups on page 177

 ➤  Load Generator Distribution on page 180

 ➤  Configuring Optional Workload Settings on page 185

 ➤  Viewing Scripts on page 190
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The Workload Tab at a Glance

You design a workload in the Workload tab of the Load Test configuration 
page.  

The Workload tab is divided into the following areas:

➤ Workload definition area. Provides a definition of the workload selected 
for the load test. 

➤ Groups pane. In the Groups pane, you create and configure Vuser groups 
to run in the load test and define how to distribute the load generators 
among the Vuser groups.

➤ Scheduler pane. In the Scheduler pane, you can design a schedule for the 
load test.



Chapter 10 • Designing Load Test Workloads

171

Tip: You can optimize the area of the Groups and Scheduler panes by 
clicking the Collapse/Expand buttons in the top left corner of each pane.

Overview of Configuring Workload Settings 

Part of creating a load test involves designing a workload for the load test. 
You create Vuser groups that emulate groups of users running on the 
application, and configure how they should behave in the load test. 

The following diagram illustrates the workload design flow:

 1 Select a workload type.

Select the type of schedule to set up for the load test, and a method for 
distributing Vusers among the Vuser groups. See “Types of Workloads” on 
page 173.

 2 Create Vuser groups.

Create groups of Vusers to run selected Vuser scripts in your load test. See 
“Creating Vuser Groups” on page 177.

 3 Determine how to distribute load generators among the Vuser groups, and 
assign load generators to the Vuser groups.

Select a method for distributing load generators among Vuser groups in the 
load test, then assign the load generators to the Vuser groups accordingly. 
See “Load Generator Distribution” on page 180.



Chapter 10 • Designing Load Test Workloads

172

 4 Design a schedule for running the load test.

When you design a schedule for a load test, you can specify how many 
Vusers to start running in each Vuser group, how long to run them, and 
when to stop running them. See Chapter 11, “Configuring Scheduler 
Settings.”

 5 Configure optional workload settings.

You can also configure the following optional settings from the Workload 
tab:

➤ Terminal Services. When using manual load generator distribution, you 
can open terminal services sessions on the load generator, enabling you 
to run multiple GUI Vusers simultaneously on the same application. For 
more information, see “Configuring Terminal Sessions” on page 238.

➤ Run-time Settings. You can edit run-time settings for the script, and copy 
the run-time settings used in one script to another script. For more 
information, see “Configuring Run-Time Settings” on page 187.

➤ Command Line Parameters. Sending command line arguments enables 
you to configure load test settings without the need to manually define 
them in the UI. For more information, see “Using Command Line 
Arguments” on page 189. 

➤ Rendezvous Points. Rendezvous points cause multiple Vusers to perform 
tasks at exactly the same time, thereby creating intense user load on the 
server. Creating rendezvous points enables you to check your system's 
response under specific load. For more information, see Chapter 16, 
“Using Rendezvous Points.”

➤ WAN Emulation. Emulating a WAN during a load test enables the load 
test to run in an environment much closer to an actual deployment 
scenario, exposing issues that can arise from WAN conditions such as 
latency, bandwidth limitations and packet loss. For more information, 
see Chapter 17, “WAN Emulation.”
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Types of Workloads

When you start designing a load test, you design a workload for the test, 
selecting a type of schedule by which to run the load test, and an 
appropriate method for distributing Vusers among the Vuser groups that 
you created for the load test.

Schedule Run Modes
You can schedule a load test to run according to the run-time settings 
defined in the enabled Vuser groups, or you can let the groups run over and 
over again until a defined schedule instructs them to stop running.

You can create a schedule in one of the following run modes:

➤ Basic schedule. Vusers run according to the run-time settings defined in 
the Vuser script. You can schedule how to start running the Vusers 
(gradually or simultaneously), how long to run them for, and how to stop 
running the them (gradually or simultaneously). When all the Vusers 
have finished running, the load test ends.

➤ Real-world schedule. The load test runs according to a user-defined group 
of actions that simulate a real-world schedule of events. Vuser groups run 
according to the iterations defined in their run-time settings, but you can 
schedule different numbers of Vusers to start and stop running several 
times, and you can specify how long to wait between each action.

Load Test Schedule Types
When setting up a load test, you can schedule all the Vuser groups in the 
load test to run together, or you can schedule each Vuser group according to 
its own schedule. 

➤ Scheduling by Load Test. When you define a schedule by load test—one 
global schedule for all the selected Vuser groups in the load test—
Performance Center runs all the Vuser groups in the load test 
concurrently, applying each action proportionately to all the Vusers 
groups. 
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For example, take a load test with three enabled Vuser groups, Group1, 
Group2, and Group3, where Group1 has 10 Vusers, Group2 has 20 
Vusers, and Group3 has 30 Vusers, giving a total of 60 Vusers. When 
scheduling by load test, if the schedule instructs Performance Center to 
load 30 Vusers, Performance Center loads a proportional number of 
Vusers from each of the groups—that is, 5 from Group1, 10 from Group2, 
and 15 from Group3, totalling 30 Vusers, as instructed.

➤ Scheduling by Group. For each enabled Vuser group in a load test, you 
can define a separate schedule. When running the load test, all the Vuser 
groups run, but each on its own schedule. 

Note: Group schedules can run separately, or all at the same time.

Vuser Distribution Methods
When selecting a workload, you must specify how to distribute the Vusers 
among the Vuser groups.

➤ By number. Enables you to allocate a number of Vusers to each Vuser 
groups. When you create a Vuser group, by default Performance Center 
allocates 10 Vusers to the group. You can edit this number of Vusers. The 
total number of the Vusers assigned to all the Vuser Groups is displayed 
in the Groups pane toolbar.

➤ By percentage. Enables you to specify a percentage of the total number 
of Vusers in the load test to allocate to each Vuser group. After you select 
all the Vuser groups for the load test, you specify the percentage of Vusers 
that you want to assign to each group. 



Chapter 10 • Designing Load Test Workloads

175

Alternatively, you can have Performance Center calculate the percentage 
according to a ratio of Vusers to use from each group. For more 
information, see “Distributing Vusers Using Relative Distribution” on 
page 186.

Selecting a Workload Type

You select a workload for the load test in the Workload tab. The workload 
comprises a type of schedule by which to run the load test, and an 
appropriate method for distributing Vusers among the Vuser groups that 
you created for the load test.

To select a workload option for your load test:

 1 On the Load Test configuration page, click the Workload tab.

 2 Next to the Workload type box, click the Select Workload Type button. The 
Workload Types dialog box opens.
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 3 Select a workload by clicking the image:

➤ Basic schedule, by load test. All Vuser groups run on one basic schedule. 

➤ Basic schedule, by group. Each Vuser groups runs on its own basic 
schedule.

➤ Real-world schedule, by load test. All Vuser groups run on one real-world 
schedule. 

➤ Real-world schedule, by group. Each Vuser groups runs on its own 
real-world schedule.

For more information about the workload types, see “Types of Workloads” 
on page 173.

 4 If you select a schedule by load test, select a method for distributing the 
Vusers among the Vuser groups:

➤ By number. Enables you to allocate a number of Vusers to each Vuser 
groups. 

➤ By percentage. Enables you to specify a percentage of the total number 
of Vusers to allocate to each Vuser group. 

For details, see “Vuser Distribution Methods” on page 174.

Note: When scheduling by Vuser group, you can allocate Vusers to the 
Vuser groups by number only. 

 5 Click OK. A definition for the workload you selected is displayed in the 
Workload type box.
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Creating Vuser Groups

After you have selected a type of workload for the load test, you create one 
or more Vuser groups to run Vuser scripts in the load test run.

To create Vuser groups:

 1 On the Load Test configuration page, click the Workload tab.

 2 In the Groups pane, select scripts in one of the following ways:

➤ To select a single script: In the Script column, click Click here to add a 
new group. A list opens containing all the scripts in the current project. 

Select a script for the Vuser group.

➤ To select multiple scripts: Click the Add Multiple Groups button, select 
multiple scripts in the list, and click OK.
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Note: If the script you want to use does not appear in the list, you need to 
upload it to the Vuser Scripts page. For details, see “Uploading Scripts to the 
Vuser Scripts Page” on page 130. 

 3 In the Group Name column, the Vuser group is given the same name as the 
selected script.

(Optional) To rename the Vuser group, click the group name and type a new 
name. The name must not contain spaces nor any of the following 
characters: < > . | : ; ! ? & * # - @ % ^ ( ) $.

 4 (Optional) Allocate Vusers to the Vuser groups according to the type of 
workload you selected for your load test (see “Vuser Distribution Methods” 
on page 174):

➤ By number. Allocate Vusers to each Vuser group. 

➤ Basic schedule: In the Groups pane, enter the number of Vusers in the 
# column.  

➤ Real-world schedule: In the Scheduler pane, enter the number of 
Vusers to run in each Start Vusers action. 
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The total number of the Vusers assigned to all the Vuser Groups is 
displayed in the Groups pane toolbar.

➤ By percentage. Specify the total number of Vusers to run in the load test:

➤ Basic schedule: In the Groups pane, enter the number of Vusers in the 
Total Vusers box.  

➤ Real-world schedule: In the Scheduler pane, enter the number of 
Vusers to run in each Start Vusers action. 
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After you select all the groups for the load test, specify the percentage of 
Vusers that you want to assign to each group, or select a relative 
distribution ratio by which Performance Center should distribute the 
Vusers from each group (see “Distributing Vusers Using Relative 
Distribution” on page 186).

 5 Click Save to save your settings.

Load Generator Distribution

In a load test, you specify how to distribute available load generators among 
the Vuser groups. 

Load Generator Distribution Methods
If you have symmetrical load generators, you can select one of the 
automatic distribution methods, or you can assign a different number of 
load generators to each group manually.

Using the automatic distribution method, Performance Center 
automatically assigns virtual load generators to Vuser groups during the load 
test design phase. These virtual load generators serve as placeholders for 
actual load generators that are allocated at run time.

Using the manual distribution method, if you know which load generators 
will be available at run time, you can manually assign these actual load 
generators to Vuser groups during the design phase. If you do not know 
which load generators will be available at run time, you can manually assign 
virtual load generators to Vuser groups during the design phase, and then at 
the initialization stage of the load test run, assign actual load generators. 
Manual distribution enables you to distribute your load generators among 
Vuser groups, without overloading any one load generator.
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Automatic Load Generator Distribution

When you select an automatic load generator distribution method, 
Performance Center assigns a selected number of virtual load generators to 
the Vuser groups during the load test design phase. At run-time, 
Performance Center automatically replaces the virtual load generators with 
actual load generators available in the system. 

The following automatic distribution methods are available:

➤ Assign all load generators to each group. Performance Center 
automatically assigns all load generators to each group (Default).

➤ Assign one load generator to each group. Performance Center 
automatically assigns one virtual load generator to each Vuser group. If 
you have fewer groups than load generators, not all load generators are 
assigned to groups. If you have more groups than load generators, the 
load test is saved with an Invalid status.

➤ Assign an equal number of load generators to each group. Performance 
Center automatically distributes all of the virtual load generators one by 
one, evenly among all the Vuser groups.

If you have more groups than load generators, the load test is saved with 
an Invalid status.
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Manual Load Generator Distribution

The manual load generator distribution options enable you to assign virtual 
or actual load generators to the Vuser groups.

The following manual distribution options are available:

➤ Assign virtual load generators to groups at design time. You manually 
assign virtual load generators (LG1, LG2, and so on) to the Vuser groups, 
and Performance Center assigns actual load generators at run time. 

➤ Assign actual load generators manually at run time. If you select this 
option, when the load test starts, Performance Center prompts you to 
assign the actual load generators to the virtual load generators, instead 
of assigning the actual load generators itself. For more information, see 
“Manually Assigning Specific Load Generators at Run Time” on 
page 363.

➤ Assign actual load generators to groups. You manually assign actual load 
generators to the Vuser groups. 

Distributing Load Generators Among Vuser Groups
You distribute load generators among Vuser groups when you design the 
load test. You can have Performance Center distribute the load generators 
automatically, or you can distribute them manually among the groups.

To distribute load generators among Vuser groups:

 1 On the Load Test configuration page, click the Workload tab.

 2 Next to LG Distribution, click the browse button. The Load Generator 
Distribution Method dialog box opens.
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 3 Select a method for distributing the load generators among the Vuser 
groups, as follows:

➤ Automatic Distribution. Performance Center automatically assigns load 
generators to the Vuser groups, as described in “Automatic Load 
Generator Distribution” on page 181.

➤ Manual Distribution. You manually assign virtual or actual load 
generators to the Vuser groups, as described in “Manual Load Generator 
Distribution” on page 182.

Click OK. 

 4 If you selected an automatic load generator distribution method, in the 
LG box specify the number of load generators to automatically distribute 
among the Vuser groups at run-time.

 5 If you selected a manual load generator distribution method, you need to 
manually assign the load generators to the Vuser groups according to the 
method you selected.

➤ If you selected Assign virtual load generators to groups at design time, 
assign virtual load generators as follows: 

➤ To assign virtual load generators to a single Vuser group, in the Groups 
pane, select the group, and click the Select virtual load generators 
link. 

➤ To assign virtual load generators to multiple groups simultaneously, 
click the Assign Load Generators to Multiple Groups button next to 
the LG Distribution box.
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In the dialog box that opens, select load generators to assign. If you are 
assigning the load generators to multiple Vuser groups, select the Vuser 
groups to which to assign the load generators.

You can add more virtual load generators to the list by clicking the Add 
button. In the Add Load Generators dialog box that opens, enter the 
number of load generators to add and click OK. Performance Center adds 
the selected number of virtual load generators to the list in the Virtual 
Load Generators dialog box.

Note: If you selected Assign actual load generators at run time, you can 
assign actual load generators at run time. For more information, see 
“Manually Assigning Specific Load Generators at Run Time” on page 363.
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➤ If you selected Assign actual load generators to groups, assign actual 
load generators as follows:

➤ To assign load generators to a single Vuser group, select the group and 
click the Select Load Generators link. 

➤ To assign load generators to multiple groups simultaneously, click the 
Assign Load Generators to Multiple Groups button next to the LG 
Distribution box 

The dialog box that opens displays the load generators that are currently 
available in the host pool. Select load generators to assign. If you are 
assigning the load generators to multiple Vuser groups, select the Vuser 
groups to which to assign the load generators.

 6 (Optional) To open terminal services sessions on a particular load generator, 
see “Configuring Terminal Sessions” on page 238.

 7 Click Apply to apply your selections, or click OK to apply your settings and 
close the Load Generators dialog box. In the Workload tab, the selected load 
generators are displayed in the Virtual/Actual Load Generators column.

 8 Click Save on the Load Test configuration page to save your settings.

Configuring Optional Workload Settings

You can configure the following optional workload settings:

➤ Distribute Vusers using relative distribution. See “Distributing Vusers Using 
Relative Distribution” on page 186.

➤ Configure script run time settings. See “Configuring Run-Time Settings” on 
page 187.

➤ Define command-line arguments. See “Using Command Line Arguments” 
on page 189.
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➤ Emulate WAN settings. See Chapter 17, “WAN Emulation.”

Distributing Vusers Using Relative Distribution
When distributing Vusers by percentage, Performance Center can calculate 
the exact percentage of Vusers to assign to each Vuser group based on a 
relative distribution ratio that you provide. 

To distribute Vusers using relative distribution:

 1 On the Load Test configuration page, click the Workload tab.

 2 Click the Relative Distribution button. The Relative Distribution dialog box 
opens. 

 3 Under # Vuser Ratio, type a number representing the ratio for each Vuser 
group, and click OK. Performance Center converts this number into a 
percentage. 

For example, to distribute the Vusers among the groups at a ratio of 1:1:3, 
type 1 for group1, 1 for group2, and 3 for group3. 

 4 Click Save on the Load Test configuration page to save your settings. 

Following the example above, Performance Center assigns 20% of the Vusers 
to group1, 20% to group2, and 60% to group3.
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Configuring Run-Time Settings
You can configure the run-time settings of Vuser scripts that you have 
uploaded. The run-time settings define the way that the script runs. 
Run-time settings are applied to Vusers when you run a script. 

Configuring run-time settings allows you to emulate different kinds of user 
activity. For example, you could emulate a user who responds immediately 
to output from the server, or a user who stops and thinks before each 
response. You can also configure the run-time settings to specify how many 
times the Vuser should repeat its set of actions. 

If you do not edit the run-time settings, Performance Center runs the script 
using the default settings, or the last saved settings if the script was recorded 
in VuGen.

You can also copy run-time settings used in one script to other scripts in 
your load test.

To edit run-time settings for the script:

 1 On the Load Test configuration page, click the Workload tab.

 2 Select the script, and click the Edit Runtime Settings button. The Run-Time 
Settings dialog box opens.
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 3 Configure the run-time settings. For more information on configuring a 
script’s run-time settings, see “Configuring General Run-Time Settings” on 
page 549.

To use the default settings, click Use Defaults. Vuser scripts have individual 
run-time setting defaults for VuGen and the Controller, to support the 
debugging environment of VuGen and the load testing environment of the 
Controller.

 4 Click OK to save the settings.

 5 Click Save on the Load Test configuration page to save your settings.

To copy run-time settings:

 1 On the Load Test configuration page, click the Workload tab.

Note: To copy run-time settings, there must be at least two different scripts 
of the same type selected for the load test.

 2 Click the Duplicate Runtime Settings button. The Duplicate Run Time 
Settings dialog box opens.
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 3 Under Select source group, select the group from which you want to copy 
the run-time settings. The source group is displayed in the box and any 
other groups in the load test with the same type of script are listed below as 
potential target groups.

 4 Select the target groups into which to copy the run-time settings. 

 5 Click OK. The run-time settings are copied into the selected target groups.

 6 Click Save on the Load Test configuration page to save your settings.

Using Command Line Arguments
You can pass arguments to instruct the Controller how to behave. By 
passing arguments in the command line, you configure load test settings 
without the need to manually define them in the UI. 

To send parameters to the script:

 1 On the Load Test configuration page, click the Workload tab.

 2 Select a script and click the Command line button. The Command Line 
dialog box opens.

 3 Type the name and value of the parameter you want to send using the 
format:
 

For more information on the command line parsing functions, or for details 
on including arguments on a command line, see the HP LoadRunner Online 
Function Reference.

 4 In the list box, select whether to apply the command line to the current 
script only or to all the scripts in the load test, or to add it to all the scripts 
in the load test.

<-Parameter_Name> <value>
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Viewing Scripts

You can open an uploaded script, and view the code for each action from 
the Load Test configuration page.

To view a Vuser script:

 1 On the Load Test configuration page, click the Workload tab.

 2 Select a group and click the View Script button. The script opens in a read-
only window.

 3 Select an action to view its code.

 4 To download the script, click Download Script and follow the instructions 
in “Downloading Scripts from the Vuser Scripts Page” on page 137. 

You can use VuGen to edit the downloaded scripts and then upload them 
back on to your system.
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11
Configuring Scheduler Settings

After you select a workload and create the Vuser groups to run in your load 
test, you can define a schedule according to which the load test should run. 
You can schedule when to initialize, start, and stop Vusers during the run, 
and how long an action should continue running.

This chapter includes:

 ➤  About Scheduling Load Tests on page 192

 ➤  Scheduler at a Glance on page 193

 ➤  Setting Scheduler Options on page 194

 ➤  Understanding Schedule Actions on page 195

 ➤  Managing the Scheduler on page 201

 ➤  Managing Schedule Actions on page 205

 ➤  Viewing Load Test Schedules in the Schedule Graph on page 210

 ➤  Managing Schedule Actions From the Schedule Graph on page 214

 ➤  Controlling Scheduler During Load Test Runs on page 215
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About Scheduling Load Tests

You use the Scheduler to create a schedule that distributes load in a load test 
in a controlled manner. You can then monitor your Vusers throughout the 
load test run. Using the Scheduler, you can:

➤ Set the time at which the load test should begin running. You specify the 
amount of time you want Performance Center to wait after the load test 
is started.

➤ Stipulate how Vusers are initialized, and how many Vusers Performance 
Center starts and stops within a certain time frame. You specify whether 
Performance Center should start or stop all Vusers in a load test or Vuser 
group simultaneously, or start/stop only a certain number of Vusers 
within a specified amount of time. 

➤ Set the timing aspect of a load test, limiting the execution duration of the 
Vusers or of Vuser groups within the load test. You limit the execution 
time duration by specifying the amount of time the Vusers or Vuser 
groups should be in the running state. You can set a load test to run 
according to the run-time settings defined in the enabled Vuser groups, 
or you can let the groups run over and over again until the schedule 
settings instruct them to stop running.

You configure schedule settings in the Workload tab of the Load Test 
configuration page. You can select the schedule you want to use for all the 
Vuser groups in your load test, or for each Vuser group.

Note: Rendezvous points (see Chapter 16, “Using Rendezvous Points”) in a 
Vuser script interfere with a scheduled load test. If your script contains 
rendezvous points, your load test will not run as scheduled. 
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Scheduler at a Glance

You configure a schedule for a load test in the Scheduler pane of the Load 
Test configuration page’s Workload tab. 

The Scheduler pane contains the following sections: 

Schedule Actions Grid

You define the actions for a schedule in the Actions grid. For real-world 
schedules, you can add, modify, and delete schedule actions.

When creating a schedule by group, you can copy a Vuser group’s schedule 
settings to other Vuser groups’ schedules.

For more information about schedule actions, see “Understanding Schedule 
Actions” on page 195.

Schedule Graph

The schedule graph displays a graphical representation of the defined 
schedule. The lines in the graph correspond to the groups in the Groups 
pane, and the line segments correspond to the actions defined in the 
Actions grid. The graph is interactive—you can split actions and delete 
actions from the graph itself.

For more information, see “Viewing Load Test Schedules in the Schedule 
Graph” on page 210.

Schedule 
Graph

Actions 
Grid
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Setting Scheduler Options

You set general Scheduler options from the Scheduler Options box.

To set schedule options:

 1 On the Load Test configuration page, in the top right corner of the 
Workloads tab, click Schedule Options.

 2 Select Scheduler options as follows:

➤ Enable Scheduler. Enables the Scheduler so that you can run the load test 
according to a defined schedule. To define a schedule, this option must 
be selected.

➤ Start the Scheduler after a delay of HH:SS:MM. Enables you to specify 
when, after the Run Load Test command has been issued, the Scheduler 
should start running the schedule. If this option is not selected and the 
Scheduler is enabled, the schedule starts to run as soon as the load test is 
started.

➤ Wait for all groups to initialize. Instructs the Scheduler to wait until all 
the Vusers in all the Vuser groups have finished initializing, before 
starting to run any of the groups.

➤ Pause Scheduler at load test start. Pauses the Scheduler at the start of a 
load test run, enabling you make changes to the load test design just 
before the load test is about to run. You can then restart the Scheduler 
manually. For more details, see “Manually Starting the Scheduler” on 
page 362.

 3 Click OK to save the selected options.
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Understanding Schedule Actions

A load test schedule contains a series of actions that instruct the load test 
when to start running a Vuser group, when to initialize, start, and stop the 
Vusers, and how long to run an action.

This section describes the available schedule actions:

➤ Start Group

➤ Initialize

➤ Start Vusers

➤ Duration

➤ Stop Vusers

For information on managing the schedule actions, see “Managing Schedule 
Actions” on page 205.
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Start Group
The Start Group action defines when to start running a Vuser group. This 
action is available for group schedules only.

Note: By default, the Start Group action appears as the first action in the 
Actions grid when you select a workload with a schedule by group. It is 
always followed by the Initialize action. It cannot be deleted.

Options Description

Start immediately after the load test 
begins

(Default)

The Scheduler starts running the 
selected Vuser group as soon as the 
load test starts running. 

Start <00:00:00> (HH:MM:SS) after the 
load test begins

After the load test starts running, the 
Scheduler waits the specified time (in 
hours, minutes, and seconds) before it 
starts running the selected Vuser 
group.

Start when group <group name> 
finishes

The Scheduler starts running the 
selected Vuser group immediately after 
the Vuser group specified in this 
option has finished running.
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Initialize
The Initialize action instructs the Scheduler to prepare the Vusers so that 
they are in the Ready state and can run. 

Note: By default, the Initialize action appears in the Actions grid for all 
schedules. It cannot be deleted.

Options Description

Initialize all Vusers simultaneously
Wait for <00:00:00> (HH:MM:SS) after 
initialization

The Scheduler initializes all the Vusers 
in the load test or selected Vuser group 
together, and waits the specified 
amount of time before running them.

Initialize XX Vusers every <00:00:00> 
(HH:MM:SS)
Wait for <00:00:00> (HH:MM:SS) after 
initialization

The Scheduler initializes the specified 
number of Vusers gradually, according 
to the specified time interval (in hours, 
minutes, and seconds), and waits the 
specified amount of time before 
running them.

Initialize each Vuser just before it runs

(Default)

The Scheduler initializes the each 
Vuser in the load test or selected Vuser 
group just before it starts running.

Note: This option is not available for 
Group schedules when the Wait for all 
groups to initialize option is selected. 
See “Setting Scheduler Options” on 
page 201.
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Start Vusers
The Start Vusers action instructs Performance Center to start running the 
Vusers. 

Notes:

➤ The Scheduler starts running Vusers only when they have reached the 
Ready state.

➤ In a Basic schedule, the Scheduler always runs all the Vusers, whether 
simultaneously or gradually. In a Real-world schedule, you can select 
how many Vusers to start running at a time.

➤ While a load test is running, you can add Vuser groups/scripts to a load 
test and enable them. When starting the Vusers gradually, if you add a 
Vuser group after all the Vusers in the load test have started running, the 
new group will start running immediately.

Options Description

Start XX Vusers: Simultaneously

(Default)

The Scheduler runs the specified 
number of Vusers simultaneously.

Start XX Vusers: YY Vusers every 
<00:00:00> (HH:MM:SS)

The Scheduler runs the specified 
number of Vusers (XX) gradually. 
That is, the Scheduler runs YY Vusers, 
and waits the specified time (in hours, 
minutes, and seconds) before running 
another YY Vusers.
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Duration
The Duration action instructs the Scheduler to continue running the load 
test in the current state, for the specified amount of time. 

Note: 

➤ In a real-world schedule, if a Duration action is not followed by another 
action, the load test continues to run indefinitely.

➤ In a basic schedule, a Run for Duration action is always followed by a 
Stop Vuser action.

Options Description

Run until complete The load test runs until all the Vusers 
have finished running.

Run for <00.00:00:00> (dd.HH:MM:SS) The load test in its the current state for 
the specified amount of time (in days, 
hours, minutes, and seconds) before 
continuing with the next action. 

The default Duration period is 
5 minutes. The maximum definable 
duration period is 
99.23:59:59 dd.HH:MM:SS.

Run indefinitely
(Basic schedule only)

The load test runs indefinitely.
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Stop Vusers
The Stop Vusers action instructs the Scheduler to stop the running Vusers. 

Note: 

➤ A basic schedule that has a Run for Duration action, is always followed by 
a Stop Vuser action that stops all the Vusers, simultaneously or gradually. 

➤ In a real-world schedule, if no action is specified after a Run for Duration 
action, the Vusers continue to run indefinitely—that is, the schedule 
continues to run indefinitely. 

➤ When scheduling by group, if Group A is scheduled to run indefinitely, 
and Group B is scheduled to run after Group A, then Group A must be 
stopped manually before Group B can start running.

Options Description

Stop XX Vusers: Simultaneously

(Default)

The Scheduler stops the specified 
number (All or XX) of running Vusers 
at once.

Stop XX Vuser: YY Vusers every 
<00:00:00> (HH:MM:SS)

The Scheduler stops the specified 
number of Vusers (All or XX) gradually. 
That is, the Scheduler stops YY Vusers, 
and waits the specified time (in hours, 
minutes, and seconds) before stopping 
another YY Vusers.
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Managing the Scheduler

When you select atype of workload for your load test, you select the type of 
schedule you want to design for the load test. (See “Load Test Schedule 
Types” on page 173.) After you have created the Vuser groups to run in the 
load test, you design the schedule by which to run the groups.

This section includes:

➤ “Setting Scheduler Options” on page 201

➤ “Defining Load Test Schedules” on page 202

Setting Scheduler Options
You set general Scheduler options from the Scheduler Options box.

To set schedule options:

 1 On the Load Test configuration page, in the top right corner of the 
Workloads tab, click Schedule Options.

 2 Select Scheduler options as follows:

➤ Enable Scheduler. Enables the Scheduler so that you can define a 
schedule for the load test, and run the load test according to the defined 
schedule. 

➤ Start the Scheduler after a delay of HH:SS:MM. Enables you to specify 
when, after the Run Load Test command has been issued, the Scheduler 
should start running the schedule. If this option is not selected, the 
schedule starts to run as soon as the load test starts running.



Chapter 11 • Configuring Scheduler Settings

202

➤ Wait for all groups to initialize. Instructs the Scheduler to wait until all 
the Vusers in all the Vuser groups have finished initializing before 
starting to run any of the groups. 

Note: If you select this option, if any of the Vuser groups in the load test 
are set to Initialize each Vuser just before it runs, the Scheduler 
automatically changes this setting to Initialize all Vusers simultaneously.

➤ Pause Scheduler at load test start. Pauses the Scheduler at the start of a 
load test run, enabling you make changes to the load test design just 
before the load test is about to run. You can then restart the Scheduler 
manually. For more details, see “Manually Starting the Scheduler” on 
page 362.

 3 Click OK to save the selected options.

Defining Load Test Schedules

Note: These instructions also apply when modifying an existing schedule.
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To define a schedule:

 1 Ensure that the Scheduler is enabled. In the top right corner of the 
Workload tab, click Scheduler Options, select Enable Scheduler, and click 
OK.

 2 The Actions grid displays the default actions that correspond to the schedule 
type you selected in your workload.

For details about the schedule actions, see “Understanding Schedule 
Actions” on page 195.

You can modify these actions, and, in real-world schedules, you can add 
more actions. For details, see “Managing Schedule Actions” on page 205.

Notes: Schedules by group only: 

➤ When the load test is scheduled by group, each group runs its own 
schedule. 

➤ You can copy schedule settings from one Vuser group to another. For 
more information, see “Copying Group Schedule Settings” on page 209.

Select action for the schedule as follows:

 a Start Group. (Schedule by group only). Start running the group:

➤ Immediately upon starting the load test run

➤ After the specified period of time has elapsed

➤ After a specified group has finished running
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 b Initialize. Set the Vusers that will run in the load test to initialize before 
they run as follows:

➤ Initialize all the Vusers at the same time, and wait the specified time 
before running the Vusers

➤ Initialize a specified number of Vusers at given time intervals, and wait 
the specified time before running the Vusers

➤ Initialize each Vuser just before it starts running

Note: When scheduling by group, you can schedule all the Vusers in all 
the enabled Vuser groups to initialize before any of them start running. 
To set this option, see “Setting Scheduler Options” on page 201.

 c Start Vusers/Duration/Stop Vusers. Specify how many Vusers to start 
running, how long they should run, and how many to stop running at a 
time.

In basic schedules, there is one Start Vuser action, one Duration action, 
and one Stop Vuser action. You can specify whether to start all the Vusers 
simultaneously or gradually, how long to run them, and whether to stop 
them all simultaneously or gradually.

Note: For real-world schedules, to create a schedule that runs 
indefinitley, the last action should be a Run for Duration action.

 3 If you want to delay the start time of the load test schedule, click 
Scheduler Options, select Start the Scheduler after a delay of:, and enter the 
amount of time after the Run Load Test command has been issued that the 
Scheduler should activate the schedule. 

Enter this value in the hh:mm:ss format. The maximum delay that you can 
define is 23:59:59 hh:mm:ss.

Click OK.

 4 Click Save to save the settings.
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Managing Schedule Actions

When you create a load test, the Actions grid of the Scheduler lists default 
schedule actions. These actions are also displayed in the schedule graph. You 
add, edit, and delete schedule actions in the Actions grid.

This section includes:

➤ “Actions Grid Toolbar” on page 205

➤ “Adding Schedule Actions” on page 206

➤ “Editing Schedule Actions” on page 208

➤ “Deleting Schedule Actions” on page 208

➤ “Copying Group Schedule Settings” on page 209

Actions Grid Toolbar

Toolbar Button Button Name Enables You To

Add New Action Add an action after the selected 
action.

Delete Action Delete the selected action.

Duplicate Schedule 
Settings

Copy another group’s schedule 
settings to the selected group.

For details, see “Copying Group 
Schedule Settings” on page 209.

Apply View modification to action in the 
schedule graph.



Chapter 11 • Configuring Scheduler Settings

206

Adding Schedule Actions
In a real-world schedule, you can add actions to simulate a more true-to-life 
schedule by which to run your load test.

Note: You can also add schedule actions in the schedule graph. For more 
information, see “Managing Schedule Actions From the Schedule Graph” on 
page 214.

To add an action to a schedule:

 1 In the Actions grid, select an action after which to insert the new action, 
and click the Add New Action button. 

Note: A new action is always added after the action selected in the Actions 
grid.

A list of actions opens.
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 2 Select the type of action to add. 

Note: You can add a Start Vusers, Stop Vusers, or Duration action. For details 
about each action type, see “Understanding Schedule Actions” on page 195.

➤ If you are adding a Start Vusers or Stop Vusers action:

In the Properties column, type the number of Vusers to start/stop 
running, and select whether to:

➤ start/stop running the Vusers simultaneously

➤ start/stop running the Vusers gradually

When starting/stopping Vusers gradually, type the number of Vusers 
to start/stop at a time, and at what time interval.

➤ If you are adding a Duration action, select how long to run the action.

Click the Apply button to save the action settings.

 3 When you have finished adding actions to the schedule, click Save to save 
the updated schedule.

Important: If you navigate away from the Load Test configuration page 
without clicking Save, changes made to the schedule are not saved.



Chapter 11 • Configuring Scheduler Settings

208

Editing Schedule Actions
You edit the schedule actions in the Actions grid.

To edit a schedule action:

 1 In the Actions grid, select the action that you want to edit. 

You can select the action in the grid or by selecting the corresponding line 
in the schedule graph (see “Viewing Load Test Schedules in the Schedule 
Graph” on page 210).

The Properties column becomes editable. 

 2 Modify the action settings and click the Apply button.

You can edit all types of actions. For details about each action type, see 
“Understanding Schedule Actions” on page 195.

 3 When you have finished editing the actions, click Save.

Important: If you navigate away from the Load Test configuration page 
without clicking Save, changes made to the schedule are not saved.

Deleting Schedule Actions
You delete schedule actions in the Actions grid.

Alternatively, you can delete schedule actions from the schedule graph. For 
more information, see “Managing Schedule Actions From the Schedule 
Graph” on page 214.

To delete a schedule action:

 1 In the Actions grid, select the action you want to delete.

Note: You cannot delete Start Group or Initialize actions.
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 2 On the Actions grid toolbar, click the Delete Action button, and click OK.

The selected action is deleted from the Actions grid.

 3 Click Save.

Important: If you navigate away from the Load Test configuration page 
without clicking Save, the actions are not deleted.

Copying Group Schedule Settings
If you are creating a schedule by group, and you have already defined 
schedule settings for one of the groups, you can copy those settings to other 
groups. 

Note: 

➤ Schedule settings include the schedule run mode and the set of actions.

➤ You can copy group schedules that are the same type only.

To copy a Vuser group’s schedule settings to a particular group:

 1 In the Groups pane or in the header of the Actions grid, select the Vuser 
group to which you want to copy the settings.

 2 On the Actions grid toolbar, click the Duplicate Schedule Settings button. 
The Select Group dialog box opens. 

 3 Select the Vuser group from which to copy the schedule settings, and click 
OK.

The schedule settings are copied to the selected Vuser group.



Chapter 11 • Configuring Scheduler Settings

210

Viewing Load Test Schedules in the Schedule Graph

The schedule graph provides a graphical representation of the load test’s 
schedule. 

For real-world schedules, the graph is interactive in that you can split and 
delete schedule actions from within the graph. 

To edit actions, you can select them in the graph and modify them in the 
Actions grid. For details, see “Editing Schedule Actions” on page 208.

This section includes:

➤ “Schedule Graph Toolbar” on page 211

➤ “Showing and Hiding the Graph Legend” on page 211

➤ “Viewing Vuser Group Schedules in the Schedule Graph” on page 212
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Schedule Graph Toolbar

Showing and Hiding the Graph Legend

➤ To hide the schedule graph legend, click the Hide_Legend button in the 
upper-right corner of the graph pane.

➤ To show the schedule graph legend, click the Show_Legend button in the 
upper-right corner of the graph pane.

Toolbar Button Button Name Enables you to

Delete Action Delete a selected action from the 
schedule.

Split Action Split a selected action into two 
identical halves of the original 
action.

Hide Legend Hide the graph legend.

Show Legend Show the graph legend.
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Viewing Vuser Group Schedules in the Schedule Graph

Note: This section is relevant to group schedules only.

When scheduling by group, all the Vuser groups’ schedules are displayed in 
the schedule graph. You can also view a selected Vuser group’s schedule on 
its own.

To view a particular Vuser group’s schedule:

 1 In the Actions grid, select a group from the Group schedule for list that you 
want to view in the graph. 

Make sure that the graph legend is displayed. (See “Showing and Hiding the 
Graph Legend” on page 211.) The line representing the selected group is 
highlighted in the graph. In the legend, the check box of the selected Vuser 
group is unavailable.   
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 2 At the top of graph legend, clear the Vuser Group check box. Alternatively, 
you can clear the check boxes adjacent to each of the other groups. 

The Vuser group that you selected remains selected, and is displayed in the 
graph. 

➤ To view all of Vuser groups in the graph again, select the Vuser Groups 
check box. 

➤ To view a specific group together with the default group, select that 
group’s check box.
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Managing Schedule Actions From the Schedule Graph

You can split actions in the graph and delete actions from the graph. Each 
line in the graph represents an action in the Actions grid. When you split or 
delete actions in the graph, the schedule is updated in the Actions grid as 
well.

Note: Only Start Vusers, Duration, and Stop Vusers actions are displayed in 
the graph. 

This section describes:

➤ Splitting an Action In the Schedule Graph

➤ Deleting an Action From the Schedule Graph

Splitting an Action In the Schedule Graph
In the schedule graph,when you split an action, the resulting two actions 
represent two identical halves of the original action. 

For example:

➤ You can split an action that starts 20 Vusers into two identical actions 
that start 10 Vusers each. Then you can modify each of these actions to 
start a different number of Vusers, or to start the Vusers at different rates.

➤ You can split an action that runs the scenario for 30 minutes into two 
identical actions that run the scenario for 15 minutes each. Then you can 
modify each of these actions to run the scenario for different durations.
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To split an action into two:

 1 In the graph, select the line that represents the action that you want to split. 

Tip: Selecting the action in the Actions grid highlights the corresponding 
line in the graph.

 2 Click the Split Action button. The selected line is split in two. The original 
action in the Actions grid is split into two equivalent actions, each 
representing half of the original action.

 3 Edit the actions in the Actions grid (see “Editing Schedule Actions” on 
page 208). The change is reflected in the graph.

 4 Click Save to save your changes.

Deleting an Action From the Schedule Graph
You can delete a schedule action from the schedule graph.

To delete a schedule action:

 1 In the Actions grid or in the graph, select the action you want to delete.

 2 In the graph pane toolbar, click the Delete Action button, and click OK.

The selected action is deleted from the graph and from the Actions grid.

 3 Click Save to save your changes.

Controlling Scheduler During Load Test Runs

For information about pausing the scheduler or modifying schedules during 
a load test run, see “Configuring Schedule Settings from the Load Test Run 
Page” on page 364.
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12
Configuring Load Test Monitor Settings

When you design a load test, you can configure one or more monitor 
profiles to monitor server resources when you run the load test.

This chapter includes:

 ➤  Configuring Monitor Settings on page 218

 ➤  Creating Monitor Profiles for a Load Test on page 219

 ➤  Selecting Monitor Profiles for a Load Test on page 221

 ➤  Editing a Monitor Profile for a Load Test on page 223
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Configuring Monitor Settings

When configuring a load test, you can configure monitor settings to 
monitor server resources during the load test run. 

Note: You can also configure monitor settings while the load test is running. 
For more information, see “Creating or Modifying the Runtime Monitor 
Profile” on page 386.

You configure monitor settings in the Monitors tab of the Load Test 
configuration page.

In the Monitors tab you can:

➤ Define a monitor profile for the current load test and create monitor 
profiles that can be used for the current load test and for other load tests. 
For details, see “Creating Monitor Profiles for a Load Test” on page 219. 

➤ Select existing monitor profiles and Monitor Over Firewall machines to 
use for the load test. For details, see “Selecting Monitor Profiles for a Load 
Test” on page 221.

➤ Edit monitor profiles. For details, see “Editing a Monitor Profile for a 
Load Test” on page 223.
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Creating Monitor Profiles for a Load Test

When designing a load test, you can create a local monitor profile that is 
specific to the load test you are designing, and you can create monitor 
profiles for the load test that can be used by other load tests in the project. 

To create a monitor profile when configuring a load test:

 1 On the Load Test configuration page, click the Monitors tab.

 2 Select the monitor profile that you want to create:

➤ To create a monitor profile for the current load test, click Add Local 
Profile. 

➤ To create a monitor profile that can be used for other load tests, click 
Add Profile, type a name and description of the profile and click OK.

 3 The Add Monitor page opens. Select the monitor that you want to run and 
click Next.
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 4 The Choose Server page opens. Type the name or IP address of the server 
whose resources you want to monitor and, where relevant, the user login 
name and password. Click Next. 

 5 The Choose Measurements page opens.

Expand a measurement group to display the available measurements. Select 
the measurements or measurement groups that you want to monitor.

To remove a selection, clear the relevant measurement’s check box.

 6 Click Save.

 7 To add additional monitors or servers to the profile, click Add and repeat 
steps 3 - 6 for each monitor and server that you want to add to the profile.
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 8 Click Close to close the Monitor Profile window. 

➤ If you added a local profile, it is displayed as Local Profile.

➤ If you added a regular monitor profile (Add Profile), it is displayed on the 
Monitors tab and is also added to the main Projects> Monitor Profiles 
page. For more information, see Chapter 6, “Monitor Profiles.”

Selecting Monitor Profiles for a Load Test

You can select monitor profiles for a load test when designing the load test. 
You can select one or more monitor profiles defined in the project, and one 
or more Monitor Over Firewall machines. 

To select monitor profiles for the load test:

 1 On the Load Test configuration page, click the Monitors tab.

 2 Select one or more profiles in the list. 

Note: When selecting more than one SiteScope monitor, make sure that 
they all have the same account credentials.
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To select a Monitor Over Firewall machine for the load test:

 1 On the Load Test configuration page, click the Monitors tab.

 2 Click the Over Firewall Machines button. The Modify Agents List dialog box 
opens.

 3 Select the Monitor Over Firewall machines for the load test and click OK.

When you run the load test, your system monitors Vusers over the firewall. 
While the test is running, you can view graphs of the monitor over firewall 
data from the load test server monitors. For more information in viewing 
online monitor data, see Chapter 25, “Online Monitor View.”

Removing a Monitor Profile from a Load Test

You can remove a monitor profile from a load test if you no longer want to 
use it for that load test.

Note: You can also remove monitor profiles from the load test while the 
load test is running. For more information, see “Creating or Modifying the 
Runtime Monitor Profile” on page 386.
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To remove a monitor profile from a load test:

 1 On the Load Test configuration page, click the Monitors tab.

 2 Clear the check box of the monitor profile that you no longer want to use 
for the load test.

 3 For Monitor Over Firewall machines, click Over Firewall Machines, clear the 
relevant machine’s check box, and click OK.

 4 Click Save to save the changes to the load test configuration.

Editing a Monitor Profile for a Load Test

You can edit any monitor profile used in your load test. 

To edit a profile:

 1 On the Load Test configuration page, click the Monitors tab.

 2 Click the Edit Profile button in the relevant profile row. The Monitor Profile 
configuration page opens and displays the profile properties. 

➤ To add another monitor to the profile, click Add. Provide the server 
information and select the measurements to monitor in the same way 
you would when creating a new profile. For details, see “Creating 
Monitor Profiles” on page 111.



Chapter 12 • Configuring Load Test Monitor Settings

224

➤ To edit details of a monitor server in the profile, click the Edit button 
next to the relevant server, modify the measurement selection, and click 
Save.

➤ To delete a monitor server from the profile, click the Delete Server 
button next to the relevant server and click OK.

➤ To delete a monitor from the monitor profile, click the Delete Monitor 
button next to the relevant monitor and click OK.

 3 Click Close to close the Monitor Profile dialog box.

 4 Click Save to save the changes to the load test configuration.
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13
Configuring Diagnostics Settings

After you create a load test for your application, you configure the 
diagnostics settings. You can then save or run your load test.

Performance Center's Diagnostics modules are application performance 
optimization solutions that are designed to help you improve the 
performance of your applications on the J2EE/.NET and ERP/CRM platforms 
throughout the application life cycle. They provide monitors that trace, 
time, and troubleshoot individual transactions that rapidly identify and 
pinpoint performance problems. These monitors help you to maximize 
business process performance, scalability, and efficiency. 

HP Diagnostics provides you with the capability to monitor the 
performance of your applications that run on most of the J2EE compliant 
application servers and the Microsoft .NET Framework.

ERP/CRM Diagnostics provides you with the capability to monitor the 
performance of your applications that run on SAP, Siebel, Siebel DB, and 
Oracle DB environments.

For more information about setting up the diagnostics modules, see Part IV, 
“Working with Diagnostics.”



Chapter 13 • Configuring Diagnostics Settings

226



227

14
Post Load Test Configuration

After you create and configure a load test for your application, you can save, 
copy, or run your load test.

This chapter includes:

 ➤  Saving and Validating a Load Test on page 227

 ➤  Copying a Load Test on page 228

 ➤  Running a Load Test on page 229

Saving and Validating a Load Test

After you configure a load test, you save it so that you can run it later. Each 
time you save design settings, Performance Center checks the validity of the 
settings, and displays the validation status in the lower-left corner of the 
Load Test configuration page.

The possible values for the validation status are:

Status Description

Load test saved. Load test configuration settings are valid and 
load test is saved.

Load test cannot be saved. Load test configuration settings are not all 
valid. The load test is not saved.

Load test contains errors. 
Click here for more information.

The load test contains errors and is rendered 
invalid. The erros can be viewed in the Load 
Test Validation Results window.
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If the load test contains errors, clicking the Click here link displays the Load 
Test Validation Results window. The validation results provide the problem 
level, the name of the tab and the location of where the problem occurred, 
and a description of the problem. 

Fix the problem and click Save to validate your design settings. 

Note: You can also view the Load Test validation results for any load test 
that has an Invalid status on the Load Tests page. Click the Invalid link to 
display the errors, then click Edit Load Test to open the Load Test 
configuration page for the invalid test.

Copying a Load Test

After you configure your load test, you can make copies of it for use within 
the project. You do so from any of the tabs in the Load Tests configuration 
page. This enables you to make minor changes to your load test (for 
example, scheduling), and reuse it, without having to recreate the whole 
test.

Note: Performance targets are not copied when you copy a load test.
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To copy a load test:

 1 In any of the Load Test configuration page tabs, click Save As. The 
Save Load Test As dialog box opens.

 2 Type the new name of the load test. By default, Performance Center names 
the copy of the load test <loadtest_name>_<number>.

 3 Click OK. The Load Test configuration page displays the new copy of the 
load test.

Running a Load Test

After you configure your load test, you can run it from the Load Test 
configuration page. You can also run a load test that you saved, or ran 
previously, from the Load Tests page.

To start running the load test, do one of the following:

➤ From the Load Test configuration page, click Start.

➤ From the Load Tests page, click the Run Load Test button in the row of the 
load test that you want to run.

The load test initialization process begins. For more information, see 
“Starting a Load Test” on page 353.
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15
Using Terminal Sessions

You can use Performance Center’s terminal sessions feature to run multiple 
load generators simultaneously in your load test on a terminal server. It also 
enables you to overcome the limitation of being able to run only a single 
GUI Vuser on a Windows-based load generator.

This chapter includes:

 ➤  About Terminal Sessions on page 232

 ➤  Using Terminal Sessions in Performance Center on page 232

 ➤  Setting up the Performance Center Agent on the Load Generator on page 234

 ➤  Configuring Terminal Services Logon Settings on page 235

 ➤  Launching a Terminal Client Session on page 236

 ➤  Configuring Terminal Sessions on page 238
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About Terminal Sessions

Terminal sessions allow centralized management of computing resources for 
each client connected to the server, and provides each user with their own 
working environment. Using a terminal server client, you can operate in a 
server-based computing environment from a remote machine, and see only 
your individual session, which is managed transparently by the server 
operating system, independent of other client sessions.

Using terminal sessions in Performance Center enables you to overcome the 
limitation of being able to run only a single GUI Vuser on a Windows-based 
load generator. GUI Vusers, which operate graphical user interface (GUI) 
applications, are defined in a GUI Vuser script. You create GUI Vuser scripts 
using HP’s GUI testing tools: WinRunner (for Microsoft Windows 
applications), and QuickTest Professional (for Web applications). By opening 
a terminal server session for each GUI Vuser, you can run multiple GUI 
Vusers on the same application.

Using Terminal Sessions in Performance Center

Using Performance Center’s terminal sessions, you can run multiple load 
generators simultaneously in your load test on a terminal server. 
Performance Center lets you create a new terminal services session, or 
connect to an existing terminal services session.

You select the number of terminals to be used in your load test (provided 
that you have sufficient terminal sessions running), and the maximum 
number of Vusers that can be run per terminal. The maximum number of 
Vusers depends on the Vuser type used in the script. For GUI Vusers, the 
maximum is 1 Vuser for each terminal session. Performance Center then 
evenly distributes the number of Vusers among the client sessions.

Note: For terminal sessions troubleshooting information, see Chapter 50, 
“Troubleshooting Terminal Sessions.”
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Overview of Setting up Terminal Sessions in Performance 
Center
The number of terminal services is limited, according to the terminal server 
installation, and client configuration as described below. 

Before opening a terminal session:

➤ Install a load generator host on the terminal server machine. For details, see 
the HP Performance Center System Configuration and Installation Guide

Note: You cannot use terminal sessions on UNIX load generators.

➤ Ensure that the Remote Desktop Connection client software is installed on 
the Controller machine. 

If you are running a terminal client session on a Windows Server 2003 or 
Windows XP SP2 machine, make sure that the Performance Center user has 
Create Global Object privileges. Add the Performance Center Administrators 
group (or group the Performance Center user belongs to) to the Create 
Global Object privilege under Local Security Policies\Users Rights on the 
terminal server machine.

To create a new terminal session: 

 1 Configure the Performance Center Agent on the load generator machine. 
See “Setting up the Performance Center Agent on the Load Generator” on 
page 234.

 2 Check that the correct terminal services logon settings are configured in the 
Remote Desktop Connection client software on the Controller machine. 
See “Configuring Terminal Services Logon Settings” on page 235.

 3 Configure terminal sessions from the Controller machine, as described in 
“Configuring Terminal Sessions” on page 238.

To connect to an existing terminal session:

 1 Configure the Performance Center Agent on the load generator machine. 
See “Setting up the Performance Center Agent on the Load Generator” on 
page 234.
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 2 Launch a terminal client session on the Controller machine, ensuring that 
the Performance Center Agent is running as a process, as described in 
“Launching a Terminal Client Session” on page 236.

 3 Configure terminal sessions from the Controller machine, as described in 
“Configuring Terminal Sessions” on page 238.

Setting up the Performance Center Agent on the Load 
Generator

This section decribes how to configure the Performance Center Agent on the 
machine where the load generator machine.

To set up the Performance Center Agent on the load generator machine:

 1 Select Start > Programs > HP Performance Center > Advanced Settings > 
Agent Configuration. The Agent Configuration dialog box opens.

 2 Select Enable Terminal Services and click OK. Performance Center displays 
the following message.

 3 Click OK to restart the Performance Center Agent and apply the new 
settings.
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Configuring Terminal Services Logon Settings

If you are creating a new terminal services session, you must check that 
Remote Desktop Connection client software is installed on the Controller 
machine, and the correct terminal services logon settings are selected. For 
load generators on Windows 2003 operating systems, you must make sure 
that each user is not restricted to one session.

For computers running Microsoft Windows XP or Windows Server 2003, the 
Terminal Services client program (Remote Desktop Connection) is already 
installed. Remote Desktop Connection can also be installed on other 32-bit 
Windows-based operating systems.

To configure the correct Terminal Server logon settings:

 1 Select Start > Programs > Administrative Tools > Terminal Services 
Configuration > RDP-TCP. Right-click RDP-TCP, and select Properties to 
open the RDP-TCP Properties dialog box.

 2 In the RDP-TCP Properties dialog box, click the Logon Settings tab.

 3 Make sure that Use client-provided logon settings is selected and Always 
prompt for password is not selected.



Chapter 15 • Using Terminal Sessions

236

To configure load generators on Windows 2003 operating systems:

 1 Select Start > Programs > Administrative Tools > Terminal Services 
Configuration > Server Settings.

 2 In the Server Settings, make sure that the Restrict each user to one session 
attribute is No.

Launching a Terminal Client Session

If you are connecting to an existing Terminal Services session, you need to 
open a Terminal Client session, log in to the session, and run the 
Performance Center Agent as a process. 

To open a Terminal Client session on the Controller machine:

 1 Select Start > Programs > Accessories > Communcation > Remote Desktop 
Connection, or select Start > Run and run the mstsc command. The Remote 
Desktop Connection dialog box opens.

 2 Click Options.
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 3 In the General tab:

 a In the Computer box, type the name or IP address of a terminal server, or 
select a terminal server from the list of available servers.

 b Enter your user name, password, and domain name (if required) for 
logging in to the terminal server.

 4 Click Connect. A Terminal Client window opens.

 5 Repeat step 3 to open the number of Terminal Client sessions required.

Note: You must open a Terminal Client session for each terminal that you 
want to run Vusers on during the load test.
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➤ Run the Performance Center Agent as a process. To do this, run 
<Performance Center installation>\launch_service\bin\magentproc.exe. 
You need to run the Performance Center Agent as a process for each 
terminal session that you are running.

Configuring Terminal Sessions

After you have set up the Performance Center Agent on the load generator 
machine and opened a terminal client session on the Controller machine, 
you can configure terminal sessions. You configure terminal sessions from 
the User Site during load test configuration using the Terminal Services 
Manager.

Note: 

➤ You can enable Terminal Services sessions when configuring load tests 
with manual load generator distribution only. 

➤ The Terminal Services Manager does not support Terminal Services 
sessions over a firewall. To configure Terminal Services sessions over a 
firewall, see “Configuring Terminal Sessions Over A Firewall” on 
page 240.
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To configure terminal sessions:

 1 On the Load Test configuration page, click the Workload tab.

 2 For a selected group, click the Select Load Generators/Select Virtual 
Generators link. The Load Generators (Actual)/Virtual Load Generators 
dialog box opens.

 3 Select the load generator on which you want to open terminal session, and 
click the Terminal Services button. The Terminal Services Manager opens.

 4 Select Enable Terminal Sessions to apply the settings to the load generator 
running on the terminal server. 
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 5 Type the number of terminals you want to use in your load test. You must 
open a terminal client session for each terminal on which you want to run 
Vusers during the load test.

 6 Type the maximum number of Vusers that you want to run in a terminal 
session. The maximum number of Vusers depends on the Vuser type used in 
the script. For GUI Vusers, the maximum is one Vuser for each terminal 
session.

 7 Select one of the following connection options:

➤ Create new Terminal Services sessions. Enables the Controller to launch 
Terminal Services sessions automatically using the Remote Desktop 
Connection.

➤ Connect to existing Terminal Services session. Enables a connection to 
an existing Terminal Services session. For more information on opening 
and logging in to a terminal client session, see “Launching a Terminal 
Client Session” on page 236.

 8 Click OK to save the settings and close the dialog box. Performance Center 
distributes the number of Vusers evenly among the client sessions.

Note: 

➤ During run time, you can set or change terminal services settings only 
when the load generator is disconnected. You can do this from the Load 
Generators (Virtual/Actual) dialog box, or the Workload tab.

➤ If your environment is configured with a local user (from the General 
Settings page of the Administration Site), you cannot set terminal 
services for a machine name that was added as an IP address or a domain 
name (for example, 127.0.0.1, localhost.mydomain.com).

Configuring Terminal Sessions Over A Firewall
When a load generator is located over a firewall, to configure terminal 
sessions on that load generator, you need to configure terminal sessions as 
virtual, independent virtual load generators. Each virtual load generator 
must have its own logical name.
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To configure terminal sessions as independent load generators over a 
firewall: 

 1 Open the load generator machine console. 

 2 If the Performance Center Agent is not running as a process, run 
<Performance Center installation>\launch_service\bin\magentproc.exe.

 3 Configure the Performance Center Agent on the console.

 a Select Enable Firewall Agent, click Settings, and in the Local Machine 
Key field, enter a logical virtual load generator name, for example 
machine_ofw.

 b Select Enable Terminal Services.

 c Click OK.

 4 Create one or more terminal sessions on the load generator console 
machine. 

 5 For each terminal session, run the Agent Configuration as you did for the 
console above. For each session, specify a different Local Machine Key name 
in the Firewall Agent > Settings box, for example, machine_ofw_1, 
machine_ofw_2, ..., machine_ofw_n.
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Note: If you stop the agent on a terminal session, you must reconfigure the 
settings for that particular terminal session before restarting the agent.

 6 When selecting the load generators for the load test in the Controller, select 
the local machine key for each individual virtual load generator used.
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16
Using Rendezvous Points

Performance Center allows you to check your system's response under 
specific load. To do this, you can use rendezvous points to cause multiple 
Vusers to perform tasks at exactly the same time, thereby creating intense 
user load on the server.

This chapter includes:

 ➤  About Using Rendezvous Points on page 243

 ➤  Setting the Rendezvous Attributes on page 246

 ➤  Setting the Rendezvous Policy on page 247

 ➤  Viewing Rendezvous Information on page 249

 ➤  Manually Releasing Vusers from a Rendezvous on page 251

About Using Rendezvous Points

During a load test run you can instruct multiple Vusers to perform tasks 
simultaneously by using rendezvous points. A rendezvous point creates 
intense user load on the server and enables Performance Center to measure 
server performance under load. 

Suppose you want to measure how a web-based banking system performs 
when ten Vusers simultaneously check account information. In order to 
emulate the required user load on the server, you instruct all the Vusers to 
check account information at exactly the same time. 
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You make sure that multiple Vusers act simultaneously by creating a 
rendezvous point. When a Vuser arrives at a rendezvous point, it is held 
there by the Controller. The Controller releases the Vusers from the 
rendezvous either when the required number of Vusers arrives, or when a 
specified amount of time has passed. For details on the release criteria, see 
“Setting the Rendezvous Policy” on page 247.

You define rendezvous points in the Vuser script. For information about 
inserting rendezvous points into Vuser scripts, see the HP Virtual User 
Generator User Guide.

Using the Controller, you can influence the level of server load by selecting 
which of the rendezvous points will be active during the load test, and how 
the Vusers handle a rendezvous point.

For example, to test an online bank, you could create a load test that 
contains two rendezvous points. The first rendezvous ensures that one 
thousand Vusers simultaneously deposit cash. The second rendezvous 
ensures that another thousand Vusers simultaneously withdraw cash. To 
measure how the server performs when only five hundred Vusers deposit 
cash, you can set the release policy so that the Vusers are released when 500 
Vusers arrive at the rendezvous.
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Overview of Using Rendezvous Points
The following procedures outline how to use rendezvous points to control 
load peaks on the server:

 1 Create the Vuser scripts, inserting the necessary rendezvous points.

 2 Create a load test.

When you add a Vuser group to a load test, Performance Center scans the 
group’s associated script for the names of the rendezvous points and adds 
them to the list on the Rendezvous page. If you create another Vuser group 
that runs the same script, the Controller adds the new Vusers to the 
rendezvous and updates the list.

 3 Set the level of emulated user load. 

You determine the level of load by selecting the rendezvous points that will 
take part in the load test. For more information, see “Setting the Rendezvous 
Attributes” on page 246.

 4 Set the attributes for the rendezvous (optional). 

For each rendezvous you can set Policy attributes. For more information, see 
“Setting the Rendezvous Policy” on page 247.

 5 Run the load test. 

For information on manipulating the Vusers during load test execution 
using the Release command, see “Manually Releasing Vusers from a 
Rendezvous” on page 251.
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Setting the Rendezvous Attributes

You enable and disable Rendezvous Points from the Rendezvous page. By 
disabling and enabling a rendezvous, you influence the level of server load. 
In addition, the Rendezvous page displays general information about the 
rendezvous point: which script is associated with the rendezvous, and the 
rendezvous status.

To enable rendezvous points to take part in the load test:

 1 On the Load Test configuration page, click the Workload tab, and click the 
Rendezvous button. 

The Rendezvous dialog box opens.

 2 Select the rendezvous points you want to enable or disable from the 
Rendezvous list. Use the forward and back buttons to scroll through the list 
of rendezvous points.
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 3 Click the Enable/Disable button. The selected rendezvous points become 
enabled/disabled.

To select all the rendezvous points, click Select All. To clear all your 
selections, click Clear All.

 4 Click Close to close the Rendezvous page.

Setting the Rendezvous Policy

Setting the rendezvous policy determines how the Vusers handle a 
rendezvous point. You set the following policy attributes for each 
rendezvous:

➤ Release policy. Sets how many Vusers are released from a rendezvous at a 
time

➤ Timeout. How long the Controller waits before releasing Vusers from a 
rendezvous

To set the rendezvous policy attributes:

 1 On the Load Test configuration page, click the Workload tab, and click the 
Rendezvous button. The Rendezvous page opens.

 2 Select a rendezvous from the Rendezvous page, and click the Rendezvous 
Policy button. The Rendezvous Policy page opens.
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 3 In the Policy section, select one of the following three options:

➤ Release when X% of all Vusers arrive at the rendezvous. Releases the 
Vusers only when the specified percentage of all Vusers arrives at the 
rendezvous point.

Note: This option interferes with the scheduling of your load test. If you 
select this option, therefore, your load test will not run as scheduled.

➤ Release when X% of all running Vusers arrive at the rendezvous. Releases 
the Vusers only when the specified percentage of all Vusers running in 
the load test arrives at the rendezvous point.

➤ Release when X Vusers arrive at the rendezvous. Releases the Vusers only 
when the specified number arrives at the rendezvous point.

 4 Type a timeout value in the Timeout between Vusers box. After each Vuser 
arrives at the rendezvous point, Performance Center waits up to the 
maximum timeout period you set for the next Vuser to arrive. If the next 
Vuser does not arrive within the timeout period, the Controller releases all 
the Vusers from the rendezvous. 

Each time a new Vuser arrives, the timer is reset to zero. The default timeout 
is 30 seconds.

 5 Click OK to save your settings and close the Rendezvous Policy page.
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Viewing Rendezvous Information

You can view rendezvous status during a load test from the Rendezvous 
dialog box.

To view rendezvous information:

 1 On the Load Test Run page, click the Design button. The Load Test Design 
dialog box opens.

 2 Click Rendezvous. The Rendezvous dialog box opens.
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The following information is provided during load test execution:

To enable rendezvous points:

➤ Select the rendezvous points you want to participate in the load test, and 
click the Enable button.

➤ To select all the rendezvous points, click Select All. To clear all your 
selections, click Clear All.

To disable rendezvous points:

➤ Select the rendezvous points you want to disable from participating in the 
load test, and click the Disable button.

To release all Vusers waiting at selected rendezvous points:

➤ Select the rendezvous points from which you want to release all Vusers that 
are currently waiting, and click Release. Performance Center releases all 
Vusers that are currently waiting at the selected rendezvous point. 

If you want the load test to continue even though all the Vusers did not 
reach the rendezvous, click this button.

To view the rendezvous policy:

➤ Click the Rendezvous Policy button to view the rendezvous policy. You 
cannot change the rendezvous policy during a load test run.

Field Description

Rendezvous Name Displays the names of the rendezvous points in the load 
test.

Status Displays the number of Vusers that arrived at the 
rendezvous point, out of the total number of Vusers 
assigned to the rendezvous.

Vuser Script Name Lists the number of scripts in which the rendezvous point 
is defined. Drill down to view the names of Vuser scripts 
that are associated with the rendezvous point.
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Manually Releasing Vusers from a Rendezvous 

While you run a load test, you can manually release Vusers from a 
rendezvous before the Controller releases them. 

To manually release Vusers from a rendezvous: 

 1 On the Load Test Run page, click the Design button. The Load Test Design 
dialog box opens.

 2 Click Rendezvous. The Rendezvous dialog box opens.

 3 Select a rendezvous from the Rendezvous list.

 4 Click Release. The Vusers in the rendezvous are released.
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17
WAN Emulation

You can enable and configure the WAN Emulator from the Workload tab of 
the Load Test configuration page.

This chapter includes:

 ➤  About WAN Emulation on page 254

 ➤  Configuring the WAN Emulator on page 256

 ➤  Emulated Locations on page 259

 ➤  Viewing WAN Emulation Monitors on page 261

 ➤  Excluding Machines from WAN Emulation on page 261

 ➤  Additional WAN Emulation Limitations on page 262

 ➤  WAN Emulation Best Practices on page 263
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About WAN Emulation

HP Performance Center is integrated with 3rd party software that enables 
you to accurately test point-to-point performance of WAN-deployed 
products under real-world network conditions. By installing this WAN 
emulation software on your load generator, you can introduce highly 
probable WAN effects such as latency, packet loss, and link settings. As a 
result of this, your load test tests your application in a more realistic 
environment that better represents its actual deployment.

You can create more meaningful results by configuring several load 
generators with the same unique set of WAN effects, and by giving each set a 
unique location name, for example, London. When viewing scenario results 
in Analysis, you can group metrics from different load generators according 
to their location names. For information on grouping metrics according to 
an emulated location name, see the section that deals with applying filter 
and sort criteria to graphs in the HP LoadRunner Analysis User Guide.

Overview of the WAN Emulation Process
To run a load test using WAN Emulation, you follow the process below:

 1 Install the WAN Emulator

Make sure that the relevant 3rd party components are installed on the load 
generator machines. 

Note that in addition to the load generators, you may be required to install 
the WAN Emulator on additional LoadRunner components. For more 
information, see the relevant WAN emulation software installation 
documentation.

 2 Determine WAN Emulation Goals

In the WAN Emulation Settings page, determine which locations you would 
like to emulate in your load test.
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 3 Configure the WAN Emulation

Configure the WAN Emulation on the desired load generators via the WAN 
Emulation Settings dialog box, which is a component of the integrated 3rd 
party software. If several load generators are being configured to emulate a 
specific location, make sure that each load generator is configured with the 
same settings. For more information see, “Configuring the WAN Emulator” 
on page 256.

 4 Run the WAN Emulation

The WAN Emulation starts and stops automatically as you start and stop the 
load test. WAN metrics are automatically collected during the load test.

 5 View the WAN Metrics

You can view all WAN metrics in the Windows Resources monitor, as well as 
in Analysis using all of the available analysis tools, including the option to 
group metrics by emulated location, and to correlate data such as response 
time with WAN metrics. For information on grouping results in Analysis, see 
the relevant section in the HP LoadRunner Analysis User Guide.
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Configuring the WAN Emulator

You enable and configure the WAN Emulator from the Workload tab of the 
Load Test configuration page.

To configure the WAN Emulator:

 1 In the Workload tab, click the WAN Emulation Setting button. The WAN 
Emulation Settings page opens.

The WAN Emulation Settings page displays a list of the load generators 
assigned to the load test, and the WAN Emulation status for each one.

You change the settings for any selected load generator in the 
<load generator name> WAN Emulation settings pane.

Note: For important information about running the WAN Emulation on 
load generators that run on a UNIX platform, and on a load generator that is 
also the Controller, see “Load Generator Limitations” on page 258.
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 2 Select the load generator in the list and select Enable WAN Emulation in the 
<load generator name> WAN Emulation settings pane at the bottom of the 
WAN Emulation Settings page. 

 3 In the Emulated location name box, type a location for the load generator. 
For more information on emulated locations see “Emulated Locations” on 
page 259.

 4 Click WAN Emulation Settings to open the WAN Emulation Settings dialog 
box. 

➤ For information on some of the typical network emulation settings, see 
“Typical Network Emulation Settings” on page 259.

➤ For detailed information on configuring the WAN Emulation settings via 
the 3rd party software components, see the relevant WAN emulation 
software documentation.

Note: To undo changes made in the WAN Emulation Settings dialog box, 
click Restore.

 5 Click Save. The WAN Emulation status for the load generator you selected 
changes to Enabled, and if you entered an Emulated location, it appears 
under Emulated Location.
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Load Generator Limitations
When configuring the WAN Emulator, you must be aware of the following 
load generator limitations:

Load generator running on a UNIX platform

➤ WAN emulation software integration may not be available on the UNIX 
platform. In this case, the following limitations apply:

➤ If you selected one of the manual load generator distribution methods 
for your load test, then the option of running a WAN Emulation on the 
load generator will be disabled.

➤ If you selected one of the automatic load generator distribution methods, 
then the load test will return an error message upon commencement.

Load generator that is also the Controller

➤ If you selected one of the manual load generator distribution methods for 
your load test, then the option of running a WAN Emulation on the load 
generator will be disabled.

➤ If you selected one of the automatic load generator distribution methods, 
then we recommend that you disable the option of running Vusers on the 
Controller for the project. Otherwise, an error message appears when the 
load test starts. For more information, see “Running Vusers on the 
Controller Machine” on page 102.

Removing Load Generators from the Load Test

➤ If you remove a load generator using one of the automatic load generator 
distribution methods, then the most recently added load generator is 
removed, and any WAN Emulation settings configured on it will not apply 
to the load test. 

➤ If you remove a load generator using one of the manual load generator 
distribution methods, and subsequently re-add the load generator to the 
load test, then any WAN Emulation settings that were defined on that load 
generator will be lost. To run WAN Emulation on that load generator, you 
must define the relevant settings again.
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Typical Network Emulation Settings
The WAN Emulator allows you to emulate probable WAn effects over your 
network, thereby creating a more realistic scenario. The most typical effects 
which you can configure are:

Latency

The Latency value you define represents the time, in milliseconds, that it 
takes an IP packet to cross the WAN. This is usually effected by geographical 
distance, the available bandwidth, the network load on the route between 
the two ends, and whether this is a terrestrial link or not.

Packet Loss

The Packet Loss value you define represents the chance of losing IP packets 
while data travels through a WAN. Packets can get lost due to link faults or 
due to extreme network load.

Bandwidth

The Bandwidth value you define represents your network’s capacity to 
transfer data over the WAN.

Emulated Locations

To receive more meaningful results, you can configure groups of load 
generators to emulate conditions unique to specific geographic locations. 
For example, London and New York.

To view the results for each group of load generators individually in 
Analysis, you can group the results of the load test by the emulated location 
name. In other words, for any graph in Analysis, all the results of the ’New 
York based’ load generators can be grouped together, as can all the results of 
the ’London based’ load generators, and so on.
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For example, in the image below, you can group metrics according to load 
generators that were defined with the LA-NY location, as well as load 
generators where no WAN Emulation was defined. 

Note: In cases where you have to configure more than one load generator 
per location, make sure that each load generator designated for a specific 
location is configured with the same settings.

For information on grouping Analysis graph data by emulated location 
name, see the section that deals with applying filter and sort criteria to 
graphs in the HP Analysis User Guide.

For information about viewing Analysis results in Performance Center, see 
Chapter 26, “Analyzing a Load Test.”
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Viewing WAN Emulation Monitors

The WAN Emulation starts and stops automatically as you start and stop the 
load test. WAN Emulation monitors are assigned automatically when the 
load test run starts and WAN metrics are automatically collected during the 
load test run. You can view the WAN metrics during the scenario run in the 
Windows Resources monitor. 

If a load generator is connected over a firewall, you must add the monitors 
manually using the Monitor Over Firewall component. For more 
information, see Chapter 21, “Configuring Monitors Over a Firewall.” 

Excluding Machines from WAN Emulation

In some situations you may want to exclude certain machines from the 
WAN Emulation. You can do this by setting the WAN Emulator to refrain 
from affecting traffic from a load generator to specified machines, for 
example, a software update server. Network traffic which is not affected by 
the emulation will not suffer any WAN effects and will not be included in 
the WAN Emulation results.

Machines are excluded by one of the following methods: 

➤ Default. The following machines are always excluded by default: The 
Controller machine or the MI Listener and proxy server, the Diagnostics 
Commander server, and the SiteScope server (configured to monitor 
Performance Center servers and hosts).

Note: The Diagnostics server IP only appears as excluded if the load test is 
integrated with HP Diagnostics.
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➤ Global. You can set specific machines to always be excluded. That is, so long 
as they remain excluded, they will never suffer any effects of the WAN 
Emulation, irrespective of which load generator they are connected to. You 
define this in the General Settings page of the Performance Center 
Administrator Site. For more information, see the section that deals with 
configuring general settings in the HP Performance Center Administrator 
Guide.

Note: The number of machines that may excluded any one time, including 
those that are excluded by default, might be limited by the WAN emulation 
software.

Reasons to Exclude Machines

Examples of situations where you should exclude machines from an 
emulated WAN include: 

➤ In a Multiprotocol load test that includes a Web server and a database server; 
where information from the database server is not required as a part of the 
load test. In such a case, you would exclude the database server.

➤ You may want to exclude all deployment and software upgrade servers.

➤ Where the Controller is running or monitoring Vusers over a firewall using 
the HTTPS configuration. The IP address of the proxy server should be 
excluded.

Additional WAN Emulation Limitations

The following are known limitations for WAN Emulation:

➤ Selecting either Use bandwidth, or Use custom bandwidth in the Network: 
Speed Simulation node in the Run Time Settings, may interfere with the 
WAN Emulation settings and could lead to unexpected behavior. For more 
information on Run Time Settings, see “Configuring Run-Time Settings” on 
page 187.
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➤ The integrated WAN emulation software might not comply with accepted 
Internationalization (I18N) conventions. 

➤ The WAN Emulation software may consume large amounts of memory, 
since the technology delays traffic and captures traffic for later analysis. To 
verify that the load generator machine has sufficient memory, compare the 
load generator memory consumption with and without the emulation.

WAN Emulation Best Practices

We recommend the following when running a load test with WAN 
Emulation:

➤ Once the load test has started, check that WAN Emulation is running in one 
of the following ways:

➤ Check for a confirmation message in the notification messages of the 
Output window. The message should contain the following text:

➤ Ping the load generator from your machine and check that the latency 
and packet loss behavior is as defined. Your machine must not be 
excluded from WAN Emulation to do this.

➤ If you kill the LR_Bridge.exe or magentproc.exe processes on a load 
generator to stop a load test, manually stop the WAN Emulation as well.

WAN Emulation started on host <host name> with the following configuration <config>
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18 
Using Functional Testing Scripts in 
Performance Center

Using Performance Center you can test and monitor how your application’s 
functionality is affected by heavy load. Performance Center can integrate 
functional testing scripts in the form of GUI Vuser scripts into a load test. 
These GUI Vuser scripts are created using HP’s functional testing software, 
HP QuickTest Professional or HP WinRunner. 

This chapter includes:

 ➤  About Using Functional Testing Scripts in  Performance Center on page 266

 ➤  Introducing GUI Vuser Scripts on page 267

 ➤  Using QuickTest to Create GUI Vuser Scripts for  Performance Center 
on page 269

 ➤  Using WinRunner to Create GUI Vuser Scripts for  Performance Center 
on page 271

 ➤  Running GUI Vuser Scripts in a Performance Center Load Test on page 278
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About Using Functional Testing Scripts in 
Performance Center

HP QuickTest, HP’s functional testing software, enables you to create 
complex tests that examine the full spectrum of your application’s 
functionality.

Performance Center can integrate these QuickTest scripts into a load test in 
the form of GUI Vuser scripts. These scripts, which have already been 
designed and debugged in QuickTest, can be used as the basis of your load 
test.

The main advantages of running functional testing scripts in Performance 
Center are:

➤ To check how your application’s functionality is affected by heavy load

➤ To measure the response time that a typical user experiences on the 
client side while your application is under load (end-to-end response 
time)

For example, you can add QuickTest or WinRunner test scripts to specific 
points in a Performance Center load test to confirm that the application’s 
functionality is not affected by the extra load at those sensitive points.

Another advantage of using a GUI Vuser script as part of your Performance 
Center load test is that the GUI Vuser script runs on your screen during the 
load test, enabling you to watch the actual steps executed by the Vuser in 
real time.
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Introducing GUI Vuser Scripts

GUI Vusers enable you to measure and monitor end-to-end user response 
times while your client/server system is under load. A GUI Vuser emulates 
the complete environment of a human user. 

For example, a human user sits at a machine, operates applications using the 
keyboard and the mouse, and reads information on the machine’s monitor. 
Similarly, a GUI Vuser runs on its own machine and operates applications. A 
GUI Vuser can be programmed to read and act on information that appears 
on its machine’s display. 

Suppose that you have a bank server that services many automatic teller 
machines (ATMs). You could create a GUI Vuser script that:

➤ opens the ATM application

➤ enters an account number

➤ enters the amount of cash to be withdrawn

➤ withdraws cash from the account

➤ checks the balance of the account

➤ closes the ATM application

➤ repeats the process

The actions of each GUI Vuser are described in a GUI Vuser script. You use 
QuickTest and WinRunner to create GUI Vuser scripts. 

You monitor and manage GUI Vusers from the Performance Center User 
site. For instance, you can run, pause, or view Vusers, and monitor the load 
test status.

Note: You cannot use VuGen to run a GUI Vuser script. In the User site, you 
run a GUI Vuser script as part of a load test; you use WinRunner or 
QuickTest to run a GUI Vuser script in standalone mode.
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Understanding GUI Vuser Technology
GUI Vusers measure real end-to-end response times. End-to-end response 
times represent the total time that a user waits for a response after 
submitting a request. End-to-end response times include GUI response times 
as well as network and server response times.
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Using QuickTest to Create GUI Vuser Scripts for 
Performance Center

When creating test scripts in QuickTest that are going to be used as GUI 
Vuser scripts in a Performance Center load test, you need to follow certain 
guidelines to ensure smooth integration of the script. For detailed 
explanations about creating tests in QuickTest see the QuickTest 
documentation.

This section describes the following general guidelines:

➤ Limitations

➤ Including Transactions

➤ Adding Statements

➤ Designing Tests for Performance Center

Limitations
QuickTest offers several features that are designed specifically for integration 
with Performance Center. Some QuickTest features, however, may not be 
available when they are integrated with Performance Center. For more 
information about specific limitations, see the QuickTest readme.

Including Transactions
To measure the performance of the server, you define transactions. A 
transaction represents an action or a set of actions that you are interested in 
measuring. You define transactions within your Vuser script by enclosing 
the appropriate sections of the script with start and end transaction 
statements. 
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For example, you can define a transaction that measures the time it takes for 
the server to process a request to view the balance of an account and for the 
information to be displayed at the ATM.

Note: Performance Center only provides performance information for data 
that is included within a transaction. Therefore, your QuickTest test must 
include transactions to be used by Performance Center. 

For more information about defining trasnactions in your QuickTest script, 
see the QuickTest documentation.

Adding Statements
You can use the Services object and its associated methods to insert 
statements that are specifically relevant to performance testing. These 
include Abort, GetEnvironmentAttribute, LogMessage, 
SetTransactionStatus, ThinkTime, UserDataPoint, StartTransaction and 
EndTransaction. For more information on these methods, see the QuickTest 
documentation.

Designing Tests for Performance Center
Consider the following design guidelines when designing tests for use with 
Performance Center:

➤ The QuickTest tests you use with Performance Center should be simple tests, 
designed to pinpoint specific operations.

➤ Performance Center cannot run nested action iterations.

➤ Do not include references to external actions or other external resources, 
such as an external Data Table file, environment variable file, shared object 
repositories, and so forth.

➤ Include transactions in your QuickTest test because Performance Center 
only provides performance information for data that is included within a 
transaction.
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Using WinRunner to Create GUI Vuser Scripts for 
Performance Center

This section outlines how to use WinRunner to create and enhance GUI 
Vuser scripts that are going to be used in a Performance Center load test. For 
detailed explanations about creating tests in WinRunner, see the 
WinRunner documentation. 

Note: Some WinRunner features may not be available when they are 
integrated with Performance Center.

This section includes: 

➤ “Understanding GUI Vuser Scripts” on page 272

➤ “Inserting Transactions and Rendezvous Points” on page 274

➤ “Using Vuser Functions in GUI Vuser Scripts” on page 275

➤ “Sending Messages to the Controller” on page 276

➤ “Obtaining Information about Vusers and Load Generators” on page 277
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Understanding GUI Vuser Scripts
WinRunner is a complete development environment for creating, editing, 
and debugging Windows-based GUI Vuser scripts. Using WinRunner, you 
record the actions of a human user on an application. 

For example, you could record a user entering an account number into an 
ATM and then withdrawing fifty dollars. These actions are automatically 
transcribed into a script in HP’s Test Script Language (TSL).

GUI Vuser scripts are written in TSL—HP’s Test Script Language. TSL is a 
high-level C-like programming language. It combines the power and 
flexibility of a conventional programming language with functions designed 
specifically for testing. For additional information about TSL, see the TSL 
Online Reference (available from the WinRunner Help menu)

This section presents a basic Vuser script, created in WinRunner. The script 
starts an ATM application (mratm.exe), enters an account number, deposits 
fifty dollars, and then closes the application. 

Note: This script will not work on a Unix machine. 

The first section of the script starts an application and moves it to a new 
location on the screen. The system function starts the ATM application. The 
win_move function moves the ATM application to a specified location on 
the screen.

# Initialize and invoke ATM client application.
invoke_application("c:\mratm.exe","","",SW_SHOWMINIMIZED);
win_move ("Mercury ATM", 325, 0);
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Next, the Vuser enters an account number into the ATM. The set_window 
function activates the ATM window. The edit_set function instructs the 
Vuser to enter the account number into the ATM’s account field.

After entering the account number, the Vuser enters the amount it wants to 
deposit and presses the deposit button. The edit_set function enters the 
amount to be deposited in the amount field. The button_press function tells 
the Vuser to press the ATM’s Deposit button. 

The final section of the test tells the Vuser to close the ATM application. The 
menu_select_item function selects the Exit command from the File menu.

# Type in account number in the Account field.
account = 100;
set_window ("Mercury ATM");
edit_set ("Account", account);

# Enter the amount to be deposited in the amount field.
amount = 50;
set_window ("Mercury ATM");
edit_set ("Amount", amount);
# Press the Deposit button.
button_press ("Deposit");

# Close client application.
menu_select_item ("File; Exit");
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Inserting Transactions and Rendezvous Points
To measure the performance of the server, you define transactions. A 
transaction represents an action or a set of actions that you are interested in 
measuring. You define transactions within your Vuser script by enclosing 
the appropriate sections of the script with start and end transaction 
statements. For example, you can define a transaction that measures the 
time it takes for the server to process a request to view the balance of an 
account and for the information to be displayed at the ATM. 

Note: Performance Center only provides performance information for data 
that is included within a transaction. Therefore, your WinRunner test must 
include transactions to be used by Performance Center.

You insert rendezvous points into Vuser scripts to emulate heavy user load 
on the server. Rendezvous points instruct Vusers to wait during test 
execution for multiple Vusers to arrive at a certain point, so that they may 
simultaneously perform a task. For example, to emulate peak load on the 
bank server, you can insert a rendezvous point instructing 100 Vusers to 
deposit cash into their accounts at the same time. 

After recording a basic Vuser script using WinRunner, you manually insert:

➤ Transaction statements into the script to measure the performance of the 
server

➤ Rendezvous statements into the script to emulate a specific user load

To mark the start of a transaction:

➤ Insert a start_transaction statement into the Vuser script. 

To mark the end of a transaction:

➤ Insert an end_transaction statement into the Vuser script. For the syntax of 
the start_transaction and end_transaction functions, see the TSL Online 
Reference (available from the WinRunner Help menu).



Chapter 18 • Using Functional Testing Scripts in  Performance Center

275

To insert a rendezvous point:

➤ Insert a rendezvous statement into the Vuser script. For the syntax of the 
rendezvous function, see the TSL Online Reference (available from the 
WinRunner Help menu).

Using Vuser Functions in GUI Vuser Scripts
This section lists the Vuser functions that you can use to enhance your GUI 
Vuser scripts. For syntax and examples of the functions, see the sections that 
follow or the TSL Online Reference (available from the WinRunner Help 
menu). 

Function Description

declare_rendezvous Declares a rendezvous.

declare_transaction Declares a transaction.

end_transaction Marks the end of a transaction for performance 
analysis.

error_message Sends an error message to the Controller.

get_host_name Returns the name of a load generator.

get_master_host_name Returns the name of the Controller load generator.

lr_whoami Returns information about the Vuser executing the 
script.

output_message Sends a message to the Controller.

rendezvous Sets a rendezvous point in a Vuser script.

start_transaction Marks the beginning of a transaction for 
performance analysis.

user_data_point Records a user-defined data sample.
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Sending Messages to the Controller
When you run a load test, the User Site’s Output window displays valuable 
information about script execution. In addition to the messages 
automatically sent by WinRunner, you can include statements in each script 
that send error and notification messages to the User Site. For example, you 
could insert a message that displays the current state of an application. After 
load test execution, you can save these messages to a file. 

The error_message function sends an error message to the User Site’s 
Output window. The syntax of this function is:

where message is a text string. 

In the following example, the Vuser script sends a message when a fatal 
error occurs during script execution. 

The output_message function is used to send a special notification that is 
not an error message. The syntax of this function is:

where message is a text string.

For further information on the error_message and the output_message 
functions, see the TSL Online Reference (available from the WinRunner Help 
menu).

error_message (message);

if (fatal_error < 0){
mess="fatal error - Exiting.";
error_message (mess);
texit (1);

}

output_message (message);
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Obtaining Information about Vusers and Load Generators
During load test execution, you can obtain the identity of:

➤ the Vusers performing a task at a particular moment in the load test

➤ the load generator executing a script

➤ the Contorller host machine

For example, you could program statements into a Vuser script to return the 
ID of each active Vuser currently using an application, and print this 
information to a file.

The following functions obtain information about Vusers and load 
generators:

In the following example, the get_host_name function returns the name of 
the load generator currently running the script. The print statement saves 
the information to a file.

For more information about these functions, see the TSL Online Reference 
(available from the WinRunner Help menu). 

After recording a basic Vuser script, you insert statements into the script that 
measure the performance of the server (transactions), and create a 
synchronized user load (rendezvous points). For more details about GUI 
Vusers, see your HP LoadRunner Online Function Reference.

Function Description

lr_whoami Returns the name of a Vuser and the Vuser group it 
belongs to

get_host_name Returns the name of the machine executing the 
script

get_master_host_name Returns the name of the Controller host machine

my_host_name = get_host_name();
print("my local load generator name is:" & my_host_name) > vuser_file;
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Running GUI Vuser Scripts in a Performance Center Load 
Test

After you have created your GUI Vuser script in QuickTest or WinRunner, 
you are ready to integrate the script into a Performance Center load test 
Before you run the Performance Center load test you should consider the 
following guidelines:

➤ You can run only one GUI Vuser concurrently per machine.

➤ Ensure that QuickTest and WinRunner are closed before running the load 
test.

➤ In the script’s Run-Time Settings dialog box, only the General categories and 
sub-categories (Run Logic, Pacing, Miscellaneous, Think Time) are relevant 
for QuickTest and WinRunner tests. 

To add a GUI Vuser script to a Performance Center load test:

 1 Navigate to the Workload tab of the load test.

 2 If the script is not selected for the load test, click Click to add new script and 
select it from the list of scripts.
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19
Setting Project Options

You can configure how load generators and Vusers behave when you run a 
load test so that the load test accurately emulates your working 
environment.

This chapter includes:

 ➤  About Project Options on page 280

 ➤  Setting Monitor Options on page 281

 ➤  Configuring Load Test Run-Time Settings on page 284

 ➤  Setting Timeout Intervals on page 286

 ➤  Setting Debug Information Options on page 288

 ➤  Setting General Options on page 290
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About Project Options

Before you run a load test, you can configure load generator and Vuser 
options for all your load test projects from the Options pages. Although the 
default settings correspond to most environments, Performance Center 
allows you to modify the settings in order to customize the load test 
behavior. The settings apply to all future load test runs in the project and 
generally only need to be set once. The settings apply globally to all the load 
generators in a load test.

To open the Options pages, select Project > Options. You can configure the 
following options in Performance Center from the Options pages.

➤ Monitors. Enables you to activate the Transaction monitor, configure the 
behavior of the transaction data, and set the data sampling rate, debugging, 
and frequency settings.

➤ Run-Time Settings. Enables you to specify values relating to Vuser quotas, 
stopping Vusers, and random sequence seed.

➤ Timeout. Enables you to set the timeout interval for commands and Vuser 
elapsed time.

➤ Debug Information. Enables you to specify the extent of the trace to be 
performed during load test execution.

➤ General. Enables you to specify the multiple IP address mode.

Note: The settings discussed in this chapter are unrelated to the Vuser run-
time settings. These settings, which apply to individual Vusers or scripts, 
contain information about logging, think time, the network, the number of 
iterations, and the browser. For information on setting the run-time 
settings, see the HP Virtual User Generator User Guide.
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Setting Monitor Options

On the Options > Monitors page you can activate the Transaction monitor, 
configure the behavior of the transaction data, and set the data sampling 
rate, debugging, and frequency settings for the online monitors.

To set Monitor options:

 1 Select Project > Options, and click Monitors.

 2 Select Enable Transaction Monitor, specify the frequency at which the 
monitor should send updates to the Controller for the Transaction, Data 
Point, and Web Resource graphs, and set the desired Send option. For more 
information, see “Transaction Data” on page 282. 

 3 Enter a data sampling rate for the server resource monitors. For more 
information, see “Server Resource Monitors” on page 283.

 4 To display debug messages on the Output window, select Display debug 
messages. For the Network monitor, specify a Debug level from 1-9. For 
more information, see “Debug Messages” on page 283.
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 5 Click Save to save your settings. 

To restore Performance Center default settings, click Use Defaults, then click 
Save.

Transaction Data
Configures the behavior of data for the Transaction, Data Point, and Web 
Resource online graphs.

➤ Enable Transaction Monitor. Select this option to activate the online 
Vuser Transaction monitor to begin monitoring transactions at the start 
of a load test.

➤ Frequency. Select the frequency, in seconds, at which the online monitor 
samples the data to produce the Transaction, Data Point, and Web 
Resource online graphs. The data is averaged for the frequency period 
defined, and only one value is sent to the Controller. The default 
frequency is 5 seconds. For a small load test, use a frequency of 1. For a 
large load test, you use a frequency of 3 - 5. The higher the frequency, the 
less network traffic there is. The data is averaged for the frequency period 
defined, and only one value is sent to the Controller. 

Note: You cannot modify these settings during a load test; you must stop 
the load test before deactivating the monitor or changing its frequency.

➤ Send information in mode. Specify how to send data back to the 
Controller.

➤ Summary. Sends a summary of the transaction data back to the 
Controller. 

➤ Raw Data. Sends all the transaction data back to the Controller in raw 
form. Sending raw data saves time because the data does not need to 
be processed. However, since all of the data is being transferred to the 
Controller, it may cause more network traffic. If the transfer speed is 
significant to you, select Summary.
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Server Resource Monitors
Configures the behavior of the Server Resource monitors.

Data Sampling Rate is the period of time (in seconds) between consecutive 
samples. By default, the online monitor samples the data at intervals of 
three seconds. If you increase the sampling rate, the data is monitored less 
frequently. This setting applies to all graphs. To set a sampling rate for a 
specific graph, see “Customizing the Online Monitor View” on page 401.

The sampling rate you set is applied to all server monitors that you 
subsequently activate. It is not applied to server monitors that have already 
been activated. To apply the new sampling rate to activated server monitors, 
save your load test and reopen it. 

Each monitor has a different minimum sampling rate. If the default 
sampling rate, or the rate set on the Options > Monitors page is less than a 
monitor’s minimum sampling rate, the monitor samples data at its 
minimum sampling rate. For example, the minimum sampling rate for the 
Oracle Monitor is 10 seconds. If the sampling rate on the Options > 
Monitors page is set at less than 10 seconds, the Oracle Monitor continues 
to monitor data at 10 second intervals.

Debug Messages
The online monitor provides debugging capabilities. You can display the 
debug messages in the Output window. For the Network monitor, you can 
indicate the debug (detail) level of messages sent to the log, ranging from 
1-9. 
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Configuring Load Test Run-Time Settings

To prevent system overload, and to control the way in which Vusers stop 
running, you can specify load test run-time settings relating to Vuser quotas, 
stopping Vusers, and random sequence seed on the Run-Time Settings page.

To set the load test run-time settings:

 1 Select Project > Options, and click Run-Time Settings.

 2 To set a Vuser quota, specify the desired value. For more information, see 
“Vuser Quotas” on page 285.

 3 Select the way in which you want Performance Center to stop running 
Vusers. For more information, see “Stopping Vusers” on page 285.

 4 To specify a seed value for a random sequence, select Use random sequence 
with seed and type the desired seed value. For more information, see 
“Random Sequence Seed” on page 285.

 5 Click Save to save your settings.

To restore Performance Center default settings, click Use Defaults, then click 
Save.
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Vuser Quotas
To prevent your system from overloading, you can set quotas for Vuser 
activity. The Vuser quotas apply to Vusers on all load generators. You can 
limit the number of Vusers initialized at one time (when you send an 
Initialize command). 

Stopping Vusers
When you click the Stop button, you control the way in which Vusers stop 
running:

➤ Wait for the current iteration to end before stopping. Instructs 
Performance Center to allow a Vuser to complete the iteration it is 
running before stopping. The Vusers move to the Gradual Exiting status 
and exit the load test gradually (Default option).

➤ Wait for the current action to end before stopping. Instructs 
Performance Center to allow a Vuser to complete the action it is running 
before stopping. The Vusers move to the Gradual Exiting status and exit 
the load test gradually.

➤ Stop immediately. Instructs Performance Center to stop running the 
Vusers immediately. The Vusers move to the Exiting status and exit the 
load test immediately.

Random Sequence Seed
Performance Center lets you set a seed number for random sequencing. 
Each seed value represents one sequence of random values used for test 
execution. Whenever you use this seed value, the same sequence of values is 
assigned to the Vusers in the load test. This setting applies to parameterized 
Vuser scripts using the Random method for assigning values from a data file. 
It also affects the random percentage of recorded think time (see 
information on the Run-Time Settings dialog box in the HP Virtual User 
Generator User Guide). Select this option if you discover a problem in the test 
execution and want to repeat the test using the same sequence of random 
values.
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Setting Timeout Intervals

Performance Center lets you set timeouts for various Performance Center 
commands. When a command is issued by the Controller, you can set a 
maximum time for the load generator or Vuser to execute the command. If 
it does not complete the command within the time limit, the Controller 
issues an error message.

To set timeout intervals:

 1 Select Project > Options, and click Timeout.

 2 To specify a command timeout interval, select Enable timeout checks and 
specify the appropriate timeouts. For more information, see “Enable 
Timeout Checks” on page 287.

Clear Enable timeout checks to disable the timeout test. 

 3 Click Save to save your settings.

To restore Performance Center default settings, click Use Defaults, then click 
Save.
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Enable Timeout Checks
Instructs Performance Center to monitor the status of load generators or 
Vusers after a command is issued by the Controller. If the load generator or 
Vuser does not complete the command within the timeout interval, the 
Controller issues an error message. If you disable the timeout limitations, 
Performance Center waits an unlimited time for the load generators to 
connect and disconnect, and for the Initialize, Start Vusers, Duration, and 
Stop Vusers actions to be executed.

You can specify the following load generator and Vuser timeout intervals:

➤ Load Generator

➤ Connect operation (sec). Type the time limit that Performance Center 
waits to connect to any load generator. If a connection is not successful 
within this time, the status of the load generator changes to Failed. The 
default connection timeout is 30 seconds.

➤ Disconnect operation (sec). Type the time limit that Performance Center 
waits to disconnect from any load generator. If a disconnection is not 
successful within this time, the status of the load generator changes to 
Failed. The default disconnection timeout is 120 seconds.

➤ Vusers

➤ Init stage (sec). Type the timeout value for the Initialize action. The 
default time limit is 180 seconds.

➤ Run stage (sec). Type the timeout value for the Start Vusers action. The 
default time limit is 120 seconds.

➤ Pause stage (sec). Type the timeout value for the Duration action. The 
default time limit is 120 seconds.

➤ Stop stage (sec). Type the timeout value for the Stop Vusers action. The 
default time limit is 120 seconds.

For details about load test schedule actions, see Chapter 11, “Configuring 
Scheduler Settings.”
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Note: Performance Center’s calculations consider the number of active 
Vusers and their influence on the timeout values. For example, 1000 Vusers 
trying to initialize take much longer than 10 Vusers. Performance Center 
adds an internal value, based on the number of active Vusers, to the 
specified timeout value. 

Setting Debug Information Options 

Performance Center lets you create trace files, which are used to gather 
information for debugging purposes. You can determine the extent of the 
trace to be performed during a load test by enabling trace options on the 
Debug Information page. The debug information is written to the Vuser 
Errors page.

The following trace flags are available: General, File Transfer, Incoming 
Communication, and Outgoing Communication. You only need to select the 
flags relating to your problem. For example, if you encounter specific 
problems with the transfer of files, select the File Transfer flag. 
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The Performance Center agent and Controller machine create some 
temporary files, which collect information such as the parameter file sent to 
the Vuser, the output compilation file, and the configuration file. The 
Performance Center agent files are saved in brr folders in the TMP or TEMP 
directory of the agent machine. The Controller files are saved in lrr folders 
in the TMP or TEMP directory of the Controller machine. At the end of the 
load test, all these files are automatically deleted.

To set the Debug Information settings:

 1 Select Project > Options, and click Debug Information.

 2 Select the desired trace flags. 

 3 Click Save to save your settings.

To restore Performance Center default settings, click Use Defaults, then click 
Save.
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Setting General Options 

You can specify global settings for multiple IP address allocation from the 
Options > General page when the IP spoofing option is selected. For details 
on enabling IP spoofing, see “Enabling IP Spoofing from Performance 
Center” on page 301. 

The Controller can allocate an IP address per process or per thread. Web 
Vusers require IP address allocation per process. WinSock Vuser IP addresses 
can be allocated per thread or per process. Allocation per thread results in a 
more varied range of IP addresses in a load test.

To set the General settings:

 1 Select Project > Options, and click General.

 2 Select the desired multiple IP address mode.

 3 Click Save to save your settings. 

To restore Performance Center default settings, click Use Defaults, then click 
Save.
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20
Configuring Multiple IP Addresses

When you run a load test, the Vusers on each load generator machine use 
the machine’s IP address. You can define multiple IP addresses on a host 
machine to emulate a real-world situation in which users sit on different 
machines.

This chapter includes:

 ➤  About Multiple IP Addresses on page 292

 ➤  Adding IP Addresses to a Host on page 293

 ➤  Using the IP Wizard on page 294

 ➤  Configuring Multiple IP Addresses on UNIX on page 298

 ➤  Updating the Routing Table on page 300

 ➤  Enabling IP Spoofing from Performance Center on page 301
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About Multiple IP Addresses

Application servers and network devices use IP addresses to identify clients. 
The application server often caches information about clients coming from 
the same machine. Network routers try to cache source and destination 
information to optimize throughput. If many users have the same IP 
address, both the server and the routers try to optimize. Since Vusers on the 
same load generator machine have the same IP address, server and router 
optimizations do not reflect real-world situations.

Performance Center’s multiple IP addressing enables Vusers running on a 
single machine to be identified by many IP addresses. The server and router 
recognize the Vusers as coming from different machines and, as a result, the 
testing environment is more realistic.

Note: The maximum number of IP addresses that can be spoofed per 
network card for Windows NT SP3 is 35 IPs; Solaris (version 2.5.1) up to 255 
IPs; Solaris (version 2.6 and higher) up to 8192 IPs. 

Applicable Protocols
Multiple IP addressing is applicable to the following protocols:

➤ Client/Serve. DNS, Windows Sockets

➤ Custom. JavaScript Vuser, VB Vuser, VB Script Vuser

➤ E-business. FTP, Palm, SOAP, Web (HTTP/HTML), Web Services, and the dual 
WinSock\Web Dual Protocol

➤ ERP/CRM. Oracle NCA, Oracle Web Applications 11i, PeopleSoft Enterprise, 
SAP-Web, Siebel-Web

➤ Legacy. RTE
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➤ Mailing Services. Internet Messaging (IMAP), POP3, SMTP

➤ Streaming Data. Real

➤ Wireless. i-Mode, VoiceXML, WAP

This feature can be implemented on Windows and UNIX platforms.

Adding IP Addresses to a Host

Performance Center includes the IP Wizard that you run on each Windows 
host machine to create multiple IP addresses. You add IP addresses to a 
machine once and use the addresses for all load tests. For information about 
adding IP addresses on UNIX machines, see “Configuring Multiple IP 
Addresses on UNIX” on page 298.

To add new IP addresses to a load generator:

 1 Run the IP wizard on a host machine to add a specified number of IP 
addresses. Manually configure the new IP addresses for UNIX Host 
machines.

 2 Restart the machine.

 3 If necessary, update the server’s routing table with the new addresses.

 4 Enable IP spoofing in the Performance Center User Site. For more 
information, see “Enabling IP Spoofing from Performance Center” on 
page 301.
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Using the IP Wizard

The IP Wizard resides on each Performance Center host or load generator 
machine. You run this process once to create and save new IP addresses on 
Windows machines. The new addresses can be a range of addresses defined 
by the Internet Assignment Numbers Authority. They are for internal use 
only, and cannot connect to the Internet. This range of addresses is the 
default used by the IP Wizard.

To add new IP addresses to a load generator machine:

 1 Invoke the IP Wizard (ipwizard.exe) from the Performance Center \bin 
folder. 

Note: The IP Wizard only works on machines with a fixed IP, not on 
machines with a DHCP.

 2 If you have an existing file with IP address settings, select Load previous 
settings from file and select the file.

 3 If you are defining new settings, select Create new settings. 
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 4 Click Next to proceed to the next step. If you have more than one network 
card, select the card to use for IP addresses and click Next.

The optional Web server IP address step enables the IP Wizard to check the 
server’s routing table to see if it requires updating after the new IP addresses 
are added to the load generator.

 5 To check the server’s routing table directly after adding the addresses, type 
the server IP address. For more information, see “Updating the Routing 
Table” on page 300.
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 6 Click Next to see a list of the machine’s IP address(es). Click Add to define 
the range of addresses.

IP addresses include two components, a netid and hostid. The submask 
determines where the netid portion of the address stops and where the 
hostid begins. 

 7 Select a class that represents the correct submask for the machine’s IP 
addresses.

 8 Specify the number of addresses to create. Select Verify that new IP 
addresses are not already in use to instruct the IP Wizard to check the new 
addresses. The IP Wizard will only add the addresses not in use. 
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 9 Click OK to proceed.

After the IP Wizard creates the new addresses, the summary dialog box lists 
all of the IP addresses.

 10 Click Finish to exit the IP Wizard. The IP Wizard - Summary dialog box 
opens.
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 11 Note the address of the .bat file, and see “Updating the Routing Table” on 
page 300 for information about using the batch file to update the routing 
table, if necessary.

 12 After you update the routing table, check Reboot now to update routing 
tables to initialize the NT device drivers with the new addresses.

 13 Click OK.

Configuring Multiple IP Addresses on UNIX

To configure multiple IP addresses on UNIX, manually configure the 
addresses on the Performance Center host or load generator machine.

Solaris 2.5, 2.6, 7.0, 8.0

To configure the hme0 device to support more than one IP address:

 1 Create entries in /etc/hosts for each hostname on your physical machine:

 2 Create /etc/hostname.hme0:n files that contain the hostname for the 
virtual host n. Note that hostname.hme0:0 is the same as hostname.hme0.

The above changes will cause the virtual hosts to be configured at boot time. 

128.195.10.31  myhost
128.195.10.46  myhost2
128.195.10.78  myhost3

/etc/hostname.hme0   (Contains name myhost)
/etc/hostname.hme0:1 (Contains name myhost2)
/etc/hostname.hme0:2 (Contains name myhost3)
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 3 You can also directly enable/modify a logical hosts configuration by running 
ifconfig directly on one of the logical hosts, using the hme0:n naming 
scheme:

To verify the current configuration, use ifconfig –a.

Linux

To define multiple IP addresses for a single Ethernet card, you need IP 
Aliasing compiled into the kernel. To do this, use the ifconfig command:

Substitute the new IP address for x.x.x.x, and insert the correct information 
for subnet mask. Place this command in the rc.local file so that it executes 
upon boot.

HP 11.0 or Later

To define multiple IP addresses for a single Ethernet card, you need IP 
Aliasing compiled into the kernel. To do this, use the ifconfig command:

Substitute the new IP address for x.x.x.x, and insert the correct information 
for subnet mask. Place this command in the rc.local file so that it executes 
upon boot.

% ifconfig hme0:1 up
% ifconfig hme0:1 129.153.76.72
% ifconfig hme0:1 down

/sbin/ifconfig eth0:0 x.x.x.x netmask 255.255.x.x up

/sbin/ifconfig lan1:0 x.x.x.x netmask 255.255.x.x up



Chapter 20 • Configuring Multiple IP Addresses

300

Updating the Routing Table

When the client machine has new IP addresses, the server needs the 
addresses in its routing table, so that it can recognize the route back to the 
client. If the server and client share the same netmask, IP class, and network, 
the server’s routing table does not require modification.

Note: If there is a router between the client and server machines, the server 
needs to recognize the path through the router. Make sure to add the 
following to the server routing table: route from the Web server to the 
router, and routes from the router to all of the IP addresses on the load 
generator machine. 

To update the Web server routing table:

 1 Edit the batch file that appears in the IP Wizard Summary page. An example 
.bat file is shown below. 

 2 For each occurrence of [CLIENT_IP], insert your IP address instead.

 3 Run the batch file on the server machine.
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Enabling IP Spoofing from Performance Center

After you define multiple IP addresses, you can enable IP spoofing for a load 
test.

Note: You must enable IP spoofing before running a load test.

To enable IP spoofing from the User site:

 1 On the Performance Center left menu, select Load Tests > Manage. The 
Load Tests page opens, displaying all the load tests in the current project.

 2 Click the load test for which you want to enable IP spoofing.

 3 On the Load Test configuration page that opens, click the General tab.

 4 Under Advanced, select Enable IP Spoofer. 

 5 Click Save to save your settings.
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21
Configuring Monitors Over a Firewall

To monitor servers over a firewall, you need to configure the Monitor Over 
Firewall machine. On the Monitor Over Firewall machine, you use the 
Server Monitor configuration tool to select which servers to monitor and to 
define specific measurements that Performance Center collects for each 
monitored server. 

In the User Site, you establish a connection between the tests you are 
running and the Monitor Over Firewall machines.

This chapter includes:

 ➤  About Monitoring over a Firewall on page 304

 ➤  Configuring Monitor Settings on page 305

 ➤  Configuring the User Site to Receive Monitor Over  Firewall Information 
on page 310
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About Monitoring over a Firewall

To enable monitoring of your servers over a firewall, you install the Monitor 
Over Firewall component on a dedicated machine. 

Important: Before you configure the Monitor Over Firewall machine to 
monitor servers over a firewall, you need to set up your Performance Center 
system to work with firewalls. For detailed information, see the section 
about working with firewalls in the HP Performance Center System 
Configuration and Installation Guide.

After you have set up your Performance Center system to work with 
firewalls, you need to carry out the following steps to enable monitoring 
over a firewall:

 1 Configure monitor settings on the Monitor Over Firewall machine.

Use the Server Monitor configuration tool to select which servers to monitor 
and to define specific measurements that Performance Center collects for 
each monitored server. 

See “Configuring Monitor Settings” on page 305.

 2 Configure the User Site to receive monitor over firewall information.

Establish a connection between the tests you are running and the Monitor 
Over Firewall machines. 

See “Configuring the User Site to Receive Monitor Over  Firewall 
Information” on page 310.
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Configuring Monitor Settings

You configure the monitor settings from the Monitor Over Firewall 
machine, using the Monitor Configuration tool. You select the type of 
monitors to run and the server whose resources you want to monitor, add 
the measurements to monitor for each server, and specify the frequency 
with which you want the monitored measurements to be reported.

To configure monitor settings:

 1 On the Monitor Over Firewall machine, choose Start > Programs > 
HP Performance Center > Advanced Settings > Monitor Configuration. For 
machines without the complete Performance Center installation, choose 
Start > Programs > Server Monitor > Monitor Configuration. The Monitor 
Configuration dialog box opens.
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 2 Click the Add Server button. The New Monitored Server Properties dialog 
box opens.

 3 In the Monitored Server box, type the name or IP address of the server 
whose resources you want to monitor. 

Note: To add several servers simultaneously, separate the server names or IP 
ranges with commas. For example, 255.255.255.0-255.255.255.5, server1, 
server2.

 4 From the Available Monitors list, select the monitors appropriate for the 
server being monitored. 
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 5 Click OK to close the New Monitored Server Properties dialog box. The 
Monitored Servers list is displayed in the Monitor Configuration dialog box. 

Performance Center displays default measurements for certain monitors in 
the Measurements to be Monitored section. You can specify the frequency at 
which Performance Center reports the measurement in the Measurement 
Properties section. 

 6 To add additional monitored servers to the list, repeat steps 2 through 5.

 7 To edit the monitor configuration properties for a server, click the Edit 
button. The Monitored Server Properties dialog box opens enabling you to 
edit the monitors for the server whose resources you are monitoring.

 8 Click Apply to save your settings.

Monitored

Monitors
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Cloning a Monitored Server’s Properties
To monitor the same properties on different server machines, you can clone 
a selected server’s properties using the Clone Monitored Server Properties 
dialog box.

To clone a monitored server’s properties:

 1 Open the Monitor Configuration dialog box.

 2 Right-click the server you want to clone, and select Clone. The Clone 
Monitored Server Properties dialog box opens.

 3 In the Monitored Server box, type the name or IP address of the cloned 
server you want to create. 

Tip: To create several cloned servers simultaneously, separate the server 
names or IP ranges with commas. For example, 255.255.255.5, server1, 
server2.
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 4 The Available Monitors list displays the monitors that were selected for the 
server being cloned. Select additional appropriate monitors for the cloned 
server. 

 5 Click OK to close the Clone Monitored Server Properties dialog box. The 
cloned server is displayed in the Monitored Servers list.

 6 Click Apply to save your settings.

Adding and Removing Measurements 
After you configure one or more server machines to monitor, you add 
measurements to monitor for each server. If Performance Center added 
default measurements, you can edit them as required.

To add a measurement to monitor:

 1 Open the Monitor Configuration dialog box.

 2 Select a server from the Monitored Servers list.

 3 Click the Add Measurement button. Select the appropriate monitor. A 
dialog box opens, enabling you to choose measurements for the monitor 
you selected.

 4 Select the measurements that you want to monitor, and click OK.

 5 Click Apply to save your settings.

To remove a measurement from the measurements list:

 1 Select the measurement, and click the Delete button. 

 2 Click Apply to save your settings.
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Configuring Measurement Frequency 
Once you have configured monitor measurements, you configure 
measurement frequency, that is, you set a schedule for reporting each 
measurement.

To set a schedule for reporting a measurement:

 1 In the Monitor Configuration dialog box, in the Measurement Properties 
section, select the configured server measurement you want to schedule.

 2 Specify the frequency at which you want Performance Center to report the 
measurement.

 3 Click Apply to save your settings.

Configuring the User Site to Receive Monitor Over 
Firewall Information

After you configure your monitors, you configure the Performance Center 
User Site to receive Monitor Over Firewall information during load tests.

To configure the User Site to receive Monitor Over Firewall information:

 1 In the Monitor Profile page, add the Monitor Over Firewall machines that 
can be accessed by load tests in this project. See “Adding Monitor Over 
Firewall Machines to the Monitor Profiles Page” on page 311.

 2 In the Load Test configuration page, select the Monitor Over Firewall 
machines you want to use in a specific load test. See “Selecting Monitor 
Profiles for a Load Test” on page 221.

During a load test run you can edit Monitor Over Firewall machine 
information. See “Editing Monitor Over Firewall Information” on page 383.
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Adding Monitor Over Firewall Machines to the Monitor 
Profiles Page
In the Monitor Profile page, you add the Monitor Over Firewall machines 
that can be accessed by load tests in this project.

To add a Monitor Over Firewall machine to your monitor list:

 1 Select Project > Monitor Profiles. The Monitor Profiles page opens.

 2 Click Modify machine names. The Monitor Over Firewall machines dialog 
box opens.

Note: In this dialog box, you can add Monitor Over Firewall machines, and 
edit or delete existing Monitor Over Firewall machines. 
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 3 In the Machine name box, type the name of the Monitor Over Firewall 
machine. 

 4 Click Add. The Monitor Over Firewall machine is added to the page.

 5 Click Close. The name of the Monitor Over Firewall machine now appears 
on the Monitor Profiles page.

To select the Monitor Over Firewall machines to monitor a load test, see 
“Selecting Monitor Profiles for a Load Test” on page 221.

While the load test is running, you can change the status of a Monitor Over 
Firewall machine or add another monitor to the load test.

To modify the Monitor Over Firewall machines:

 1 On the Load Test Run page, click the Design button. The Load Test Design 
dialog box opens.

 2 Click Settings. The Settings dialog box opens. 

 3 Click the Server Monitors tab. Performance Center displays the Monitor 
Over Firewall machines that are monitoring the load test, as well as their 
connection status. 
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➤ To connect or disconnect a Monitor Over Firewall machine, click the 
Connect/Disconnect button.

➤ To add a Monitor Over Firewall machine to the load test, select it from 
the Add Monitor Over Firewall machine list.

 4 Click OK.

 5 Click Close to close the Settings dialog box.
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Executing Load Tests
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22
Viewing Vusers During a Load Test

During the load run, you can view the actions that are performed by Vusers.

This chapter includes:

 ➤  About Viewing Vusers During a Load Test on page 317

 ➤  Monitoring Load Test Data on page 318

 ➤  Tracking Vuser Messages on page 324

 ➤  Viewing the Output Window on page 325

 ➤  Viewing Snapshots on Errors on page 330

About Viewing Vusers During a Load Test

While a load test runs, Performance Center measures and records the 
transactions you defined in your Vuser script. You can monitor a running 
load test from the Load Test Run page.

On the Load Test Run page, you can:

➤ Monitor key load test data. For details, see “Monitoring Load Test Data” on 
page 318.

➤ Monitor Vuser status for each script. For details, see “Monitoring Vuser 
Status” on page 322.

➤ Track Vuser messages. For details, see “Tracking Vuser Messages” on 
page 324.

➤ View online graphs. For details, see Chapter 25, “Online Monitor View.”
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Monitoring Load Test Data

You monitor load test data during the load test run to get an overview of the 
test’s status and the effects of load on your Web server. At the top of the 
Load Test Run page, you can view the user and project name. 

The status section displays the name of the running test, the step that the 
Scheduler is performing, the next action of the Scheduler, and the status of 
the load test. The Status statement and corresponding icon informs you of 
the status of the run.

You also monitor run time data, displayed beneath the Groups table, during 
the load test run.

This information includes:

Link Description

Running Vusers Shows the number of currently running Vusers. 

Click Running Vusers to open the Running Vusers - Whole 
Load Test graph. You can select and view any available 
graph from the graph list. For more information, see the HP 
Performance Center Monitor Reference.

Time Shows the start Time, elapsed Time, time remaining in the 
load test, and time remaining in the timeslot. The last 15 
minutes of the timeslot are allocated to collate and analyze 
the load test data. 

Click Time to open the Load Test Time Information dialog 
box. For more information, see “Load Test Time 
Information” on page 320.
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Hits/Sec Shows the number of hits made on the Web server by 
Vusers during each second of the load test run. This figure 
helps you evaluate the amount of load Vusers generate, in 
terms of the number of hits.

Click Hits/Sec to open the Hits per Second - Whole Load 
Test graph. You can select and view any available graph 
from the graph list. For more information, see the HP 
Performance Center Monitor Reference.

Passed Trans Shows the number of completed, successful transactions 
performed during a load test run. This figure helps you 
determine the actual transaction load on your system at 
any given moment.

Click Passed Trans to open the Total Passed Transactions - 
Whole Load Test graph. You can select and view any 
available graph from the graph list. For more information 
about Transaction Monitor graphs, see the HP Performance 
Center Monitor Reference.

Failed Trans Shows the number of completed, unsuccessful transactions 
performed during a load test run.

Click Failed Trans to open the Total Failed Transactions - 
Whole Load Test graph. You can select and view any 
available graph from the graph list. For more information, 
about Transaction Monitor graphs, see the HP Performance 
Center Monitor Reference.

Errors Shows the number of Vuser errors that occurred. 

Click Errors to view the Output window. For more 
information, see “Viewing the Output Window” on 
page 325.

Trans Details Click Trans Details to open the Transaction Details dialog 
box. The Transaction Details dialog box shows each 
individual transaction in the script, and lists transactions 
per second, and the number of transactions that passed, 
failed, and stopped. For more information, see “Transaction 
Details” on page 321.

Link Description
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Load Test Time Information

To view the timing aspects of the load test, click the Time link at the top of 
the Load Test Run page. The Load Test Time Information dialog box opens.

The Load Test Time Information dialog box displays the following 
information:

➤ Timeslot Remaining Time. The time remaining in the timeslot.

➤ Start Time. The server time at the start of the timeslot.

➤ Elapsed Time. The time that has elapsed since the start of the timeslot.

➤ Remaining Time. The time remaining in the test.



Chapter 22 • Viewing Vusers During a Load Test

321

Transaction Details

You can view details of individual transactions in the Transactions Details 
dialog box. To open the Transactions Details view dialog box, click the Trans 
Details link at the top of the Load Test Run page.

The Transaction Details dialog box displays the following information:

➤ Name. Lists the names of the individual transactions in a script. 

➤ TPS. Displays the number of transactions per second. 

➤ Passed. Lists the number of transactions that passed. 

➤ Failed. Lists the number of transactions that failed. 

➤ Stopped. Lists the number of transactions that stopped. 
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Monitoring Vuser Status
Performance Center enables you to track the status of each Vuser that runs 
during the load test. Performance Center displays the number and status of 
Vusers for each Vuser script.

As a load test runs, the Load Test Run page displays, for each script, the 
number of Vusers and the Vuser’s status.

The possible statuses are as follows:

Status Description

Down The Vuser is down. 

Init The Vuser is being initialized on the remote machine.

Ready The Vuser already performed the init section of the script 
and is ready to run.

Run The Vuser is running. The Vuser script is being executed on 
a load generator.

Rendez The Vuser has arrived at the rendezvous and is waiting to be 
released by Performance Center.

Exiting The Vuser has finished running or has been stopped, and is 
now exiting. Gradual exiting is shown in parenthesis. 

Passed The Vuser has finished running. The script passed.

Failed The Vuser has finished running. The script failed.

Stopped The Vuser stopped when the Stop command was invoked.

Error A problem occurred with the Vuser. Check the output dialog 
box for a complete explanation of the error.
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To display Vuser status per host, click the “+” symbol beside the Vuser script 
name to open the host list for the script. To close the host list, click the “-” 
symbol.

To perform Vuser actions from the Vuser menu, see “Vuser Menu” on 
page 347.

To view Vuser messages for a set of Vusers, display the host list for a script, 
and click a linked number. The Vuser Details dialog box opens. Click a 
Vuser ID to view the activity log for the selected Vuser. For details, see 
“Tracking Vuser Messages” on page 324.
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Tracking Vuser Messages

Performance Center enables you to track Vuser activity that occurs during 
the load test run, including logged messages from the script run, as well as 
error messages, from the Load Test Run page. 

To view the Vuser activity log:

 1 Click the “+” symbol beside a script name to display the host list for the 
script. 

 2 To view the messages related to a group of Vusers, click the arrow next to the 
action of a group of Vusers in the Groups table, and click Show Vusers. 
Performance Center opens the Vuser Details dialog box and displays each 
Vuser's ID and relevant details. 
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 3 Click a specific Vuser ID to open the activity log for that Vuser. The Vuser 
log opens, displaying run-time information about the Vuser.

Viewing the Output Window

While the load test runs, the Vusers and load generators send error and 
notification messages to the Controller. You can view these messages in the 
Output window. Performance Center clears the messages in the Output 
window at the start of each load test run.

To view messages in the Output window: 

 1 Click the Errors link in the load test data area. The Output window opens 
and displays the Error Summary table. 

The Error Summary table lists each error and its source, the number of times 
it occurred over the course of the whole load test and the number of Vusers 
affected. 
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 2 To view all the errors, click the “+” symbol beside All Errors at the top of the 
Output window.

 3 To view a list of all occurrences of a specific error, click the “+” symbol 
beside an error in the list. 
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 4 To view the point in the Vuser script where the error occurred, click the error 
in the Error Source column. The Vuser script opens in a new page, and the 
line at which the error occurred is shown.

To download the script, click the script link and download the Vuser script 
file from the Ready to Download dialog box.
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 5 Click a specific Vuser ID to open the activity log for that Vuser.

The View Snapshot on Error button displayed next to a line of the Vuser log 
contains a snapshot of an error. To view error snapshots, see “Viewing 
Snapshots on Errors” on page 330.

Note: Only errors that originate from the Vuser script’s action may be 
viewed in the source.

Click the Close button to close the activity log.
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 6 To open a list displaying all Vuser notifications, click All Notifications.

 7 To update the information in the Output window, click Refresh.

 8 To clear all the errors in the GUI and the output file, click Remove all 
messages.

The Vuser Log Page
The Vuser log page displays run-time information for Vusers in the load test. 
In addition, if the Generate Snapshot on Error has been enabled in the Run-
Time Settings (General:Miscellaneous tab), you can view snapshots of errors 
that occurred during the load test run. For more information on the 
Snapshot Viewer, see “Viewing Snapshots on Errors” on page 330.

To open the Vuser log:

 1 Click a specific Vuser ID in the Vuser Details dialog box to open the Vuser 
activity log. 

 2 To download the Vuser log file to a local directory, click the Download 
button, and specify the directory to which you want to download the Vuser 
log file (this includes snapshot on error files).

 3 To refresh the information in the Vuser log, click Refresh.
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Viewing Snapshots on Errors

The Snapshot on Error option generates a snapshot, a graphical 
representation of the Web page, at the point when an error occurred during 
the load test run. If the Vuser log indicates that a step has a snapshot (the 
View Snapshot on Error button is displayed), you can view a snapshot of the 
error in the Vuser log, or download the snapshot and view it from a local 
directory. The Snapshot Viewer enables you to view these snapshots to help 
debug your test run.

Before using this feature, you must install the Snapshot Viewer on your 
desktop and enable the feature in the Run-time Settings.

Note: You cannot view a snapshot on an error if a Vuser is running on a 
UNIX load generator.

To install the Snapshot Viewer:

➤ In the Vuser log, click the Snapshot Viewer link, and follow the on-screen 
instructions.

➤ On the Downloads page (Miscellaneous > Downloads), click the Snapshot 
Viewer Download link, and follow the on-screen instructions.

To enable the snapshot on error option:

 1 On the Load Test configuration page, click the Workload tab.

 2 Click the Edit Run-time Settings button for a selected Vuser script to display 
its run-time settings. The Run-Time Settings dialog box opens.
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 3 Select General > Miscellaneous in the left menu. The Miscellaneous page 
opens. 

 4 Select the Generate Snapshot on Error option.

Note: Check that the Continue on Error option is disabled. If Continue on 
Error and Generate Snapshot on Error are both enabled, no error snapshots 
will be generated.

For more information, see the section about configuring run-time settings in 
the HP Virtual User Generator User Guide.
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To view error snapshots in the Vuser log:

 1 In the Output window, click a specific Vuser ID to open the activity log for 
that Vuser. 

 2 To download the Vuser log file to a local directory, click the Download 
button, and specify the directory to which you want to download the Vuser 
log file (including the Snapshot on Error files). The .INF and .HTML files are 
downloaded. The size of the zipped file is displayed. 

 3 Click the View Snapshot on Error button. Performance Center generates the 
snapshot on error (.SOE) file.
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 4 After the snapshot on error file has been generated, the File Download 
dialog box opens. Click Open to view the snapshot directly, or save it for 
viewing at a later time. The selected snapshot opens in a new window.

 5 To close the browser, click Close.

To view error snapshots in a downloaded log file:

➤ In the log directory of the downloaded file, right-click the .INF file you want 
to view, and select View Snapshots. The file opens in the Snapshot Viewer.
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23
Viewing Autostart Load Tests

You can view and manage Autostart load tests and their reports from the 
Autostart Viewer.

This chapter includes:

 ➤  About Autostart Load Tests on page 335

 ➤  Viewing Autostart Load Tests on page 336

 ➤  Reserving Additional Resources on page 338

 ➤  Viewing Autostart Load Test Reports on page 339

About Autostart Load Tests

The Autostart Viewer page provides information about load tests with 
autostart for all projects. Along with the general information provided in 
the main table, you can access reports on tests that have run and cancel tests 
that are scheduled to run. 

The Autostart Viewer page is only a list of scheduled tests that provides 
information about tests. The actual scheduling of the autostart is done in 
the Timeslots page, while the configuring of the test is done when you 
create a new load test.
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Viewing Autostart Load Tests

To open the Autostart Viewer, select Project > Autostart Viewer. The 
Autostart Viewer page opens. 

The page displays a table of information on all scheduled tests, navigation 
arrows for the table, and a link to the Load Tests configuration and 
Timeslots pages.
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The table supplies the following information that you defined when 
reserving the timeslot:

Field Description

Autostart Date 
and Time

The date and time of the timeslot you reserve when you 
schedule a test to autostart.

Test Name The name of the test that is scheduled to autostart. This is the 
same name that was given when the test was created.

Status The status of the autostart test. Some of the information 
(Scheduled to run, Failed to Run) is specific for the autostart 
status, other information describes the tests’ status in the test 
workflow. For more information on the test workflow, see 
“Changing a Test Run State” in the HP Performance Center 
Administrator Guide.

Duration The duration of the test scheduled to autostart as defined when 
reserving the timeslot.

# Hosts The number of Hosts assigned to the scheduled test as defined 
when reserving the timeslot.

Click the Delete button to cancel the scheduled test. The 
timeslot is cleared and the entry is removed from the 
Scheduled Tests page.

Note: Only tests that have not started their run can be deleted.
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Sorting Tests

When you open the Autostart Viewer page, the tests are sorted by the 
Autostart Date and Time key. It is also possible to sort the tests according to 
the Test Name or # Hosts.

To sort tests:

In the column by which you want the tests sorted, click the column 
heading. An arrow appears next to the column heading indicating if the 
tests are sorted in descending or ascending order.

When you click the heading again, the arrow reverses direction, and the 
tests are sorted in the opposite order of the values in that column.

Note: Sorting settings are saved per user, per project. The next time the same 
user enters the Autostart Viewer page in a specific project, the page displays 
results based on the most recent sort order.

Reserving Additional Resources

If you change the settings for a load test scheduled to run using Autostart 
(for example, you increase the number of load generators or Vusers required 
in the load test), the autostart may fail to run if there are insufficient 
resources available to run the test. 

If the timeslot contains less resources than those required for the scheduled 
load test, a Did not run status will be displayed in the Autostart Viewer page.
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Viewing Autostart Load Test Reports

The Autostart Load Test Report page displays an overview of load test 
performance, a link to the test’s results, and a table of the schedule actions.

To open the Autostart Load Test Report page:

In the Autostart Viewer page table, click the status link of an active test 
name. The Autostart Load Test Report page for the test opens. 

You can view and access the following information in the Autostart Load 
Test Report page:

➤ Load Test performance information. The information includes the start of 
the run, Vuser information, the Controller of the load test, and the names of 
any additional Hosts.

➤ Download Messages. Enables you to download a zip file containing all the 
error and notification messages.

➤ Summary Report. Opens the Analysis Summary page.
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➤ View Results. Opens the Load Test Status page. 

➤ Autostart Test actions. This information reports on the performance aspect 
of the test run, not on the actual running of the load test. The table gives a 
step by step list of the performance during the running of the test. The 
sortable Time column supplies the date and time of the action, while the 
Status column supplies a self-explanatory note of the action performed.
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24
Running a Load Test

When you run a load test, Performance Center generates load on the 
application you are testing, and measures the system’s performance.

This chapter includes:

 ➤  About Running a Load Test on page 342

 ➤  The Load Test Run Page on page 343

 ➤  Starting a Load Test on page 353

 ➤  Manually Assigning Specific Load Generators at Run Time on page 363

 ➤  Configuring Schedule Settings from the Load Test Run Page on page 364

 ➤  Manually Adding Vusers to a Running Load Test on page 369

 ➤  Controlling Individual Vusers on page 373

 ➤  Adding and Modifying Vuser Groups on page 375

 ➤  Managing Load Generators on page 378

 ➤  Altering Load Test Settings During the Run on page 381

 ➤  Creating or Modifying the Runtime Monitor Profile on page 386

 ➤  Manually Releasing Vusers from a Rendezvous on page 388

 ➤  Adding, Editing, and Viewing Vuser Scripts on page 389

 ➤  Stopping a Load Test Run on page 390
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About Running a Load Test

When you run a load test, Vusers are assigned to their load generators and 
execute their Vuser scripts. During load test execution, Performance Center:

➤ records the durations of the transactions you defined in the Vuser scripts

➤ collects error, warning, and notification messages generated by the Vusers

You can run an entire load test unattended, or you can interactively select 
the Vuser groups and Vusers that you want to run. When the load test starts 
running, the Controller first checks the load test configuration information. 
Next, it invokes the applications that you selected to run with the load test. 
Then, it distributes each Vuser script to its designated load generator. When 
the Vuser groups are ready, they start executing their scripts. 

While the load test runs, you can monitor each Vuser, view error, warning, 
and notification messages generated by the Vusers, and stop both Vuser 
groups and individual Vusers. During the load test you can instruct 
Performance Center to allow individual Vuser or the Vusers in a group to 
complete the iterations they are running before stopping, to complete the 
actions they are running before stopping, or to stop running immediately. 
For more information, see “Configuring Load Test Run-Time Settings” on 
page 284.

You can also activate additional Vusers while the load test is running, using 
the Add Vusers dialog box, or from the drop-down menu in the Ready or 
Run columns. You can also rerun Vusers that finished running or were 
aborted during the load test from the Passed column. For more information, 
see “Configuring Schedule Settings from the Load Test Run Page” on 
page 364.

The load test ends when all the Vusers have completed their scripts, when 
the duration runs out, or when you terminate it.

In addition, you can add, edit, and view Vuser scripts, and edit and view 
run-time settings, as required. Note that you can edit run-time settings for a 
script during a run only if the script has no Vusers currently running. 
Otherwise, you can only view the run-time settings. For details, see 
“Altering Load Test Settings During the Run” on page 381, and “Adding, 
Editing, and Viewing Vuser Scripts” on page 389.
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The Load Test Run Page

On the Load Test Run page, you can control Vusers and Vuser groups and 
monitor their performance online. You can run all the Vusers and Vuser 
groups in a load test, or you can select the specific Vuser groups and Vusers 
that you want to run. The Load Test Run page contains settings that affect 
all scripts in your load test, and settings that affect individual scripts only. 

From the Load Test Run page, you can:

➤ configure and modify load settings

➤ monitor run time data

➤ track test status

➤ view online monitor graphs

For an explanation of the different sections of the Load Test Run page, see 
“Load Test Status” on page 344, “Groups Table” on page 346, “Global Load 
Test Settings” on page 350, and “Online Graphs” on page 352.
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To open the Load Test Run page:

In the Load Tests page, click the Run Load Test button, or in the Load Test 
configuration page, click Start. For information on starting a load test, see 
“Starting a Load Test” on page 353. 

Load Test Status
The status bar at the top of the page displays the name of the user, the name 
of the project, the name of the running test, the stage that the Scheduler is 
performing, the next step of the Scheduler, and the status of the load test.

The possible schedule actions are: Starting, Initialize, Delay After 
Initialization, Start Vusers, Duration, Stop Vusers, Not Active.

The next steps of teh Schedulerinclude: Initializing, Starting, Stopping. 
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The load test status statement informs you of the status of the run. The 
possible statuses are: Scheduler Running, Running Vusers, Stopping, 
Finished, Down, Failed, Before Collating Results, Collating Results, Collating 
Failed, Before Analyzing Results, Analyzing, or Analysis Failed.

You can view a synopsis of the running load test from the links beneath the 
status bar.

This information includes:

Command Description

Running Vusers Displays the number of Vusers currently running in the load 
test. For more information about the Running Vusers graph, 
see the HP Performance Center Monitor Reference.

Time Displays the start Time, elapsed Time, and time remaining in 
the load test and timeslot. For more information, see “Load 
Test Time Information” on page 320.

Hits/Sec Displays how many hits (HTTP requests) there have been to 
the Web server by Vusers during each second of the load test 
run. For more information about the Hits per Second graph, , 
see the HP Performance Center Monitor Reference.

Passed Trans Displays the number of completed, successful transactions 
performed during the load test run. For more information 
about Transaction Monitor graphs, see the HP Performance 
Center Monitor Reference.

Failed Trans Displays the number of completed, unsuccessful transactions 
performed during the load test run. For more information 
about Transaction Monitor graphs, see the HP Performance 
Center Monitor Reference.

Errors Displays the number of Vuser errors that occurred during the 
load test run. For more information, see “Viewing the Output 
Window” on page 325.

Trans Details Displays details of individual transactions from the load test 
run. For more information, see “Transaction Details” on 
page 321.
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For more information, see “Monitoring Load Test Data” on page 318.

Groups Table

Beneath the load test status bar is a table containing the scripts, hosts, and 
the status of each Vuser involved in the load test. During a load test run, you 
use the groups table to monitor the actions of all Vusers and Vuser scripts in 
the load test. The status fields display the current state of each Vuser in the 
script. 

This table also allows you to configure settings that affect a specific Vuser. To 
perform an action on an individual Vuser, click the arrow next to the Vuser 
to display the Vuser menu. To perform an action on an individual script, 
click the arrow next to the script to display the Script menu. 

Script Menu

To open the Script menu, click the arrow next to the script in the Groups 
table. You can perform the following script actions from the script menu:

Note: You can only perform script actions when the load test is stopped.

Command Description

Run-time 
Settings

Allows you to view Run-time Settings for each script. 
For more information, see “Configuring Run-Time 
Settings” on page 187.

Command 
Line

Allows you to send parameters to the script. For more 
information, see “Using Command Line Arguments” 
on page 189.



Chapter 24 • Running a Load Test

347

Vuser Menu

The table below shows the possible actions that you can perform from the 
Vuser menu for each Vuser status:

Status Description Possible Actions...

Down The Vuser is down. ➤ Init X. Initializes the specified 
number of Vusers for the script.

➤ Run X. Runs the specified number 
of Vusers for the script in addition 
to the Vusers already running 
(zero at the start of a load test).

➤ Delete X. Deletes the specified 
number of Vusers for the script.

Init The Vuser is being initialized 
on the host machine.

➤ Run X. Runs the specified number 
of Vusers for each script in 
addition to the Vusers already 
running (zero at the start of a load 
test).

➤ Stop X. Stops the specified 
number of Vusers for the scrip.

Ready The Vuser already performed 
the init section of the script 
and is ready to run. 

➤ Run X. Runs the specified number 
of Vusers for each script in 
addition to the Vusers already 
running (zero at the start of a load 
test).

➤ Stop X. Stops the specified 
number of Vusers for the scrip.
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Run The Vuser is running. The 
Vuser script is being 
executed on a host machine. 
The number in parenthesis 
is the number of Vusers 
paused.

➤ Gradual Stop X. Stops the 
specified number of Vusers after 
they complete their current 
iteration/action.

➤ Stop X. Stops the specified 
number of Vusers for the script.

➤ Pause X. Pauses the specified 
number of Vusers.

➤ Run X. Runs the specified number 
of Vusers for each script in 
addition to the Vusers already 
running (zero at the start of a load 
test).

Rendez The Vuser has arrived at the 
rendezvous and is waiting to 
be released by Performance 
Center.

➤ Gradual Stop X. Stops the 
specified number of Vusers after 
they complete their current 
iteration/action.

➤ Stop X. Stops the specified 
number of Vusers immediately. 

Exiting The Vuser has finished 
running or has been 
stopped, and is now exiting. 

➤ Stop All. Stops all Vusers 
immediately.

Passed The Vuser has finished 
running. The script passed.

➤ Reset X. Resets the status of the 
specified number of Vusers to 
Down

Failed The Vuser has finished 
running. The script failed.

➤ Reset X. Resets the status of the 
specified number of Vusers to 
Down. 

➤ Run X. Runs the specified number 
of Vusers for the script in addition 
to the Vusers already running 
(zero at the start of a load test). 

➤ Init X. Initializes the specified 
number of Vusers for the script. 

Status Description Possible Actions...
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To perform a Vuser action using the Vuser menu:

 1 Click the arrow next to a Vuser to display the Vuser menu. The Vuser menu 
with the possible Vuser actions opens.

 2 Select the action that you want to perform (the selected action is 
highlighted).

 3 Type the number of Vusers that you want to perform the action in the edit 
field (if required). 

Note: The first time you open the Vuser menu, the edit field is empty. After 
you type the number of Vusers to perform an action, Performance Center 
remembers this number and displays it the next time you perform that 
action on Vusers with the same status.

 4 Click the action, or press ENTER to perform the action.

Stopped The Vuser stopped when the 
Stop command was invoked. 

➤ Reset X. Resets the status of the 
specified number of Vusers to 
Down. 

➤ Run X. Runs the specified number 
of Vusers for each script in 
addition to the Vusers already 
running (zero at the start of a load 
test). 

➤ Init X. Initializes the specified 
number of Vusers for the script. 

Error A problem occurred with the 
Vuser. Check the Output 
dialog box for an 
explanation of the error. 

➤ Reset X. Resets the status of the 
specified number of Vusers to 
Down. 

Status Description Possible Actions...
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Global Load Test Settings
The section to the right of the Groups table allows you to configure settings 
that are global and affect all of the scripts in your load test. You can perform 
the following actions:

➤ Run. Opens the Run Vusers dialog box, enabling you to activate additional 
Vusers. For more information, see “Manually Adding Vusers to a Running 
Load Test” on page 369.

➤ Stop. Opens the Stop Test dialog box, enabling you to stop the whole load 
test. For more information, see “Stopping a Load Test Run” on page 390.

➤ Vusers. Opens the Vusers dialog box, enabling you to view the status of each 
of the Vusers in a Vuser group. For more information, see “Controlling 
Individual Vusers” on page 373.

➤ Design. Opens the Load Test Design dialog box, allowing you to select from 
the following options:

➤ Design Groups. Opens the Design Groups dialog box, enabling you to 
modify the groups that you designed at the design stage. You can change 
the number of Vusers in the load test, the load generator distribution, 
and the percentage or number of Vusers distributed to each script. For 
more information, see “Adding and Modifying Vuser Groups” on 
page 375.

➤ Scheduler. Opens the Load Test Scheduler, enabling you to manually 
configure schedule settings. For more information, see “Configuring 
Schedule Settings from the Load Test Run Page” on page 364.

➤ Load Generators. Opens the Generator Details and Assignment dialog 
box, enabling you to view the status and machine utilization of load 
generators in the load test, add load generators to the load test, and 
configure terminal sessions. For more information, see “Managing Load 
Generators” on page 378.
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➤ Settings. Opens the Settings dialog box, where you can change, while a 
load test is running, the load test duration, Monitor Over Firwall 
machine settings, refresh frequency settings, and post-run analysis 
settings. For more information, see “Altering Load Test Settings During 
the Run” on page 381.

➤ Monitors. Opens the Monitors dialog box, where you can alter the 
runtime monitor profile during the load test run. For more information, 
see “Creating or Modifying the Runtime Monitor Profile” on page 386.

➤ Rendezvous. Opens the Rendezvous dialog box, where you can enable or 
disable and view general information about the rendezvous points in the 
load test. For more information, see “Viewing Rendezvous Information” 
on page 249 and “Manually Releasing Vusers from a Rendezvous” on 
page 251.

➤ Output. Opens the Output window, where you view error and notification 
messages from the load test run. For more information, see “Viewing the 
Output Window” on page 325.



Chapter 24 • Running a Load Test

352

Online Graphs
The online monitor graphs are used to display performance measurements 
for those resources being monitored in a load test. By default, three graphs 
are displayed beneath the Vuser Run table.

You can select the graphs you want to view, configure graph scale, and select 
how graph information is displayed. In addition, the legend beneath the 
graphs displays details about the maximum, average, minimum, and last 
values for each measurement, and the graph scale. You can sort all the 
measurements by one of these values. For more information, see “Viewing 
Online Monitor Graphs” on page 397, and “Customizing the Online 
Monitor View” on page 401.

Additionally, you can open an enlarged view of a graph in a separate 
window. For more information, see “Optimizing the Online Monitors View” 
on page 399.
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Starting a Load Test

After you configure a load test, you can run it from the Load Tests page or 
Load Test Configuration page. To have sufficient resources available when 
you run the load test, you should reserve resources from the Timeslots page 
before starting the test. For details, see Chapter 5, “Working With 
Timeslots.” 

You can also run a load test that you saved or ran previously from the Load 
Tests page. For details, see “Viewing Load Tests” on page 47.

To start a load test:

➤ On the Load Tests page, select a load test and click the Run Load Test button

➤ On the Load Test configuration page, click Start.

For load tests with a reserved a timeslot, see “Starting a Load Test with a 
Reserved Timeslot” on page 354. For load tests without a reserved a timeslot, 
see “Starting a Load Test Without a Reserved Timeslot” on page 358.
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Starting a Load Test with a Reserved Timeslot
If you reserved a timeslot, the Select Timeslot page opens displaying the 
reserved timeslots and the number of machines (and Vusers) that are 
required for the load test.

You can select which reserved timeslot you want to use for your test, or 
create a new timeslot. In addition, you can update the timeslot duration. If a 
timeslot has insufficient duration or resources, the field is shown in red. 
Click the update link to prolong the timeslot duration or to have 
Performance Center update the timeslot with the required number of 
machines.

If you manually assigned specific load generators to your test, you can view 
the load generator machines reserved in the timeslot by clicking the 
View list link in the Machines column.

To select a reserved timeslot and start the test:

➤ Select a reserved timeslot that has sufficient resources for the load test, and 
click Start. The load test initialization process begins.
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To create a new timeslot and start the test:

 1 Select Create new timeslot, and click Start. The Set Load Test Duration 
dialog box opens.

 2 Type the desired duration of the timeslot, and click OK. 

You can only reserve durations in half and whole hour increments. 
Performance Center checks that sufficient resources are available, and 
displays a message informing you whether the timeslot was reserved.

Note: If the Post-run Analysis setting is Collate and analyze results, 
Performance Center automatically adds an extra 15 minutes to the timeslot 
for processing results.

 3 Click Start. The load test initialization process begins.
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To update the duration of a reserved timeslot:

 1 Click Update Duration. The Prolong Timeslots Duration dialog box opens.

 2 Type the total duration in the time fields, and click OK. Performance Center 
allocates the required resources if they are available, and displays a message 
informing you whether the timeslot was successfully updated.

Note: If the Post-run Analysis setting is Collate and analyze results, 
Performance Center allocates the last 15 minutes of a timeslot to result 
processing.

 3 If the timeslot was successfully updated, select the updated timeslot. 

If Performance Center was unable to allocates the required resources, click 
Go to Timeslots page to reserve a new timeslot to run the test. For details, 
see “Reserving Timeslots” on page 91.

 4 Click Start. The load test initialization process begins.
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To allocate additional load generators:

 1 Click Update Resources/Duration to open the Update Timeslot Resource 
dialog box. 

 2 To prolong the timeslot duration, select Set total duration, and type the 
total duration in the time fields.

 3 Click OK. Performance Center allocates the required resources (if they are 
available), and displays a message informing you whether the timeslot was 
successfully updated.

Note: If the Post-run Analysis setting is Collate and analyze results, 
Performance Center allocates the last 15 minutes of a timeslot to result 
processing.
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 4 If the timeslot was successfully updated, select the updated timeslot. 

If Performance Center was unable to allocates the required resources, click 
Go to Timeslots page to reserve a new timeslot to run the test. For details, 
see “Reserving Timeslots” on page 91.

 5 Click Start. The load test initialization process begins.

Starting a Load Test Without a Reserved Timeslot
If you did not reserve a timeslot, Performance Center displays the following 
notice:

You can reserve a new timeslot from the Timeslots page, or have 
Performance Center reserve a timeslot for you.

To have Performance Center automatically reserve a timeslot:

 1 Click Proceed. The Set Load Test Duration dialog box opens.



Chapter 24 • Running a Load Test

359

 2 Type the desired duration of the timeslot, and click OK. 

You can only reserve durations in half and whole hour increments. 
Performance Center checks that sufficient resources are available, and 
displays a message informing you whether the timeslot was reserved.

Note: If the Post-run Analysis setting is Collate and analyze results, 
Performance Center automatically adds an extra 15 minutes to the timeslot 
for processing results.

 3 Click Start. The load test initialization process begins.

Load Test Initialization Process
After you start a load test, Performance Center displays the steps taken to 
initialize the test. 

Once the initialization steps are successfully completed, the Load Test Run 
page opens and Vusers start running. 
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Note: 

➤ If you did not configure or enable load settings when designing your load 
test, you can configure load settings from the Load Test Run page. You 
must configure load settings at the beginning of the load test run in 
order to run Vusers in the load test. For details, see “The Load Test Run 
Page” on page 343.

➤ If Pause Scheduler at load test start is enabled in the Scheduler Options 
(Load Test configuration page > Workload tab), the scheduler opens in 
the Pause status. For more information, see “Manually Starting the 
Scheduler” on page 362.
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If initialization fails, the page displays additional information to help you 
isolate the problem.

Select one of the following options and click Go:

➤ Report this error to the administrator and return to the Load Test 
Configuration page. Enables you to send a message (in addition to the 
error details which are automatically sent) to the administrator, and 
returns to the Load Test configuration page.

➤ Return to the Load Test Configuration page. Returns to the Load Test 
configuration page.
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Manually Starting the Scheduler
You can pause the Scheduler at the start of a load test, and manually start 
the Scheduler when you are ready to begin the test. 

To pause the Scheduler at the start of a load test:

 1 On the Load Test configuration page, click the Workload tab.

 2 In the top right corner, click the Scheduler Options button.

 3 Select Pause scheduler at load test start, and click OK.

When you start a load test with this option enabled, Performance Center 
displays the Scheduler in the Pause status, and displays a message that the 
test was initialized successfully.

To manually start the Scheduler, click Continue when you are ready to start 
the Scheduler.

Note: If you set this option, the load test does not run in Autostart mode. 
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Manually Assigning Specific Load Generators at Run Time

When you designed the load test, if you selected the manual load generator 
distribution method with the option of assigning actual load generators 
manually at runtime (see “Load Generator Distribution” on page 180), 
Performance Center prompts you to assign a load generator to each virtual 
load generator when you start the load test run.

Note: If you assign load generators while the load test is running, the 
Scheduler will not run until you have manually configured the load 
generators. For more information, see Chapter 24, “Running a Load Test.”

To manually assign a load generator at run time:

 1 When you start the load test, the Map Virtual to Actual Load Generators 
dialog box opens.
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 2 You map virtual load generators to actual load generators in the lower area 
of the dialog box. For each virtual load generator select an actual load 
generator from the Actual Generator list. Keep the following in mind:

➤ Each virtual load generator must be assigned an actual load generator. 

➤ You cannot assign the same load generator to more than one virtual load 
generator. 

To have Performance Center assign actual load generators to each virtual 
load generator, click Automatic Assignment.

 3 To modify load generator assignments, select No Generator in the Actual 
Generator list, then reassign the load generator.

 4 Click OK to save the settings and close the dialog box. 

Configuring Schedule Settings from the Load Test Run Page

You can configure or modify a load test’s schedule settings for all scripts or 
for a specific script by adding or stopping Vusers before or during the load 
test run from the Load Test Run page.
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To configure or modify load behavior for all Vuser scripts:

 1 On the Load Test Run page, click the Design button. The Load Test Design 
dialog box opens.

 2 Click Scheduler. The Scheduler opens.

 3 If you did not previously configure a schedule for the load test:

 a Select Enable Scheduler. 

 b Configure the load behavior. For more information on configuring a load 
test schedule, see Chapter 11, “Configuring Scheduler Settings.”

 c Click Start to start the Scheduler, or Close to close the Scheduler and 
return to the Load Test Run page without altering the settings. 

After you start the Scheduler, the schedule settings are applied to the load 
test. 
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 4 To pause the Scheduler, click Pause. 

Note: This only pauses the schedule timers. When you click Pause, the 
button changes to Resume. Click Resume to restart the timers.

 5 To modify the load behavior:

 a Click Stop to stop the Scheduler. No more Vuser are started. This has no 
effect on Vusers that are already running. 

 b Modify the schedule, as described in Chapter 11, “Configuring Scheduler 
Settings.” 

 c Click Start to restart the Scheduler. When the Scheduler is restarted, 
changes affect only those Vusers currently in the Down state. 

Note: Any changes you make to the schedule apply to all running Vusers. 
For example, if there are Vusers that have been running for 30 minutes and 
you change the duration from 40 to 60 minutes, the Vusers will run an 
additional 60 minutes.
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To configure or modify load for a specific Vuser script:

On the Load Test Run page, you can select a Vuser script and do the 
following:

➤ Run Vusers for a specific script. Click the arrow in the Ready column for the 
script, type the number of Vusers you want to run, and click Run.

➤ Stop Vusers for a specific Vuser script. Click the arrow in the Ready or Run or 
column for the script, type the number of Vusers you want stop 
simultaneously, stop gradually, or pause and click the Stop, Gradually Stop, 
or Pause link respectively.

➤ Rerun Vusers for a specific Vuser script that finished running. Click the 
arrow in the Passed or Stopped column for the script, type the number of 
Vusers you want to rerun, and click Init, Run, or Reset.

➤ Rerun Vusers for a specific Vuser script that were aborted. Click the arrow in 
the Failed column for the script, type the number of Vusers you want to 
rerun, and click Init, Run, or Reset.

To configure or modify load for a specific Vuser:

 1 In the Group table, click the "+" icon adjacent to a script name to display a 
list of the hosts on which the script is running. 

In the example, you see that the script html_error currently has five Vusers 
running. 

The Group table also displays the host machines associated with the test.
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 2 To view messages related to a group of Vusers, click the arrow adjacent to the 
action of a Vuser group, and click Show Vusers. Performance Center opens 
the Vuser Details dialog box and displays each Vuser's ID and relevant 
details. 

 3 To perform an action on a individual Vuser, select the check box next to the 
Vuser, and select an action. For more information, see “Controlling 
Individual Vusers” on page 373.

In addition to modifying Vuser load during a load test run, you can also 
alter load test settings (load test duration, number of hosts, and so forth) as 
desired.
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Manually Adding Vusers to a Running Load Test

During a running load test, you can manually control the addition of new 
Vusers using the Run Vusers dialog box. You can select to distribute Vusers as 
follows:

➤ By number. You specify the number of new Vusers that can be added to the 
load test, and the load generators or groups to which these additional Vusers 
will be assigned to run.

➤ By percentage. You specify the number of new Vusers that can be 
distributed among the Vuser scripts according to the percentage you define, 
and the load generators or groups to which these additional Vusers will be 
assigned to run. 

Note: At the beginning of a load test, Vusers are distributed to the load 
generators equally within the same group. When start or stopping Vusers, 
Performance Center distributes Vusers to the load generators relative to the 
number of Vusers on each the load generator. If you manually add more 
Vusers to a load generator during the load test, Performance Center takes 
this new amount into consideration, and distributes the next batch of 
Vusers accordingly.
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To add Vusers to a running load test:

 1 On the Load Test Run page, click the Run Vusers button. The Run Vusers 
dialog box opens.

 2 Select one of the following modes for adding Vusers to the load test:

➤ Distribute Vusers by Group. Displays the Vuser groups, enabling you to 
distribute Vusers to particular Vuser groups. 

➤ Distribute Vusers by Load Generator. Displays the load generator 
machines assigned to each group, enabling you to distribute Vusers to a 
group running on a particular load generator.

 3 In the Vusers column, specify the number of Vusers on which you want to 
perform actions for each group or host.
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 4 To perform actions according to the percentage of the total number of 
Vusers, click Relative Distribution. The Relative Distribution dialog box 
opens, and displays the quantity of Vusers on which you want to perform 
actions in percentage terms.

Click OK to save the settings and close the Relative Distribution dialog box.

 5 Select one of the following options, and click GO:

➤ Add new Vusers to Down. Adds the specified number of Vusers in the 
Down status.

➤ Initialize Vusers from Down. Adds and initializes the specified number of 
Vusers. Performance Center distributes the Vusers that you added to their 
designated load generators so that they are ready to execute their scripts.

➤ Run Vusers from Down. Runs the specified number of Vusers from the 
Down status.

➤ Run Vusers from Ready. Runs the specified number of Vusers from the 
Ready status.
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➤ Stop Vusers. Stops the specified number of Vusers.

➤ Reset Vusers. Resets the specified number of Vusers to the Down status.

Note: If the number of Vusers that you attempt to add exceeds the number 
of Vusers allocated for the run, Performance Center allocates additional 
Vusers if sufficient Vusers are available. Performance Center issues a warning 
if it is unable to reserve the requested number of Vusers.

 6 Click Close to close the Run Vusers dialog box and return to the Load Test 
Run page.
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Controlling Individual Vusers 

You can also manipulate individual Vusers within the Vuser groups you 
have defined. This section describes how to initialize, run, stop, and reset 
individual Vusers. 

To control individual Vusers:

 1 On the Load Test Run page, click the Vusers button. The Vusers List dialog 
box opens with a list of the ID, Status, and Load Generator for all Vusers in 
the load test run.
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 2 You can control an individual Vuser as follows: 

➤ Select a Vuser and click Init to initialize it.

➤ Select a Vuser and click Run to run it.

➤ Select a Vuser and click Stop to stop it immediately from running.

➤ Select a Vuser and click Reset to revert a Vuser's status to down.

➤ To select all listed Vusers, click the Select All button. 

➤ To clear the selection, click the Clear All button.

 3 To filter for individual Vusers, click Edit. The Active Filters dialog box opens. 

Select the groups, load generators, and statuses that you want to filter, and 
click OK. The filtered Vusers are displayed in the Vuser Details section. 

 4 Click Refresh to refresh the status of Vusers at any time.

 5 Click Close to close the Vuser List dialog box.
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Adding and Modifying Vuser Groups

Before running the load test, you can modify the groups that you designed 
in the design stage from the Load Test Run page. You can change the 
number of Vusers in the load test, the host distribution, and the percentage 
or number of Vusers distributed to each script. You can also create new Vuser 
groups. During the load test run, you can create and add new Vuser groups 
to the load test.

Note: 

➤ During a load test run, you cannot edit groups that have Vusers in the 
Running, Pausing, Init, or Ready mode. 

➤ If you edit a group during run time (except for Run-time settings), this 
resets the Vusers to the Down status.
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To modify or create Vuser Groups:

 1 On the Load Test Run page, click the Design button. The Load Test Design 
dialog box opens.

 2 Click Design Groups. The Design Groups dialog box for the load test opens.

 3 Modify the Design Groups settings as necessary. 

To create a new Vuser group, specify the script, group name, number of 
Vusers, and assign load generators to the new group. For more information, 
see Chapter 10, “Designing Load Test Workloads.”

Note: Duplicate Runtime Settings is limited to importing settings into the 
new group only.
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 4 To upload a Vuser script that is not on the list, click the Upload scripts 
button. The Upload a Vuser Script dialog box opens. 

Upload scripts as described in “Uploading Scripts to the Vuser Scripts Page” 
on page 130. 

Note: You cannot remove scripts from the Selected Scripts list.

 5 Click OK to save the settings and close the Design Groups dialog box. Vusers 
are distributed to groups and hosts and set in the Down state.

To disregard the changes and close the dialog box, click Cancel.

Note: An new Vuser group will not be included in the scheduling if Schedule 
by Group is active.
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Managing Load Generators

During a load test, you can view the status and machine utilization of load 
generators in the load test, connect and disconnect load generators, add 
load generators to the load test, and configure terminal sessions from the 
Load Generator Details and Assignment dialog box.

To manage load generators during a load test:

 1 On the Load Test Run page, click the Design button. The Load Test Design 
dialog box opens.

 2 Click Load Generators. The Load Generator Details and Assignment dialog 
box opens. 
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The Load Generator Details and Assignment dialog box provides the 
following information:

➤ Name. The name of the load generator machine.

➤ Status. The current status of the load generator machine. The following 
table describes the possible statuses of the load generator.

➤ Utilization. Provides information on the percentage of total CPU 
processing capacity and virtual memory being used. This information 
helps you to assign your Vuser groups to load generators without 
overloading any one load generator.

 3 To change the terminal services configuration on a load generator, select the 
load generator and click the Terminal Services button. For more 
information, see “Configuring Terminal Sessions” on page 238.

 4 To connect a load generator for the load test, select the load generator and 
click Connect. The load generator status changes from Down to Ready when 
the load generator is connected.

To disconnect a load generator, select the load generator and click 
Disconnect. The load generator status changes from Ready to Down.

Status Description

Ready The load generator is connected

Connecting The load generator is in the process of connecting

Active The load generator is running Vusers

Down The load generator is not connected

Failed A connection with the load generator could not be 
established
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 5 To add a load generator machine to the load test, click Add Load Generator. 

➤ If you manually assigned specific load generators to your test, a dialog 
box opens displaying the requested number of load generators (if 
currently available) in the project’s host pool. 

Select the load generator machines that you want to reserve for your load 
test run, and click OK. The dialog box closes and the load generators are 
added to the Load Generator Details and Assignment list.

➤ If Performance Center automatically assigned load generators to your 
test, the following dialog box opens.
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Type the number of load generators to add to the load test, and click OK. 
If the load generators are available, the dialog box closes and the load 
generators are added to the Load Generator Details and Assignment list. 
A message is issued if the load generators are not available.

 6 Click Refresh to refresh the information in the Load Generator Details and 
Assignment dialog box.

 7 Click Close to save the settings and close the dialog box.

Altering Load Test Settings During the Run

You can modify general settings while a load test is running from the Load 
Test Run page. Note that these changes only apply to the current run and 
are not saved for future runs of the load test. 

You can make the following changes to general settings during the load test 
run:

➤ Change duration

➤ Editing Monitor Over Firewall Information

➤ Change refresh frequency

➤ Change the post-run analysis settings

Changing Duration
You can alter the duration of the load test during the load test run, using the 
Change Duration tab.

To change duration settings:

 1 On the Load Test Run page, click the Design button. The Load Test Design 
dialog box opens.

 2 Click Settings. The Settings dialog box opens.
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 3 Click the Change Duration tab. 

 4 To prolong the load test, select Prolong load test by X min, and type the 
number of minutes by which to prolong the load test.

Note: The ability to prolong your load test, may be limited by your timeslot 
reservation. For example, suppose you reserve a timeslot from 2:00-3:00 PM 
and some one else reserves the timeslot from 3:00-4:00 PM. At 2:50 you try 
to prolong your test by 15 minutes. The requested extension cannot be 
given because of the 3:00-4:00 PM reservation.

 5 To shorten the load test, select Shorten load test by "X" min and type the 
number of minutes by which to shorten the load test.

 6 To free the timeslot at the end of the test, select Free the timeslot. For more 
information, see “Freeing a Timeslot After a Test” on page 392. 

 7 Click OK to alter the duration settings, and again to confirm the change.

 8 Click Close to close the Settings dialog box.
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Editing Monitor Over Firewall Information
While the load test is running, you can change the status of a Monitor Over 
Firewall machine or add another monitor to the load test.

To modify the Monitor Over Firewall machines:

 1 On the Load Test Run page, click the Design button. The Load Test Design 
dialog box opens.

 2 Click Settings. The Settings dialog box opens. 

 3 Click the Server Monitors tab. Performance Center displays the Monitor 
Over Firewall machines that are monitoring the load test, as well as their 
connection status. 

➤ To connect or disconnect a Monitor Over Firewall machine, click the 
Connect/Disconnect button.

➤ To add a Monitor Over Firewall machine to the load test, select it from 
the Add Monitor Over Firewall machine list.

 4 Click OK.

 5 Click Close to close the Settings dialog box.
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Changing Refresh Frequency
You can alter the frequency for refreshing Vuser table during the load test 
run, using the Refresh Frequency tab.

To modify the default refresh rate:

 1 On the Load Test Run page, click the Design button. The Load Test Design 
dialog box opens.

 2 Click Settings. The Settings dialog box opens. 

 3 Click the Refresh Frequency tab. 

 4 Select the frequency at which to refresh the Vuser groups table. 
Alternatively, select Do not refresh so that the table does not auto-refresh 
automatically.

 5 Click OK, and click Close to close the Settings dialog box.
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Changing the Post-Run Analysis Option
You can change the post-run analysis settings during the load test run, using 
the Miscellaneous tab.

To modify the post-run analysis settings:

 1 On the Load Test Run page, click the Design button. The Load Test Design 
dialog box opens.

 2 Click Settings. The Settings dialog box opens.

 3 Click the Miscellaneous tab. 

 4 Select one of the post-run analysis options:

➤ Collate and analyze results. Performance Center collates the run data 
from the load generators and generates analysis data. This option takes 
the most time.

➤ Collate only. Performance Center collates the run data from the load 
generators. This is the default setting.

➤ Do not collate results. Frees the machines immediately after the load test 
ends. You can collate and analyze results at a later point from the Load 
Test Results page.

For more information on the post-run analysis options, see “Configuring 
Post-Run Analysis Settings” on page 101.

 5 Click OK to save the post-run analysis option, and click Close to close the 
Settings dialog box.
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Creating or Modifying the Runtime Monitor Profile

Performance Center enables you to monitor your load test while it is 
running. To monitor the run, you must define a monitor profile that 
incorporates all the monitors and servers that you want to monitor the run. 
This profile is known as the runtime monitor profile. 

The runtime monitor profile is valid for the current run only, and can 
incorporate monitor profiles defined on a project level, a local monitor 
profile defined specifically for this load test, and even Monitor Over Firewall 
machines. These monitors profiles can be created and configured before 
running a load test, or during the load test run. 

For more information about configuring monitor profiles for a load test, see 
Chapter 12, “Configuring Load Test Monitor Settings.”

To create or modify a runtime monitor profile:

 1 On the Load Test run page, click the Design button. The Load Test Design 
dialog box opens.

 2 Click Monitors.

➤ If no profile has been selected for load test, the Add Monitors page opens. 
Create the runtime monitor profile as described in “Creating Monitor 
Profiles” on page 111.

➤ If monitor profiles were selected for the test before runtime, the Monitor 
Profile dialog box opens displaying the runtime monitor profile, which 
includes all the selected monitor profiles. Edit the runtime monitor 
profile as follows:

➤ To add another monitor to the profile, click Add. Provide the server 
information and select the measurements to monitor in the same way 
you would when creating a new profile. For details, see “Creating 
Monitor Profiles” on page 111.

➤ To edit details of a monitor server in the profile, click the Edit button 
next to the relevant server, modify the measurement selection, and click 
Save.

➤ To delete a monitor server from the profile, click the Delete Server 
button next to the relevant server and click OK.
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➤ To delete a monitor from the monitor profile, click the Delete Monitor 
button next to the relevant monitor and click OK.

 3 Click Close to close the Monitor Profile dialog box.

Note: To remove a specific measurement from a runtime monitor profile 
that consists of multiple monitor profiles, be sure to remove the same 
measurement from each monitor profile in which it is selected.
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Manually Releasing Vusers from a Rendezvous

While you run a load test, you can manually release Vusers from a 
rendezvous before the Controller releases them. 

To manually release Vusers from a rendezvous: 

 1 On the Load Test Run page, click the Design button. The Load Test Design 
dialog box opens.

 2 Click Rendezvous. The Rendezvous page opens.

 3 Select a rendezvous from the Rendezvous list.

 4 Click Release. The Vusers in the rendezvous are released.

For more information, see Chapter 16, “Using Rendezvous Points.”
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Adding, Editing, and Viewing Vuser Scripts

You can add, edit, and view Vuser scripts during a load test run from the 
Load Test Run page. You can also view the run-time settings for a Vuser 
script.

To add a Vuser script during the load test run:

 1 On the Load Test Run page, click the Design button. The Load Test Design 
dialog box opens.

 2 Click Design Groups. The Design Groups dialog box opens.

 3 Add a script as described in “Adding and Modifying Vuser Groups” on 
page 375.

 4 After you add a script, click the Select Load Generator link, and specify a 
load generator to run the script.

 5 Configure load settings for the new script as described in “Configuring 
Schedule Settings from the Load Test Run Page” on page 364.

To view or edit a running Vuser script during the load test run:

 1 Select Project > Vuser Scripts to open the Vuser Scripts page.

 2 Click the Vuser script that you want to edit. Performance Center opens the 
Script Actions dialog box. 

 3 Click the Download Scripts button. Performance Center prepares the script 
for download.

 4 Click Download to download the script. Specify the folder to which you 
want to save the script files.

Note that if you have VuGen installed on the machine to which you are 
downloading, Performance Center can open the file directly in VuGen.

 5 View or edit the script, as required.

When editing a running Vuser script, it is important to understand the way 
a load test accesses a script and its run-time settings. For detailed 
information, see “About Managing Vuser Scripts” on page 123.
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 6 After editing in VuGen, establish the Performance Center connection. For 
more information, see “Uploading a Vuser Script from VuGen” on page 141.

 7 Select File > Save to upload the edited script to the Performance Center 
database.

To edit run-time settings for a Vuser script:

 1 On the Load Test Run page, click the arrow next to a script, and select Run-
time Settings.

 2 Edit the run-time settings as required, and click OK. 

The edited run-time settings replace the previous setting on the database 
server. For detailed information, see “About Managing Vuser Scripts” on 
page 123.

For more information about run-time settings, see Chapter 35, “Configuring 
General Run-Time Settings.”

Stopping a Load Test Run

A load test stops running automatically when it reaches the end of the 
configured load test duration. At the end of the load test run, Performance 
Center performs the post-run analysis option that you selected in the 
Timeslots page. For more information, see “Configuring Post-Run Analysis 
Settings” on page 101. 

You can manually stop a load test during a load test run, for example, to 
delay data collation and analysis until a more convenient time. After the 
load test has stopped, you will only be able to view test data in the analysis.
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To stop a load test during its run:

 1 On the Load Test Run page, click Stop Test. The Stop Run dialog box opens 
and displays the post-run analysis settings. 

 2 Select a post-run analysis option. For more information, see “Configuring 
Post-Run Analysis Settings” on page 101.

 3 To free the timeslot at the end of the test, select Free the timeslot.

 4 Click Stop to stop the load test, or click Close to close the Stop Test dialog 
box without stopping the run.

If you stop the load test, Vusers in the load test exit the load test gradually. 
The Stop button on the Load Test Run page changes to Stop Now button 
until all Vusers have exited.

 5 To stop the load test immediately, click the Stop Now button. Performance 
Center immediately stops the load test.

After all the Vusers have exited the load test, Performance Center performs 
the specified post-run analysis action.
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Freeing a Timeslot After a Test
To run a test, you must reserve a timeslot (see “About Project Resources and 
Reserving Timeslots” on page 82). What is important to note, is that your 
reservation assigns the requested number of hosts to your timeslot.

If there is a total of ten hosts, and you reserve a timeslot using eight, there 
are only two hosts available until the end of the timeslot. Since hosts are a 
limited resource, it is important to maximize their usage.

Let’s say you reserve a three hour timeslot that starts at 3:00 PM and uses 
eight out of ten hosts. At the start of your timeslot, you begin a test that 
runs for two hours and twenty minutes. This means that at 5:20 PM, your 
test is finished, but the hosts are still locked to the timeslot. If someone else 
from your project needs to run a twenty minute test using four hosts, they 
won’t know that there are actually eight free hosts that are dedicated to the 
unused portion of the reserved timeslot. They cannot run their test because 
there is an insufficient number of available hosts.

When you stop a load test, Performance Center gives you the option to free 
the timeslot at the end of the test, making the unused portion of the 
timeslot and the hosts assigned to it, accessible to other users.

In the above example, the user with the short test would be able to reserve a 
thirty minute timeslot, from 5:30-6:00, with a sufficient number of hosts to 
run their test.

Selecting Free timeslot after test, allows you to maximize your host and 
timeslot usage.
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25
Online Monitor View

You monitor load test execution using the Performance Center online 
monitors. During a load test run, you can view graphs that display 
information about the load that Vusers generate on your Web server and 
other applications. Performance Center displays this data in real-time 
during test execution. 

This chapter includes:

 ➤  Overview of Online Monitoring on page 394

 ➤  Setting Monitoring Options on page 396

 ➤  Viewing Online Monitor Graphs on page 397

 ➤  Managing Online Graphs on page 400

 ➤  Customizing the Online Monitor View on page 401

 ➤  Displaying Network Delay Data on page 405

 ➤  Drilling Down Diagnostics Data on page 407
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Overview of Online Monitoring

When designing a load test, you configure monitors and the measurements 
that you want to view in the load test so that when you run the load test 
you can monitor information about the load that Vusers generate on your 
Web server and other applications.

Performance Center provides the following online monitors:

➤ The Run-Time monitor displays the number and status of Vusers 
participating in the load test, as well as the number and types of errors that 
the Vusers generate. It also provides the User-Defined Data Point graph that 
displays the real-time values for user-defined points in a Vuser script. For 
more information about Run-Time monitoring, see the HP Performance 
Center Monitor Reference.

➤ The Transaction monitor displays the transaction rate and response time 
during load test execution. For more information about Transaction 
monitoring, see the HP Performance Center Monitor Reference.

➤ The Web Resource monitor measures statistics at the Web servers during 
load test runs. It provides information about the number of Web 
connections, throughput volume, HTTP responses, server retries, and 
downloaded pages during the load test. For more information on the Web 
Resource monitor, see the HP Performance Center Monitor Reference.

➤ The System Resource monitors gauge the Antara FlameThrower, Windows, 
Unix, SiteScope, and Server ResourcesTUXEDO, SNMP, used during a load 
test. To activate the System Resource monitors, you must set the monitor 
options before you run your load test. For information on setting these 
options, see the HP Performance Center Monitor Reference.

➤ The Network monitor displays information about the network delays on 
your system. To activate the Network monitor, you must set up the network 
paths to monitor before you run your load test. For more information about 
Network monitoring, see the HP Performance Center Monitor Reference.

➤ The Firewall monitor measures statistics at the firewall servers during the 
load test. To activate the Firewall monitor, you must set up a list of resources 
to monitor before you run your load test. For more information about 
Firewall Server Performance monitoring, see the HP Performance Center 
Monitor Reference.
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➤ The Web Server Resource monitors measure statistics at the Apache, 
Microsoft IIS, iPlanet (SNMP) and iPlanet/Netscape Web servers during the 
load test. To activate the Web Server Resource monitors, you must set up a 
list of resources to monitor before you run your load test. For more 
information, see the HP Performance Center Monitor Reference.

➤ The Web Application Server Resource monitors measure statistics at the 
Ariba, ATG Dynamo, BroadVision, ColdFusion, iPlanet (NAS), MS Active 
Server Pages, Oracle9iAS, SilverStream, WebLogic (JMX), WebSphere 
application servers during the load test. To activate the Web Application 
Server Resource monitors, you must set up a list of resources to monitor 
before you run your load test. For more information, see the HP Performance 
Center Monitor Reference.

➤ The Database Server Resource monitors measure statistics related to the 
SQL, DB2, Sybase, and Oracle servers. To activate the database server 
monitors, you must set up a list of measurements to monitor before you run 
your load test. For more information, see the HP Performance Center Monitor 
Reference.

➤ The Java Performance monitor measure statistics of Java 2 Platform, 
Enterprise Edition (J2EE) objects using the J2EE server machine. To activate 
the J2EE Performance monitor, you must set up lists of resources to monitor 
before you run your load test. For more information, see the HP Performance 
Center Monitor Reference.

➤ The Application Deployment Solutions monitor measures statistics of the 
Citrix MetaFrame XP and 1.8 servers during a load test run. To activate the 
Citrix MetaFrame XP monitor, you must set the monitor options before you 
run your load test. For information on setting these options, see the HP 
Performance Center Monitor Reference.

➤ The ERP/CRM Server Resource monitors measure statistics of the SAP, 
SAPGUI, SAP Portal, Siebel Server Manager, Siebel Web Server, and 
PeopleSoft (Tuxedo) during a load test run. To activate the ERP/CRM 
monitors, you must set the monitor options before you run your load test. 
For information on setting these options, see the HP Performance Center 
Monitor Reference.
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➤ The Application Component monitors measure statistics of the Microsoft 
COM+ and Microsoft .NET CLR servers during a load test run. To activate 
the Application Component monitors, you must set the monitor options 
before you run your load test. For information on setting these options, see 
the HP Performance Center Monitor Reference.

➤ The Middleware Performance monitor measures statistics of the Tuxedo 
server during a load test run. To activate the Tuxedo monitor, you must set 
the monitor options before you run your load test. For information on 
setting these options, see the HP Performance Center Monitor Reference.

➤ The J2EE/.NET Diagnostics monitors provide information to trace, time, and 
troubleshoot individual transactions through J2EE/.NET Web, application, 
and database servers. To activate the J2EE/.NET Diagnostics monitors, you 
must set up the J2EE/.NET Diagnostics module to communicate with the 
mediator machine and define the servers that you want to monitor. For 
more information, see Chapter 34, “HP Diagnostics Integration with 
Performance Center.”

Tip: At the conclusion of the load test, you can use HP Analysis, to view a 
summary and graphs of the data collected from these monitors during the 
load test run. For detailed information on the available graphs, see the HP 
LoadRunner Analysis User Guide.

Setting Monitoring Options

Before running your load test, you can set the data sampling rate, and 
debugging and frequency settings for the online monitors. 

You set these options from Project > Options > Monitors. For more 
information, see “Setting Monitor Options” on page 281.
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Viewing Online Monitor Graphs

During a load test run, you can view graphs that display information about 
the load test. This information is obtained from online monitors that are 
configured before or while running a load test. 

This section describes:

➤ “Online Monitor View at a Glance” on page 397

➤ “Displaying Online Monitor Graphs” on page 398

➤ “Optimizing the Online Monitors View” on page 399

Online Monitor View at a Glance
When you start a load test (see “Starting a Load Test” on page 353), the Load 
Test Run page opens, displaying the online monitor view.

 

The online monitor view contains the graph tree, the graph display area, 
and the graph legend.

Graph Tree

The graph tree displays a list of the configured online monitors graphs.

Graphs 
Tree

Graph 
Legend

Graph Display 
Area
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Graph Display Area

The graph display area displays the online activity of the selected monitors. 
You can display up to six graphs in this area, and you can open displayed 
graphs in their own enlarged windows. You can freeze the graphs to view 
specific data and then resume viewing current data. You configure graph 
display properties in the graph display area.

Graph Legend

The graph legend is located below the graph display area. For any graph 
selected in the display area, the legend displays data about each 
measurement in the graph. You configure the measurement display 
properties in the legend.

Displaying Online Monitor Graphs 
When you start running a load test, online monitor activity is displayed in 
the graph display area. You can select how many monitor graphs to display, 
and customize how to display the measurements in each graph. You can 
display graphs in separate windows, enabling you to view many graphs 
simultaneously. While viewing the graphs, you can change the refresh rates 
of the graphs. You can freeze graphs to study data displayed, and then 
resume watching the graph online.

Note: Performance Center saves the changes to your view so that the next 
time you run the load test, the changes you made are displayed. This 
enables you to configure a different online view for each load test according 
to the data you want to see.

To view a graph in the graph display area:

➤ In the graph tree, click the name of the graph you want to display. The 
graph is displayed in the graph display area and is highlighted by a blue 
border.

The graph legend below the graph display area displays the graph’s details— 
the scale of the graph, and the maximum, minimum, average, standard, and 
last values for each measurement in the graph. 
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Note: A value of a measurement in the format xE+y denotes a value 
equivalent to x * 10y.

To sort the measurements in the legend by one of these values, click the 
relevanr column heading. An arrow icon is displayed beside the column 
heading, showing you whether the measurements are sorted in ascending 
(up arrow) or descending (down arrow) order.

Optimizing the Online Monitors View
When running a load test, you can optimize the online monitors view by:

➤ maximizing the online monitors pane

➤ opening graphs in their own windows

To maximize online monitors pane:

➤ Hide the graph tree by clicking the Hide Graph Tree button in the top right 
corner of the graph tree pane.

➤ Hide the Performance Center left menu by clicking the double arrow on the 
bottom left corner of the menu pane.

➤ Expand the online monitors pane by dragging the upper border splitter 
upwards.
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To open a graph in a new window:

➤ Select a graph and click the Open in New Window button. 

A new graph window opens displaying the selected graph.

The new graph window has the same functionality as the online monitor 
view of the Load Test Run page. (See ““Customizing the Online Monitor 
View” on page 401.) Configuring graphs in this window does not affect the 
configuration of other graph windows. 

Managing Online Graphs

You duplicate, rename, and delete monitor graphs from the graph tree. You 
can also configure graph display properties from the graph tree.

When you select a graph, a small down arrow appears in the graph tree to 
the left of the graph name. When you click the arrow, a drop-down menu 
opens. 

To duplicate a graph:

 1 In the graph tree, select the graph you want to duplicate.

 2 Click the down arrow next to the graph name, and select Duplicate. The 
duplicated graph is listed in the graph tree.

 3 To display the graph in the graph display area, select it in the tree.

To rename a graph:

 1 In the graph tree, select the graph you want to rename.

 2 Click the down arrow next to the graph name, and select Rename.

 3 Rename the graph and click OK.
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To delete a graph:

 1 In the graph tree, select the graph you want to delete.

Note: You can delete a duplicated graph only.

 2 Click the down arrow next to the graph name, and select Delete.

 3 Confirm that you want to delete the graph. 

The graph is removed from the graph tree.

Customizing the Online Monitor View

You can customize your online monitors view to display graphs and data 
according to your needs. Performance Center saves these settings per user 
per load test. This means that:

➤ You can define different display options for each load test.

➤ Each time you run a load test, Performance Center display the settings 
that you selected the previous time you ran that load test. Other users 
who run the same load test can select different display settings which are 
displayed when they run the load test.

This section describes:

➤ “Viewing Measurements in the Graph” on page 399

➤ “Selecting Number of Graphs to Display” on page 399

➤ “Configuring the Graph Display” on page 400

➤ “Refreshing the Graph Data” on page 401
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Viewing Measurements in the Graph

Performance Center displays graphs with their default measurements. You 
can select which measurements to display and which ones to hide. You can 
display a measurement in bold and customize its color.

To configure a measurement’s appearance:

 1 Select a graph. The graph legend displays the measurements that appear in 
the graph.

 2 Configure each measurement as follows:

➤ To show or hide a measurement, select or clear the check box in the 
V column.

➤ To display the measurement in bold in the graph, select the check box in 
the B column.

➤ To change the color of a measurement, click the color box adjacent to the 
measurement, select a color or type a color code (hexadecimal) and click 
OK. 

To highlight a measurement in the graph:

➤ Select the line in the graph or the measurement the legend. 

Selecting Number of Graphs to Display

You can display one to six graphs in the graph display area. 

To select a number of graphs to display:

➤ In the graph display area, click the # Graphs button and select the number 
of graphs to display.

The graph display area is updated accordingly.
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Configuring the Graph Display

You can select the interval over which to view a graph, set how to display 
the time on the x-axis, and select a scale to use for the graph.

To configure the graph display:

 1 Select a graph.

 2 Click the Graph Configuration button. 

The Graph Configuration dialog box opens.

 3 Select the configuration options as follows:

Property Description

Granularity The interval of the load test displayed in the graph:

Last minute; Last 3 minutes; Last 10 minutes; Last hour; 
Whole load test

Time Display The time displayed on the x-axis:

➤ Relative to load test start. Displays the amount of time 
that has elapsed since the beginning of the load test (in 
hours, minutes, and seconds)

➤ Controller clock. Displays the time on the Controller 
clock.

➤ None. No clock or time is displayed.

Scale ➤ Automatic. Each measurement in the graph is displayed 
in the scale that best suits it.

➤ None. Each measurement’s true values are displayed in 
the graph.

Line Style ➤ With markers. Lines in the graph are marked with dots.

➤ Without markers. Lines in the graph are smooth.

Display DNS 
names

Network Delay Time graph only. 

Displays the DNS name of each measurement, in addition to 
its IP address. 

Note: This option assumes that the Network Delay Time 
monitor was configured to enable display of network nodes 
by DNS names. For more information, see the HP 
Performance Center Monitor Reference.
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 4 To apply the selected configuration options to all the graphs displayed in 
the window, select Apply to all visible graphs.

 5 Click OK.

Refreshing the Graph Data

You can change the frequency at which Performance Center refreshes the 
displayed graph data. 

To modify the refresh frequency of the graphs:

➤ Click the Refresh Frequency button, and select a rate at which Performance 
Center should refresh the graphs. 

➤ To freeze the graphs in their current frames, click the Freeze Graphs button. 
To resume refreshing the graphs according to the selected refresh frequency, 
click the Resume Auto-Refresh button.
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Displaying Network Delay Data

The Network Delay Time monitor graph shows the network path delay for 
the complete path between the source and destination machines. Each path 
defined in the Network Delay Monitor page is represented by a separate line 
with a different color in the graph. 

You can also view the delay time of sub-paths and segments of the network 
paths.

To view delay time for each of the sub-paths of the network path:

 1 Select the Network Delay Time graph.

 2 Make sure that the full paths are displayed—click the Network Breakdown 
button and select Full Paths. 

 3 Select the path to break down.

 4 Click the Network Breakdown button again and select Sub Paths.

The graph displays the delay time from the source machine to each of the 
nodes along the network path.



Chapter 25 • Online Monitor View

406

To view the delay time for each segment of the network path:

 1 Select the Network Delay Time graph.

 2 Make sure that the full paths are displayed—click the Network Breakdown 
button and select Full Paths. 

 3 Select the path to break down.

 4 Click the Network Breakdown button again and select one of the following:

➤ Segments of Areas. Displays the segments of the network path in an area 
graph.

➤ Segments as Pie. Displays the segments of the network path in a pie 
graph.

Note: The segment delays are measured approximately, and do not add 
up to the network path delay which is measured exactly. The delay for 
each segment of the path is estimated by calculating the delay from the 
source machine to one node and subtracting the delay from the source 
machine to another node. For example, the delay for segment B to C is 
calculated by measuring the delay from the source machine to point C, 
and subtracting the delay from the source machine to point B. 
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Drilling Down Diagnostics Data

Important: This section assumes that your Performance Center system is 
configured to work with HP Diagnostics.

During a load test, you can view HP Diagnostics data for the whole load test 
or you can drill down to HP Diagnostics data from a particular transaction.

To view a summary screen of the load test run in HP Diagnostics:

➤ On the right of the Load Test Run page, click Diagnostics, 

HP Diagnostics opens, displaying the Scenario Summary dashboard view.

The Scenario Summary dashboard view displays monitoring versions of the 
transactions, server requests, load, and probe views for the current run. For 
more information about the working with HP Diagnostics, see the HP 
Diagnostics User Guide.

To drill down to HP Diagnostics data from a particular transaction:

 1 In the graph tree, select the Transaction Response Time graph.

 2 In the graph legend, click the transaction that you want to break down. 

 3 Click the Transaction Breakdown button.

HP Diagnostics opens, displaying the Transactions view, which contains 
performance metrics and drill down options for the relevant transaction.
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For more details about interpreting data in the Diagnostics Transactions 
view see the section that described the transaction views in the HP 
Diagnostics User Guide.
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26
Analyzing a Load Test

When a load test is finished, Performance Center automatically organizes 
the load test data. The data can then be analyzed and placed into various 
graphs and reports, or downloaded to a local machine for analysis, then 
uploaded back to Performance Center.

This chapter includes:

 ➤  About Analyzing a Load Test on page 410

 ➤  Collating and Analyzing Load Test Data on page 412

 ➤  Viewing Load Test Results on page 417

 ➤  Viewing the Analysis Summary Report on page 423

 ➤  Integration with HP LoadRunner Analysis on page 427

 ➤  Downloading Result and Session Files on page 431

 ➤  Uploading Session Files and Reports on page 433
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About Analyzing a Load Test

When a load test is finished, Performance Center performs post-run analysis 
according to the setting you selected in the Options tab of the Timeslots 
page (see “Configuring Post-Run Analysis Settings” on page 101). If you did 
not select a post-run analysis setting, Performance Center automatically 
collates the test data.

If you stop a load test before it is finished, you can override the post-run 
analysis option, and select to collate data immediately, collate and analyze 
data immediately, or delay collation until a later time. For more information 
on stopping load tests, see “Stopping a Load Test Run” on page 390. For 
more information on collating and analyzing results, see “Collating and 
Analyzing Load Test Data” on page 412.

After the load test data is collated and analyzed, you can view load test 
results in the default summary report and graphs. 

Additionally, you can analyze load test data off-line, from any computer on 
which Standalone Analysis is installed. Standalone Analysis enables you to 
generate various graph views, merge graphs, drill down within graphs, 
change zoom level and granularity, and create custom reports and graphs to 
suit your particular needs. 

To integrate with Standalone Analysis, you must connect Analysis to 
Performance Center. You can then download result and session files for 
analysis on a local machine. After analyzing the files, you can upload the 
session data and reports to Performance Center, and share the results with 
other users. For more information, see “Integration with HP LoadRunner 
Analysis” on page 427.
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Note: 

➤ Collating results may place excessive stress on a machine that is running 
a load test. Performance Center will alert you if a test is running on the 
Controller machine that will do the collating.

➤ When the Controller is collating and analyzing test data, it is not 
available for another load test scheduled for the same time.
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Collating and Analyzing Load Test Data

At the conclusion of the test run, Performance Center performs post-run 
analysis. The table below shows the post-run analysis settings, and the 
corresponding run status and options available for viewing run data on the 
Load Tests Results page. 

You set the post-run analysis settings in the Timeslots page > Options tab. 
For more information, see “Configuring Post-Run Analysis Settings” on 
page 101.

Post-Run 
Analysis 
Settings

Description
Run Status 
(Load Tests 
Page)

Available Options

Downloadable 
Files
(Files and 
Reports tab)

Do not 
Collate 
results

Frees the machines 
immediately after the 
load test ends. You can 
collate and analyze 
results at a later time.

Before 
Collating 
Results

➤ Collate Results

➤ Delete Temporary 
Results 

➤ Edit Load Test

None

Collate 
Only

Performance Center 
collates the run data from 
the load generators and 
automatically deletes 
temporary results from 
them. You can download 
the raw results and 
manually analyze results 
at a later time.

Before 
Creating 
Analysis 
Data

➤ Analyze Results

➤ Delete Temporary 
Results 

➤ Edit Load Test

➤ Raw results 
file

If Performance Center is 
unable to collate data, 
follow the instructions in 
the error message and 
collate the data again.

Failed 
Collating 
Results 

➤ Collate Results

➤ Delete Temporary 
Results 

➤ Edit Load Test

None
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Note: If the Delete Temporary Results option is selected (selected by default) 
in the Administrations Site’s General Settings page, Performance Center 
automatically deletes the temporary results from the load generators. To 
allow manual deletion of the temporary results, clear this option.

Collate 
and 
Analyze 
results

Performance Center 
collates the run data from 
the load generators and 
generates analysis data. 
After data is collated, 
Performance Center 
automatically deletes 
temporary results from 
the load generators and 
Controllers. You can 
display the results using 
analysis graphs and 
reports, or download 
them for analysis on a 
local machine.

Finished ➤ Download Logs

➤ Edit Load Test

➤ Summary 
Report

➤ Results file

➤ Raw results 
file

If Performance Center is 
unable to generate 
analysis data, you can 
download the raw results, 
and analyze them using 
Standalone Analysis.

Failed 
Creating 
Analysis 
Data

➤ Delete Temporary 
Results

➤ Edit Load Test

➤ Raw results 
file

Post-Run 
Analysis 
Settings

Description
Run Status 
(Load Tests 
Page)

Available Options

Downloadable 
Files
(Files and 
Reports tab)
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Collating Results
Performance Center collates the run data from the load generators. If you 
selected the Do not collate results post-run Analysis setting, Performance 
Center does not automatically collate the results, and you need to collate 
and then analyze the data before you can view test results.

To collate results:

 1 On the Load Tests page, click the Before Collating Results link for the run. 
The Load Test Results page opens, displaying the following options on the 
right of the Files and Reports tab:

 2 Click Collate Results. The Controller gathers the results from the load 
generators and merges the results into a single package. Performance Center 
automatically deletes the temporary results from the load generators.

Note: If a test is running on the Controller that will do the collating, 
Performance Center issues an alert. Click OK to proceed with collating 
results, or Cancel to defer collating and analyzing results.

 3 At the end of result collation, you can analyze test results (see “Analyzing 
Results” on page 416), or download the raw results for analysis on a local 
Analysis machine. 

For more information about using Standalone Analysis, see “Integration 
with HP LoadRunner Analysis” on page 427.
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Failure to Collate Results

If there is a problem collating the load test data, an error message is 
displayed.

Collate the results again, or follow the instructions in the error message.
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Analyzing Results
After Performance Center collates load test results (see “Collating Results” 
on page 414), it must generate analysis data before you can view test results.

To analyze results:

 1 On the Load Tests page, click the Before Creating Analysis Data link for the 
run. The Load Test Results page opens, displaying the following options on 
the right of the Files and Reports tab:

 2 Click Analyze Results. Performance Center generates analysis data and 
automatically deletes the temporary results from the load generators and the 
Controller. After Performance Center analyzes the load test data, you can 
view the results for the load test (see “Viewing Load Test Results” on 
page 417), or download the log files and summary report (see “Viewing the 
Analysis Summary Report” on page 423). 

Note: If Performance Center is unable to analyze the load test data or to 
delete the temporary results automatically, the Delete Temporary Results 
link becomes available.
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Failure to Create Analysis Results

If Performance Center is unable to analyze the load test data, an error 
message is displayed.

You can download the raw results from Load Test Results page (see “File and 
Reports Table” on page 418), and analyze them using Standalone Analysis. 

For more information about analyzing results using Standalone Analysis, see 
“Integration with HP LoadRunner Analysis” on page 427.

Viewing Load Test Results

If you selected Collate and analyze results in the post-run Analysis settings, 
(Timeslot page > Options tab) Performance Center automatically collates 
and analyzes the load test data. The status displayed on the right side of the 
Load Test Run page changes as the test results are collated and analyzed. At 
the end of result analysis, you can view the results, or to restart the test.

If you select to restart the test, the test begins again. 

If you select to view the results of the test, the Load Test Results page opens. 
The Load Test Results page contains the following tabs:

➤ Files and Reports. Displays the summary report, result file, session files, 
and HTML reports, and allows users with the relevant permissions to 
upload files. Also displays links that let you collate/analyze test results, 
edit tests, and access test results. For more information, see “Files and 
Reports Tab” on page 418. 
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➤ Results vs. Targets. Displays the Load Test Targets and Results table which 
contains an analysis of the performance targets for the test with the 
results from the load test run. Also enables you to publish the load test 
results to the Dashboard. For more information, see “Results vs. Targets 
Tab” on page 420.

Files and Reports Tab
The Load Test Results page opens by default on the Files and Reports tab 
which displays:

➤ Files and Reports table. Displays load test result files, session files, and 
HTML reports, and allows users with the relevant permissions to upload 
files. 

➤ Load Test Description area. Contain links that enables you to 
collate/analyze test results, edit tests, and access test results. Also provides 
area for user comments about the load test run.

File and Reports Table

You can access run result files that are automatically generated by 
Performance Center, and any other user-uploaded files from the Files and 
Reports tab. 
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After Performance Center has successfully collated and analyzed the result 
data, the Files and Reports table contains the following files:

➤ Report.html. A summary report of the data collected during the load test 
that is automatically generated by Performance Center. This file cannot 
be deleted, although you can replace it with an alternative HTML report 
uploaded from Standalone Analysis. For more information, see “Viewing 
the Analysis Summary Report” on page 423.

➤ Results.zip. Contains the Analysis Session files that are automatically 
generated by Performance Center. The Results.zip file can be deleted or 
replaced by uploading a different one.

➤ RawResults.zip. Contains the original raw result files, which can be used 
at anytime to analyze the run. 

➤ In addition, the table might contains files that have been uploaded by 
users with the relevant permissions. 

You can download any of these files from the table.

To download a file from the Files and Reports table:

➤ In the Files and Reports table, click the file name link, and save the file to 
your local file directory.

To upload a file to the Files and Reports table:

 1 Click the Upload Files button. The Upload File dialog box opens.

 2 In the Upload File dialog box that opens, click Browse and select the file 
that you want to upload to Performance Center.

 3 (Optional) Type a comment about the file in the Comments box.

 4 Click Upload.

 5 Click Close to close the Upload File dialog box, and click the Refresh button 
in the Files and Reports tab to update the Files and Reports table.

To delete a file from the Files and Reports table:

➤ In the Files and Reports table, click the Delete button adjacent to the file 
you want to delete. The file is removed from the table.
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Load Test Description Area

In the Load Test Description area, Performance Center displays the 
following options:

➤ Collate Results. Performance Center collates the run data from the load 
generators. For more information, see “Collating Results” on page 414.

➤ Analyze Results. Performance Center generates analysis data, and 
displays the results in analysis graphs and reports. For more information, 
see “Analyzing Results” on page 416.

➤ Download Logs. Enables you to download a zip file containing Vuser log 
files, error and notification messages, or a summary report of the data 
Performance Center collected during the load test. For more information, 
see “Downloading Load Test Data Files” on page 422.

➤ Delete Temporary Results. Enables you to delete temporary result files 
from the load generator machines. If the Delete Temporary Results 
option in the Administrator Site is selected, this option only appears 
before data collation and analysis.

➤ Edit Load Test. Enables you to edit load test configuration settings.

➤ User Notes. Enables you to add user comments about the load test. To 
add a user note for the results, type your note in the User notes box, and 
click Save Notes.

Note: You can edit a load test, add user notes, and delete results even before 
collating and analyzing results.

Results vs. Targets Tab
The Results vs. Targets tab displays the name of the load test, the load test 
start time, and test duration.

The tab displays targets and results for load test runs with Finished status 
only. If you select a load test run that does not have the Finished status, you 
must collate and analyze the run data before you can view performance 
targets and results.
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If you set performance targets using the SLA wizard, Load Test Targets and 
Results table shows performance targets that you specified for the test 
compared to the actual run results. Results marked in red show transactions 
that did not achieve their specified targets.

Note: 

➤ The Load Test Targets and Results table may contain approximate data if 
target values were set that cannot be actually measured. For example, if 
you specified load levels targets for 10, 20, and 30 running Vusers, and 
during the test only 10 and 30 Vusers ran, Performance Center calculates 
the value for 20 Vusers based on the results for 10 and 30 Vusers

➤ The transaction response time displayed in the dashboard automatically 
includes think time (if lr_think_time was part of the script's transactions). 
You can disable think time by selecting Ignore think time in the 
General:Think Time tab of the script's run-time settings the next time you 
run the test.

You can publish (or remove) the targets and results for the load test run to 
the Dashboard. For more information, see “Viewing Load Test Performance 
Targets and Results” on page 47.
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Downloading Load Test Data Files
You can download a zip file containing Vuser log files, error and notification 
messages, or a summary report of the data Performance Center collected 
during the load test.

To download a zip file containing load test data:

 1 On the Load Test Reults page, in the Files and Reports tab, click the 
Download Logs link. The Download Test Results dialog box opens.

 2 Select the type of data file that you want to download and save to your local 
directory.

➤ Download Vuser Logs. Downloads a zip file containing all the Vuser log 
files.

➤ Download Messages. Downloads a zip file containing the error and 
notification messages.

➤ Download Report. Downloads a zip file containing the default Analysis 
Summary report.

 3 Click Close to close the Download Test Results dialog box.
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Viewing the Analysis Summary Report

After a load test run is completed and you have analyzed the data gathered 
during the run, you can view a summary report of the load test results.

In the Load Test Results page, in the Files and Reports table, click 
Reports.html.
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Performance Center displays an Analysis Summary report of the data 
collected during the load test.

The summary report provides general information about load test 
execution, lists statistics about the load test run, and provides links to 
graphs containing load test data.
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The appearance of the summary report, and the information displayed, 
varies depending on whether you defined performance targets for your load 
test.

Performance targets define goals for the load test. Performance Center 
measures these goals during the load test and analyzes them in the summary 
page. For more information on performance targets, see Chapter 8, 
“Defining Performance Targets.”

Note: A transaction that contains the "@" symbol in its name will not 
display performance targets results. To view results, rename the transaction 
so that it does not contain the symbol.

The summary report contains the following sections:

➤ Load Test Details. This section shows the basic details of the load test 
being analyzed.

➤ Statistics Summary. This section shows a breakdown of the transaction 
statistics.

➤ X Worst Transactions (Only if performance targets defined). The X Worst 
Transactions table shows the worst transactions in terms of how often 
the transactions exceeded the SLA boundary during the load test, and by 
how much.

➤ Scenario Behavior Over Time. This section displays the average errors per 
second received by the application under test per time interval. 

➤ Where performance targets were defined, this section shows how each 
transaction performed in terms of the SLA over time intervals.

➤ Transaction Summary. This section displays a table containing the load 
test’s diagnostics data. Included in this data is a percentile column (x 
Percent). This column indicates the maximum response time for that 
percentage of transactions performed during the run.

➤ HTTP Responses Summary. This section shows the number of HTTP 
status codes returned from the Web server during the load test, grouped 
by status code.
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Note: There are additional Diagnostics sections that may appear at the end 
of the summary, depending on the configuration of your system.

Analysis creates a separate report for each one of the open graphs. To open a 
graph report, select the graph listed in the left menu. Each graph report 
displays the graph name, result location, filters, group by settings, 
granularity, and transaction legend. The report also provides a link to an 
Excel file containing the graph data.

For more details regarding the summary page, see the relevant section in the 
HP LoadRunner Analysis User Guide.
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Integration with HP LoadRunner Analysis

HP LoadRunner Analysis lets you analyze load test data off-line, from any 
computer on which Analysis is installed. You use Analysis to generate 
various graph views, merge graphs, drill down within graphs, change zoom 
level and granularity, and so forth. A standalone version of Analysis is 
available from the Downloads page of the Performance Center User Site.

Analysis integrates with Performance Center to let you analyze data 
collected during a Performance Center run. You can download raw results 
and sessions for analysis on a local machine. After analyzing the data, you 
can upload the analysis data (Microsoft Word and HTML reports) to 
Performance Center to share the results with other users. The files and 
reports are available from the Load Test Results page.

For Analysis to access a Performance Center project, your version of Analysis 
must be properly configured, and you must connect Analysis to 
Performance Center. 

Note: You must have the latest standalone installation of HP LoadRunner 
Analysis to use this feature.

To check for proper upload/download configuration in HP LoadRunner 
Analysis:

 1 Start HP LoadRunner Analysis.

 2 Select Tools.

If the menu item Performance Center Connection is available on the Tools 
menu, your version of Analysis is enabled to upload/download analysis files.

If your version of Analysis is not enabled to do uploads/downloads or if you 
do not have Analysis installed on your machine, you need to uninstall your 
older version, and install a newer version of Analysis. To uninstall Analysis, 
select it in Control Panel > Add/Remove Program Files, and click Remove.
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To install Standalone Analysis or update an installed version of Analysis:

 1 Select Miscellaneous > Downloads.

 2 Click the Standalone Analysis Download link to install the full standalone 
version of Analysis. For more information, see “Downloads Page” on 
page 34.

 3 Follow the download instructions.

Once you have a version of Analysis that is enabled, you can connect 
Analysis to Performance Center and upload and/or download files. 

Connecting HP LoadRunner Analysis to Performance 
Center
You can connect Analysis to a Performance Center project at any time 
during an Analysis session.

The connection process has two stages. First, you connect Analysis to a local 
or remote Performance Center Web server. This server handles the 
connections between Analysis and the Performance Center project.

Next, you select the Performance Center project, load test, and load test run 
from/to which you want to download/upload files. Note that Performance 
Center projects are password protected, so you must provide a user name 
and a password.
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To connect Analysis to Performance Center:

 1 In Analysis, select Tools > Performance Center Connection. The Configure 
Performance Center Connection dialog box opens.

 2 In the URL box, type the URL address of the Web server on which 
Performance Center is installed. The URL address should be in the format: 

 3 Type your User Name and Password. Contact your Performance Center 
administrator if you need assistance.

To automate the login process, select Remember user name and password. 
The specified user name and password are saved to the registry, and 
displayed each time you open the dialog box. 

 4 To automatically open the connection to the Performance Center server 
when you start Analysis, select Auto connect on start. Analysis attempts to 
connect to Performance Center using the configuration information 
displayed.

http://<server_name>/loadtest
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 5 Click Connect to connect to Performance Center. The Performance Center 
Connection dialog box displays the connection status.

Once the connection is established, all the fields are displayed in read-only 
format, and the Connect button changes to Disconnect. 

Note: You cannot connect to Performance Center and Quality Center at the 
same time.

Disconnecting HP LoadRunner Analysis from Performance 
Center 
You disconnect Analysis from the Performance Center Web server using the 
Configure Performance Center Connection dialog box.

To disconnect Analysis from Performance Center:

 1 In Analysis, select Tools > Performance Center Connection. The Configure 
Performance Center Connection dialog box opens.

 2 Click the Disconnect button. Analysis disconnects from Performance 
Center, and the dialog box closes.
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Downloading Result and Session Files

When Analysis is connected to a Performance Center project, you can 
download analysis result and session files stored on the Performance Center 
server. You locate result and session files according to their position in the 
projects tree.

When downloading a new session, Analysis prompts you for the load test 
result file (.lrr extension) to include in the download. To download an 
existing Analysis session with display information and layout settings for 
the active graphs, you specify an Analysis session file (.lra extension). 

To download a results file to Analysis:

 1 Connect to the Performance Center server. For more information, see 
“Connecting HP LoadRunner Analysis to Performance Center” on page 428.

 2 In Analysis, select File > New. The Open Result File for New Analysis Session 
dialog box opens and displays the load test project tree on the Performance 
Center server.

Note: Performance Center displays only those projects that the user has 
rights to access.
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 3 Select the relevant result file by browsing the project, test, and run folders in 
the projects tree. Result files are identified by a result icon. 

To expand the tree and view sublevels, double-click closed folders. To 
collapse the tree, double-click open folders. 

To open a result file from the file system (while connected to Performance 
Center), click File System. The Open Result File for New Analysis Session 
dialog box opens displaying the file system. Browse to the directory of the 
file that you want to open, and click Open. 

 4 Click OK to download the file and analyze the results. The downloaded 
result file is saved to your temp directory. If the download fails, an error 
message is displayed.

To download a session file to Analysis:

 1 Connect to the Performance Center server. For more information, see 
“Connecting HP LoadRunner Analysis to Performance Center” on page 428.

 2 In Analysis, select File > Open. The Open Session dialog box opens and 
displays the load test project tree on the Performance Center server.

Note: Performance Center displays only those projects that the user has 
rights to access.
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 3 Select the relevant session file by browsing the project, test, and run folders 
in the projects tree. Session files are identified by a session icon. 

To expand the tree and view sublevels, double-click closed folders. To 
collapse the tree, double-click open folders. 

To open a session file from the file system (while connected to Performance 
Center), click File System. The Open Existing Analysis Session File dialog 
box opens displaying the file system. Browse to the directory of the file that 
you want to open, and click Open. 

 4 Click OK to download the file and open the session. The downloaded 
session file is saved to your temp directory. If the download fails, an error 
message is displayed.

Uploading Session Files and Reports

When Analysis is connected to Performance Center, you can upload 
Analysis session files and save them to a Performance Center project, or to 
the local file system. To save a session file to a Performance Center project, 
you give it a descriptive name and specify the directory to which you want 
to upload the file in the projects tree. If Analysis is not connected to 
Performance Center, you can save the session file to your local file system. 
Later, when Analysis s is connected to Performance Center, you can upload 
the file to Performance Center.

You can also upload Analysis HTML and Word reports and save them to a 
Performance Center project.
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To upload an Analysis session file to a Performance Center project:

 1 Connect to the Performance Center server. For more information, see 
“Connecting HP LoadRunner Analysis to Performance Center” on page 428.

 2 In Analysis, select File > Save. The Performance Center Save As dialog box 
opens displaying the load test project tree on the Performance Center server.

Note: Performance Center displays only those projects that the user has 
rights to access.

 3 Select the Performance Center project, load test, and run directory to which 
you want to upload the file.

To expand the tree and view sublevels, double-click closed folders. To 
collapse the tree, double-click open folders. Note that when you select a run, 
the sessions that belong to the run are displayed in the tree.

To save the session to the file system, click File System. Browse to the 
directory where you want to save the files, and click Save.

Note: You must disconnect from Performance Center before you can save a 
session on the file system.
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 4 In the File name box, type a name for the session file. Make sure that file 
names consist of English letters, digits, or the underscore character, and do 
not exceed 250 characters.

 5 Click OK to upload the session file to Performance Center. A progress 
indicator displays the progress of the upload. 

If the upload fails, an informative error message is displayed.

To upload a session file from the file system:

 1 Connect to the Performance Center server. For more information, see 
“Connecting HP LoadRunner Analysis to Performance Center” on page 428.

 2 In Analysis, select File > Open. The Performance Center Open Session dialog 
box opens displaying the load test project tree on the Performance Center 
server.
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 3 Click File System. The Open Existing Analysis Session File dialog box opens.

 4 Browse to the directory where the session file is saved, and click Open. The 
session opens in Analysis.

 5 Select File > Save As. The Performance Center Save As dialog box opens 
displaying the load test project tree on the Performance Center server. 

 6 Continue with the upload procedures from step 3 of “Uploading Session 
Files and Reports” on page 433.
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To upload an HTML Report:

 1 Connect to the Performance Center server. For more information, see 
“Connecting HP LoadRunner Analysis to Performance Center” on page 428.

 2 In Analysis, select File > Upload to Performance Center > New HTML 
Report. The Upload HTML Report dialog box opens.

 3 In the Upload HTML Report dialog box, select the project, load test, and run 
directory to which you want to upload the HTML report. 

 4 In the File name box, type a name for the report. By default, the file name 
"Report" is displayed. The report name can only consist of English letters, 
digits, or the underscore character, and must not exceed 250 characters. 

You can type a description of the report in the Comment box.

 5 Click OK to create the HTML report and upload it to Performance Center. If 
the upload fails, an error message is displayed.
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To upload a Word report:

 1 Connect to the Performance Center server. For more information, see 
“Connecting HP LoadRunner Analysis to Performance Center” on page 428.

 2 In Analysis, select File > Upload to Performance Center > Existing Microsoft 
Word Report. The Upload Word Report dialog box opens.

 3 Click the Browse button, and navigate to the Word report that you want to 
upload. The path of the selected report is displayed in the File name box.

You can add a description of the report in the Comment box.

 4 In the Select upload location section, select the project, load test, and run to 
which you want to upload the report.

 5 Click OK. Analysis uploads the Word report to Performance Center. If the 
upload fails, an error message is displayed.
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27
Trend Reports

Trend reports allow you to compare performance trends over time, thereby 
giving you better visibility and control of your application’s performance.

This chapter includes:

 ➤  About Trend Reports on page 440

 ➤  Understanding Trend Report Components on page 440

 ➤  Trend Reports Main Page at a Glance on page 441

 ➤  Creating Trend Reports on page 445

 ➤  Viewing Trend Reports on page 449

 ➤  Adding Load Test Runs to Trend Reports on page 451

 ➤  Viewing the Trended Load Test Runs on page 454

 ➤  Customizing the Trended Runs Table on page 458

 ➤  Managing Trend Report Tabs on page 459

 ➤  Working with Trend Views on page 463

 ➤  Understanding Trend View Information on page 470

 ➤  Comparison Methods on page 475

 ➤  Setting Trend Thresholds on page 478

 ➤  Custom Measurement Mapping on page 481

 ➤  Measurement Acronyms on page 488

 ➤  Deleting Trend Reports on page 490
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About Trend Reports

The Performance Center Trend reports provide you with the ability to 
compare performance trends over time, thereby giving you better visibility 
and control of your application’s performance. Using trend thresholds, you 
can easily identify any performance regression and focus your analysis 
efforts accordingly.

Understanding Trend Report Components

Trend reports are made up of the following components:

➤ Trend view. A trend view is a display item that presents trending 
information for a particular performance metric, for example, transaction 
response time. You can customize the functionality of any individual trend 
view and select one of three display settings, either table view, line graph 
view, or stacked bar chart view. Trend views of similar categories can be 
grouped together under a single trend report tab.

➤ Trend report tab. A trend report consists of various tabs, where each tab can 
contain any number of trend views. The tabs are defined by a template 
which sets the name of the tab and automatically includes trend views that 
are related to its name. 

The tabs are fully customizable. That is, you can modify any of the tab 
settings, and add or remove trend views to suit your needs. 

➤ Trend report template. Performance Center lets you create a trend report 
based on one of four predefined templates. Each template has a specific area 
of focus and provides a combination of tabs and trend views based on that 
focus.
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Trend Reports Main Page at a Glance

From the main Trend Report page, (Load Tests > Trend Reports) you can 
create, view, duplicate, and delete trend reports.

The Trend Reports page contains the following components:

➤ Trend Reports Toolbar

➤ Trend Reports Table 

➤ Trend Report Information Pane
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Trend Reports Toolbar
You use the toolbar buttons to perform the following actions.

Trend Reports Table
Each row in the Trend Reports table represents a trend report. The Trend 
Reports table displays the following:

➤ Report Name. The name of the report.

➤ Description. Description of the report. Note: Due to size limitations, the 
description may be only partially displayed. In this case, place the cursor 
over the column and a tooltip displaying the entire description appears.

➤ Date Modified. The date on which the report was last modified. 

Sorting and Filtering the Reports

You can sort the reports in the table in ascending or descending order by 
clicking the heading of the column by which you want to sort. Click the 
column heading again to reverse the sort order.

You filter the reports using the filter boxes below the column headings. 

Note: Sorting and filtering settings are saved per user, per project. The next 
time the same user enters the Trend Report page in a specific project, the 
page displays results based on the most recent sort order and filter.

Function Button Enables you to

Create New 
Report

Create a new trend report

Duplicate 
Report

Duplicate the selected trend report

Delete Report Delete the selected trend report

Refresh Refresh the Trend Reports page
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To filter the reports:

➤ In one of the filter boxes below the column headings, type the relevant text 
or select a value from the list. Press ENTER. 

The table displays reports according to the selected filter option.

➤ You can filter these results further by entering additional filter values for 
other columns in the table. 

Notes:

➤ The filter supports partial text entries. For example, if you entered th, the 
display list might include Seth, Thomas, and Anthony. 

➤ The filter does not support regular expressions or the following 
characters: : ; & * \ ' / # ~ , ? { } $ % | < > + = ` ^ [ ] !

Trend Report Information Pane
When you select a report from the table, the report details are displayed in 
the Trend Report Information pane in the lower area of the page. You can 
edit the Name and the Description fields.

Note: To edit report details, you need to have Edit Trend Report 
permissions.
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The details pane includes the following fields:

➤ Name. The name of the report.

➤ Description. A description of the report.

➤ Date Created. The date on which the report was last created.

➤ Date Modified. The date on which the script was last modified.

➤ Last Modified By. The user who last modified the report.

➤ Number of Trended Runs. The number of trended runs included in the 
report.

To edit the Name or Description fields:

 1 Type the relevant information in the Name or Description fields.

 2 To revert back to the original details that were displayed before you 
modified them, click Restore.

To save your changes to the details, click Save.

Note: Each trend report name must be unique.
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Creating Trend Reports

You create trend reports from the main Trend Report page.

To create a new trend report:

 1 On the Trend Reports page (Load Tests > Trend Reports), click the Create 
New Report button. The Trend Report creation page opens.

 2 In the General Details pane, enter a name and description for the report.

 3 In the Contents and Layout pane, select a template to use for the report.

When you select a template from the Template list, a description of the 
selected template appears in the Contents and Layout Description area. For 
more information on the Trend Reports templates, see “Trend Reports 
Templates” on page 447.
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 4 Click Create. The trend report is created and the <Trend Report Name> 
Trend Report page opens. 

 5 Add the load test runs to the report to view trending information. For more 
information, see “Adding Load Test Runs to Trend Reports” on page 451.
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Trend Reports Templates
The Trend Reports templates provide predefined categories of trend views 
based on the focus of each template. 

Note: Even though you can create a trend report using a template, the 
report remains fully customizable. That is, you can make any changes to the 
tabs and to the trend views they contain. For information on customizing a 
trend report, see “Managing Trend Report Tabs” on page 459 and “Working 
with Trend Views” on page 463.

The following templates are provided:

Transaction Trends

Th Transaction Trends template provides trend views that display trending 
information for the following measurements:

➤ Transaction response time

➤ Transaction summary

➤ Transactions per second

Transaction and Monitor Trends 

The Transaction and Monitor Trends template provides trend views that 
display trending information for the following measurements:

➤ Transaction response time

➤ Transaction summary

➤ System resources (specifically: CPU utilization, Disk utilization, and 
Available memory)
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Trend by Quality Attributes

This template provides trend views that display the trending information 
from the point of view of quality attributes. The following table shows 
which measurements are trended and by which quality attribute the 
information is displayed:

User-Defined

This template provides only the basic layout for the trend report with no 
further predefined tab or trend view configuration. 

For more information see:

➤ “Managing Trend Report Tabs” on page 459

➤ “Working with Trend Views” on page 463

Quality Attribute Trended Measurement

Performance Transaction response time (compared to baseline). 
For more information on comparison methods, see 
“Comparison Methods” on page 475.

System Performance CPU utilization

Disk utilization

Available memory

Availability Transaction Summary (compared to baseline). For 
more information on comparison methods, see 
“Comparison Methods” on page 475.

Repeatability Transaction percentiles (compared to baseline). For 
more information on comparison methods, see 
“Comparison Methods” on page 475.

Stability Errors Statistics

Transaction Failures
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Duplicating Trend Reports
You can duplicate a trend report with all its data.

To duplicate a trend report:

 1 On the Trend Reports page, select the trend report you want to duplicate.

 2 Click the Duplicate Report button. The Save Trend Report As dialog box 
opens.

 3 Type the name of the duplicated trend report. 

 4 Click OK. 

A duplicate of the selected trend report appears in the Trend Reports list.

Viewing Trend Reports

You view Trend Reports from the main Trend Reports page (Load Tests > 
Trend Reports).

A trend report consists of multiple trend views, where each trend view 
displays trending information for a particular performance metric, for 
example, Transaction Response Time.

The template on which the report is based, automatically groups the trend 
views into predefined categories, where each category appears as a separate 
tab on the report. The names of the tabs and the number of trend views in 
the report varies depending on the template you select. For more 
information, see “Trend Reports Templates” on page 447.

To view trend reports:

➤ On the main Trend Reports page (Load Tests > Trend Reports), in the Trend 
Reports Table, click the trend report you want to view. The <Trend Report 
Name> Trend Report page opens displaying the Trend Overview tab.
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The Trend Overview Tab
The Trend Overview tab displays the load test runs trended in the report. 
The tab is common to all trend reports, irrespective of which template you 
selected. 

The Trend Overview Toolbar.

Function Button Enables You To:

Add Add load test runs to the trend report. For more 
information on adding load test runs, see “Adding 
Load Test Runs to Trend Reports” on page 451.)

Remove Remove load test runs from the trend report.

Set as baseline Set the selected load test run as the baseline run for 
comparing load test runs. For more information, see 
“Comparison Methods” on page 475.

Move run up Move the load test run up in the run order. 
Changing the position of the load test run in the 
order may have an effect on the comparison value 
when the Compare to previous method is selected. 
For more information, see “Comparison Methods” 
on page 475.

Move run 
down

Move the load test run down in the run order. 
Changing the position of the load test run in the 
order may have an effect on the comparison value 
when the Compare to previous method is selected. 
For more information, see “Comparison Methods” 
on page 475.

Customize Customize which columns appear in the Trended 
Runs table. For more information, see “Viewing the 
Trended Load Test Runs” on page 454.
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Adding Load Test Runs to Trend Reports

You add load test runs to a trend report from the Trend Overview tab.

Notes:

➤ In order to add load test runs to the trend report, there must be a data 
processor present in your project pool.

➤ The process whereby Performance Center extracts the load test data from 
Analysis is very labor intensive on the data processor and may take 
anywhere from several minutes to over an hour. We recommend that you 
use a machine dedicated for this purpose.

➤ Performance Center extracts the load test data from Analysis using a 
granularity of 16 seconds. This value might be different from the defined 
granularity in Analysis, and may lead to slight variations when 
comparing values between Analysis and Performance Center.

Set threshold Set the threshold settings to be used for identifying 
performance improvements and regressions. For 
more information, see “Setting Trend Thresholds” 
on page 478.

Customize 
Measurement 
Mapping

Define and customize mapped measurements. For 
more information, see “Custom Measurement 
Mapping” on page 481.

Function Button Enables You To:
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To add load test runs to a report:

 1 On the main Trend Reports page (Load Tests > Trend Reports), in the Trend 
Reports table, select the trend report you want to add the load test runs to. 
The trend report opens displaying the Trend Overview tab.

 2 Click the Add runs to trend report button. The Add Load Test Runs to Trend 
Report page opens.

 3 From the Project and Load Test lists respectively, select the project and load 
test that you want to trend. 

 4 Click Go. The Load Test runs table displays information for all analyzed 
instances of the load test you selected.

The Load Test Runs table displays the following information:

➤ Run ID. The run ID. 

➤ Time Range. The time range within the run. For more information, see 
“Test Run Time Range” on page 453.

➤ Date. The date of the load test run.

➤ Duration. The duration (in minutes) of the load test run.
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➤ Vusers. The maximum number of running Vusers during the load test 
run.

➤ User notes. Any user notes for the test run.

 5 Click Add. The selected load test runs are added to the Trend Overview tab 
and appear in the Trended Runs table. For more information on the Trended 
Runs table, see “Viewing the Trended Load Test Runs” on page 454.

Test Run Time Range
The Time Range value in the Load Test Runs table represents the duration of 
the load test run that is selected for trending. By default the whole test run is 
selected. You can vary the selected time range for each individual load test.

To change the selected time range:

 1 In the Test Runs table, select the load test run whose time range you want to 
modify.

 2 In the Time Range column, click the filter button. The Define Time Range 
dialog box opens. 
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 3 Select the desired time range option:

➤ Trend Complete Run. Select this option to make all the data collected 
from the beginning to the end of the load test run available for trending.

➤ Trend Part of Run. Select this option to make only part of the load test 
run available for trending. Select the desired part of the run to trend by 
entering the start and end times in the Start Time and End Time boxes.

Note: Think time in Transaction Response Time measurements is always 
excluded.

 4 Click OK. The Define Time Range dialog box closes and the load test run 
information in the Load Test Runs table is updated accordingly.

Viewing the Trended Load Test Runs

You view the load test runs that have been added to the report in the 
Trended Runs table of the Trend Overview tab.

The Trended Runs table is divided into three sections. You can customize 
which columns appear in each section. For information on customizing the 
columns of the Trended Runs table, see “Customizing the Trended Runs 
Table” on page 458.

General Details section
The General Details display general information relating to the load test 
run. The following columns are available (The names of the columns as they 
appear in the table appear in parentheses):

➤ Run ID. The run ID. This column is displayed by default.

➤ Run Date (Date). The date of the load test run. This column is displayed 
by default.

➤ Run By. The name of the user who ran the load test. This column is 
displayed by default.
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➤ Project Name (Project). The name of the project in which the load test 
was run.

➤ Load Test Name (Load Test). The name of the load test. 

➤ Run Duration (Duration). The duration of the load test run, in minutes. 
This column is displayed by default.

➤ Trended Time Range (Trended Range). The time range within the load 
test run you selected. For more information, see “Test Run Time Range” 
on page 453.

➤ Total Vusers in Run (Total Vusers). The number of Vusers in the load test 
run, within the selected time range.

➤ Publish State (State). Indicates whether the load test run was successfully 
added to the report or not, either trended or not trended respectively. A 
load test run that was not successfully added appears in red and a tooltip 
displays the reason. This column is displayed by default.

Workload Characteristics Section
The purpose of this section is to provide you with enough information to 
identify whether the load test runs are similar in terms of overall workload, 
and therefore suitable for trending. 

The values displayed in this section are relevant only for the selected time 
range. Changing the selected time range (as explained in “Test Run Time 
Range” on page 453) will most likely lead to different results. 

The following columns are available:

➤ Total Number of Transactions (Transactions). The total number of 
transactions in the load test run that passed or failed within the selected 
time range. This column is displayed by default.

➤ Total Vusers in Trended Range (Trended Vusers). The maximum number 
of running Vusers within the trended time range. This column is 
displayed by default.

➤ Total Hits (Hits). The total number of hits per second within the trended 
time range.
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➤ Total Throughput (Throughput). The average throughput within the 
trended time range.

➤ Hits per Second (HPS). The average number of hits per second within the 
trended time range.

➤ Throughput per Second (Throughput per Sec.). The amount of 
throughput per second within the selected time range.

➤ Passed Transactions per Minute (TPM). The number of transactions that 
passed per minute of the load test run within the selected time range. 
This column is displayed by default.

➤ Passed Transactions per Second (TPS). The number of transactions that 
passed per second of the load test run within the selected time range. 
This column is displayed by default.

Performance Overview Section
The Performance Overview section of the Trended Runs table contains 
information relating to the overall performance of your application. 

The purpose of this section is to provide you with basic overview trending 
information without having to open a trend view. The basic trend 
information is shown by upward or downward arrows that indicate 
performance improvements or regressions with regards the baseline only. 
For more information on the baseline run, see “Comparison Methods” on 
page 475.

Note: Only overall summary trending information is shown in this section. 
More detailed information appears in the trend views.

The values displayed in this section are relevant only for the selected time 
range. Changing the selected time range (as explained in “Test Run Time 
Range” on page 453) will most likely lead to different results. 
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The following columns are available:

➤ Average Transaction Response Time (Response Time). The weighted 
average transaction response time for all the transactions within the 
selected time range. This column is displayed by default.

➤ Transaction Success Rate (Success). The percentage of the total amount 
of transactions that passed within the selected time range. This column is 
displayed by default.

➤ Errors per Second (EPS). The average amount of errors per second within 
the selected time range. This column is displayed by default.

➤ Passed Transactions (Passed). The actual amount of transactions that 
passed within the selected time range.

➤ Failed Transactions (Failed). The actual amount of transactions that 
failed within the selected time range.

➤ Total Errors (Errors). The total number of errors within the selected time 
range.

Run Information Pane
When you select a load test run in the Trended Runs table, the details of the 
run are displayed in the Run Information pane in the lower area of the page. 

The Run Information pane displays the following information:

➤ Project. The name of the project in which the load test ran.

➤ Load Test. The name of the load test.

➤ Run User Notes. User notes that were entered on the run results page.

➤ State. The publish state of the run, either Trended or Not Trended. If Not 
Trended, then the reason for this error appears in this field. A link 
appears to republish the run after you have fixed the error.
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Customizing the Trended Runs Table

You can customize the appearance of the Trended Runs table.

To customize the appearance of the Trended Runs table:

 1 In the Trend Overview tab toolbar, click the Customize Table Columns 
button. The Select Columns dialog box opens. 

The Select Columns dialog box is divided into three areas, each area 
corresponding to a section of the Trended Runs table. 

Each area contains two lists: One list containing the names of the columns 
that can be displayed (Available Columns), and another containing the 
names of the columns selected for the Trended Runs table (Visible Columns).

 2 To display a column in the table, select it in the Available Columns box and 
click the right arrow button to move it to the Visible Columns box.
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 3 Click OK. The Select Columns dialog box closes.

 4 In the <Trend Report Name> Trend Report page, click the refresh button to 
refresh the report in order for the changes to take effect.

Managing Trend Report Tabs

You can add a tab to a trend report, add a trend view to a trend report, as 
well as customize some of a tab’s display settings.

For information about how to add a tab to a trend report, see “Adding a Tab 
to a Trend Report” on page 460.

To customize a tab’s display settings, click the arrow button to the right of 
the tab name to open the Tab Editing menu. The Tab Editing editing menu 
enables you to do the following:

➤ Add Views to Tab. Lets you add trend views to the tab. For more 
information, see “Adding Trend Views to a Tab” on page 460.

➤ Edit Tab Title. Lets you edit the tab title. For more information, see 
“Editing Tab Titles” on page 462.

➤ Move Tab Left/Right. Lets you change the location on the tab in the 
trend Report. For more information, see “Repositioning Tabs in the Trend 
Report” on page 462.

➤ Delete this Tab. Lets you remove the tab from the trend report. For more 
information, see “Deleting Tabs” on page 463.
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Adding a Tab to a Trend Report
In addition to the tabs that are included when you select a trend report 
template, you can add a custom tab to the trend report.

To add a tab to a trend report:

 1 On the row of tab names, click the Add a new tab button. The Add tab 
dialog box appears.

 2 In the Name box, type a name for the new tab.

 3 Click OK. The tab appears in the trend report next to the Trend Overview 
tab.

Adding Trend Views to a Tab
In addition to the trend views that are included by default when you 
selected a trend report template, you can add additional trend views to any 
tab in the report. You can customize the functionality of any individual 
trend view and select one of three display settings, either table view, line 
graph view, or stacked bar chart view. For information on customizing trend 
views after they have been added, see “Working with Trend Views” on 
page 463.
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To add a trend view to a tab:

 1 Next to the tab name, click the arrow button.

 2 From the menu, select Add Trend Views to Tab. The Add Trend Views to Tab 
dialog box opens.

The Add Trend Views to Tab dialog box that opens contains a list of 
preconfigured trend views that you can add. 

Note: All trend views can be fully customized to suit your needs once they 
have been added to the tab. For more information, see “Working with Trend 
Views” on page 463.

The trend views are divided into three categories: 

➤ Transactions Trend Views. Trend measurements related to transactions.

➤ Monitors Trend Views. Trend measurements related to monitors.
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➤ Other Trend Views. Trend measurements other than transactions and 
monitor measurments (Web Resources and Error Statistics). Included in 
this section are three basic non-configured trend views, each one based 
on one of the trend view display options. You can select one of these 
trend views and customize it any way you desire. For more information 
on customizing trend views and trend view display settings, see 
“Working with Trend Views” on page 463.

 3 Select the trend views you want to add to the tab.

 4 Click Add. The Add Trend Views to Tab dialog box closes and the selected 
trend views appear in the tab.

Editing Tab Titles
You can edit the title of a tab from the Edit Tab Title dialog box.

To edit a trend view’s title:

 1 Next to the tab name, click the arrow button.

 2 From the list, select Edit Tab Title. The Edit Tab Title dialog box opens.

 3 In the Name box, make the desired changes to the trend view’s title.

 4 Click OK. The Edit Tab Title dialog box closes and Performance Center 
updates the trend view to reflect the change.

Repositioning Tabs in the Trend Report
You can change the position of a tab in the row of tabs in the trend report 
by shifting it to the left or the right.

To move a tab to the left or the right:

 1 Next to the tab name, click the arrow button.

 2 From the menu, select Move Tab Left/Right. The tab moves to it’s new 
position.
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Deleting Tabs
You can delete a tab from the trend report.

To delete a tab:

 1 Next to the tab name, click the arrow button.

 2 From the menu, select Delete this Tab. In the confirmation box that opens, 
click OK. The tab is removed from the report.

Working with Trend Views

A trend view is a display item that presents the trending information for 
multiple measurements. The templates that you select when creating trend 
report each provide some predefined trend views. 

These trend views are customizable. That is, you can define specific 
comparison and display settings.

This section includes:

➤ “Customizing a Trend View” on page 464

➤ “Editing Trend Views” on page 464
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Customizing a Trend View
You customize trend view settings from the toolbar in the top right corner of 
the trend view. The following table outlines the various toolbar functions:

Editing Trend Views
You can edit a trend view’s display and comparison settings from the trend 
view toolbar described above. To open the Trend View Editing Menu, click 
the arrow button on the toolbar. The editing menu enables you to do the 
following:

Note: The availability of the menu items depends on your selected display 
setting: table view, line graph view, or stacked bar chart view. For more 
information about the display options, see “Understanding Trend View 
Information” on page 470.

Function Button Description:

Minimize or 
restore trend 
view’s display

To minimize or restore a trend view to its previous 
display size, click the Minimize or Restore button. 
The direction of the arrow on the button indicates 
whether the button will minimize (upward) or 
restore (downward) the trend view.

Show 
maximized 
view

To maximize a trend view’s display, that is, to have 
the trend view occupy the entire width of the tab, 
click the Maximize button.

Show normal 
view

To restore a maximized trend view to a normal 
display, that is, to have the trend view occupy half 
the width of the tab, click the Normal View button.

Edit trend view To edit a trend view’s display and comparison 
settings, you click the arrow button on the toolbar 
to open the editing menu. For more information on 
editing these settings, see “Editing Trend Views” 
below.
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➤ Select measurements. Lets you add measurements to the trend view. For 
more information, see “Selecting Trend View Measurements” on page 466.

➤ Edit Display Setting. Lets you change the appearance of the trend view. For 
more information, see “Editing Trend View Display Settings” on page 468.

➤ Edit Trend View Title. Lets you edit the title of a trend view. For more 
information, see “Editing Trend View Titles” on page 469.

➤ Compare to baseline/previous. (Table view only) Lets you change the 
comparison method displayed in the trend view. For more information, see 
“Comparison Methods” on page 475.

➤ Show difference as value/percentage. (Table view only) Lets you define how 
to display value differentials between load test runs in the trend view - as 
percentages or as values.

➤ Do not show difference. (Table view only) Lets you hide the value 
differentials between load test runs. We suggest that you use this setting 
when exporting the trend report to CSV format.

➤ Color Trends. (Table view only) Allows you to activate the trend report’s 
threshold settings. For more information on defining thresholds, see 
“Setting Trend Thresholds” on page 478. 

➤ Export to CSV. (Table view only) Lets you export the trend view to a CSV 
format.

➤ 3D Mode. (Stacked bar chart view only) Lets you view the chart in 3D.

➤ Show Values. (Stacked bar chart view only) Lets you view the measurements 
values on the actual bar columns. 

➤ Delete trend view. Lets you delete the trend view.
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Selecting Trend View Measurements

Each trend view has a default set of measurements that it trends. You can 
add additional measurements in the Measurements Configuration dialog 
box.

To select measurements to add to the trend view:

 1 On the trend view toolbar, click the arrow button to open the Trend View 
Editing Menu.

 2 Select Select Measurements. The Measurements Configuration dialog box 
opens.

 3 From the Trend Data Types pane on the left, select the measurement type 
you would like to add. The details of your selection appear in the table in 
the Measurement Selection area on the right.

The Trend Data Types pane contains a list of the measurements which are 
available for trending. Only measurements where data exists will appear.
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There are three categories of data types:

➤ Transactions. All transactions that contain data.

➤ Monitors. All monitor related measurements that contain data.

➤ Others. Additional measurements.

➤ User-Defined. This node appears only if you have mapped any 
measurements. The user-defined mapped measurements appear in this 
section. For more information on mapped measurements, see “Custom 
Measurement Mapping” on page 481.

 4 From the table in the Measurement Selection area, select the measurements 
you want to add to the trend view.

The table displays the following information:

➤ Rule. An icon appears in this column to indicate that the measurement 
has already been selected using an automatic selection rule. For more 
information on automatic selection rules, see “Defining an Automatic 
Selection Rule” on page 468.

➤ Select Measurements. Contains check boxes for selecting measurements 
to be added to the trend view.

➤ Name. The name of the measurement.

 5 From the list in the Select Values to Trend box, select which values of the 
selected measurements to include in the trend view. 
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Defining an Automatic Selection Rule

You can use regular expressions to define a rule that automatically selects 
measurements to be included in the trend view. The automatic selection rule 
applies to measurements that are currently displayed in the trend report 
data, as well as any future measurements.

To define/remove an automatic selection rule: 

 1 Click the Define automatic selection rule link under the list of 
measurements. The Automatic Selection Rule dialog box opens.

 2 Add or edit a rule as follows:

➤ To add a rule, in the top text box, type the regular expression that will 
define the automatic selection rule. Then click Add.

➤ To remove a rule, in the list box, select the rule you want to remove, then 
click Remove. The rule is removed from the list.

Editing Trend View Display Settings

You can configure the display setting of a trend view from the Edit Display 
Setting dialog box. For more information on the trend view display settings, 
see “Understanding Trend View Information” on page 470.
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Editing Trend View Titles

You can edit the title of a trend view from the Edit Trend View Title dialog 
box.

To edit a trend view’s title:

 1 From the Trend View Editing menu, select Edit Trend View Title. The Edit 
Trend View Title dialog box opens.

 2 In the Name box, make the desired changes to the trend view’s title.

 3 Click OK. The Edit Trend View Title dialog box closes and Performance 
Center updates the trend view to reflect the change.

Deleting Trend Views

Select this option to remove the trend view from the tab.

To delete a trend view:

 1 From the Trend View Editing Menu, select Delete this Trend View. 

 2 In the confirmation box that appears, click OK. The trend view is removed 
from the tab.
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Understanding Trend View Information

A trend view displays trending information by comparing values of specific 
measurements over time, and by identifying changes in these values as 
either improvements or regressions in performance.

This section includes:

➤ “Selecting a Trend View Display Setting” on page 470

➤ “Table View Display Setting” on page 471

➤ “Line Graph Display Setting” on page 472

Selecting a Trend View Display Setting

You select which display setting to use from the Trend View Editing Menu:

To edit a trend view’s display settings:

 1 On the trend view toolbar, click the arrow button to open the Trend View 
Editing menu. 

 2 Select Edit Display Setting. The Edit Display Setting dialog box opens.

The dialog box contains thumbnail images of the three display options. A 
blue frame appears around the current selection. The display options are:

➤ Table view. This view is best suited for displaying comparisons between 
measurements. You can view threshold settings in this view only. For 
more information, see “Table View Display Setting” on page 471.

➤ Line graph view. This view is suited for displaying trending information 
graphically over a timeline. For more information, see “Line Graph 
Display Setting” on page 472.

➤ Stacked bar chart view. This view displays trending information 
graphically over time. It is best suited for trending a small number of 
multiple measurements. For more information, see “Stacked Bar Chart 
Display Setting” on page 473.

 3 Select a display option. The blue frame moves to the new selection.

 4 Click OK. The Edit Display Setting dialog box closes and Performance Center 
updates the trend view to reflect the change.
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Table View Display Setting
A trend view in table view displays the following columns:

➤ Name. The name of the measurement being compared.

➤ Type. The type of measurement being compared

➤ Measurement comparison section. This section is subdivided into the 
following:

➤ Measurement value name. The name of the measurement value being 
trended, for example, minimum, maximum, average, and so on. In the 
image shown above, it’s the Average value of the Transaction Response 
Time measurement.

➤ Measurement value. The actual value of the measurement being trended, 
and its comparison value; displayed per load test run. For more 
information see “Comparison Methods” on page 475.

Note: You can view threshold settings in the table view only. For more 
information on thresholds, see “Setting Trend Thresholds” on page 478.
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Line Graph Display Setting
The line graph view is suited for displaying trending information 
graphically over a timeline.

The line graph allows you to visualize the performance trend over time, by 
making major performance improvements and regressions easily 
identifiable to the eye. The load test runs appear on the x-axis according to 
their run date, while the y-axis represents the unit of the measurement. For 
example, for the Transaction Response Time measurement, the y-axis value 
represents seconds, while for the transactions per second measurement, the 
value represents the number of transactions. 

When you hold the cursor over the line graph, a tooltip appears displaying 
the exact amount of units for that measurement, correct to the nearest load 
test run on the timeline. In other words, if you hold the cursor near the left 
point of the line graph, you see the value of the first load test run.

The upward or downward slope of the line represents an upward or 
downward change in the measurement’s unit. For example, a higher 
transaction response time (which is a performance regression), or a higher 
transactions per second value (which is a performance improvement).

For information on managing the appearance of the line graph 
measurements, see “Managing Measurements” on page 474.
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Stacked Bar Chart Display Setting
The stacked bar chart view is best suited for trending a small number of 
multiple measurements. It displays trending information graphically over 
time.

The stacked bar chart allows you to visualize the performance trend over 
time, by making major performance improvements and regressions easily 
identifiable to the eye. The load test runs appear on the x-axis according to 
their run date, while the y-axis represents the unit of the measurement. For 
example, for the Transaction Response Time measurement, the y-axis values 
represent seconds, while for the transactions per second measurement, the 
values represent the number of transactions. When you hold the cursor over 
a bar, a tooltip appears which displays the exact number of units for that 
measurement, correct for that load test run. 

The height of the bar represents the change in the measurement’s unit. For 
example, a higher transaction response time, which represents a 
performance regression, or a higher transactions per second value, which 
represents a performance improvement.
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If different values are selected for the same measurement (for example, 
Maximum and Average transaction response times), then the measurements 
appear as stacked bars. That is, the values appear above each other for the 
bar that represents the transaction response time measurement for a specific 
load test run.

For information on managing the appearance of the stacked bar chart 
measurements, see “Managing Measurements” below.

Managing Measurements

You manage the appearance of measurements in the line graph and stacked 
bar chart from the legend below the graph. 

The legend displays the following information:

➤ V. Determines whether the measurement is visible. All measurements are 
displayed by default. Clear the check box to hide a measurement.

➤ B. (line graph only) Displays the measurement in bold.

➤ C. Displays the color of the measurement as it appears in the graph. Click 
the colored square in the column to select a different color for the 
measurement.

➤ Type. Contains an acronym that identifies the measurement type. For a 
full list of available acronyms, see “Measurement Acronyms” on 
page 488.

➤ Function. Displays the value of the measurement being trended.
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➤ Scale. Indicates the scale of the measurement. When viewing 
information in the line graph view, you can adjust the scale of any 
measurement to make comparing measurements more meaningful. 

To change the scale of a measurement, click the value in the column and 
select the desired scale from the Set Scale box that opens. You can also 
apply the selected scale to all the measurements in the graph.

➤ Name. The name of the measurement.

Comparison Methods

You can choose how to compare measurements contained in a load test run 
for the purposes of trending.

This section includes:

➤ “Compare to Baseline” on page 475 

➤ “Compare to Previous” on page 477 

Compare to Baseline
When you select the Compare to Baseline comparison method, you select 
one load test run in the trend report, and define it as the baseline. This 
means that all measurements contained in the remaining load test runs in 
the report are compared to the measurements contained in the selected 
baseline run when determining trending information.
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When you view the specific measurement in the trend view, improvements 
and regressions in performance are identified relative only to the baseline.

As shown in the example below, the average Transaction Response Time 
measurement is being trended from four load test runs: 1, 5, 4, and 3.

Load test run 1 has been defined as the baseline (as indicated by the word 
Base in brackets). The average transaction response times contained in the 
other load test runs are compared to load test run 1 only.

In load test run 1, the average transaction response time for TRX_01 was 
2.045. The average transaction response time for the same transaction in 
load test run 5 was 4.073, which represents a slower response time and a 
regression in the performance of this measurement. The percentage 
difference between the two figures is displayed in brackets, in this case 
+99.17%. 

Note: Value differentials between compared measurements can be displayed 
as percentages or as numbered values. You select either method from the 
Trend View Editing menu.
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When the average transaction response time for a given transaction is 0, the 
percentage of improvement in comparison to any transaction response time 
greater than 0 is displayed as -100%.

Tip: You can define specific measurement thresholds and assign a unique 
color to each threshold to facilitate identifying performance improvements 
and regressions. For more information, see “Setting Trend Thresholds” on 
page 478.

Setting the Baseline

To define a load test run as the baseline, select it in the Trended Runs table 
and click the Set Run as Baseline button.

You cannot set different load test runs as baselines for different trend views. 
Setting a load test run as the baseline is done on a global level and holds true 
across all trend views in the report.

Compare to Previous 
An alternative method of comparing load test measurements is to identify 
improvements and regressions in performance by comparing the 
measurements in a load test to the measurements in the load test that 
immediately precedes it in the Trended Runs table. 

For example, using the same load test runs as in the example above, when 
using the Compare to Previous method, run 3 is compared to run 4. We can 
see that for transaction TRX_01_sut_01_eventssimulationutility, the 
transaction response time improved by -48.4%.
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Note: Value differentials between compared measurements can be displayed 
as percentages or as numerical values. You select either method from the 
Trend View Editing menu.

To vary the comparison results when this method is selected, you can move 
the load test runs in the Trended Runs table up or down by selecting them 
and clicking the Move Up or Move Down buttons respectively.

Tip: You can define specific measurement thresholds and assign a unique 
color to each threshold to make it easier to identify performance 
improvements and regressions. For more information, see “Setting Trend 
Thresholds” on page 478.

Setting Trend Thresholds

To identify significant improvements or regressions in performance, you can 
define unique thresholds to track differentials between measurement being 
compared. If a differential exceeds a defined threshold, that value appears in 
the trend view in a predetermined color, easily identifying it as an 
improvement, minor regression, or major regression.

For example, if you define an improvement threshold for comparing 
transaction response times as 50%, then any transaction response time that 
is 50% lower than that of the baseline or previous run (depending on your 
selected comparison method) will appear in the trend view in the color you 
defined for improvements.
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In the following example, the Compare to Previous comparison method is 
shown:

The value of the average transaction response time of the 
Action_Transaction in load test run 158681 is 46900% higher than in load 
test run 158685—a major performance regression. Because this percentage 
differential exceeds a threshold that was defined for major regressions, the 
value appears in red, the default color for major regressions. 

The corresponding value for load test run 158679 represents a 100% 
improvement on load test run 158681. This percentage differential 
represents a significant improvement in performance and appears in green, 
the default color for improvements.

Note: Threshold definition and color settings are done on a global level and 
hold true across all trend views in the report.
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To define trend thresholds and assign colors:

 1 On the Trend Overview tab, click the Set Thresholds button. The Threshold 
Settings dialog box opens.

You use the Threshold Settings dialog box to define which percentage 
differentials between measurements constitute significant improvements or 
regressions in performance. 

Note: You can define thresholds for the measurements displayed in the 
dialog box only.

 2 For each measurement, set the improvement, minor regression, and major 
regression threshold percentages.

For example, if you would like to focus only on performance improvements 
greater that 50% for a specific measurement, then you can set that 
percentage as the threshold, that is, only percentage differentials greater 
than this threshold will be considered. 

Note: Any percentage differential between the minor and major regression 
thresholds are considered a minor regression.
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 3 (Optional) To change the default color selection for a threshold, click the 
colored square next to the threshold name, and select a new color from the 
selection box and dlick OK.

 4 Click OK to close the Threshold Settings dialog box.

Custom Measurement Mapping

Custom Measurement Mapping allows you to map measurements with 
different names to a new single measurement which your create.

This section includes:

➤ “Reasons to Use Custom Measurement Mapping” on page 481

➤ “Working with Custom Measurement Mapping” on page 483

➤ “Creating and Editing Mapped Measurements” on page 485

➤ “Viewing Mapped Measurement Information” on page 487

➤ “Duplicating Mapped Measurements” on page 487

➤ “Deleting Mapped Measurements” on page 487

Reasons to Use Custom Measurement Mapping
You use the Custom Measurement Mapping feature to reconcile inconsistent 
transaction or monitor names between load test runs, thereby allowing you 
to properly trend these measurements. See the following section for detailed 
examples.

Inconsistent Transaction Name

Consider the following example: You run a load test that contains the 
transaction BuyBook. A while later you run the load test again. However, in 
the time between the two load test runs, the transaction name has been 
changed to TRX_01_BuyBook. 

As a result of this inconsistent naming, you cannot obtain any trending 
information for this measurement, as Performance Center cannot recognize 
that the two transactions are actually the same, and compare them for 
trending purposes. 
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To overcome this problem, you map the two measurements (BuyBook and 
TRX_01_BuyBook) to a new third measurement which you create, for 
example Buy_Book_mapped. You add this new user-defined measurement to 
the trend report. Performance Center can then compare two instances of the 
Buy_Book_mapped transaction and give you meaningful trending 
information.

You can give the new transaction the same name as one of the current 
transactions. Additionally, you can configure the mapping so that all future 
instances of the transaction are automatically mapped to the new 
transaction name.

Inconsistent Monitor Name

As another example, consider the following scenario: You want to compare 
your application’s performance on different operating systems or when 
running against different Web/application servers. 

You run the load test once on a Windows platform, and then again on a 
UNIX platform. You then want to compare the CPU utilization between the 
two runs. However, each platform provides for a different name for this 
measurement, for example, % Processor Time (Processor_Total) in 
Windows and CPU Utilization in UNIX. 

Performance Center cannot successfully obtain trending information for 
this measurement because the measurement names are different.

To overcome this problem, you map the two measurements (% Processor 
Time (Processor_Total) and CPU Utilization) to a third measurement which 
you create, for example CPU_mapped. You then add this new user-defined 
measurement to the trend report. Performance Center can then compare the 
two instances of the CPU_mapped transaction and give you meaningful 
trending information. 

You can give the new monitor the same name as one of the current 
monitors. Additionally, you can configure the mapping so that all future 
instances of the monitor are automatically mapped to the new monitor 
name.
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Working with Custom Measurement Mapping
You perform all custom measurement mapping related tasks from the 
Custom Measurement Mapping dialog box.

To open the Custom Measurement Mapping dialog box, click the Custom 
Measurement Mapping button on the Trend Overview tab’s toolbar. The 
dialog box opens.
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The Custom Measurement Mapping dialog box contains the following 
components:

Custom Measurement Mapping Toolbar

You use the toolbar buttons to perform the following actions:

Mapped Measurements Table

Displays a list of all the user-defined mapped measurements in the trend 
report. The list displays the following information for each mapped 
measurement:

➤ Name. The name of the mapped measurement.

➤ Data Type. The data type of the mapped measurement.

➤ Description. The description of the mapped measurement.

Mapping Information Pane 

Displays detailed information for the selected mapped measurement. This 
pane displays the following information:

➤ Name. The name of the mapped measurement.

➤ Description. The description of the mapped measurement.

Function Button Enables You To:

Create New 
Mapping

Create a mapped measurement. For more 
information, see “Creating and Editing Mapped 
Measurements” on page 485.

Duplicate 
Mapping

Duplicate a mapped measurement. For more 
information, see “Duplicating Mapped 
Measurements” on page 487.

Delete 
Mapping

Delete a mapped measurement. For more 
information, see “Deleting Mapped Measurements” 
on page 487.

Refresh Refresh the Custom Measurement Mapping dialog 
box
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➤ Data Type. The type of measurement. This can be Transaction, Monitor, 
or Other.

➤ Details table. Displays a list of all the load test runs and the 
measurements from each run that have been mapped to the new 
measurement. The load test runs appear in the table in the same order as 
they appear in the Trended Runs table.

The Details table displays the following information:

➤ Run ID. The run ID.

➤ Type. The measurement type.

➤ Name. The measurement name. 

Creating and Editing Mapped Measurements
You use mapped measurements to reconcile inconsistent transaction or 
monitor names between load test runs. You add and edit mapped 
measurements in the Measurement Configuration dialog box.

To create a mapped measurement:

 1 On the Custom Measurement Mapping page, click the Create New Mapping 
button. The Add New Mapping dialog box opens.

 2 In the Name box, type the name of the new mapped measurement.

 3 In the Description box, type a description of the new mapped measurement.

 4 Select the type of measurement from the Data Type list: Transaction, 
Monitor, or Other.
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 5 Click Add. The mapped measurement name appears in the Mapped 
Measurements table.

Note: The remaining steps in the procedure can be used to edit an existing 
mapped measurement.

 6 In the Details table in the Mapping Information pane, click in the cells to 
select the following information for each load test run in the table. 

For example, if you were creating the mapped measurement described in the 
inconsistent transaction name example on page 481, you would enter the 
unique information for each load test run. 

➤ Type. The type of measurement. For example, TRT (Transaction Response 
Time). For a full list of the available measurement types, see 
“Measurement Acronyms” on page 488.

➤ Name. The name of the measurement. For example BuyBook or 
TRX_01_BuyBook.

You use the Default row of the table to define Type and Name definitions to 
apply to all load test runs in the table. If you select information for the 
Default row and click Save, all empty fields for the other load test runs are 
automatically set to match the Default settings.

When you use the Default option, all future instances of the measurement 
are automatically mapped to these settings.

 7 Click Save. 

To edit a mapped measurement:

 1 Select the measurement in the Mapped Measurements table.

 2 Edit the details in the Details table, as described in step 6 above.

 3 Click Save. 
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Viewing Mapped Measurement Information
To view trending information for a mapped measurement, you select the 
measurement from the User Defined node of the Measurements 
Configuration dialog box. For more information, see “Selecting Trend View 
Measurements” on page 466.

Duplicating Mapped Measurements
You can duplicate a mapped measurement, with all its data, within the 
trend report. 

To duplicate a mapped measurement within the trend report:

 1 In the Mapped Measurements table, select the measurement to duplicate.

 2 On the Custom Measurement Mapping toolbar, click the Duplicate 
Mapping button. The Save Mapping As dialog box opens.

 3 Performance Center automatically assigns a default name for the duplicate 
measurement, which you can edit as desired. In the Save as box, type the 
desired name of the duplicate measurement. 

 4 Click OK. 

A duplicate of the selected mapped measurement appears in the Mapped 
Measurements table.

Deleting Mapped Measurements
You can delete any mapped measurement from the trend report.

To delete a mapped measurement:

 1 On the Custom Measurement Mapping page, select the measurement to 
delete.

 2 Click the Delete Mapping button.

 3 In the confirmation box that appears, click OK. The measurement is 
removed from trend report.
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Measurement Acronyms

The following table lists all the measurement acronyms that might be used 
in the trend report:

Data Type Full Name Initials

Vusers Running Vusers VU

Errors Errors ERR

Transactions Transaction 
Response Time

TRT

Transaction Per 
Second

TPS

Transaction 
Summary

TRS

Web Resources Hits per Second

Throughput

Connections

WEB

User defined data 
points

User Defined Data 
Points

UDP

System Resources Windows 
Resources

WIN

UNIX Resources UNX

Server Resources SRVR

SNMP SNMP

SiteScope SiS

Firewalls CheckPoint 
Firewall 1

FW

Web Server 
Resources

Apache APA

MS IIS IIS

iPlanet PLA
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Web Application 
Server Resources

Ariba ARI

ATG Dynamo ATG

BroadVision BDV

ColdFusion CFU

MS ASP ASP

Oracle Application 
Server

OAS

SilverStream SST

Weblogic WL

Websphere WS

Database Server 
Resources

DB2 DB2

Oracle ORA

MS SQL SQL

Sybase SYB

ERP/CRM Server 
Resources

SAP SAP

SAP Portal SAPP

SAP CCMS CCMS

SAP GUI SAPU

Siebel Web Server SIEB

Siebel Server 
Manager

SIEB

PeopleSoft PSFT

J2EE Server Request J2EE

.NET Server Request NET

Additional 
Components

COM+ COM

.NET NET

Data Type Full Name Initials
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Deleting Trend Reports

You can delete trend reports from the Trend Reports page.

To delete a trend report:

 1 On the Trend Reports page, select the trend report to delete.

 2 Click the Delete Report button.

 3 In the confirmation box that opens, click OK. The trend report is removed 
from Trend Reports page.

Application 
Deployment 
Solution

Citrix MetaFrame 
XP

CTRX

Middleware 
Performance

TUXEDO 
Resources

TUX

IBM WebSphere 
MQ

MQ

Application Traffic 
Measurement

F5 BIG-IP F5

Data Type Full Name Initials
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28
Using Performance Center Diagnostics

Performance Center’s J2EE/.NET and ERP/CRM diagnostics modules provide 
monitors that trace, time, and troubleshoot individual transactions that 
rapidly identify and pinpoint performance problems in J2EE, .NET, Siebel, 
Oracle 11i, and SAP environments. These monitors help you to maximize 
business process performance, scalability, and efficiency. 

The diagnostics module monitors come with a set of customized Analysis 
reports. Using these reports, you can communicate your insights to 
developers and managers, ultimately accelerating problem resolution, while 
avoiding expensive hardware upgrades.

This chapter includes:

 ➤  Enabling Diagnostics on page 493

 ➤  Enabling the Web Page Breakdown on page 498

Enabling Diagnostics

You enable diagnostics from the Diagnostics tab in the Load Test 
configuration page.

You can use the Diagnostics tab to perform the following actions:

➤ Enable/disable Performance Center Diagnostics and select Performance 
Center Diagnostics modules

➤ Set the distribution of Vusers in a load test

➤ Configure the settings of the application under test
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Before enabling the diagnostics settings:

➤ For ERP/CRM diagnostics, make sure that you have installed an ERP/CRM 
Mediator on a machine that resides in the same LAN as the monitored 
ERP/CRM server. For installation instructions, see the HP Performance Center 
System Configuration and Installation Guide.

➤ If you are monitoring over a firewall, you must install an MI Listener on a 
machine outside the firewall, and define the MI Listener in the Firewall 
Diagnostics Communicator field of the Administration Site’s MI Listener 
page. For installation instructions, see the HP Performance Center System 
Configuration and Installation Guide. For details on defining the MI Listener, 
see the HP Performance Center Administrator Guide.

➤ Make sure that you have defined at least one mediator machine in the 
Diagnostics page of the Administration Site. You cannot enable a 
Diagnostics module if a mediator machine has not been defined. For details, 
see the section about setting up the diagnostics modules in the HP 
Performance Center Administrator Guide. 
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To enable Diagnostics for a load test:

 1 In the Load Test configuration page, click the Diagnostics tab. The 
Diagnostics tab opens.

 2 To enable transaction breakdown monitoring, select Enable diagnostics. You 
can disable diagnostics between load test runs without losing your settings 
by clearing the Enable diagnostics check box (provided that you saved your 
settings).

 3 Specify the percentage of Vusers for which you want transaction breakdown 
to be performed. The percentage determines how many of the Vuser’s 
transactions on the application server are reported to the Controller. 
Reducing this number reduces the overhead on the application server for 
Web Page and Oracle 11i diagnostics. 
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Note: 

➤ The maximum transaction breakdown percentage is the lowest 
percentage of all the selected diagnostics types. For example, if Web Page 
Breakdown (maximum 10%) and Oracle 11i Diagnostics (maximum 5%) 
are selected, the maximum number of Vusers for which transaction 
breakdown will be performed is 5%.

➤ The minimum transaction breakdown is 1% or 1 Vuser per script, 
whichever is more. For example, if you enter a sampling value of 25% 
and run 12 Vusers in script1, 8 Vusers in script2, and 1 Vuser in script3, 
transaction breakdown will be performed on 3 Vusers in script1, 2 Vusers 
in script2, and 1 Vuser in script3.

➤ You cannot change the percentage value during a load test.

 4 To enable and configure diagnostics, click the Configure button next to the 
appropriate diagnostics type for which you want transaction breakdown to 
be performed. 

➤ To enable Web Page Breakdown, see “Enabling the Web Page Breakdown” 
on page 498.

➤ To configure Siebel Diagnostics, see Chapter 30, “Configuring Siebel 
Diagnostics.”

➤ To configure Siebel DB Diagnostics, see Chapter 31, “Configuring Siebel 
DB Diagnostics.”

➤ To configure Oracle 11i Diagnostics, see Chapter 32, “Configuring Oracle 
11i Diagnostics.”

➤ To configure SAP Diagnostics, see Chapter 33, “Configuring SAP 
Diagnostics.”

➤ To configure J2EE/.NET Diagnostics, see Chapter 34, “HP Diagnostics 
Integration with Performance Center.”
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Note: If you run a script containing Vusers that are supported by more than 
one diagnostics type (for example Siebel-Web), the same Vusers will be 
monitored by all the diagnostics modules which support that Vuser type. 
This enables you to compare results generated in different diagnostics 
modules.

After you configure and enable a diagnostics module, a check mark appears 
next to the diagnostics module, indicating that the diagnostics module is 
enabled in the current load test. If you disable the diagnostics module, the 
check mark is replaced by a minus sign (-). 

 5 Click Save in the Load Test configuration page to save and validate your 
settings.

Note: You can disable diagnostics between load test runs without losing 
your configuration settings by clearing the Enable diagnostics check box 
(provided that you saved your settings). 

The Diagnostics dialog box is disabled during a load test run. 
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Enabling the Web Page Breakdown 

Web Page Breakdown graphs provide you with performance information for 
each transaction and sub-transaction defined in your script. You enable the 
Web page breakdown feature from the Diagnostics dialog box of the Load 
Test configuration page, before running your load test. No configuration is 
required.

To enable Web Page Diagnostics:

 1 In the Load Test configuration page, click the Diagnostics tab.

 2 Select Enable diagnostics.

 3 Set the percentage of Vusers to participate in the monitoring. The maximum 
number of Web Page Vusers on which Web page breakdown can be 
performed is 10%.

Note: If you have enabled other diagnostics types, the percentage of Vuser 
participation cannot exceed the maximum of any of the selected diagnostics 
types.

 4 Check that Web Page Breakdown is selected (default setting). If it is not 
selected, click the Enable button next to Web Page Breakdown. The minus 
sign (-) is replaced by a check mark indicating that Web Page Breakdown is 
selected.

 5 Click Save to save and validate your settings.

For more information about analyzing Web Page Breakdown graphs, see the 
HP LoadRunner Analysis User Guide.

To disable Web Page Diagnostics:

Click the Disable button next to Web Page Breakdown. A minus sign (-) 
replaces the check mark and the button changes to Enable.



499

29
Introducing ERP/CRM Diagnostics

Performance Center's ERP/CRM diagnostics modules provide detailed 
performance information to help you rapidly identify and pinpoint 
performance problems in Siebel, Oracle, and SAP environments.

The ERP/CRM Transaction Breakdown Diagnostics modules come with a set 
of customized Analysis reports. Using these reports, you can communicate 
your insights to developers and managers to accelerate resolution, while 
avoiding expensive hardware upgrades.

This chapter includes:

 ➤  About Performance Center ERP/CRM Diagnostics on page 500

 ➤  ERP/CRM Diagnostics Module Architecture on page 501

 ➤  ERP/CRM Diagnostics Types on page 502

 ➤  Working with Performance Center ERP/CRM Diagnostics on page 504

 ➤  Connecting to a Remote Server on page 505

 ➤  Viewing Diagnostics Results on page 507
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About Performance Center ERP/CRM Diagnostics

During a performance test, Performance Center’s diagnostics modules trace, 
time, and troubleshoot individual transactions across the Web, application, 
and database servers. You can drill-down from a slow end-user transaction 
all the way to the bottlenecked method or SQL statement. The Performance 
Center modules help organizations to:

➤ Trace the application components exercised by business processes

➤ Rapidly isolate application components that have a significant impact on 
end-user experience

➤ Provide developers with precise data on how to make performance 
improvements

Such precision pinpointing of performance problems directly translates into 
significant business value: 

➤ Quicker and more efficient performance testing cycles

➤ Decreased time to problem resolution by development

➤ Better-performing applications that are optimized to meet the needs of the 
business
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ERP/CRM Diagnostics Module Architecture 

The ERP/CRM Diagnostics architecture is composed of the following 
components:

➤ ERP/CRM Mediator. The ERP/CRM Mediator ("mediator") gathers and 
correlates offline transaction data from the Web, database, and application 
servers. The mediator must be installed on a machine that resides in the 
same LAN as the monitored ERP/CRM server, and preferably on a dedicated 
server. We do not recommend installing the mediator on a Siebel, Oracle, or 
SAP server that is involved in the load test. For more information on 
installing the ERP/CRM Mediator, see the HP Performance Center System 
Configuration and Installation Guide.

Note: For Siebel DB diagnostics, it may take a long time to copy the files 
from the application server to the mediator, and then from the mediator to 
the results directory. During the first copying stage, the Summary Data 
Processing dialog box is displayed. 
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➤ Controller. Before load test execution, the Controller machine transfers all 
server information to the mediators and distributes the percentage of Vusers 
that will participate in the monitoring. After load test execution, the 
Controller collects the aggregated transaction data files from the mediator 
machines and collates the results. Results are transferred to the Siebel 
diagnostics, SAP diagnostics, or Oracle DB results directory.

If you do not want to collate the information right after the load test, you 
can perform collation at a later time.

➤ Load Generator. When you execute a load test, the Controller distributes 
each Vuser to a load generator, and the load generator executes the Vuser 
script.

➤ Analysis. Displays detailed diagnostic graphs and reports. For more 
information about the diagnostic graphs, see the HP LoadRunner Analysis 
User Guide.

ERP/CRM Diagnostics Types

Performance Center provides ERP/CRM diagnostics solutions for Siebel, 
Oracle and SAP systems.

Siebel Diagnostics

The diagram below shows transaction breakdown on a Siebel CRM system. 



Chapter 29 • Introducing ERP/CRM Diagnostics

503

Performance Center’s Siebel Diagnostics are split into the following 
modules:

➤ Siebel Diagnostics Module. Enables you to breakdown Siebel transactions 
into layers, areas, sub-areas, servers, and scripts. You can also view the 
transaction chain of calls and call stack statistics to track the percentage 
of time spent for each part of the transaction. Siebel-Web Vusers support 
Siebel diagnostics. For more information, see Chapter 30, “Configuring 
Siebel Diagnostics.”

➤ Siebel DB Diagnostics Module. Enables you to view the SQLs for each 
transaction, identify the problematic SQL queries of each script, and 
identify at what point problems occurred. Siebel DB diagnostics support 
Siebel-Web Vusers. For more information, see Chapter 31, “Configuring 
Siebel DB Diagnostics.”

Oracle Diagnostics

Oracle Diagnostics help you pinpoint performance problems on Oracle NCA 
systems. The diagnostics information drills down from the transaction, to 
the SQL statements and the SQL stages of each statement. Oracle NCA 
Vusers support Oracle DB diagnostics. For more information, see 
Chapter 32, “Configuring Oracle 11i Diagnostics.”

SAP Diagnostics

SAP Diagnostics help you pinpoint the root cause of a certain problem (i.e. 
DBA, Network, WAS, Application, OS/HW) quickly and easily, and engage 
with the relevant expert only, without having to present the problem to a 
whole team of people. For more information, see Chapter 33, “Configuring 
SAP Diagnostics.”
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Working with Performance Center ERP/CRM Diagnostics

To use Performance Center’s ERP/CRM diagnostics, follow these steps:

 1 Prepare for generating diagnostics data.

Make sure that the ERP/CRM Mediator is installed and configured. The 
mediator collects and processes the diagnostics data.

For information on installing the ERP/CRM Mediator, see the HP 
Performance Center System Configuration and Installation Guide. For 
information on configuring the ERP/CRM Mediator in the Administration 
Site, see the section that describes setting up the diagnostics modules in the 
HP Performance Center Administrator Guide.

 2 Configure the server machine to enable the diagnostics feature. 

For more information, see “Configuring Siebel Diagnostics on the 
Application and Web Servers” on page 510 (Siebel Diagnostics), “Enabling 
Server Logging on the Siebel Server” on page 520 (Siebel DB Diagnostics), 
and “Enabling Server Logging on the Oracle Server” on page 527, and 
“Selecting the Oracle NCA Application Version” on page 529 (Oracle DB 
Diagnostics).

 3 Prepare the server machine to generate diagnostics data and communicate 
with the mediator machines. 

For more information, see “Setting Up the Siebel Diagnostics Module” on 
page 514, “Setting Up the Siebel DB Diagnostics Module” on page 522, 
“Setting Up the Oracle 11i Diagnostics Module” on page 530, and “Setting 
Up the SAP Diagnostics Module” on page 536.

 4 Collect and prepare the diagnostics data.

During the load test, the mediator collects the data and processes the 
diagnostics information. 

 5 Create the results.

After the load test, the Controller machine collects the aggregated data from 
the Mediator machines and collates the results. 
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 6 Present the data.

Use the Analysis graphs to view the diagnostics data and drill down to the 
problematic areas. For more information about ERP/CRM Transaction 
Breakdown graphs, see the HP LoadRunner Analysis User Guide.

Connecting to a Remote Server

When you set up the ERP/CRM diagnostics modules, you define a server to 
monitor by entering the user name of the machine where trace/log files are 
stored. This section describes how you connect to remote Windows or UNIX 
servers.

Connecting to a Remote Windows Server
For Windows platforms, the user should have administrator privileges. 

When working on a remote Windows server, the mediator first tries to add a 
connection to that machine with the details supplied by the user. This 
configuration should give administrator permissions to the remote 
machine.

If the Mediator machine is already connected to the server machine with a 
different configuration, it will use the existing connection to the server. This 
may lead to an error if the user is a non-administrator. 

To solve this conflict you may select one of the following solutions:

➤ Change the LoadRunner Agent to work as a service and not as a process.

➤ Close existing connections from the Mediator to the server.

These connections can use \\servername\sharename in the Windows 
Explorer, or a specified mount in My Computer.

To check whether connections exist, open the Command prompt and run 
the following command:

net use



Chapter 29 • Introducing ERP/CRM Diagnostics

506

To remove a connection, remove the mount, and run the following 
command:

➤ You may use your own created connection to the log directory by supplying 
the UNC-path to the log directory and marking the OS as WINDOWS. 
When the Mediator runs, it will not try to create a connection, but rely on 
the given UNC-path instead.

Connecting to a Remote UNIX Server
Before using the remote shell (RSH) through the Mediator, verify that:

➤ RSH and RCP daemons are running on the UNIX server.

➤ The user has permission to run remote shell commands. To check this, type 
the following at the DOS command prompt: 

For example: 

➤ No output is generated after executing the RSH command. Due to a bug in 
the RCP UNIX command, you should not generate output from the .login, 
.profile, and .cshrc files (for example by echo, or in any other way, including 
commands that generate output indirectly, such as biff). Where an existing 
user generates output in the RSH step that cannot be deleted, you should 
create a new user that does not generate output, and who has permissions to 
run RSH and RCP commands on the server machine. 

net use \\servername\sharename /DELETE

rsh <server machine name> -l <UNIX user login name> -n <command>

rsh my_unix -l my_name -n "cd ~;pwd"
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Viewing Diagnostics Results

To view transaction breakdown results, you run Performance Center 
Analysis to analyze the data gathered during the run. You perform analysis 
from the Load Test Results page. For more information on using the 
analysis, see Chapter 26, “Analyzing a Load Test.”

You can use the Analysis transaction breakdown graphs and reports to view 
the performance data and drill down to pinpoint problem areas in any layer 
of the application. For more information about Performance Center 
Transaction Breakdown Diagnostics graphs, see the HP LoadRunner Analysis 
User Guide.
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30
Configuring Siebel Diagnostics

Siebel Diagnostics enable you to breakdown Siebel transactions into layers, 
areas, sub-areas, servers, and scripts. You can also view the transaction chain 
of calls and call stack statistics to track the percent of time spent for each 
part of the transaction. Siebel-Web Vusers support Siebel Diagnostics.

This chapter includes:

 ➤  Configuring Siebel Diagnostics on the Application and Web Servers 
on page 510

 ➤  Configuring Diagnostics where the Web Server is Inside a DMZ on page 512

 ➤  Copying Files from the Siebel Application Server to the Mediator on page 513

 ➤  Setting Up the Siebel Diagnostics Module on page 514

Note: Siebel Diagnostics (Siebel Application Response Measurements) 
supports Siebel application servers versions 7.53 and 7.7. 
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Configuring Siebel Diagnostics on the Application and 
Web Servers

To configure Siebel Application and Web servers for transaction breakdown, 
you need to do the following:

➤ Enable Siebel diagnostics on all Siebel Application and Web servers involved 
in the load test

➤ Optimize server performance settings

➤ Generate a list of Siebel server IDs (required for Siebel Application servers 
only)

To enable Siebel diagnostics:

 1 Set the environment variable on the Siebel server to:

 2 Restart the server. 

To optimize server performance:

You can change the maximum memory caching and file size using the 
following variables: 

SIEBEL_SarmMaxMemory controls the size of the buffer that Siebel keeps in 
the memory before writing the information to the Siebel log files. You can 
improve server performance by increasing the parameter value, however 
information from the end of the run will be missing from the Analysis 
graphs. We recommend setting SIEBEL_SarmMaxMemory= 50000 for low 
loads on the server and SIEBEL_SarmMaxMemory= 1000000 for high loads 
on the server. A low load on the server is 20 Vusers or less, and a high load is 
more than 100 Vusers.

SIEBEL_SarmEnabled=true

SIEBEL_SarmMaxMemory= <bytes> 
SIEBEL_SarmMaxFileSize = <bytes>
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For SIEBEL_SarmMaxFileSize, the recommended file size is from 5000000 
for low loads on the server to 25000000 for high loads on the server. If more 
than one Siebel log file is generated on the server every 10 seconds, you 
should increase the SIEBEL_SarmMaxFileSize.

Note: Before running a load test, delete Siebel Diagnostics logs from all 
servers involved in the load test.

To generate Siebel Server IDs:

On the Siebel application server, open a command window and run the 
command: 

where:

/u  <username> is the server administrator username

/p  <password> is the server administrator password

/g  <gateway server> is the gateway server address

/e  <entrpr server> is the enterprise server name

/c  <command> is the execute a single command

This command generates a list of all the Siebel application servers and their 
IDs. Keep a record of the server IDs, since this information is required for the 
Add Siebel Server page. For more information, see step 8 of “Setting Up the 
Siebel Diagnostics Module” on page 514.

<Siebel bin directory>\srvrmgr /u <username> /p <password> /g <gateway server> /e 
<entrpr server> /c "list servers show SBLSRVR_NAME, SV_SRVRID" 
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Configuring Diagnostics where the Web Server is Inside a 
DMZ

If you are using an application server in the internal network and a Web 
(file) server in a DMZ (a "neutral zone" that separates an internal network 
from a public one that is used to prevent outside access to a company’s 
private data), you must install the mediator on the internal (over firewall) 
LAN, and enable SMB/CIFS communication from the internal machine to 
the file server in the DMZ. SMB/CIFS are the file sharing services that use the 
NBT (NetBIOS over TCP/IP) as the transport protocol. 

To enable the NBT protocol between the client (over firewall machine) and 
the file server, use the following port configuration:

 

For example, configure the firewall settings as follows:

Service enabled: "nbsession" for TCP 139 connection.

Service enabled: "Microsoft-ds" for TCP 445 connection.

Note: CIFS over TCP 445 (direct SMB over TCP/IP) is optional with Windows 
2000 and above (since it is a more secure way of communicating with the 
file server). To enable CIFS over TCP/IP, you must disable the NetBIOS over 
TCP/IP protocol using the operating system configuration.

File Sharing Service Port

SMB/CIFS over NBT TCP 139 (SMB)

CIFS over TCP/IP (Direct SMB) TCP 445
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Copying Files from the Siebel Application Server to the 
Mediator

After configuring the application server, you need to copy the files listed 
below from the Siebel Application server \bin directory to either the 
<LR mediator installation>\bin directory, or any other directory in PATH on 
the Siebel mediator machine.

➤ For Siebel 7.53, copy the following files:

➤ For Siebel 7.7, copy the following files:

➤ sarmanalyzer.exe

➤ msvcr70.dll

➤ sslcver.dll

➤ sslcsym.dll

➤ sslcshar.dll

➤ sslcosa.dll

➤ libarm.dll

➤ msvcr70.dll

➤ sslcacln.dll

➤ sslccore.dll

➤ sslcevt.dll

➤ sslcos.dll

➤ sslcosa.dll

➤ sslcosd.dll

➤ sslcrsa.dll

➤ sslcscr.dll

➤ sslcshar.dll

➤ sslcsrd.dll

➤ sslcsym.dll

➤ sslcver.dll
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Setting Up the Siebel Diagnostics Module

To generate transaction breakdown data, you set up the Siebel Diagnostics 
module to communicate with the mediator machine and define the servers 
that you want to monitor. You can then enable the diagnostics module and 
specify the sampling percentage of transaction data to include in the 
diagnostics graphs, as described in “Enabling Diagnostics” on page 493.

Note: For meaningful transaction breakdown results, you should define 
every action as a transaction in the Vuser script Run-time Settings. To 
generate valid transaction breakdown data, you should manually define the 
transactions in the Vuser script rather than using automatic transactions. 
Make sure to disable the following options in the Run-Time Settings’ 
General: Miscellaneous node: Define each action as a transaction and 
Define each step as a transaction.

To set up the Siebel Diagnostics module:

 1 On the Load Test configuration page, click the Diagnostics tab. The 
Diagnostics tab opens.

 2 Make sure that Enable diagnostics is selected.

 3 Set the percentage of Vusers to participate in the monitoring. The maximum 
number of Siebel Vusers on which breakdown can be performed is 10%.

Note: If you have enabled other diagnostics types, the percentage of Vuser 
participation cannot exceed the maximum of any of the selected diagnostics 
types.
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 4 In the Offline Diagnostics section, click the Configure button next to Siebel 
Diagnostics (Max. Vuser Sampling: 10%).

The Siebel Configuration dialog box opens displaying any previously saved 
data.

 5 Select Enable Siebel Diagnostics to enable all the other fields in the dialog 
box. 

To disable the Siebel DB Diagnostics module, clear the Enable Siebel 
Diagnostics check box. The information in the dialog box (if any) is 
displayed in gray and is read only.

 6 From the Mediator list, select the mediator machine used to collect and 
process the Siebel diagnostics data. Only one mediator machine is supported 
for each diagnostics module.

Note: Mediators must be predefined on the Administrator site. For more 
information, see the HP Performance Center Administrator Guide.
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 7 To test the connection between the Web server (User) and the mediator, 
click Test Mediator. The Web server attempts to connect to the mediator. 
The connection status is displayed in the dialog box. 

 8 Click Add Server to define a Siebel server to monitor. The Add Siebel Server 
dialog box opens.

Note: The Add Server button is disabled if no mediator has been defined.

 9 Type or select the following Siebel server information in the Add Siebel 
Server dialog box:

➤ Server Name. Type the name of the Siebel server.

➤ Server Type. Select the Siebel server type (Web or Application).

➤ Server ID. Type the Siebel server ID (for Siebel application servers only). 
For information on generating a list of server IDs, see “Configuring Siebel 
Diagnostics on the Application and Web Servers” on page 510.

➤ Platform. Select the Siebel server platform (Windows, Solaris, AIX, HAPX, 
or LINUX).
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➤ Log Directory. Type a location where the Siebel application saves the log 
files. The log files can be saved in a shared log directory on the Siebel 
server or in a separate folder.

➤ User Name. Type the user name of the machine where log files are stored. 

Note: For Windows platforms, the user should have administrator 
privileges. See “Connecting to a Remote Windows Server” on page 505 
for more information. For UNIX platforms, see “Connecting to a Remote 
UNIX Server” on page 506. 

➤ User Password. Type the user password (optional).

➤ Domain. Type the Siebel Server domain (for Windows platforms only).

Click OK. The Add Siebel Server dialog box closes and the server information 
is added to the list of Siebel servers.

 10 In the Siebel Configuration dialog box, select the check box in the left 
column for each Siebel server that you want to enable in the session.

To disable a server from the session, clear the check box for the desired 
server.

 11 To edit server information, click the Edit button. The Add Siebel Server 
dialog box opens displaying the server information. Edit the desired fields, 
then click OK.

 12 To delete a Siebel server, select the server and click Delete. The server is 
removed from the Siebel server list.

 13 Click OK to save your settings and close the Siebel Configuration dialog box. 
A check mark icon appears next to Siebel Diagnostics in the Diagnostics 
page, indicating that it is enabled.
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31
Configuring Siebel DB Diagnostics

Siebel DB Diagnostics help you to rapidly identify and resolve database 
performance problems. You can view the SQLs for each transaction, identify 
the problematic SQL queries of each script, and identify at what point 
problems occurred. Siebel-Web Vusers support Siebel DB Diagnostics.

This chapter includes:

 ➤  Preparing the Script on page 519

 ➤  Synchronizing Times on page 520

 ➤  Enabling Server Logging on the Siebel Server on page 520

 ➤  Setting Up the Siebel DB Diagnostics Module on page 522

Preparing the Script

When preparing your script for transaction breakdown, add think time at 
the end of each transaction using the ratio of one second per hour of 
testing.

To avoid session ID conflicts, make sure that the Vusers log out of the 
database at the end of each session.
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Synchronizing Times

To check that the correlation of SQLs to transactions is correct, you should 
synchronize server times before performing transaction breakdown.

On a Windows Siebel server, you synchronize the time with the Siebel 
Gateway server by running the following command from the Load 
Generator machine:

Replace <Gateway name> with the name of the Siebel Gateway.

On Unix Siebel servers you can synchronize the time in one of the following 
ways:

➤ Use the date command on the UNIX Siebel Gateway server to change the 
time manually, so it will be synchronized with the Load Generator time.

➤ Change the time on the Load Generator machine so that it will be 
synchronized with the UNIX Siebel Gateway server.

➤ Configure the time difference in Analysis. For more information see the 
section that describes Siebel DB diagnostics graphs in the HP LoadRunner 
Analysis User Guide.

Enabling Server Logging on the Siebel Server

Before you set up the Siebel DB diagnostics module on the Controller, you 
must configure the Siebel server to create the database log files.

To enable logging on the Siebel server:

 1 On the Siebel server, open a command window and run the command: 

net time \ <Gateway name> /set /y

<Siebel bin directory>\srvrmgr /g <gateway server> /s <Siebel server> /e <enterprise 
server name> /u <username> /p <password>
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 2 Type the following commands: 

For the Call Center, type sccobjmgr_enu as the component name. For 
example:

To disable logging on the Siebel server:

On the Siebel server, type the following commands:

Note: Before running a load test, delete log files from all servers involved in 
the load test.

change evtloglvl ObjMgrsqllog=4 for comp <component name>

evtloglvl EventContext=3 for comp <component name>

evtloglvl ObjMgrSessionInfo =3 for comp <component name> 

change evtloglvl ObjMgrsqllog=4 for comp sccobjmgr_enu

change evtloglvl ObjMgrsqllog=0 for comp <component name>

change evtloglvl EventContext=0 for comp <component name>

change evtloglvl ObjMgrSessionInfo =0 for comp <component name>
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Setting Up the Siebel DB Diagnostics Module

To generate transaction breakdown data, you set up the Siebel DB 
Diagnostics module to communicate with the mediator machine and define 
the servers that you want to monitor. You can then enable the diagnostics 
module and specify the sampling percentage of transaction data to include 
in the diagnostics graphs, as described in “Enabling Diagnostics” on 
page 493.

Note: For meaningful transaction breakdown results, you should define 
every action as a transaction in the Vuser script Run-time Settings. To 
generate valid transaction breakdown data, you should manually define the 
transactions in the Vuser script rather than using automatic transactions. 
Make sure to disable the following options in the Run-Time Settings’ 
General: Miscellaneous node: Define each action as a transaction and 
Define each step as a transaction.

To set up the Siebel DB Diagnostics module:

 1 On the Load Test configuration page, click the Diagnostics tab. The 
Diagnostics tab opens.

 2 Make sure that Enable diagnostics is selected.

 3 Set the percentage of Vusers to participate in the monitoring. The maximum 
number of Siebel Vusers on which breakdown can be performed is 10%.

Note: If you have enabled other diagnostics types, the percentage of Vuser 
participation cannot exceed the maximum of any of the selected diagnostics 
types.
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 4 In the Offline Diagnostics section, click the Configure button next to Siebel 
DB Diagnostics (Max. Vuser Sampling: 10%). 

The Siebel DB Configuration dialog box opens displaying any previously 
saved data.

 5 Select Enable Siebel DB Diagnostics to enable all the other fields in the 
dialog box. 

To disable the Siebel DB Diagnostics module, clear the Enable Siebel DB 
Diagnostics check box. The information in the dialog box (if any) is 
displayed in gray and is read only.

 6 From the Mediator list, select the mediator machine used to collect and 
process the Siebel diagnostics data. Only one mediator machine is supported 
for each diagnostics module.

Note: Mediators must be predefined on the Administrator site. For more 
information, see the HP Performance Center Administrator Guide.
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 7 To test the connection between the Web server (User) and the mediator, 
click Test Mediator. The Web server attempts to connect to the mediator. 
The connection status is displayed in the dialog box. 

 8 Click Add Server to define a Siebel server to monitor. The Add Siebel DB 
Server dialog box opens.

Note: The Add Server button is disabled if no mediator has been defined.

 9 Type the following Siebel server information in the Add Siebel DB Server 
dialog box:

➤ Server Name. Type the name of the Siebel server.

➤ Platform. Select the Siebel server platform (Windows, Solaris, or HAPX).

➤ Log Directory. Type a location where the Siebel application saves the log 
files. The log files can be saved in a shared log directory on the Siebel 
server or in a separate folder.

➤ User Name. Type the user name of the machine where log files are stored. 
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Note: For Windows platforms, the user should have administrator 
privileges. See “Connecting to a Remote Windows Server” on page 505 
for more information. For UNIX platforms, see “Connecting to a Remote 
UNIX Server” on page 506. 

➤ User Password. Type the user password (optional).

➤ Domain. Type the Siebel Server domain (for Windows platforms only).

Click OK. The Add Siebel DB Server dialog box closes and the server 
information is added to the server list in the Siebel DB Configuration dialog 
box.

 10 In the Siebel DB Configuration dialog box, select the check box in the left 
column for each Siebel server that you want to enable in the session.

To disable a Siebel server from a session, clear the check box in the left 
column for the desired server.

 11 To edit server information, click the Edit button. The Add Siebel DB Server 
dialog box opens displaying the server information. Edit the desired fields, 
then click OK.

 12 To delete a Siebel server, select the server and click Delete. The server is 
removed from the Siebel server list.

 13 Click OK to save your settings and close the Siebel DB Configuration dialog 
box. A check mark icon appears next to Siebel DB Diagnostics in the 
Diagnostics page, indicating that it is enabled.
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32
Configuring Oracle 11i Diagnostics

Oracle Diagnostics help pinpoint performance problems on Oracle 11i NCA 
systems. The diagnostics information drills down from the transaction, to 
the SQL statements and the SQL stages of each statement. Oracle NCA 
Vusers support Oracle 11i Diagnostics.

This chapter includes:

 ➤  Enabling Server Logging on the Oracle Server on page 527

 ➤  Selecting the Oracle NCA Application Version on page 529

 ➤  Setting Up the Oracle 11i Diagnostics Module on page 530

Enabling Server Logging on the Oracle Server

Verify that the trace diagnostics are enabled, disable the Enable Diagnostics 
password request, and set the trace file size to unlimited. By default, trace 
diagnostics are enabled on the Oracle server during installation. In addition, 
to help Performance Center deal with the Oracle application diagnostics 
password, you can either set the diagnostics password in the Vuser script or 
disable the password request on the application server.

To check that trace diagnostics are enabled:

 1 Log on to the Oracle application server with administrator privileges, and 
select the module you want in the Oracle application. The Responsibilities 
dialog box opens.

 2 Select System Administrator and click OK. 

 3 In the Functions tab, select Profile > System and click Open. The System 
Profile Values dialog box opens.
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 4 In the Display section, select Site and Profiles with No Values, type 
%Diagnostics% in the Profiles field, then click Find.

 5 If any diagnostics profiles are disabled (denoted by a "Yes" in the Site 
column), change the setting to "No". 

 6 Save your settings.

To set the trace file size to unlimited:

For Oracle 9i:

On the Oracle server, run the following command in the SQL editor:

For Oracle 8i:

 1 On the Oracle server, run the following command in the SQL editor:

 2 Edit the init*.ora file on $ORACLE_HOME\admin\<sid>\pfile\init<sid>.ora. 
Find the line of the parameter, change its value, then save the file.

Note: Verify that you have enough disk space on the database server since 
these trace files can be very large.

Alter system set max_dump_file_size=UNLIMITED scope=both;

Alter system set max_dump_file_size=2048000;
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To set the diagnostics password in the Vuser script:

In VuGen, add the nca_set_diagnostics_password(<password>) function 
to your script and select a password.

Note: The nca_set_diagnostics_password function must come after the 
nca_connect_server function.

To disable the Enable Diagnostics password request:

 1 Log on to the Oracle application server with administrator privileges, and 
select the module you want in the Oracle Application. The Responsibilities 
dialog box opens.

 2 Select System Administrator and click OK. 

 3 In the Functions tab, select Profile > System and click Open. The System 
Profile Values dialog box opens.

 4 In the Display section, select User, and type the required user name. In the 
Profile field, type %Utilities:Diagnostics% and click Find. The 
Utilities:Diagnostics profile values are displayed.

 5 In the User column of the Utilities:Diagnostics profile, set the value to Yes.

 6 Save your settings.

Selecting the Oracle NCA Application Version

The Oracle diagnostics module supports Oracle NCA versions 11.5.0 and 
later. type the version of your Oracle application server in VuGen’s run-time 
settings to enable the built-in trace mechanism. To check the version of your 
Oracle server, log in to the Oracle server and click Help > About Oracle. The 
version of your Oracle server is displayed in the Oracle Application field.

To enter your Oracle application version:

Open the script in VuGen, and select Vuser > Run-Time Settings. In the 
Oracle NCA: Client Emulation node, select the version of Oracle NCA that 
you are using in the Application Version field.



Chapter 32 • Configuring Oracle 11i Diagnostics

530

Note: 

➤ If the Oracle 11i trace cannot be enabled using the built-in mechanism, 
you can enable it manually in the Vuser script using the 
nca_set_custom_dbtrace and nca_set_dbtrace_file_index functions. This 
may occur if you are using a custom application that does not have a 
standard UI.

➤ Before enabling the diagnostics module, delete old trace log files from all 
servers involved in the load test.

➤ Real users should not work on the Oracle server while the diagnostics 
module is running, as this may affect transaction breakdown results.

Setting Up the Oracle 11i Diagnostics Module

To generate transaction breakdown data, you set up the Oracle 11i 
Diagnostics module to communicate with the mediator machine and define 
the servers that you want to monitor. You can then enable the diagnostics 
module and specify the sampling percentage of transaction data to include 
in the diagnostics graphs, as described in “Enabling Diagnostics” on 
page 493.

Note: For meaningful transaction breakdown results, you should define 
every action as a transaction in the Vuser script Run-time Settings. To 
generate valid transaction breakdown data, you should manually define the 
transactions in the Vuser script rather than using automatic transactions. 
Make sure to disable the following options in the Run-Time Settings’ 
General: Miscellaneous node: Define each action as a transaction and 
Define each step as a transaction.
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To set up the Oracle 11i Diagnostics module:

 1 On the Load Test configuration page, click the Diagnostics tab. The 
Diagnostics tab opens.

 2 Make sure that Enable diagnostics is selected.

 3 Set the percentage of Vusers to participate in the monitoring. The maximum 
number of Oracle Vusers on which breakdown can be performed is 5%.

Note: If you have enabled other diagnostics types, the percentage of Vuser 
participation cannot exceed the maximum of any of the selected diagnostics 
types.

 4 In the Offline Diagnostics section, click the Configure button next to Oracle 
11i Diagnostics (Max. Vuser Sampling: 5%).

The Oracle 11i Configuration dialog box opens displaying any previously 
saved data.
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 5 Select Enable Oracle 11i Diagnostics to enable all the other fields in the 
dialog box. 

To disable the Oracle 11i Diagnostics module, clear the Enable Oracle 11i 
Diagnostics check box. The information in the dialog box (if any) is 
displayed in gray and is read only.

 6 From the Mediator list, select the mediator machine used to collect and 
process the Oracle diagnostics data. Only one mediator machine is 
supported for each diagnostics module.

Note: Mediators must be predefined on the Administrator site. For more 
information, see the HP Performance Center Administrator Guide.

 7 To test the connection between the Web server (User) and the mediator, 
click Test Mediator. The Web server attempts to connect to the mediator. 
The connection status is displayed in the dialog box. 

 8 Click Add Server to define an Oracle server to monitor. The Add Oracle 
Server dialog box opens.

Note: The Add Server button is disabled if no mediator has been defined.



Chapter 32 • Configuring Oracle 11i Diagnostics

533

 9 Type the following Oracle server information in the Add Oracle Server 
dialog box:

➤ Server Name. Type the name of the Oracle server.

➤ Platform. Select the Oracle server platform (Windows, Solaris, or HAPX).

➤ Log Directory. Type a location where the Oracle application saves the 
trace files. The trace files can be saved in a shared directory on the Oracle 
server or in a separate folder.

➤ User Name. Type the user name of the machine where trace files are 
stored. 

Note: For Windows platforms, the user should have administrator 
privileges. See “Connecting to a Remote Windows Server” on page 505 
for more information. For UNIX platforms, see “Connecting to a Remote 
UNIX Server” on page 506. 

➤ User Password. Type the user password (optional).

➤ Domain. Type the Oracle server domain (for Windows platforms only).

Click OK. The Add Oracle Server dialog box closes and the server 
information is added to the list of Oracle servers.

 10 In the Siebel Configuration dialog box, select the check box in the left 
column for each Oracle server that you want to enable in the session.

To disable an Oracle server from a session, clear the check box for the 
desired server.

 11 To edit server information, click the Edit button. The Add Oracle Server 
dialog box opens displaying the server information. Edit the desired fields, 
then click OK.

 12 To delete an Oracle server, select the server and click Delete. The server is 
removed from the Oracle server list.

 13 Click OK to save your settings and close the Oracle 11i Configuration dialog 
box. A check mark icon appears next to Oracle 11i Diagnostics in the 
Diagnostics page, indicating that it is enabled.
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33
Configuring SAP Diagnostics

SAP Diagnostics help you to rapidly identify and resolve DBA, Network, 
WAS, Application, and OS/HW problems in your SAP system.

This chapter includes:

 ➤  SAP Diagnostics Overview on page 535

 ➤  SAP Diagnostics Supported Environments on page 536

 ➤  Setting Up the SAP Diagnostics Module on page 536

SAP Diagnostics Overview

Server-side Data Collection

SAP Diagnostics is based on SAP Distributed Statistical Records (DSR). For 
each dialog step performed on application server, a statistical record is 
generated, which includes information such as response time components, 
database statistics, RFC times, and so on. 

The Diagnostics Mediator is responsible for collecting diagnostics data from 
the server during a load test run.

Vuser Coloring

SAP Diagnostics works for replay of the SAPGUI protocol. You set the 
percentage of colored Vusers in the Configuration dialog (up to 100% 
allowed). Coloring of SAPGUI users creates no overhead on the Application 
server.
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SAP Diagnostics Supported Environments

The following table outlines the supported versions and required Kernel 
patches for the SAP Application Server and the SAPGUI Client:

Setting Up the SAP Diagnostics Module

To generate transaction breakdown data, you set up the SAP Diagnostics 
module to communicate with the mediator machine and define the servers 
that you want to monitor. You can then enable the diagnostics module and 
specify the sampling percentage of transaction data to include in the 
diagnostics graphs, as described in “Enabling Diagnostics” on page 493.

Note: 

➤ When using SAP Diagnostics, ensure that a SAPGUI client is installed on 
the same machine as the ERP/CRM Mediator.

➤ To generate valid transaction breakdown data, you should manually 
define the transactions in the Vuser script rather than using automatic 
transactions. In the Run-Time Settings’ General: Miscellaneous node, 
clear the following options: Define each action as a transaction and 
Define each step as a transaction.

Supported Version Required Kernel Patch

SAP Application 
Server

4.6C; 4.6D Kernel Patch 1984 (released 
on 11/01/05, SAP note 
0451251)

4.7 and higher No patch required.

SAPGUI Client SAPGUI for Windows 6.20 Minimum patch level: 48

SAPGUI for Windows 6.40 Minimum patch level: 2
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To set up the SAP Diagnostics module:

 1 On the Load Test configuration page, click the Diagnostics tab. The 
Diagnostics tab opens.

 2 Make sure that Enable diagnostics is selected.

 3 Set the percentage of Vusers to participate in the monitoring. The maximum 
number of SAP Vusers on which breakdown can be performed is 100%.

Note: If you have enabled other diagnostics types, the percentage of Vuser 
participation cannot exceed the maximum of any of the selected diagnostics 
types.

 4 In the Offline Diagnostics section, click the Configure button next to SAP 
Diagnostics (Max. Vuser Sampling: 100%).

The SAP Configuration dialog box opens displaying any previously saved 
data.
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 5 Select Enable SAP Diagnostics to enable all the other fields in the dialog box. 

To disable the SAP Diagnostics module, clear the Enable SAP Diagnostics 
check box. The information in the dialog box (if any) is displayed in gray 
and is read-only.

 6 In the Mediator section, select the mediator machine used to collect and 
process the SAP diagnostics data. Only one mediator machine is supported 
for each diagnostics module.

Note: Mediators must be predefined on the Administrator site. For more 
information, see the HP Performance Center Administrator Guide.

 7 In the Server Properties section, type the following SAP server information:

➤ Server Host Name. The name of the SAP server.

➤ User Name. The name of the SAP client.

➤ User Password. The password for the SAP client.

➤ Client #. The number of the SAP client machine.

➤ System Router String. The system router string of the SAP server 
(optional).

➤ System #. The system number of the SAP server.

➤ Route String. The system route string of the SAP server (optional).

 8 Click Validate to check that the server is connected properly. 

When you click Validate, the Controller produces a report of all the servers 
that are available for diagnostics through the Server Host. The report is 
displayed in the Output window. If the validation process fails, an error 
window opens displaying detailed error messages.

Note: Errors that occur during the validation process may not occur during 
the load test run.
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 9 Click OK to save your settings and close the SAP Configuration dialog box. A 
check mark icon appears next to SAP Diagnostics in the Diagnostics page, 
indicating that it is enabled.
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34
HP Diagnostics Integration with 
Performance Center

This chapter describes the Performance Center integration with HP 
Diagnostics.

This chapter includes:

 ➤  About HP Diagnostics Software Integration with  Performance Center 
on page 542

 ➤  Setting Up the HP Diagnostics Software Module on page 542

 ➤  Configuring Performance Center to Use HP Diagnostics on page 543

For detailed information about setting up Performance Center to use HP 
Diagnostics, see the HP Performance Center Administrator Guide.

For detailed information about viewing diagnostics data while running a 
load test, see “Drilling Down Diagnostics Data” on page 407.
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About HP Diagnostics Software Integration with 
Performance Center

The HP Diagnostics integration with Performance Center allows you to 
monitor and analyze the performance of Java 2 Enterprise Edition (J2EE), 
.NET-connected, SAP, Oracle, and other complex environments.

During a load test run, you can drill down into HP Diagnostics data for the 
whole load test or for a particular transaction. After the load test run, you 
can use HP LoadRunner Analysis to analyze offline diagnostics data 
generated during the load test. 

For detailed information about viewing diagnostics data, see the HP 
Diagnostics User Guide.

Setting Up the HP Diagnostics Software Module

Important: Before you can use HP Diagnostics with Performance Center, you 
need to make sure that you have specified the Diagnostics Server details in 
the Performance Center Administration Site. For details, see the HP 
Performance Center Administrator Guide. 
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Configuring Performance Center to Use HP Diagnostics

To capture Diagnostics metrics in a load test, you need to configure the 
Diagnostics parameters for the load test and select the probes that will be 
included in the load test. You provide this information on the Load Test 
Configuration page of the Performance Center User Site.

To configure the Diagnostics parameters for a load test:

 1 On the Load Test configuration page, click the Diagnostics tab. The 
Diagnostics tab opens.

 2 Make sure that Enable diagnostics is selected.

 3 Set the percentage of Vusers to participate in the HP Diagnostics (J2EE/.NET 
Diagnostics) monitoring. 

The maximum percentage of Vusers for which HP Diagnostics (J2EE/.NET 
Diagnostics) data can be collected is 100%, unless you have enabled other 
types of diagnostics. In this case, the percentage of Vuser participation in HP 
Diagnostics (J2EE/.NET Diagnostics) cannot exceed the maximum of any of 
the other types of diagnostics that you enabled. 

For example, if you enabled Web Page Diagnostics, which has a maximum 
user participation of 10%, the percentage of Vuser participation for HP 
Diagnostics (J2EE/.NET Diagnostics) cannot exceed 10%.

The minimum amount of Vusers for which HP Diagnostics (J2EE/.NET 
Diagnostics) data can be collected is 1% or 1 virtual user per script.
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 4 In the Offline and Online Diagnostics section, click Configure to open the 
J2EE/.NET Configuration dialog box.

Note: This dialog box is read-only while a load test is running.

 5 Select Enable J2EE/.NET Diagnostics.

 6 In the Select Probes list, select the probes to be included in your load test.

➤ Select the check box adjacent to each probe that you want to monitor. 

➤ To disable a probe for the duration of a load test, clear the check box.

Note: You must enable at least one probe in order to save the HP 
Diagnostics configuration.
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 7 If the Diagnostics Server (or a Diagnostics Server in Mediator mode in a 
distributed environment) is located behind a firewall, select There is a 
firewall between the mediator and the Controller.

If you are monitoring over a firewall, make sure that you have installed an 
MI Listener on a machine outside the firewall, and that you specify the 
IP address of the MI Listener on the Performance Center Administration 
Site’s MI Listeners page, in the Firewall Diagnostics Communicator field. For 
installation instructions, see the HP Performance Center System Configuration 
and Installation Guide. For details on defining the MI Listener, see the HP 
Performance Center Administrator Guide..

 8 To capture a percentage of server requests which occur outside the context 
of any Vuser transaction select Monitor server requestsx.

The server requests will be captured at the same percentage as was selected 
for the percentage of Vusers on Diagnostics Distribution dialog box.

Note: Enabling this functionality imposes an additional overhead on the 
probe.

The benefit of enabling this functionality is that calls into a back-end VM 
can be captured even in the case where: 

➤ the probe is not capturing RMI calls.

➤ RMI calls cannot be captured (perhaps because an unsupported 
application container is being used).

➤ the application uses some other mechanism for communications 
between multiple VMs.

To investigate any issues that you have with the connections between the 
Diagnostics components, click the Troubleshoot diagnostics for J2EE/.NET 
connectivity link. This will open the HP Diagnostics System Health Monitor 
in a new browser window.

 9 Click OK to confirm your selections and to close the J2EE/.NET Diagnostics 
Configuration dialog box. 
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 10 Click Save on the Load Test configuration page to save and validate your 
settings and complete the configuration.

Note: For more information about configuring Diagnostics to work with a 
firewall see the HP Diagnostics Installation and Configuration Guide.
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35
Configuring General Run-Time Settings

Before you run a load test, you can configure its behavior using run-time 
settings. You can configure general settings and protocol-specific settings.

For information about the protocol-specific settings, see Chapter 36, 
“Configuring Protocol-Specific Run-Time Settings.”

This chapter includes:

 ➤  About Run-Time Settings on page 549

 ➤  Run Logic Settings on page 551

 ➤  Pacing Settings on page 553

 ➤  Log Settings on page 555

 ➤  Think Time Settings on page 558

 ➤  Miscellaneous Settings on page 560

About Run-Time Settings

After you record a Vuser script, you can configure its run-time settings. The 
run-time settings define the way the script runs, such as delay between 
actions, the number of times to repeat an action, and the level of logging.

Configuring run-time settings allows you to emulate different kinds of user 
activity. For example, you can emulate a user who responds immediately to 
the server, or a user who stops and thinks before each response. You can also 
configure the run-time settings to specify how many times the Vuser should 
repeat a set of actions.
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To open the run-time settings:

 1 Open a project and select Load Tests > Manage.

 2 Click the Workload tab to see the list of scripts. If there are no scripts listed, 
click Click here to add a new group, and add a script from the list.

 3 Click the Edit Runtime Settings button. The Run Logic options are 
displayed.

 4 Select the run-time setting link that you want to set.

See the following sections to understand the meaning and the impact of 
each run-time setting.

The General runtime settings described in this chapter, apply to all types of 
Vuser scripts. They include:

➤ Run Logic Settings

➤ Pacing Settings

➤ Log Settings

➤ Think Time Settings

➤ Miscellaneous Settings
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Run Logic Settings 

Note: Run Logic settings are not available to certain protocols, such as 
Windows Socket, Sybase, and Oracle 2-tier.

Every Vuser script contains three sections: Init, Run, and End. You can 
instruct a Vuser to repeat the Run section a specific number of times when 
you run the script. Each repetition is known as an iteration.

The Init and End sections of a Vuser script are not repeated when you run 
multiple iterations.

Within the Run section, you can organize your steps into separate actions. 
You do this when creating the script.

The Run Logic settings let you organize the actions and their sequence. You 
can also organize blocks that perform one or more actions. 
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To configure the Run Logic settings:

 1 In the Run-Time Settings window, click Run Logic.

 2 In the Run section, select the action or block that you want to manipulate.

 3 Set the sequence of the action. Click the appropriate button on the right 
side of the window—Move Up, Move Down, Insert Action, and so on.

 4 Click OK to save the settings and close the window.
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Pacing Settings

The Pacing Runtime settings let you control the number of iterations and 
the time between them. You can use one of the following methods: 

➤ As soon as the previous iteration ends. The new iteration begins as soon as 
possible after the previous iteration ends.

➤ After the previous iteration ends with a fixed delay of. Starts each new 
iteration at a fixed delay after the end of the previous iteration.

➤ After the previous iteration ends with a random delay of. Starts each new 
iteration at a random delay from the end of the previous iteration. You 
specify a range for the delay. 

When you run the script, the Execution Log shows the actual time the Vuser 
waited between the end of one iteration and the start of the next one.

➤ At fixed or random intervals, every … [to …] seconds. You specify the time 
between iteration—either a fixed number of seconds or a range of seconds 
from the beginning of the previous iteration. For example, you can specify 
to begin a new iteration every 30 seconds, or at a random rate ranging from 
30 to 45 seconds from the beginning of the previous iteration. Each 
scheduled iterations begins only when the previous iteration is complete.

When you run the script, the Execution Log shows the time the Vuser 
waited between the end of one iteration and the start of the next one.

The Execution Log also indicates if the delay could not be achieved, for 
example where it took the iteration 8 seconds and the delay was 7 seconds.
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To configure the Pacing settings:

 1 In the Run-Time Settings window, click Pacing.

 2 In the Iteration Count section, specify the number of times to repeat the 
script’s Run section.

 3 In the Start New Iteration section, select the desired pacing method. When 
applicable, provide a delay time or a range of times.

 4 Click OK to save the settings and close the window.
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Log Settings

During execution, Vusers log information about themselves and their 
communication with the server. The log information is useful for debugging 
purposes.

The Log runtime settings let you disable logging or determine how much 
information is logged to the output—a Standard or Extended log. 

Disabling Logging

Disabling the log is useful when working with many Vusers. If you have tens 
or hundreds of Vusers logging their runtime information to disk, the system 
may work slower than normal. During development, enable logging so that 
you will have information about the replay. You should only disable logging 
after verifying that the script is functional.

If you disable logging, it only affects automatic logging. Messages sent 
manually using message functions such as lr_output_message, are still 
issued. 

Setting the Log Detail Level

You can specify the type of information that is logged: 

➤ Standard Log. Creates a standard log of functions and messages sent during 
script execution to use for debugging. Disable this option for large load 
testing scenarios or profiles. 

If the logging level is set to Standard, the logging mode is automatically set 
to JIT logging when adding it to the Controller host. If, however, the 
logging mode was disabled or set to Extended, then running it from a 
Controller host will not affect its logging settings.

➤ Extended Log. Creates an extended log, including warnings and other 
messages. Disable this option for large load tests. 

You can specify which additional information to add to the extended log 
using the Extended log options:

➤ Parameter substitution. Logs all parameters assigned to the script with 
their values. 

➤ Data returned by server. Logs all data returned by the server.
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➤ Advanced trace. Logs all of the functions and messages sent by the Vuser 
during the session. This option is useful when you debug a Vuser script.

Log Options

The Log runtime settings let you indicate when to send log messages to the 
log: Send messages only when an error occurs or Always send messages. 
During development, you can always send messages. Once you verify that 
your script is functional, you can enable logging for errors only.

If you choose to send messages only when errors occur, also known as JIT, 
(Just in Time) messaging, you can set an advanced option, indicating the 
size of the log cache. See “Setting the Log Cache Size” below.

Setting the Log Cache Size
The Advanced options for the Log runtime settings let you indicate the size 
of the log cache. The log cache stores raw data about the test execution, to 
make it available should an error occur. When the contents of the cache 
exceed the specified size, it deletes the oldest items. The default size is 1KB.

When an error occurs (either an internal error or a programmed error using 
lr_error_message), VuGen places the contents of the cache into the log file 
and Execution Log tab. This allows you to see the events that led up to the 
error. 

The actual file size will be greater than the cache size. For example, if your 
cache size is 1KB, the log file size may be 50 KB. This is normal and only 
reflects the overhead required for formatting the raw data into readable text. 
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To configure the Log settings:

 1 In the Run-Time settings window, click Log.

 2 Click Disable logging to stop the logging. By disabling logging, you may be 
able to conserve resources.

 3 Select the desired type of logging: Standard or Extended. If you chose 
Extended log, enable the desired sub-options. Even without enabling any of 
the sub-options, the Extended log contains more details than the Standard 
log. 

 4 In the Log Options section, indicate when to send messages—always or only 
when an error occurs. Click Advanced options to set the size of the log 
cache.

 5 Click OK to save the settings and close the window.
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Think Time Settings

Vuser think time emulates the time that a real user waits between actions. 
For example, when a user receives data from a server, they may wait several 
seconds to review the data before responding. Vuser scripts use lr_think_time 
functions to emulate the think time delays. 

The following recorded function indicates that the user waited 8 seconds 
before performing the next action:

lr_think_time(8);

By default, when you run a Vuser script, the Vuser uses the think time values 
that were recorded into the script during the recording session. VuGen 
allows you to use the recorded think time, ignore it, limit it, or use a value 
related to the recorded time.
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To configure the Think Time settings:

 1 In the Run-Time Settings window, click Think TIme.

 2 Select the desired think-time option:

➤ Ignore think time. Replay the script ignoring all lr_think_time functions.

➤ Replay the think time as recorded. Use the value recorded. It is the 
argument that appears in the lr_think_time function. For example, 
lr_think_time(10) waits 10 seconds.

➤ Multiply recorded value by. Use a multiple of the recorded think time. 
This can increase or decrease the think time applied during playback. For 
example, if a think time of four seconds was recorded, you can instruct 
your Vuser to multiply that value by two, for a total of eight seconds. To 
reduce the think time to two seconds, multiply the recorded time by 0.5.
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➤ Use random percentage of the recorded think time. Use a random 
percentage of the recorded think time. You set a range for the think time 
value by specifying a range for the think time. For example, if the think 
time argument is 4, and you specify a minimum of 50% and a maximum 
of 150%, the lowest think time can be two (50%) and the highest value 
six (150%). 

 3 To limit the think time’s maximum value, select Limit think time to and 
specify a time. You can use this option in conjunction with the other 
options.

 4 Click OK to save the settings and close the window.

Miscellaneous Settings

You can set the following Miscellaneous runtime options for a Vuser script: 

➤ Error Handling

➤ Multithreading

➤ Automatic Transactions

Error Handling

➤ Continue on Error. Instructs Vusers to continue script execution when an 
error occurs. This option is turned off by default, indicating that the Vuser 
will exit if an error occurs.

➤ Fail open transactions on lr_error_message. Marks all transactions in which 
an lr_error_message function was issued, as Failed. The lr_error_message 
function is issued through a programmed If statement, when a certain 
condition is met. 

➤ Generate Snapshot on Error. Generates a snapshot when an error occurs. 
You can see the snapshot by viewing the Vuser Log and double-clicking the 
line at which the error occurred. 

It is not recommended to enable both the Continue on Error and Generate 
Snapshot on Error options in a load test environment. This configuration 
may adversely affect the Vusers’ performance.
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Multithreading
Vusers support multithread environments. The primary advantage of a 
multithread environment is the ability to run more Vusers per load 
generator. Only threadsafe protocols should be run as threads.

Note: The following protocols are not threadsafe: Sybase-Ctlib, Sybase-
Dblib, Informix, Tuxedo, and PeopleSoft-Tuxedo. 

➤ To enable multithreading, click Run Vuser as a thread. 

➤ To disable multithreading and run each Vuser as a separate process, click 
Run Vuser as a process.

The Controller host uses a driver program (such as mdrv.exe or r3vuser.exe) 
to run your Vusers. If you run each Vuser as a process, then the same driver 
program is launched (and loaded) into the memory again and again for 
every instance of the Vuser. Loading the same driver program into memory 
uses up large amounts of RAM (random access memory) and other system 
resources. This limits the numbers of Vusers that can be run on any load 
generator.

Alternatively, if you run each Vuser as a thread, the Controller host launches 
only one instance of the driver program (such as mdrv.exe), for every 50 
Vusers (by default). This driver process/program launches several Vusers, 
each Vuser running as a thread. These threaded Vusers share segments of the 
memory of the parent driver process. This eliminates the need for multiple 
re-loading of the driver program/process saves much memory space, thereby 
enabling more Vusers to be run on a single load generator.

Automatic Transactions
You can instruct the Controller host to handle every step or action in a 
Vuser script as a transaction. This is called using automatic transactions. The 
Controller assigns the step or action name as the name of the transaction. 
By default, automatic transactions per action are enabled.
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➤ To disable automatic transactions per action, clear the Define each action 
as a transaction check box. (enabled by default)

➤ To enable automatic transactions per step, check the Define each step as 
a transaction check box. (disabled by default)

If you disable automatic transactions, you can still insert transactions 
manually during and after recording. 

To configure the Miscellaneous settings:

 1 In the Run-Time Settings window, click Miscellaneous.

 2 Enable the desired options.

 3 Click OK to save the settings and close the window.
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36
Configuring Protocol-Specific Run-Time 
Settings

Before you run a load test, you can configure its behavior using run-time 
settings. You can configure general settings and protocol-specific settings.

For general information about run-time settings, see Chapter 35, 
“Configuring General Run-Time Settings.”

This chapter includes:

 ➤  About Protocol-Specific Run-Time Settings on page 564

 ➤  Advanced Settings on page 565

 ➤  Browser Emulation Settings on page 568

 ➤  Classpath Options on page 572

 ➤  Client Emulation Settings on page 573

 ➤  Configuration Settings on page 576

 ➤  Download Filter Settings on page 578

 ➤  Gateway Settings on page 580

 ➤  SAPGUI Settings on page 583

 ➤  Java VM Settings on page 586

 ➤  .NET Environment Settings on page 588

 ➤  Preferences (Internet) on page 590

 ➤  Proxy Options on page 599

 ➤  Radius Settings on page 603

 ➤  RTE Settings on page 605
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 ➤  Server and Protocol Settings on page 607

 ➤  Speed Simulation Settings on page 608

 ➤  Timing Settings on page 610

About Protocol-Specific Run-Time Settings

Before replaying a Vuser script, you can configure its run-time settings. The 
run-time settings define the way the script runs, using setting that are 
specific for your particular environment.

Since run-time settings are protocol-specific, you will notice that not all run-
time settings are available. 

This following list shows the protocol-specific run-time settings in 
alphabetical order. For a list of the General run-time settings that apply to 
all protocols, see Chapter 35, “Configuring General Run-Time Settings.”

Run-Time Setting Protocol(s) / Category

Advanced Settings Web Services / JMS

Browser Emulation Settings Internet Protocols / Browser 

Classpath Options Java / Java Environment Settings

Client Emulation Settings Oracle NCA / Oracle NCA 

Configuration Settings Citrix ICA / Citrix

Download Filter Settings Internet Protocols / Internet Protocol

Gateway Settings WAP, MMS / WAP

SAPGUI Settings SAPGUI / SAPGUI

Java VM Settings Java / Java Environment Settings

.NET Environment Settings Microsoft .NET / .NET

Preferences (Internet) Internet Protocols / Internet Protocol

Proxy Options Internet Protocols / Internet Protocol

Radius Settings WAP, MMS / WAP
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Advanced Settings

To use JMS as a transport for Web Service calls, there are several resources 
that need to be allocated and configured. Those resources include the JVM, 
JNDI initialization parameters, JMS resources, and timeout values. 

Performance Center lets you configure some of those resources through the 
run-time settings. You can set options in the area of VM (Virtual Machine), 
the JMS connections, and message timeouts.

VM

➤ Use external VM. Enables you to select a VM (Virtual Machine) other than 
the standard one. If you disable this option, Vusers use the JVM provided 
with Performance Center.

➤ JVM Home. The location of the external JVM. This should point to the JDK 
home directory, defined by JDK_HOME. Performance Center supports JDK 
1.4 and above.

➤ Classpath. The vendor implementation of JMS classes together with any 
other required supporting classes, as determined by the JMS implementation 
vendor

JMS

➤ Additional VM Parameters. Extra parameters to send to the JVM such as 
Xbootclasspath, and any parameters specified by the JVM documentation

➤ JNDI initial context factory. The fully qualified class name of the factory 
class that will create an initial context. Select a context factory from the list 
or provide your own.

RTE Settings Terminal Emulation / RTE

Server and Protocol Settings MMS (Multimedia Messaging Service)

Speed Simulation Settings Internet Protocols, NCA / Network

Timing Settings Citrix ICA / Citrix
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➤ JNDI provider. The URL string of the service provider. For example:
Weblogic - t3://myserver:myport
Websphere - iiop://myserver:myport

➤ JMS connection factory. The JNDI name of the JMS connection factory. You 
can only specify one connection factory per script.

➤ JMS security principal. Identity of the principal (for example the user) for 
the authentication scheme.

➤ JMS security credentials. The principal’s credentials for the authentication 
scheme.

➤ Number of JMS connections per process. The number of JMS connections 
per mdrv process, or Vuser. All Vusers sharing a connection will receive the 
same messages. The default is 1, and the maximum is 50 Vusers. The less 
connections you have per process, the better your performance.

➤ Receive message timeout options. The timeout for received messages. The 
default is No wait.

➤ Indefinite wait. Wait as long as required for the message before 
continuing.

➤ No wait. Do not wait for the Receive message, and return control to 
the script immediately. If there was no message in the queue, the 
operation fails. (default)

➤ Specify the timeout in seconds. Manually specify a timeout value for 
the message. If the timeout expired and no message arrived, the 
operation fails.

User defined timeout. Specify the amount of seconds to wait for the 
message before timing out. The default is five seconds.

➤ Automatically generate selector. Generates a selector for the response 
message with the correlation ID of the request (No by default). Each JMS 
message sent to the server has a specific ID. Enable this option if you want 
Performance Center to automatically create a selector that includes the 
message ID.
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To configure the JMS settings:

 1 In the Run-Time settings window, click Advanced under the JMS section.

 2 Specify your VM preferences.

 3 Set the JMS options.

 4 Define the timeout options.

 5 Click OK to save the settings and close the window.
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Browser Emulation Settings

You use the Browser Emulation settings to set the browser properties of your 
testing environment. You can set the browser properties in the following 
areas:

➤ User-Agent (browser to be emulated)

➤ Simulate browser cache

➤ Download non-HTML resources

➤ Simulate a new user on each iteration

User-Agent (browser to be emulated)

By default, the user-agent emulates the Microsoft Internet Explorer 5.5 
browser agent. You can, however, instruct the script to emulate a different 
browser, that is compatible with Internet Explorer 5.5. This setting creates a 
User-Agent header that identifies the type and version of the browser. 

Simulate browser cache

This option instructs the Vuser to simulate a browser with a cache. A cache 
is used to keep local copies of frequently accessed documents and thereby 
reduces the time connected to the network. By default, cache simulation is 
enabled. When the cache is disabled, Vusers will ignore all caching 
functionality and download all of the resources for every request.

Even if you disable the cache simulation, each resource is only downloaded 
once for each page, even if it appears multiple times. A resource can be an 
image, frame, or another type of script file.

When running multiple Vusers, every Vuser uses its own cache and retrieves 
images from the cache. If you disable this option, all Vusers emulate a 
browser with no cache. 

You can also set the following browser cache options: 

➤ Cache URLs requiring content (HTML). Cache only the URLs that require 
the HTML content. The content may be necessary for parsing, verification, 
or correlation. When you select this option, HTML content is automatically 
cached. This option is enabled by default. 
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Tip: To decrease the memory footprint of the virtual users, disable this 
option, unless it is an explicit requirement for your test.

Specify URLs requiring content in addition to HTML page. This setting lets 
you specify the URL content types other than HTML pages, that you want to 
store in the cache for verification purposes. For example, text/xml or 
image/gif. Separate multiple content types with a semicolon. 

➤ Check for newer versions of stored pages every visit to the page. This 
setting instructs the browser to check for later versions of the specified URL, 
than those stored in the cache. When you enable this option, the "If-
modified-since" attribute is added to the HTTP header. This option brings up 
the most recent version of the page, but also generates more traffic during 
the scenario or session execution. By default, browsers do not check for 
newer resources, and therefore this option is disabled. 

You can modify your Run-Time settings to match your browser settings for 
Internet Explorer, as follows:

Browser Setting Run-Time Setting

Every visit to the page Select Simulate Browser Cache and 
enable Check for newer versions of 
stored pages every visit to the 
page.

Every time you start Internet Explorer Select Simulate Browser Cache only

Automatically Select Simulate Browser Cache only

Never Select Simulate Browser Cache and 
disable Check for newer versions of 
stored pages every visit to the 
page.
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Download non-HTML resources

This option loads graphic images when accessing a Web page during replay. 
This includes both graphic images that were recorded with the page, and 
those which were not explicitly recorded along with the page. When real 
users access a Web page, they wait for the images to load. Therefore, enable 
this option if you are trying to test the entire system, including end-user 
time. To increase performance and not emulate real users, disable this 
option. 

Tip: Disable this option if you experience discrepancies in image checks, 
since some images vary each time you access a Web page (for example, 
advertiser banners).

Simulate a new user on each iteration

This setting resets all HTTP contexts between iterations to their states at the 
end of the init section. This setting allows the Vuser to more accurately 
emulate a new user beginning a browsing session. It deletes all cookies, 
closes all TCP connections (including keep-alive), clears the emulated 
browser’s cache, resets the HTML frame hierarchy (frame numbering will 
begin from 1) and clears the user-names and passwords. This option is 
disabled by default.

➤ Clear cache on each iteration. Clears the browser cache for each iteration in 
order to simulate a user visiting a Web page for the first time. Disable this 
option if you want Vusers to use the browser’s cache, simulating a user who 
recently visited the page. 
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To configure the Browser settings:

 1 In the Run-Time settings window, click Browser Emulation.

 2 Accept the default browser or specify a custom one.

 3 Set the browser cache options.

 4 Indicate whether to download non-HTML resources.

 5 Select whether to simulate a new user for each iteration.

 6 Click OK to save the settings and close the window.
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Classpath Options 

The Classpath settings lets you specify the location of additional classes that 
were not included in the system’s CLASSPATH environment variable. You 
may need these classes to run Java applications and insure proper replay.

To configure the Classpath settings:

 1 In the Run-Time settings window, click Classpath.

 2 Specify the Classpath Entries—type in the path of the additional classes. 
Separate multiple entries with a semicolon.

 3 Click OK to save the settings and close the window.
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Client Emulation Settings

The Oracle NCA Client Emulation run-time settings let you specify the 
communication parameters for your NCA client. You should configure the 
settings to accurately emulate your Oracle NCA environment. 

You can set the following options:

Socket Mode

The communication to and from the client is performed on a socket level—
not on the higher HTTP level.

Timeout (seconds): The time that an Oracle NCA Vuser waits for a response 
from the server. The default value of -1 disables the timeout and the client 
waits indefinitely.

Pragma Mode 

In Pragma mode, communication is carried out in the Oracle-defined 
Pragma mode. This communication level, above the HTTP and Servlet 
levels, is characterized by the periodic sending of messages. In this mode, 
the client recognizes that the server cannot respond with data immediately. 
The server sends messages at given intervals until it is able to send the 
requested data. 

➤ Max Retries. Indicates the maximum number of IfError messages the 
client will accept from the server before issuing an error. IfError messages 
are the periodic messages the server sends to the client, indicating that it 
will respond with the data as soon as it is able. 

➤ Retry Interval. Defines the interval between retries in the case of IfError 
messages. 

➤ Include retry intervals in transaction. Includes the interval between retry 
time, as part of the transaction duration time. 
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Heartbeat

You can enable or disable the heartbeat sent to the Oracle server. The 
heartbeat verifies that there is proper communication with the server. If you 
are experiencing a heavy load on the Oracle NCA server, disable the 
heartbeat. If you enable the heartbeat, you can set the frequency of how 
often heartbeat messages are sent to the server.

➤ Enable Heartbeat. By default, a heartbeat signal is sent to the server. To 
disable it, clear the check box.

➤ Frequency. The frequency of the heartbeat signal. The default is 120 
seconds.

Forms

You can specify the version of the Oracle Forms server detected during 
recording. 

➤ Version. Modify this setting only if the server was upgraded since the 
recording.

Diagnostic

This section lets you provide information about diagnostic modules for the 
database layer of Oracle Applications.

➤ Application version. The version of Oracle Application. This option is 
relevant when using Oracle Application—not a custom Oracle NCA 
application. It is only required when using Oracle database breakdown. 
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To configure the Client Emulation settings:

 1 In the Run-Time settings window, click Client Emulation under Oracle NCA.

 2 In the Socket mode section, set the network timeout value in seconds. To 
instruct the client to wait indefinitely for a server response, use the default 
value of -1.

 3 When working in Pragma mode, specify the number of retries Max Retries, 
(IfError messages) for the client to accept before issuing an error. The default 
is 5. If desired, specify retry options.

 4 To send a a heartbeat to the Oracle NCA server, select Enable Heartbeat. In 
the next line, specify a frequency in seconds for the sending of the 
heartbeat. The default is 120 seconds. 

 5 When using the Oracle database breakdown, specify the Oracle Application 
version.

 6 Click OK to accept the settings and close the window.
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Configuration Settings

The Citrix Configuration settings relate to the screen latency, data 
compression, disk cache, and queuing of mouse movements. These settings, 
which will influence the load on the server, should correspond to the 
properties of your Citrix client. To view the client properties, select the icon 
representing the ICA connection in the Citrix Program Neighborhood, and 
select Properties from the right-click menu. Select the Default Options tab.

You can set options in the following areas:

➤ SpeedScreen Latency Reduction. The mechanism used to enhance user 
interaction when the network speed is slow. You can turn this mechanism 
on or off, depending on the network speed. The auto option turns it on or 
off based on the current network speed. If you do not know the network 
speed, set this option to Use Server Default to use the machine’s default. 

➤ Use data compression. Instructs Vusers to compress the transferred data. To 
enable this option, select the check box to the left of the option; to disable 
it, clear the check box. You should enable data compression if you have a 
limited bandwidth (enabled by default).

➤ Use disk cache for bitmaps. Instructs Vusers to use a local cache to store 
bitmaps and commonly-used graphical objects. To enable this option, select 
the check box to the left of the option; to disable it, clear the check box. You 
should enable this option if you have a limited bandwidth (disabled by 
default).

➤ Queue mouse movements and keystrokes. Instructs Vusers to create a queue 
of mouse movements and keystrokes, and send them as packets to the server 
less frequently. This setting reduces network traffic with slow connections. 
Enabling this option makes the session less responsive to keyboard and 
mouse movements. To enable this option, select the check box to the left of 
the option; to disable it, clear the check box (disabled by default).

➤ Sound quality. Specifies the quality of the sound: Use server default, Sound 
off, High sound quality, Medium sound quality, or Low sound quality. If the 
client machine does not have a 16-bit Sound Blaster-compatible sound card, 
select Sound Off. With sound support enabled, you will be able to play 
sound files from published applications on your client machine.
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To set the Configuration Run-Time Settings:

 1 Click the Configuration link in the Run-Time setting screen. 

 2 Set the desired client configuration options. These settings should 
correspond to the properties of your Citrix client. To view the client 
properties, select the icon representing the ICA connection in the Citrix 
Program Neighborhood, and select Properties from the right-click menu. 
Select the Default Options tab.

 3 Click OK to accept the settings and close the window.
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Download Filter Settings

The Download Filters run-time setting lets you specify the Web sites from 
which Vusers should download resources during replay. You can indicate 
either the sites to exclude or the sites to include. You control the allowed or 
disallowed sources, by specifying a URL, host name, or host suffix name. 

A URL is the complete URL address of a Web site, beginning with http:// or 
https://. Host is the name of the host machine with its domain, such as 
www.hp.com. 

Host suffix is the common suffix for several host names, such as hp.com. 
This is useful where you have several Web sites on a common domain.

If you specify the sites to exclude, the Vuser downloads resources from all 
Web sites except for those specified in the list. If you specify the sites to 
include, the Vuser filters out resources from all Web sites except for those in 
the Include list.
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To configure the filter settings:

 1 In the Run-Time settings window, click Download Filters.

 2 Select the desired option: Include only addresses in list or Exclude addresses 
in list.

 3 Add entries to the list. To add an entry, click the plus sign. The Add Item 
dialog box opens. 

Select a filter type: URL, Host, or Host Suffix, and type the filter data, such as 
a URL. When entering a URL, make sure to type a complete URL beginning 
with http:// or https://. Click OK.
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 4 To edit an entry, select it and click Edit.

 5 To delete and entry, select it and click the minus sign. To delete all entries, 
click Remove All.

 6 Click OK to save the settings and close the window.

Gateway Settings

You use the Gateway link to set the WAP Gateway settings. You can set 
options in the following areas:

Connection Options

The connection options specify the method that the Vuser uses to connect 
to the WAP gateway.

➤ WAP Gateway. Run the Vusers accessing a Web server via a WAP Gateway. 

➤ HTTP Direct. Run the Vusers run in HTTP mode, accessing a Web server 
directly. 

If you select the HTTP Direct connection mode, the remaining WAP 
Gateway options are not applicable.

Gateway Settings

If the Vusers connect through a gateway, the IP, Port, and WAP Versions 
options specify the Gateway connection.

➤ IP. The IP address of the gateway.

➤ Port. The port of the gateway. When running your Vusers through a WAP 
gateway, the Vusers automatically use default port numbers, depending on 
the selected mode. However, you can customize the settings and specify a 
custom IP address and port for the gateway.

➤ WAP version. The WAP version, 1.x (WSP) or 2.0 (HTTP proxy). If you 
recorded in WAP 1.x (WSP), you can run the Vuser in either 1.x (WSP), or 
2.0 (HTTP proxy) mode. If you recorded in WAP 2.0 (HTTP proxy), then you 
can only run the Vuser in the same mode.
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If you are running the script in WAP 1.x (WSP), you can specify several 
connection and advanced options.

Gateway Connection Mode

The connection mode settings apply to WAP version 1.x (WSP) connections. 

➤ Connection-oriented Mode. Set the connection mode for the WSP session to 
Connection-Oriented.

➤ Connectionless Mode. Set the connection mode for the WSP session to 
Connectionless.

➤ Enable security. Enable a secure connection to the WAP gateway.

To set the Gateway Run-Time Settings:

 1 Click the Gateway link in the Run-Time setting screen, under WAP. 

 2 To replay the script in WSP mode (not HTTP), select WAP Gateway.

 3 Specify an IP address and port for the gateway. You can also use the default 
port.

 4 Select a WAP version: WAP 1.x (WSP) or WAP 2.0 (HTTP).

 5 For WAP 1.x (WSP), select a connection mode—Connection-oriented or 
Connectionless. To indicate a secure connection mode, select the Enable 
Security option. 

 6 For WAP 1.x (WSP), expand the Advanced node to set the client capabilities 
and other advanced gateway options. For more information about the 
Advanced Gateway options, see the HP Virtual User Generator User Guide.

 7 Click OK to accept the settings and close the window.
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Advanced Gateway Options
Open the Advanced option in the Gateway run-time settings to configure 
the WAP Capabilities and other advanced Gateway options. 

➤ Confirm Push support. In CO mode, if a push message is received, this 
option instructs the Vuser to confirm the receipt of the message (disabled by 
default). For more information, see the HP Virtual User Generator User Guide.

➤ Push support. Enables push type messages across the gateway (disabled by 
default).

➤ CAPSessionResume. Enables requests for session suspend or resume.

➤ Acknowledge headers. Returns standard headers that provide information 
to the gateway (disabled by default).

➤ Server SDU buffer size. The largest transaction service data unit that may 
be sent to the server during the session (4000 by default).

➤ Client SDU buffer size. The largest transaction service data unit that may 
be sent to the client during the session (4000 by default).

➤ MethodMOR. The number of outstanding methods that can occur 
simultaneously.

➤ PushMOR. The number of outstanding push transactions that can occur 
simultaneously.

➤ BearerType. The type of bearer used as the underlying transport.

➤ Retrieve messages. When a push messages is received, this option 
instructs the Vuser to retrieve the message data from the URL indicated 
in the push message (disabled by default).

➤ Support Cookies. Provide support for saving and retrieving cookies (disabled 
by default).

➤ WTP Segmentation and Reassembly. Enables segmentation and reassembly 
(SAR) in WTP, Wireless Transport Protocol. (True by default).

➤ WTP Retransmission Time. The time in seconds that the WTP layer waits 
before resending the PDU if it did not receive a response. (5000 by 
default).

➤ WTLS Abbreviated Handshake. Use an abbreviated handshake instead of a 
full one, when receiving a redirect message. (False by default).
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➤ WTLS Deffie Hellman. Use the Deffie Hellman encryption scheme for WTLS 
(Wireless Transport Layer Security) instead of the default scheme, RSA. (False 
by default).

➤ WTLS Deffie Hellman identifier. An identifier for the Deffie Hellman 
encryption scheme. This identifier is required for the abbreviated 
handshake with the Operwave gateway that uses the Deffie Hellman 
encryption scheme.

➤ Network MTU Size. the maximum size in bytes, of the network packet. 
(4096 by default).

SAPGUI Settings

The SAPGUI run-time settings let you set the general settings for a SAPGUI 
Vuser script. Performance Center uses these settings when running the 
script.

➤ Send status bar text. Send the text from the status bar to the log file. 

➤ Send active window title. Send the active window title text to the log file. 

The Performance run-time settings allow you to indicate whether or not to 
display the SAP client during replay. 

➤ Show SAP Client during replay. Shows an animation of the actions in the 
SAP client during replay. The benefit of displaying the user interface (UI) is 
that you can see how the forms are filled out and closely follow the actions 
of the Vuser. This option, however, requires additional resources and may 
affect the performance of your load test. 

➤ Take ActiveScreen snapshots during replay. Captures replay snapshots with 
the Control ID information for all active objects. ActiveScreen snapshots 
differ from regular ones, in that they allow you to see which objects were 
recognized by VuGen in the SAPGUI client. As you move your mouse across 
the snapshot, VuGen highlights the detected objects. You can then add new 
steps to the script directly from within the snapshot. It also allows you to 
add steps interactively from within the snapshot for a specific object. For 
more information, see the HP Virtual User Generator User Guide.
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Advanced options let you set a timeout for the SAPfewgsvr.exe process, save 
a snapshot on error, and configure Performance Center to use SAPlogon 
during replay. For more information, see “SAPGUI Advanced Run-Time 
Settings” on page 585.

To configure the SAPGUI Run-Time Settings:

 1 In the Run-Time settings window, click General under SAPGUI.

 2 In the Log messages on error section, select one or more message sources: 
Send status bar text or Send active window title.

 3 In the Performance section, select the Show SAP client during replay check 
box to show the SAPGUI user interface during replay. 

 4 In the Advanced section, click Options to set a timeout for the 
SAPfewgsvr.exe process. 

 5 Click OK to save the settings and close the window.
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SAPGUI Advanced Run-Time Settings
Each Vuser invokes a separate SAPfewgsvr.exe process during test execution. 
In some instances, the process stays active even after the replay session has 
ended. You can check the Windows Task Manager to see if the process is still 
active.

The Advanced SAPGUI settings let you set a timeout for this application. 
When the timeout is reached, Performance Center closes any SAPfewgsvr 
processes not previously terminated.

➤ Replay using running SAPlogon application. Instructs the Vusers to use the 
SAPlogon application that is currently running for replay.

➤ Set SAPfewgsvr application timeout. Allows you to modify the 
SAPfewgsvr.exe process timeout.

Timeout to SAPfewgsvr. The SAPfewgsvr.exe process timeout in seconds. 
The default is 300 seconds. 
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Java VM Settings
For Java scripts, you provide information about the Java virtual machine 
settings in the Java VM section. The following settings are available:

➤ Virtual Machine settings

➤ Use internal logic to locate JDK. Search the PATH, registry, and Windows 
folder for the JDK to use during replay.

➤ Use specified JDK. Use the JDK specified below during replay.

➤ Additional VM Parameters. Type any optional parameters used by the 
virtual machine.

➤ Using Xbootclasspath parameters. Replays the script with the 
Xbootclasspath /p option.

➤ Class Loading Settings

➤ Load each Vuser using dedicated class loader. Load each Vuser using a 
dedicated class loader. This will allow you to use a unique namespace 
for each Vuser and manage their resources separately.
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To configure the Java VM settings:

 1 In the Run-Time settings window, click Java VM.

 2 Specify the Virtual Machine settings—use internal logic to locate the JDK or 
manually indicate the JDK.

 3 If applicable, specify additional VM parameters and whether to use 
Xbootclasspath parameters. 

 4 Select a Class Loading settings.

 5 Click OK to save the settings and close the window.
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.NET Environment Settings

The .NET environment run-time settings let you specify information about 
the application, such as its base path and the location of its configuration 
file. 

AUT Configuration 

AUT Application Base Path. The AUT (Application Under Test) base directory 
from which DLLs are loaded during replay. By default, during recording, all 
of the necessary DLLs are stored in the script’s directory. Use this option to 
specify the location of any missing DLL files for the AUT. This is usually the 
installation path of the recorded application. Note that the AUT must be 
installed on the machine running the script. If you leave this box empty, the 
Vusers use the local script\bin directory as the application base directory 
during replay.

AUT Configuration File. The file name of the recorded application’s 
configuration file. Performance Center copies the AUT configuration file to 
the script\bin directory and loads the locally saved file. To specify a 
different location, use a full path. If you only specify a file name, and the file 
is not in the script\bin folder, the Vusers load it from the App base directory.

Concurrency

➤ AppDomain Per Vuser. Enables execution of each Vuser in a separate app 
domain (true by default). Running Vusers in separate App Domains enables 
each Vuser to execute separately without sharing static variables and 
prevents locking between them.

ADO.NET providers deploy a feature called connection pooling which can 
significantly influence load test accuracy. Whenever only one app domain is 
used for all Vusers, connection pooling is turned on—.NET Framework keeps 
the database connections open and tries to reuse them when a new 
connection is requested. Since many Vusers are executed in the context of a 
single application domain, they may interfere with one another. Their 
behavior will not be linear and that may decrease their accuracy. The default 
setting, true, allocates a separate connection pool for each Vuser. This means 
that there is connection pooling in the scope of each Vuser, but the Vusers 
will not interfere with one another. This setting provides more accuracy, but 
lower scalability.
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If you disable this option, you need to manually disable connection pooling 
for the database. For more information, the HP Virtual User Generator User 
Guide.

To configure the .NET Environment settings:

 1 In the Run-Time settings window, click .NET Environment.

 2 Set the base folder of the DLLs in the AUT Application Base Path box.

 3 Set the path of the recorded application in the AUT Configuration File box.

 4 The recommended setting for AppDomain Per Vuser is true, the default.

 5 Click OK to accept the settings and close the window.
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Preferences (Internet)

You use the Internet Protocol Preferences Run-Time Settings, to control the 
Vusers in the following areas:

➤ Image and Text Checks

➤ Generating Web Performance Graphs

➤ Advanced Web Run-Time Options

Image and Text Checks

The Enable image and text checks option allows the Vuser to perform 
verification checks during replay by executing the verification functions: 
web_find or web_image_check. This option only applies to test steps that 
were recorded in HTML-based mode. Vusers running with verification 
checks enabled, require additional memory.

Generating Web Performance Graphs 

Collects data to create several Web Performance graphs: Hits per Second and 
HTTP codes, Pages per Second, and Response Bytes per Second. You view 
the graphs during test execution using the online monitors and after test 
execution using the Analysis. You view the Component Breakdown graph 
after test execution using the Analysis. Select the types of graph data for the 
Vuser to collect.

Note: If you do not use the Web performance graphs, disable all graphs to 
conserve memory.
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Advanced Web Run-Time Options

➤ WinInet Replay. Instructs Vusers to use the WinInet replay engine instead of 
the standard Sockets replay. There are two HTTP replay engines: Sockets-
based (default) or WinInet based. The WinInet is the engine used by Internet 
Explorer and it supports all of the features incorporated into the IE browser. 
The limitations of the WinInet replay engine are that it is not scalable, nor 
does it support UNIX. In addition, when working with threads, the WinInet 
engine does not accurately emulate the modem speed and number of 
connections.

The proprietary sockets-based replay is a lighter engine that is scalable for 
load testing. It is also accurate when working with threads. The limitation of 
the sockets-based engine is that it does not support SOCKS proxy. If you are 
recording in that type of environment, use the WinInet replay engine.

➤ File and line in automatic transaction names. Creates unique transaction 
names for automatic transactions by adding file name and line number to 
the transaction name (enabled by default).

Note: This option places additional information in the log file, and 
therefore requires more memory. 

➤ Non-critical item errors as warnings. This option returns a warning status 
for a function which failed on an item that is not critical for load testing, 
such as an image or Java applet that failed to download. This option is 
enabled by default. If you want a certain warning to be considered an error 
and fail your test, you can disable this option. You can set a content-type to 
be critical by adding it to the list of Non-Resources. For more information, 
see the HP Virtual User Generator User Guide.

➤ Save snapshot resources locally. Saves the snapshot resources to files on the 
local machine. This feature lets the Run-Time viewer create snapshots more 
accurately and display them quicker. 
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Additional Options for Internet Preferences
Click the Options button in the Advanced section of the Preferences Run-
Time settings, to set advanced options in the following areas: DNS caching, 
HTTP version, Keep-Alive HTTP connections, Accept server-side 
compression, Accept-Language headers, HTTP-request connect timeout, 
HTTP-request receive timeout, Network buffer size, and Step download 
timeout.

HTTP

➤ HTTP version. Specifies which version HTTP to use: version 1.0 or 1.1. This 
information is included in the HTTP request header whenever a Vuser sends 
a request to a Web server. 

➤ Keep-Alive HTTP connections. Keep-alive is a term used for an HTTP 
extension that allows persistent or continuous connections. These long-
lived HTTP sessions allow multiple requests to be sent over the same TCP 
connection. This improves the performance of the Web server and clients.

The keep-alive option works only with Web servers that support keep-alive 
connections. This setting specifies that all Vusers that run the Vuser script 
have keep-alive HTTP connections enabled (enabled by default).

➤ Accept-Language request header. Provides a comma-separated list of 
accepted languages. For example, en-us, fr, and so forth.

➤ HTTP errors as warnings. Issues a warning instead of an error upon failing to 
download resources due to an HTTP error.

➤ HTTP-request connect timeout (seconds). The time, in seconds, that a Vuser 
will wait for the connection of a specific HTTP request within a step before 
aborting. Timeouts provide an opportunity for the server to stabilize and 
respond to the user (default value is 120 seconds). Note that this timeout 
also applies to the time the Vuser will wait for a WAP connection, initiated 
by the wap_connect function.

➤ HTTP-request receive timeout (seconds). The time, in seconds, that a Vuser 
will wait to receive the response of a specific HTTP request within a step 
before aborting. Timeouts provide an opportunity for the server to stabilize 
and respond to the user (default value is 120 seconds).
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➤ Request Zlib Headers. Sends request data to the server with the zlib 
compression library headers. By default, requests sent to the server include 
the zlib headers. This option lets you emulate non-browser applications that 
do not include zlib headers in their requests. To exclude these headers, set 
this option to No (default is Yes).

➤ Accept Server-Side Compression. Indicate to the server that the replay can 
accept compressed data. The available options are: None (no compression), 
gzip (accept gzip compression), gzip, deflate (accept gzip or deflate 
compression), and deflate (accept deflate compression). Note that by 
accepting compressed data, you may significantly increase the CPU 
consumption. The default is to accept gzip, deflate compression.

General

➤ DNS caching. Instructs the Vuser to save a host’s IP addresses to a cache after 
resolving its value from the Domain Name Server. This saves time in 
subsequent calls to the same server. In situations where the IP address 
changes, as with certain load balancing techniques, be sure to disable this 
option to prevent Vuser from using the value in the cache (enabled by 
default).

➤ Convert from/to UTF-8. Converts received HTML pages and submitted data 
from and to UTF-8. You enable UTF-8 support in the recording options (No, 
by default). For more information, see the HP Virtual User Generator User 
Guide.

➤ Step timeout caused by resources is a warning. Issues a warning instead of 
an error when a timeout occurs due to a resource that did not load within 
the timeout interval. For non-resources, Performance Center issues an error 
(disabled by default).

➤ Parse HTML Content-Type. When expecting HTML, parse the response only 
when it is the specified content-type: HTML, text\html, TEXT any text, or 
ANY, any content-type. Note that text/xml is not parsed as HTML. The 
default is TEXT. 
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The timeout settings are primarily for advanced users who have determined 
that acceptable timeout values should be different for their environment. 
The default settings should be sufficient in most cases. If the server does not 
respond in a reasonable amount of time, check for other connection-related 
issues, rather than setting a very long timeout which could cause the scripts 
to wait unnecessarily.

➤ Step download timeout (sec). The time that the Vuser will wait before 
aborting a step in the script. This option can be used to emulate a user 
behavior of not waiting for more than x seconds for a page.

➤ Network buffer size. Sets the maximum size of the buffer used to receive the 
HTTP response. If the size of the data is larger than the specified size, the 
server will send the data in chunks, increasing the overhead of the system. 
When running multiple Vusers from the Controller, every Vuser uses its own 
network buffer. This setting is primarily for advanced users who have 
determined that the network buffer size may affect their script’s 
performance. The default is 12K bytes. The maximum size is 0x7FFF FFFF.

➤ Print NTLM information. Print information about the NTLM handshake to 
the standard log.

➤ Print SSL information. Print information about the SSL handshake to the 
standard log.

➤ Max number of error matches issued as ERRORS. Limits the number of error 
matches issued as ERRORS for content checks using a LB or RB (left 
boundary or right boundary). This applies to matches where a failure occurs 
when the string is found (Fail=Found). All subsequent matches are listed as 
informational messages. The default is 10 matches.

➤ Maximum number of META Refresh to the same page. The maximum 
number of times that a META refresh can be performed per page. The default 
is 2.

➤ ContentCheck values in UTF-8. Store the values in the ContentCheck XML 
file in UTF-8.
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Authentication

➤ Fixed think time upon authentication retry (msec). Automatically adds a 
think time to the Vuser script for emulating a user entering authentication 
information (username and password). This think time will be included in 
the transaction time (default is 0).

➤ Disable NTLM2 session security. Use full NTLM 2 handshake security instead 
of the more basic NTLM 2 session security response (default is No).

➤ Use Windows native NTLM implementation. Use the Microsoft Security API 
for NTLM authentication instead of the indigenous one.

➤ Enable integrated Authentication. Enable Kerberos-based authentication. 
When the server proposes authentication schemes, use Negotiate in 
preference to other schemes (default is No).

➤ Induce heavy KDC load. Do not reuse credentials obtained in previous 
iterations. Enabling this setting will increase the load on the KDC (Key 
Distribution Server). To lower the load on the server, set this option to Yes in 
order to reuse the credentials obtained in previous iterations. This option is 
only relevant when Kerberos authentication is used (default is No).

Log

➤ Print buffer line length. Line length for printing request/response 
header/body and/or JavaScript source, disabling wrapping.

➤ Print buffer escape only binary zeros. 

➤ Yes. Escape only binary zeros when printing request/response 
headers/body and/or JavaScript source. 

➤ No. Escape any unprintable/control characters.

Web (Click and Script) Specific

➤ General

➤ Home Page URL. The URL of the home page that opens with your 
browser (default is about:blank). 

➤ DOM-based snapshots. Generates snapshots from the DOM instead of 
from the server responses (Yes by default).
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➤ Charset conversions by HTTP. Perform charset conversions by the 
‘Content-Type:....; charset=...’ HTTP response header. Overrides ‘Convert 
from /to UTF-8.’

➤ Reparse when META changes charset. Reparse HTML when a META tag 
changes the charset. Effective only when Charset conversions by HTTP is 
enabled. Auto means reparsing is enabled only if it used in the first 
iteration.

➤ Fail on JavaScript error. Fails the Vuser when a JavaScript evaluation error 
occurs. The default is No, issuing a warning message only after a 
JavaScript error, but continuing to run the script.

➤ Initialize standard classes for each new window project. When enabled, 
the script—the src compiled script, will not be cached.

➤ Ignore acted on element being disabled. Ignore the element acted on by 
a Vuser script function being disabled. 

➤ Timers

➤ Optimize timers at end of step. When possible, executes a 
setTimeout/setInterval/<META refresh> that expires at the end of the step 
before the expiration time (default is Yes).

➤ Single setTimeout/setInterval threshold (seconds). Specifies an upper 
timeout for the window.setTimeout and window.setInterval methods. If 
the delay exceeds this timeout, these methods will not invoke the 
functions that are passed to them. This emulates a user waiting a 
specified time before clicking on the next element (default is 5 seconds).

➤ Accumulative setTimeout/setInterval threshold (seconds). Specifies a 
timeout for the window.setTimeout and window.setInterval methods. If 
the delay exceeds this timeout, additional calls to window.setTimeout 
and window.setInterval will be ignored. The timeout is accumulative per 
step (default is 30 seconds). 

➤ Reestablish setInterval at end of step. 0 = No; 1 = Once; 2 = Yes.
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➤ History

➤ History support. Enables support for the window.history object for the 
test run. The options are Enabled, Disabled, and Auto. The Auto option 
(default) instructs Vusers to support the window.history object only if it 
was used in the first iteration. Note that by disabling this option, you 
improve performance.

➤ Maximum history size. The maximum number of steps to keep in the 
history list (default is 100 steps).

➤ Navigator Properties

➤ navigator.browserLanguage. The browser language set in the navigator 
DOM object’s browserLanguage property. The default is the recorded 
value. Scripts created with older recording engines, use en-us by default.

➤ navigator.systemLanguage. The system language set in the navigator 
DOM object’s systemLanguage property. The default is the recorded 
value. Scripts created with older recording engines, use en-us by default.

➤ navigator.userLanguage. The user language set in the navigator DOM 
object’s userLanguage property. The default is the recorded value. Scripts 
created with older recording engines, use en-us by default.

➤ Screen Properties

➤ screen.width Sets the width property of the screen DOM object in pixels 
(default is 1024 pixels).

➤ screen.height Sets the height property of the screen DOM object in pixels 
(default is 768 pixels).

➤ screen.availWidth Sets the availWidth property of the screen DOM object 
in pixels (default is 1024 pixels).

➤ screen.availHeight. Sets the availHeight property of the screen DOM 
object in pixels (default is 768 pixels).

➤ Memory Management

➤ Default block size for DOM memory allocations. Sets the default block 
size for DOM memory allocations. If the value is too small, it may result 
in extra calls to malloc, slowing the execution times. Too large a block 
size, may result in an unnecessarily big footprint (default is 16384 bytes).
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➤ Memory Manager for dynamically-created DOM objects. Yes—Use the 
Memory Manager for dynamically-created DOM objects. No—Do not use 
the Memory Manager, for example when multiple DOM objects are 
dynamically created in the same document as under SAP. Auto—Use the 
protocol recommended (default Yes for all protocols except for SAP).

➤ JavaScript Runtime memory size (KB). Specifies the size of the JavaScript 
runtime memory in kilobytes (default is 256 KB). 

➤ JavaScript Stack memory size (KB). Specifies the size of the JavaScript 
stack memory in kilobytes (default is 32 KB). 

To configure the Web Preferences settings:

 1 In the Run-Time settings window, under the Internet Protocol section, click 
Preferences.

 2 Set the desired options in the Checks, Graphs, and Advanced categories.
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 3 To set advanced options, click the Options button. Read the hints to 
determine if the option is recommended for your test.

 4 Click OK to save the settings and close the window.

Proxy Options

You use the Proxy Run-Time Settings to set the proxy-related settings. The 
following proxy options are available in the Run-Time settings. 

➤ No proxy. All Vusers should use direct connections to the Internet. This 
means that the connection is made without using a proxy server.

➤ Obtain the proxy settings from the default browser. All Vusers use the 
proxy settings of the default browser from the machine upon which they 
are running.

➤ Use custom proxy. Use a custom proxy server. for all Vusers. You can 
supply the actual proxy server details or the path of a proxy automatic 
configuration script (.pac file) that enables automatic configuration. (See 
“Setting the Automatic Proxy Configuration” on page 599.)

To supply the details of the server, you specify its IP address or name and 
port. You can specify one proxy server for all HTTP sites, and another 
proxy server for all HTTPS (secure) sites. 

After providing the proxy information, you can specify Authentication 
information for the proxy server, and indicate Exceptions to the proxy 
rules.

Setting the Automatic Proxy Configuration
Automatic Proxy Configuration is a feature supported by most browsers. 
This feature allows you to specify a JavaScript file (usually with a .pac 
extension) containing proxy assignment information. This script tells the 
browser when to access a proxy server and when to connect directly to the 
site, depending on the URL. In addition, it can instruct the browser to use a 
specific proxy server for certain addresses and another server for other 
addresses. 
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You can instruct Performance Center or your Internet Explorer browser to 
work with a configuration script. You specify a file for the automatic proxy 
configuration, so that when the Vuser runs the test, it uses the rules from 
the proxy file.

To specify a configuration script in Performance Center:

 1 In the Run-Time settings window, and click the Proxy link. 

 2 Select Use custom proxy and select the Use automatic configuration script 
option. Specify the location of the script.

To specify a configuration script in Internet Explorer (IE):

 1 Select Tools > Internet Options, and select the Connections tab. 

 2 Click the LAN Settings button. The LAN Settings dialog box opens.

 3 Select the Use automatic configuration script option, and specify the 
location of the script.

Authentication
If the proxy server requires authentication for each Vuser, use this dialog 
box to type the relevant password and user name.

➤ User Name. The user name for Vusers to access the proxy server.

➤ Password. The password required by Vusers to access the proxy server.

Exceptions
You can specify that all Vusers use a specified proxy server. In such a case, if 
there are any URLs that you want Vusers to access directly, that is, without 
using the proxy server, type the list of these URLs in the Exceptions box.

➤ Do not use proxy server for addresses beginning with. Type the addresses 
you want to exclude from the proxy server. Use semicolons to separate 
entries.

➤ Do not use proxy server for local (intranet) addresses. Select this check box 
to exclude local addresses, such as those from an Intranet, from the proxy 
server.
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To configure the Proxy settings:

 1 In the Run-Time settings window, under the Internet Protocol section, click 
Proxy.

 2 Select the desired proxy option: No proxy, Obtain the proxy settings from 
the default browser, or Use custom proxy.

 3 If you specified a custom proxy:

➤ indicate the IP addresses for the HTTP and HTTPS proxy servers

➤ To use a pac or JavaScript file to indicate the proxy, select the Use 
automatic configuration script option and specify the script location. 
You can specify either a web location beginning with http:// (for 
example, http://hostname/proxy.pac), or a location on the file server, for 
example, C:\temp\proxy.pac.
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 4 To specify URLs that you want Vusers to access directly, without the proxy 
server, click Exceptions and then supply the list of these URLs. In the 
Exceptions dialog box, you can also specify direct access to local (Intranet) 
addresses.

 5 If the proxy server requires authentication, click Authentication, and then 
supply the relevant password and user name.

 6 Select the Use the same proxy server for all protocols check box to use the 
same proxy server for all Internet protocols (HTTP, HTTPS) rather than 
specifying a specific server for secure sites.

 7 Click OK to accept the settings and close the window.

To track the behavior of the Vusers, generate a log during text execution and 
view the Execution Log tab or the mdrv.log file. The log shows the proxy 
servers that were used for each URL. In the following example, the Vusers 
used a direct connection for the URL australia.com, but the proxy server 
aqua, for the URL http://www.MyLab.com.

Action1.c(6): t=1141ms: FindProxyForURL returned DIRECT
Action1.c(6): t=1141ms: Resolving australia.com
Action1.c(6): t=1141ms: Connecting to host 199.203.78.255:80
… 
Action1.c(6): t=1281ms: Request done "http://australia.com/GetElementByName.htm"

… 
Action1.c(6): web_url was successful, 357 body bytes, 226 header bytes
Action1.c(15): web_add_cookie was successful
Action1.c(17): t=1391ms: FindProxyForURL returned PROXY aqua:2080
Action1.c(17): t=1391ms: Auto-proxy configuration selected proxy aqua:2080
Action1.c(17): t=1391ms: Resolving aqua
Action1.c(17): t=1391ms: Connecting to host 199.203.139.139:2080
… 
Action1.c(17): t=1578ms: 168-byte request headers for "http://www.MyLab.com/" 
(RelFrameId=1)
Action1.c(17):     GET http://www.MyLab.com/ HTTP/1.1\r\n
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Radius Settings 

RADIUS (Remote Authentication Dial-In User Service) is a client/server 
protocol and software that enables remote access servers to communicate 
with a central server to authenticate dial-in users and authorize their access 
to the requested system or service.

RADIUS allows a company to maintain user profiles in a central database 
that all remote servers can share. It provides better security, allowing a 
company to set up a policy that can be applied at a single administered 
network point. Using a central service makes it easier to track usage for 
billing and store network statistics.

RADIUS has two sub-protocols:

➤ Authentication. Authorizes and controls user access.

➤ Accounting. Tracks usage for billing and for keeping network statistics.

For Vusers, the RADIUS protocol is supported for WSP replay for both of the 
Radius sub-protocols—authentication and accounting. You supply the dial-
in information in the Radius run-time settings:

➤ Network Type. Accounting network type: GPRS (General Packet Radio 
Service) or CSD (Circuit-Switched Data).

➤ IP Address. IP address of the Radius server.

➤ Authentication port number. Authentication port of the Radius server.

➤ Accounting port number. Accounting port of the Radius server.

➤ Secret Key. The secret key of the Radius server.

➤ Connection Timeout (sec). The time in seconds to wait for the Radius server 
to respond. The default is 120 seconds.

➤ Retransmission retries. The number of times to retry after a failed 
transmission. The default is 0.

➤ Store attributes returned by the server to parameters. Allow Vusers to save 
attributes returned by the server as parameters, which can be used at a later 
time. The default is False.
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➤ Radius client IP. Radius packets source IP, usually used to differentiate 
between packets transmitted on different NIC cards on a single Load 
Generator machine.

To set the WAP Radius options:

 1 Click the Radius link under WAP in the Run-Time settings window.

 2 Select an accounting Network type: GPRS (General Packet Radio Service) or 
CSD (Circuit-Switched Data).

 3 Type the IP address of the Radius server in dot form.

 4 Type the Authentication Port number and Accounting Port number of the 
Radius server.

 5 Type in the Secret key for Radius or Accounting Authentication. 

 6 Type a Connection Timeout value.

 7 Specify the number of Retransmission retries.

 8 Specify whether you want the Vusers to store attributes returned by the 
server to parameters.

 9 Click OK to accept the settings and close the window.
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RTE Settings

Terminal Emulator run-time settings allow you to configure your TE Vusers 
so that they accurately emulate real users performing remote terminal 
emulation. You can configure settings for the number of connection 
attempts, device names, typing delay, and X-System synchronization.

Modifying Connection Attempts
The TE_connect function is generated when you record a connection to a 
host. When you replay an RTE script, the TE_connect function connects the 
terminal emulator to the specified host. If the first attempt to connect is not 
successful, the Vuser retries a number of times to connect successfully. 
Details of each connection are recorded in the report file output.txt.

To set the maximum number of times that a Vuser will try to connect, type a 
number in the Maximum number of connection attempts box in the RTE 
Run-Time settings. By default, a Vuser will try to connect 5 times.

Specifying an Original Device Name
In certain environments, each session (Vuser) requires a unique device 
name. The TE_connect function generates a unique 8-character device 
name for each Vuser, and connects using this name. To connect using the 
device name (that is contained within the com_string parameter of the 
TE_connect function), select the Use original device name option in the 
RTE Run-Time settings.

The original device name setting only applies to IBM block-mode terminals. 
By default, Vusers use original device names to connect.

Setting the Typing Delay
The delay setting determines how Vusers execute TE_type functions.

To specify the amount of time that a Vuser waits before entering the first 
character in a string, type a value in the First key box, in milliseconds.

To specify the amount of time that a Vuser waits between submitting 
successive characters, type a value in the Subsequent keys box, in 
milliseconds. 
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If you type zero for both the first key and the subsequent key delays, the 
Vuser will send characters as a single string, with no delay between 
characters.

You can use the TE_typing_style function to override the Delay settings for 
a portion of a Vuser script. 

Configuring the X-System Synchronization
RTE Vuser scripts use the TE_wait_sync function for synchronization. You 
can set a timeout value and a stable-time value that applies to all 
TE_wait_sync functions. 

Timeout

When you replay a TE_wait_sync function, if the system does not stabilize 
before the synchronization timeout expires, the TE_wait_sync function 
returns an error code. To set the synchronization timeout, type a value (in 
seconds) in the Timeout section of the RTE Run-Time settings.

The default timeout value is 60 seconds.

Stable Time

After a Vuser executes a TE_wait_sync function, the Vuser waits until the 
terminal is no longer in the X-SYSTEM mode. After the terminal returns 
from the X-SYSTEM mode, the Vuser still monitors the system for a short 
time. This makes sure that the terminal has become stable, that is, that the 
system has not returned to the X-SYSTEM mode. Only then does the 
TE_wait_sync function terminate. 

To set the time that a Vuser continues to monitor the system after the 
system has returned from the X-SYSTEM mode, type a value (in 
milliseconds) in the Stable time box of the RTE Run-Time settings. The 
default stable time is 1000 milliseconds.



Chapter 36 • Configuring Protocol-Specific Run-Time Settings

607

To configure the RTE settings:

 1 In the Run-Time settings window, click RTE.

 2 Specify the relevant setting as described above.

 3 Click OK to save the settings and close the window.

Server and Protocol Settings

The following section describes the run-time settings specific to MMS 
(Multimedia Messaging Service) Vusers. These run-time setting allow you to 
configure the Server and Protocol settings. You can set the following 
options:

➤ MMSC URL. The URL of the MMSC (Multimedia Messaging Center) server.

➤ MMS Version. The version of the MMS protocol used by the script.
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➤ Timeout (seconds). The time that the server waits for incoming messages. 
The default value is 60 seconds.

➤ SMSC IP. The IP address of the SMSC server used for sending MMS 
notifications over SMPP.

➤ SMSC Port. The IP port of the SMSC server used for sending MMS 
notifications over SMPP.

➤ Automatic WAP Connections. Defines when to connect and disconnect from 
a WAP gateway. This setting is only relevant when a WAP gateway is used. 
The possible values are: 

➤ Per Iteration. Connect at the beginning of each iteration and disconnect 
at the end of each iteration. (default)

➤ Per Send or Receive. Connect and disconnect at the beginning and end 
of each message.

➤ None. Do not use automatic WAP connections.

➤ Default Sender address. The default address sent in the Sender header. The 
default is +999999.

To set the MMS Server and Protocol settings:

 1 Click the Server and Protocols link under the MMS Run-Time settings. 

 2 Select the desired values as explained above.

 3 Select Miscellaneous from the Run-Time settings tree, under General. 

 4 Under Multithreading, select Run Vuser as a process.

 5 Click OK to accept the settings and close the window.

Speed Simulation Settings

The Speed Simulation setting lets you emulate your network connection.

Using these settings, you select a bandwidth that best emulates the 
environment under test. The following options are available:
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➤ Use maximum bandwidth. By default, bandwidth emulation is disabled and 
the Vusers run at the maximum bandwidth that is available over the 
network.

➤ Use bandwidth. Indicate a specific bandwidth level for your Vuser to 
emulate. You can select a speed ranging from 14.4 to 512 Kbps, emulating 
analog modems, ISDN, or DSL. 

➤ Use custom bandwidth. Indicate a bandwidth limit for your Vuser to 
emulate. Specify the bandwidth in bits, where 1 Kilobit=1024 bits.

To configure the Network settings:

 1 In the Run-Time settings window, click Speed Simulation.

 2 Specify a network setting. When relevant, specify the applicable bandwidth.

 3 Click OK to save the settings and close the window.



Chapter 36 • Configuring Protocol-Specific Run-Time Settings

610

Timing Settings

The Citrix Timing run-time settings relate to the connect and waiting 
timeouts. These settings apply to the entire script. To set the waiting time 
for a specific section of the script, use the Set Waiting Time step in the Vuser 
script. The new waiting time applies from the point of insertion until the 
end of the script or the next Set Waiting Time step.

 1 In the Run-Time settings screen, under Citrix, click the Timing link . 

 2 Indicate the Connect Time, the time in seconds to wait idly at an established 
connection before exiting. The default is 180 seconds.

 3 Indicate the Waiting Time, the time in seconds to wait idly at a 
synchronization point before exiting. The default is 60 seconds.

 4 Specify a Typing rate, the delay in milliseconds between keystrokes.

 5 Click OK to accept the settings and close the window. 
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37
Introducing User Management

The User Management module enables you to view and manage project 
information, user information, and project-user-role assignments, and view 
project-related user roles and privileges.

Note: To manage users, projects, and project-user-role assignments in the 
User Site, a Performance Center administrator must grant you the 
appropriate permissions from the Administration site. For more 
information, contact your Performance Center administrator.

➤ For more information about viewing and managing Performance Center 
users, see Chapter 38, “Users.”

➤ For more information about user roles, see Chapter 28, “User Roles.”

➤ For more information about viewing and managing Performance Center 
projects, see Chapter 40, “Performance Center Projects.”

➤ For more information about managing project-user-role assignments, see 
Chapter 41, “Privilege Management.”
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38
Users

This chapter describes how to view and manage Performance Center users.

This chapter includes:

 ➤  Understanding User Information on page 616

 ➤  Managing Your Personal Details on page 617

 ➤  Users Page at a Glance on page 618

 ➤  Managing Performance Center Users on page 620
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Understanding User Information 

You view and manage your personal details and other users’ details on the 
Personal Details and Users pages. This information includes the user’s login 
details, personal details, and other general information.

Detail Description
Lo

g
in

 D
et

ai
ls

User Name The user’s user name for logging in to 
Performance Center.

Password
Confirm Password

The user’s password for logging in to 
Performance Center.

(Not available when adding LDAP/SSO 
users, where the password is stored in the 
records of the respective system.)

Account Expiration ➤ Account Expires. The expiration date of 
the user account.

➤ Account Never Expires. The user 
account never expires.

Pe
rs

on
al

 D
et

ai
ls Full Name The user’s full name.

Email The user’s email address.

Additional Data Any additional relevant information about 
the user.

G
en

er
al

 In
fo

rm
at

io
n

User Creator The name of the user who created the user 
account—recorded automatically when the 
user is created. It cannot be edited.

Status The status of the user—Active or 
Not active. 

(Not editable for LDAP/SSO users.)

Note: A user with a Not Active status 
cannot log in to Performance Center.

Creation Date The date the user account was created in 
the system.
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Managing Your Personal Details

You view your personal details on the Personal Details page.

If you have Edit Personal Information privileges, you can also edit your 
personal details.

To view and edit your personal details:

 1 On the Performance Center left menu, select User Management > 
Personal Details. 

 2 Edit your details. (See “Understanding User Information” on page 616.)

 3 To revert back to the original details without saving your changes, click 
Restore.

To save your changes, click Save.
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Users Page at a Glance

The Users page displays a list of all the users in your current project.

To access the Users page, on the Performance Center left menu, select 
User Management > Users. 
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The Users page includes the following components:

➤ User list. Displays all of the users in your current project. 

By default the table displays 10 users at a time. To change the number of 
users displayed in the list, select the appropriate number in the 
Displaying <n> items per page area. You can display 10, 15, or 20 users 
per page.

➤ User Information pane. Displays the details of the user selected in the 
list.

Refreshing the List of Users

➤ To refresh the list of users, click the Refresh button on the toolbar.

Sorting and Filtering the List of Users

➤ You can sort the users in ascending or descending order by clicking the 
heading of the column by which you want to sort. 

Click the column heading again to reverse the sort order.

➤ You can filter the users using the filter boxes below the column headings. 

In the filter boxes below the column headings, type the relevant text or 
select values from drop-down lists. Press ENTER. The table displays users 
according to the selected filter options.
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Notes:

➤ The filter supports partial text entries. For example, if you type th, the 
filter results might include Seth, Thomas, and Anthony. The filter does 
not support regular expressions or the following characters: : ; & * \ ' / # ~ 
, ? { } $ % | < > + = ` ^ [ ] !

➤ Sort order and filter settings are saved per user, per project. The next time 
you access the Users page in a specific project, the page displays your 
most recent sort order and filter.

Managing Performance Center Users

You view and manage Performance Center users in your projects from the 
Users page. You can modify or delete users, and create users.

Note: You must have the appropriate user management privileges to 
perform these tasks, as described in the sections below.

Creating Users
If you have Create user privileges, you can create Performance Center users 
in your projects.

To create a user:

 1 On the Performance Center left menu, select User Management > Users.

 2 On the Users page, click the Add New User button on the toolbar. The Add 
New User dialog box opens.
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 3 Enter the new user’s details. (See “Understanding User Information” on 
page 616.)

 a Enter a user name and password for the new user. Re-enter the password 
for confirmation.

Note: When creating LDAP or SSO users, the password fields are not 
available. The password is taken from the user records in the respective 
system.

 b Enter the user’s full name, email address, and any additional details.

 c Select an expiration option:

➤ To set an expiration date for the user account, select Account Expires, 
click the calendar icon, and select a date. The expiration date must be 
later than the current date.

➤ To create a user account that never expires, select Account Never 
Expires.

 d Select a status for the user—Active or Non Active.

Note: A user must have the Active status in order to log in to 
Performance Center. 

 4 Click Add. The user is added to the list of users and is automatically assigned 
to the current project with the role, Guest. For more information about 
project-user-role assignments, see Chapter 41, “Privilege Management.”



Chapter 38 • Users

622

Editing User Information
If you have Edit user privileges, you can edit user information.

To edit a user’s details:

 1 On the Performance Center left menu, select User Management > Users.

 2 Select the user whose details you want to edit. The details are displayed in 
the User Information pane.

Note: To edit details of users assigned to the Performance Center or All 
Projects containers, you must have Edit user privileges in the 
Administration Site. For more information, contact your Performance 
Center administrator.

 3 Edit the details. (See “Understanding User Information” on page 616.)

 4 To revert back to the original details without saving your changes, click 
Restore.

To save your changes, click Save.

Deleting Users
If you have Delete user privileges, you can delete users from Performance 
Center.

To delete a user:

 1 On the Performance Center left menu, select User Management > Users.

 2 Select the user you want to delete, and click the Delete User button on the 
toolbar. 

Note: To delete users assigned to the Performance Center or All Projects 
containers, you must have Delete user privileges in the Administration Site. 
For more information, contact your Performance Center administrator.
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 3 Click OK to confirm that you want to delete the user.

The user is deleted from the list of users.
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39
User Roles

This chapter describes roles in Performance Center. Roles are groups of 
permissions assigned to users. A role determines what information a user is 
allowed to access, and which tasks the user can perform.

This chapter includes:

 ➤  User Roles Page at a Glance on page 626

 ➤  Understanding User Roles on page 627

 ➤  Canned Roles on page 628

 ➤  Understanding Role Permissions on page 630

 ➤  Assigning Roles to Users on page 636
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User Roles Page at a Glance

You view user roles on the Roles page (User Management > Roles). 

Note: To access the Roles page in the User Site, you must have Assign user to 
role and/or Remove user from role privileges.

In the User Site, the Roles page displays Project roles in read-only format. 
The roles are displayed on the left, and the role properties on the right. 

Note: You cannot edit or delete the roles, nor create new roles.

The list of roles displays canned roles which are predefined groups of 
permissions, and user-defined roles, that is, roles made up of user-defined 
groups of permissions.
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Understanding User Roles

Performance Center has two types of roles:

➤ Performance Center roles. Allow users to perform Performance Center 
administrative tasks, including:

➤ Management of Performance Center assets, that is, projects, users, 
roles, and license information

➤ Management of Performance Center system resources, that is, hosts, 
host pools, timeslots and runtime information

➤ General server administration 

Note: Performance Center roles can be viewed and managed in the 
Administration Site only. In the User Site, you can perform limited 
Performance Center administrative tasks including user management, 
project management, and project-user-role assignment only.  To do this, 
a Performance Center administrator must grant you the appropriate 
permissions in the Administration Site. For more information, contact 
your Performance Center administrator.

➤ Project roles. Allow users to perform project-related tasks, including:

➤ Managing project-related resources, that is hosts and timelsots 

➤ Defining load test settings, monitor profiles, Dashboard settings, and 
other general settings

➤ Defining load test run-time settings for tasks that you can perform on 
running load tests

Performance Center has canned roles which are predefined groups of 
permissions. For more information about the canned roles in Performance 
Center, see “Canned Roles” on page 628.

Roles can also be user-defined, that is, made up of user-defined groups of 
permissions. For more information about creating and managing 
user-defined roles, see the HP Performance Center Administrator Guide. 
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Filtering Roles

To locate a specific role, you can filter the list of roles by role name. 

To filter the list of roles:

 1 In the Role box, enter the name of the role you are looking for. 

 2 Click Filter. The list displays all the roles whose names contain the string 
that you entered.

Note: The filter supports partial text entries. For example, if you enter th, the 
display list might include Seth, Thomas, and Anthony.

To clear the filter:

➤ In the Role box, clear the text and click Filter. All the roles are redisplayed.

Canned Roles

Performance Center comes packaged with predefined roles, called canned 
roles. For example, the Project Manager role is a canned role that grants a 
user permission to perform all project management tasks. 
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The following table describes the canned roles that are built into 
Performance Center. 

Canned Role Description

Administrator
(Performance Center role - 
Administration Site only)

Privileges: 

➤ Can perform Performance Center administration 
—project/user/roles/licence management

➤ Can manage Performance Center resources—
hosts and servers, events

➤ Can manage reports and general Performance 
Center administration settings

Project Manager
(Project role)

Manages the engagement between the LOB (Life of 
Business) and the COE (Center of Excellence). Not 
expected to perform any load testing (although he 
has permissions to do so), but rather ensures that 
the project works as planned.

Privileges: 

➤ Can manage projects and project resources 

➤ Can manage reports, Dashboard, events

Power Tester
(Project role)

Load testing user. Can manage limited resource 
tasks.

Privileges: 

➤ Can configure and run load tests

➤ Can share/import/export project-related assets

➤ Can publish to Dashboard

➤ Can reboot machines

Tester
(Project role)

Load testing user. No resource management 
privileges.

Privileges: 

➤ Can configure and run load tests
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Understanding Role Permissions

Roles include permissions for performing administrative or project-related 
tasks in the Performance Center system. 

Some permissions are directly associated with other permissions. If a role 
includes such a permission, it automatically includes the associated 
permissions too. 

For example, creating a load test is directly associated with editing a load 
test, so if a role includes the Create load test permission, it automatically 
includes the Edit load test permission too. 

This section describes:

➤ “Performance Center Role Permissions” on page 631

➤ “Project Role Permissions” on page 632

LT Adviser
(Project role)

Privileges: 

➤ Can monitor load test runs, Vuser groups, graphs

➤ Can perform manual operations on Vusers and 
Vuser groups

Guest
(Project role)

Privileges:

➤ Can edit personal details and configure own 
graphs

➤ Can monitor load test runs, graphs, Vuser groups

Canned Role Description



Chapter 39 • User Roles

631

Performance Center Role Permissions
This section describes permissions for administrative tasks that you can 
perform from the User Site. 

Note: To view and edit these permissions, you must be logged in to the 
Administration Site with the appropriate Role Management privileges. 

Permission Description

Project Management 

Create project Allows the user to create projects

Associated with:

➤ Edit project

Edit project Allows the user to edit projects

Delete project Allows the user to delete projects

User Management 

Create user Allows the user to create Performance Center users.

Associated with:

➤ Edit user

➤ Edit user personal information

Edit user Allows the user to edit user details

Associated with:

➤ Edit user personal information

Delete user Allows the user to delete users

Assign user to role Allows the user to assign roles to users, and to 
change user-role assignments

Remove user from role Allows the user to remove user-role assignments 
from projects, and to change user-role assignments

Edit personal information Allows the user to edit personal information
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For information about permissions for administrative tasks in the 
Administration Site only, see the HP Performance Center Administrator Guide, 
or contact your Performance Center administrator.

Project Role Permissions
This section describes permissions for project-related tasks.

Load Testing - Design Permissions

Permission Description

Load Test Management

Create load test Allows the user to create load tests

Associated with:

➤ Edit load test

Edit load test Allows the user to edit load tests

Delete load test Allows the user to delete load tests

Associated with:

➤ Delete run

➤ Delete timeslot

➤ Delete monitor profile

➤ Delete run results

Upload script Allows the user to upload scripts from VuGen

Edit script details Allows the user to edit script details on the User Site 
Vuser Scripts page

Delete script Allows the user to delete scripts
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Monitor Profile Management

Create monitor profile Allows the user to create monitor profiles

Associated with:

➤ Edit monitor profile

Edit monitor profile Allows the user to edit monitor profiles

Delete monitor profile Allows the user to delete monitor profiles

Dashboard Management

Configure SLAs Allows the user to create and edit service level 
agreements

Delete SLAs Allows the user to delete service level agreements

Publish SLA statuses Allows the user to publish service level agreement 
statuses to the Dashboard

General

Edit user personal data Allows the user to edit personal information

Download applications Allows the user to download applications from the 
Downloads page

Integration with VuGen Allows the user to enable integration with 
Standalone VuGen

Associated with:

➤ Upload scripts

Integration with Analysis Allows the user to enable integration with 
Standalone Analysis

Permission Description
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Project Resource Management Permissions

Permission Description

Timeslot Management

Create timeslot Allows the user to create timeslots

Associated with:

➤ Edit timeslot

Edit timeslot Allows the user to edit timeslots

Delete timeslot Allows the user to delete timeslots

Create Autostart Allows the user to configure the Autostart feature

Associated with:

➤ Run load test

➤ Create timeslot

➤ Edit timeslot

Resource Management

Reboot machine Allows the user to reboot Performance Center 
servers/hosts

Check host Allows the user to check the status of Performance 
Center servers/hosts

Kill process Allows the user to end running processes on 
Performance Center servers/hosts

Edit host (partial) Allows the user to change the state of Performance 
Center hosts on the User Site
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Load Testing - Run-Time Permissions

Permission Description

Run-Time Operations

Run load test Allows the user to run load tests (create runs)

Stop run Allows the user to stop runs

Delete run Allows the user to delete runs

Associated with:

➤ Delete run results

Manual operation during 
run

Allows the user to change run-time settings during a 
run

Add run notes Allows the user to add summary information about 
a run

Collate/Analyze results Allows the user to collate or analyze run results

Associated with:

➤ Stop run

Upload files to Results 
page

Allows the user to upload files to the Load Test 
Results page

Configure scenario 
schedule

Allows the user to create load test schedules

Delete run results Allows the user to delete load test results
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Assigning Roles to Users

In order to access Performance Center, a Performance Center user must be 
assigned at least one role in at least one active project. 

If you have Assign user to role privileges, you can assign roles to users in 
your projects. You create project-user-role assignments on the Privilege 
Management page.

To access the Privilege Management page from the Roles page, click the 
Assign Project-User-Role button. For details on assigning roles to users in 
Performance Center projects, see Chapter 41, “Privilege Management.”



637

40
Performance Center Projects

This chapter describes how to manage projects in Performance Center. 
Project details includes a project’s name, status, Vuser limit, machine limit, 
and other information about the project. You can view, add, edit, and delete 
project information.

This chapter includes:

 ➤  Viewing Project Information on page 637

 ➤  Managing Performance Center Projects on page 640

Viewing Project Information 

If you have Project Management privileges, you can view and manage your 
projects in the User Site. The Projects page displays a list of all of your active 
projects.

To access the Projects page, on the Performance Center left menu, select 
User Management > Projects.

The Project Information pane below the list of projects displays information 
about the project selected in the list. This information includes:

Detail Description

Project Name The name of the project.

Project Status The status of the project in the Performance Center system. 
The status can be Active or Not Active. 

Note: In order to log in to Performance Center, at least one 
of the projects to which a user is assigned must be active.
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Running Vusers on 
Controller

Enables users to run Vusers on the Controller. This provides 
greater flexibility when resources are scarce. 

To give users more control in advanced projects, the Allow 
project users to override this selection option allows project 
users at the administration level to override the Running 
Vusers on Controller setting.

Note: For best results, running Vusers on dedicated load 
generators is recommended. Running Vusers on the 
Controller can overload the machine and affect load test 
results.

Vuser Limit The maximum number of Vusers a project can run at once. 
The total number of Vusers used by all of the project’s 
concurrent load tests must not exceed this limit.

Machine Limit The maximum number of host machines a project can use 
at once. The total number used by all of the project’s 
concurrent load tests must not exceed this limit.

Concurrent Runs The maximum number of concurrent runs allowed within 
the project.

Host Pool Specification of what class of host machines should be 
assigned to the project for load tests. If you have 
administrative privileges, you can edit the set of available 
pools.

For details, see the HP Performance Center Administrator 
Guide.

Creation Date The date and time the project was created in the system.

Expiration Date The date and time the project’s validity expires.

Use Target IP 
Definitions

Allows the user to define IP addresses to use as targets for 
load testing. 

For details, see “Using IP Addresses” on page 642.

J2EE\.NET 
Diagnostics Server

The J2EE\.NET Diagnostics Server selected for the project. 

For details on adding J2EE\.NET Diagnostics Servers to 
Performance Center, see the HP Performance Center 
Administrator Guide.

Detail Description
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Sorting the List of Projects

You can sort the projects in the list in ascending or descending order by 
clicking the heading of the column by which you want to sort. 

Click the column heading again to reverse the sort order.

Filtering the List of Projects

To locate a specific project, you can filter the list of projects by project name. 

To filter the list of projects:

 1 In the Find project box, enter the name of the project. The filter supports 
partial text entries. For example, if you enter th, the display list might 
include Seth, Thomas, and Anthony. 

 2 Click Find. The list displays all the projects whose names contain the string 
that you entered.

To clear the filter:

➤ Click the Show All button. All the projects are redisplayed.

Notes:

➤ The filter supports partial text entries. For example, if you type th, the 
filter results might include Seth, Thomas, and Anthony. The filter does 
not support regular expressions or the following characters: : ; & * \ ' / # ~ 
, ? { } $ % | < > + = ` ^ [ ] !

➤ Sorting and filtering settings are saved per user, per project. The next 
time you access the Projects page in a specific project, the page displays 
your most recent sort order and filter.



Chapter 40 • Performance Center Projects

640

Managing Performance Center Projects

You manage Performance Center projects from the Projects page.

Note: To manage Performance Center projects, you must have Project 
Management privileges. For more information, see “Performance Center 
Role Permissions” on page 631.

This section includes:

➤ “Creating Performance Center Projects” below

➤ “Editing Project Information” on page 644

➤ “Deleting Performance Center Projects” on page 644

Creating Performance Center Projects
If you have Create project privileges, you can create Performance Center 
projects.

To add a project:

 1 On the Performance Center left menu, select User Management > Projects.

 2 On the Projects page, click Add New Project. The Project Information pane 
(below the list of projects) changes to Add mode and displays an empty 
Project Information form.

 3 Enter details of the new project. (See “Viewing Project Information” on 
page 637.)

 a Enter a name for the project.

 b Select the Project Status—either Active or Not Active.

 c Select whether to allow Vusers to run on the Controller.

➤ Under Running Vusers on Controller, select Disable or Enable. 

➤ To allow Vusers to override this selection, select Allow project users to 
override selection.
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 d In the Vuser Limit box, enter the maximum number of Vusers a project 
can run at a time.

 e In the Machine Limit box, enter the maximum number of host machines 
a project can use at a time.

 f In the Concurrent Runs box, enter the maximum number of concurrent 
runs allowed within a project.

 g From the Host Pool list, select the class of host machines that should be 
assigned to the project.

 h Set an expiration date for the project.

➤ Under Expiration Date, click the Select expiration date link. A 
calendar window opens. Select the desired date and time (this must be 
later than the current date), and click Set. The calendar closes and the 
account expiration date is updated.

➤ To create a project that never expires, select Never Expires.

 i To use IP addresses as targets for load testing, select the Use Target IP 
Definitions option. Later, you must define the IP addresses to use as 
targets for load testing. For details, see “Using IP Addresses” below.

 j If you are working with HP Diagnostics, select a J2EE\.NET Diagnostics 
Server from the list. For more information about adding Diagnostics 
Servers to Performance Center, see the HP Performance Center 
Administrator Guide.

 4 Click Add. The project is added to the list, and you are assigned to the 
project with the role Guest.



Chapter 40 • Performance Center Projects

642

Using IP Addresses

IP addresses are assigned so that the addresses of all hosts on a given 
network share a common prefix. The common prefix defines the network 
portion of the IP address, and the remainder defines the host portion (also 
referred to as the local portion).

The term network in this context refers to a logical network which might 
span one or more physical networks. The network portion of an IP address 
identifies a site and the local portion identifies a single host at that site. 

Using Subnet Masks 

A site using subnet addressing must specify a 32-bit subnet mask for each 
network. Each bit in the subnet mask is set to 1 if the network treats the 
corresponding bit in the IP address as part of the network address or 0 if it 
treats the corresponding bit in the IP address as part of the host ID.

Consider, for example, the subnet mask 11111111 11111111 0000000 
0000000 (or in decimal form, 255.255.0.0). This subnet mask specifies that 
the first two octets identify the network and the last two octets identify the 
host on that network.

The subnet mask 255.255.255.255 (or in binary form, 11111111 11111111 
11111111 11111111), which you add when defining individual IP addresses, 
specifies that all four octets in the IP address identify the network and host 
as if there were no subnet mask. In practice, this means that null will use the 
exact IP address to target load tests.

Defining Target IP Addresses

If a project is set to Use Target IP definitions, you must define a target IP 
address. The project’s load tests are targeted to these addresses. If no 
addresses are defined, the project’s load tests cannot run.

By default, this option is not selected, and the project can target its tests to 
any IP address.

To limit your load test to one or more individual IP addresses, type the IP 
addresses along with the following mask address: 255.255.255.255. 
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To limit your load test to a network of target IP addresses, type the correct IP 
and Subnet mask combination that your network administrator has 
provided for your organization. 

To define target IP addresses for a project:

 1 On the Projects page, select the project from the list. The Project 
Information pane displays the selected project’s information.

 2 If Use Target IP Definitions has not been selected, click Edit to change the 
Project Information area to edit mode, and select it. 

 3 Click Save.

 4 Below the Project Information pane, click Define Target IP. The Define 
Target IP Addresses for Project dialog box opens.

 5 In the IP Address column, enter a target IP address.

 6 To add another IP address, click New Line and enter the address. 

 7 To edit an address, place the cursor in the box you want to edit, and type the 
new address.

 8 To delete a line, click the Delete Line button for the relevant IP address.

 9 Click Save to save changes and close the dialog box.
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Editing Project Information
If you have Edit project privileges, you can edit project information.

To edit a project’s details:

 1 On the Performance Center left menu, select User Management > Projects.

 2 On the Projects page, select the project whose information you want to edit.

 3 Click Edit. The Project Information pane changes to Edit mode. 

 4 Edit the information in the editable fields. (See “Viewing Project 
Information” on page 637.)

Note: If you edit the project’s host pool allocation, reserved timeslots may 
not appear in the Timeslots page. 

 5 Click Save to save changes to the project’s information.

Deleting Performance Center Projects
If you have Delete project privileges, you can delete Performance Center 
projects.

Notes: 

➤ If you delete the project you are currently logged in to, you will 
automatically be logged out of the system. 

➤ Deleting a project also deletes associated load test results, test definitions, 
Vuser scripts, and monitor profiles from the system.
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To delete a project:

 1 On the Performance Center left menu, select User Management > Projects.

 2 On the Projects page, select the project you want to delete and, below the 
Project Information pane, click Delete.

 3  Click OK to confirm that you want to delete the project.

The project is deleted from the list of projects.
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41
Privilege Management

The Privilege Manager stores all the project-user-role assignments in 
Performance Center.

This chapter includes:

 ➤  About Privilege Management on page 647

 ➤  Accessing the Privilege Manager on page 648

 ➤  Privilege Manager at a Glance on page 648

 ➤  Managing User Privilege Assignments on page 649

About Privilege Management

The Privilege Manager enables you to assign users with selected privileges to 
manage Performance Center resources and assets or to manage Performance 
Center projects.

After you have defined users, user roles, and projects in Performance Center, 
you use the Privilege Manager to create associations between these elements.

The Privilege Management page lists these associations and is a portal to the 
pages where these associations are managed.
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Accessing the Privilege Manager

You access the Privilege Manager directly from the Performance Center left 
menu or from the Roles page.

Note: To access the Privilege Manager in the User Site, you must have Assign 
user to role and/or Remove user from role privileges.

➤ To access the Privilege Manager from the Performance Center left menu, 
select User Management > Privilege Management. 

➤ To access the Privilege Manager from the Roles page, below the Role 
Properties pane, click the Assign Project-User-Role button.

Privilege Manager at a Glance

In the User Site, the Privilege Manager displays a list of all of your active 
projects on the left, and the User-Roles table on the right. When you select a 
project, the User-Roles table displays the users assigned to that project, and 
the roles assigned to them in that project.

Using the Privilege Manager, you can:

➤ View all the users assigned to a project, and the roles assigned to them in 
that project

➤ Assign users to a project

➤ Change roles assigned to users in a project

➤ Remove users assigned to a project
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Managing User Privilege Assignments

You use the Privilege Manager to assign users to Performance Center 
projects, and manage their roles therein.

Note: You must have Assign user to role and/or Remove user from role 
privileges to perform these tasks, as described in the sections below.

This section includes:

➤ “Assigning Users to Performance Center Projects” on page 649

➤ “Changing User-Role Assignments” on page 651

➤ “Removing Users from Projects” on page 652

Assigning Users to Performance Center Projects
If you have Assign user to role privileges, you can assign users to projects 
where they can manage project-related tasks.

Assigning users to a project involves a two-fold operation: 

➤ Selecting a project to which to assign the users

➤ Assigning roles to users that allow them to perform tasks in the selected 
project

To assign users to a project:

 1 On the Performance Center left menu, select User Management > Privilege 
Management.

 2 On the Privilege Management page, select the project to which to assign the 
users. 

The User-Roles table on the right lists all the existing user-role assignments 
in the selected project.

 3 Below the User-Roles table, click Assign New User. The Assign New 
User-Role to <project> dialog box opens. 
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 4 In the Role list, select a role that you want to assign to users.

Users already assigned this role are displayed in the Assigned to users boxes.

➤ Users assigned this role in the selected project are displayed in the Project 
Assignment box. 

➤ Users assigned this role for all projects (through the Administration Site) 
are displayed in the All Projects Assignment box.

 5 In the Available users list, select the users to whom you want to assign the 
selected role.

Tip: You can filter the Available users list by entering a user name (or part 
thereof) in the User box, and clicking Filter.

Click the single right-arrow button to move the selected user to the 
Assigned to users box. Alternatively, to move all of the available users 
simultaneously, click the double right-arrow button.

 6 Click Apply.

 7 To assign another role to users in the project, repeat steps 4 through 6.

 8 Click OK. The Assign New User-Role dialog box closes, and the User-Role 
table displays the new user-role assignments for the selected project. 



Chapter 41 • Privilege Management

651

Changing User-Role Assignments
If you have both Assign user to role and Remove user from role privileges, 
you can change the roles assigned to users in a project.

To change the roles assigned to a user:

 1 On the Performance Center left menu, select User Management > Privilege 
Management.

 2 On the Privilege Management page, select the project in which you want to 
change the user’s roles. 

Note: Roles assigned to a user in one project can differ from roles assigned to 
the same user in a different project.

 3 In the User-Roles table, select the user whose roles you want to change.

 4 Below the User-Roles table, click Change User Roles. 

Note: The Change User Roles button is enabled when one user only is 
selected in the User-Roles table.

 5 The Change User-Role Assignments in <project> dialog box opens, 
displaying the user that you selected. 

In the Roles table, all the roles available for the selected project are 
displayed, and the roles already assigned to the user are selected.
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 6 Select roles to assign to the user and clear the roles that you want to take 
away from the user.

Note: Roles assigned to the user for all projects are displayed in read-only 
format. To change these roles, you must perform this procedure in the All 
Projects container in the Administration Site. If you have user management 
privileges in the User Site only, contact your Performance Center 
administrator to perform this task for you.

 7 Click Assign. The Change User-Role Assignments dialog box closes, and the 
changes are displayed in the User-Roles table.

Removing Users from Projects
If you have Remove user from role privileges, you can remove a user from a 
project. Removing a user from a project deletes all the user-role assignments 
for the user in that project, and deletes the user from the Users page.

You can also remove yourself from other projects to which you are assigned, 
but not from the project in which you are currently working.

To remove a user from a project:

 1 On the Performance Center left menu, select User Management > Privilege 
Management.

 2 On the Privilege Management page, select the project from which you want 
to remove the user.
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 3 In the User-Roles table, select the user you want to remove. You can select 
one or multiple users.

Note: If the user has roles that are marked with an asterisk (*), to remove the 
user you must perform this procedure in the All Projects container in the 
Administration Site. If you have user management privileges in the User Site 
only, contact your Performance Center administrator to perform this task 
for you.

 4 Below the User-Roles table, click Remove Assignment. 

Note: The Remove Assignment button is enabled only if at least one user is 
selected in the User-Roles table.

 5 In the message box that opens, click OK to confirm that you want to remove 
the user.

The user and the role assignments for the user are deleted from the 
User-Roles table, and the user is deleted from the list of users on the Users 
page.
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42
Troubleshooting Performance Center 
Assets

This chapter provides information on troubleshooting problems related to 
managing Performance Center assets.

This chapter includes:

 ➤  Cannot Create Monitor Profile on page 657

 ➤  Cannot Save Measurements on page 658

 ➤  Cannot Import Monitor Profile/Vuser Script on page 659

 ➤  Cannot Download and Open Script on page 660

 ➤  Analysis - Performance Center Server Connection Failed on page 664

Cannot Create Monitor Profile

Error message: Monitor is not licensed or was not installed.

Troubleshooting

The problem is because of a misconfiguration of the host license on the 
utility server.

➤ Reset the system as follows:

 a In the Administrator Site, select System Configuration > 
Server Configuration.

 b Click Reset.

 c Try to create the monitor profile again.
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➤ If the problem persists, contact HP Software Support 
(http://www.hp.com/go/hpsoftwaresupport).

Cannot Save Measurements

Problem description: During configuration of a monitor, after you select the 
measurements that you want to monitor and you click Save, instead of 
saving the monitor, Performance Center goes back to the Choose Monitor 
page. 

Troubleshooting

This problem usually occurs when you select a large number of 
measurements. To resolve this issue, you need to increase the value of the 
AspMaxRequestEntityAllowed property in the IIS metabase. This property 
specifies the maximum number of bytes allowed in the entity body of an 
ASP request.

Note: For more information about the AspMaxRequestEntityAllowed 
property, see the Microsoft Terminal Services documentation: 
http://www.microsoft.com/technet/prodtechnol/WindowsServer2003/Library/IIS/a
6401b5e-c902-4035-90aa-ee46c270d357.mspx?mfr=true, or 
http://support.microsoft.com/kb/327659

To increase the value of the AspMaxRequestEntityAllowed property:

 1 Run the following command from the command line:

where <IIS_installation_drive> is the hard disk where IIS is installed.

 2 To view the current value of the AspMaxRequestEntityAllowed property, run 
the following command:

cd <IIS_installation_drive>:\inetpub\adminscripts.

cscript adsutil.vbs get w3svc/ASPMaxRequestEntityAllowed.

http://www.microsoft.com/technet/prodtechnol/WindowsServer2003/Library/IIS/a6401b5e-c902-4035-90aa-ee46c270d357.mspx?mfr=true
http://www.microsoft.com/technet/prodtechnol/WindowsServer2003/Library/IIS/a6401b5e-c902-4035-90aa-ee46c270d357.mspx?mfr=true
http://www.hp.com/go/hpsoftwaresupport
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 3 To increase the value of the AspMaxRequestEntityAllowed property, run the 
following command:

where <maximum value> is the maximum value, in bytes, that you want to 
set for the AspMaxRequestEntityAllowed property.

 4 Run the following command:

 5 To verify that the value of the AspMaxRequestEntityAllowed property has 
changed, run the following command again:

Note: If you are still not able to save the measurements in the monitor 
profile, increase the value of the AspMaxRequestEntityAllowed property 
further. 

For more information about this issue, see the Microsoft support Web site: 
http://support.microsoft.com/kb/327659

Cannot Import Monitor Profile/Vuser Script

Error message: Failed to import Monitor Profile/Vuser Script <asset name>. 
For more information, see the Event Log.

Troubleshooting

This problem might occur when, during the import process, another user 
has deleted the asset or modified its name.

Wait a few minutes and try again.

cscript adsutil.vbs set w3svc/ASPMaxRequestEntityAllowed <maximum value>.

iisreset.

cscript adsutil.vbs get w3svc/ASPMaxRequestEntityAllowed.

http://support.microsoft.com/kb/327659
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Cannot Download and Open Script

Error message: Windows cannot access the specified device, path, or file. 
You may not have the appropriate permissions to access the item.

Troubleshooting

The problem could be that the registry key associated with VuGen is 
corrupted or not defined.

 1 Select Start > Run and type regedit to open the registry.

 2 Locate the following keys:

➤ HKEY_CLASSES_ROOT\uszfile\shell\open\command.

➤ HKEY_CLASSES_ROOT\usrfile\shell\open\command.

 3 Make sure that the correct files are associated with the keys.

➤ USZ key: <PC home>\bin\VugenLauncher.exe

➤ USR key: %systemroot%\mercuryTestLauncher.exe, or 
<PC home>\bin\Vugen.exe

 4 Make sure that all backslashes are correct: \ and not /.

 5 Make sure all inverted commas are correct (there should be four in total).
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If the problem persists, try applying the following as a reg file on the 
machine:

Windows Registry Editor Version 5.00

[HKEY_CLASSES_ROOT\.usz]
@="uszfile"

[HKEY_CLASSES_ROOT\.usr]
@="usrfile"

[HKEY_CLASSES_ROOT\usrfile]
@="Virtual User Test"

[HKEY_CLASSES_ROOT\usrfile\DefaultIcon]
@="C:\\Program Files\\HP\\Performance Center\\bin\\vugen.exe,1"

[HKEY_CLASSES_ROOT\usrfile\shell]

[HKEY_CLASSES_ROOT\usrfile\shell\open]

[HKEY_CLASSES_ROOT\usrfile\shell\open\command]
@="C:\\WINDOWS\\system32\\MercuryTestLauncher.exe\" \"%1"

[HKEY_CLASSES_ROOT\uszfile]
@="Vugen Launcher"

[HKEY_CLASSES_ROOT\uszfile\DefaultIcon]
@="C:\\Program Files\\HP\\Performance Center\\bin\\VugenLauncher.exe,1"

[HKEY_CLASSES_ROOT\uszfile\shell]

[HKEY_CLASSES_ROOT\uszfile\shell\open]

[HKEY_CLASSES_ROOT\uszfile\shell\open\command]
@="C:\\Program Files\\HP\\Performance Center\\bin\\VugenLauncher.exe\" \"%1"

[HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\Explorer\FileE
xts\.usr]
"Application"="MercuryTestLauncher.exe"

[HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\Explorer\FileE
xts\.USZ]
"Application"="VugenLauncher.exe"
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[HKEY_LOCAL_MACHINE\SOFTWARE\Classes\.usr]
@="usrfile"

[HKEY_LOCAL_MACHINE\SOFTWARE\Classes\.usz]
@="uszfile"

[HKEY_LOCAL_MACHINE\SOFTWARE\Classes\usrfile]
@="Virtual User Test"

[HKEY_LOCAL_MACHINE\SOFTWARE\Classes\usrfile\DefaultIcon]
@="C:\\Program Files\\HP\\Performance Center\\bin\\vugen.exe,1"

[HKEY_LOCAL_MACHINE\SOFTWARE\Classes\usrfile\shell]

[HKEY_LOCAL_MACHINE\SOFTWARE\Classes\usrfile\shell\open]

[HKEY_LOCAL_MACHINE\SOFTWARE\Classes\usrfile\shell\open\command]
@="C:\\WINDOWS\\system32\\MercuryTestLauncher.exe\" \"%1"

[HKEY_LOCAL_MACHINE\SOFTWARE\Classes\uszfile]
@="Vugen Launcher"

[HKEY_LOCAL_MACHINE\SOFTWARE\Classes\uszfile\DefaultIcon]
@="C:\\Program Files\\HP\\Performance Center\\bin\\VugenLauncher.exe,1"

[HKEY_LOCAL_MACHINE\SOFTWARE\Classes\uszfile\shell]

[HKEY_LOCAL_MACHINE\SOFTWARE\Classes\uszfile\shell\open]

[HKEY_LOCAL_MACHINE\SOFTWARE\Classes\uszfile\shell\open\command]
@="C:\\Program Files\\HP\\Performance Center\\bin\\VugenLauncher.exe\" \"%1"
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Uploading Script From VuGen Fails

Problem description: Uploading a script from VuGen fails. An error message 
is provided.

Troubleshooting

 1 Make sure the machine is not configured to use a proxy server. If it is, 
disable the proxy server by searching the registry for the ProxyEnable key in 
the Internet Settings folders and setting this key to zero. 

 2 Check whether there are upload timeouts due to a slow network 
connection. In the <Performance Center installation>\dat directory, there is 
a configuration file called OrchidCommUtils.dat that holds the integration 
communication settings. To change the default timeout (60 sec.), you must 
enable the http_timeout_secs key and change its value.

If neither of the above troubleshooting options helps, you can create a log 
file that provides more information and send it to Customer Support 
(http://www.hp.com/go/hpsoftwaresupport). To create the log file, enable the 
log_file key.

Cannot Upload Script From VuGen

Problem description: Cannot upload a new script created in Standalone 
VuGen. Get following error: Failed to upload script. 

Troubleshooting

This problem occurs when Standalone VuGen, Standalone Analysis, and the 
Standalone Load Generator are installed on the same machine, and the 
Standalone Load Generator was installed last.

Workaround: To upload the script, use the Upload all files option.

http://www.hp.com/go/hpsoftwaresupport
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Analysis - Performance Center Server Connection Failed

Problem description: Connection from Anaylsis to Performance Center 
server fails with error message: Connection to <PC Server> failed.

Troubleshooting

Note: This behavior might be inconsistant among different users. 

This problem is usually related to an HTTP timeout. 

When a user who belongs to a large number of projects/scripts tries to 
connect to the Performance Center User Site server, the time taken to 
generate the list of projects/scripts exceeds the HTTP timeout.

To increase the HTTP timeout parameter:

 1 On the Analysis machine, open the following file: 
dat\OrchidCommUtils.dat.

 2 Locate the line containing the following string: http_timeout_secs.

 3 Uncomment the line by removing the semicolon (;).

 4 Change the value of the paramater from 60 to 180.
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43
Troubleshooting Load Test Design

This chapter provides information on troubleshooting problems related to 
designing load tests.

This chapter includes:

 ➤  Cannot Save Load Test (Error -ORA-03106) on page 665

Cannot Save Load Test (Error -ORA-03106)

Error message: Fatal two-task communication protocol error.

Troubleshooting

This error sometimes occurs after you change the run time settings when 
working with an Oracle database. The new details are not saved to the 
database, although a successful save was indicated.

The cause might be a mismatch between the character set of the Oracle 
client and the Oracle server.

➤ Make sure the NLS_LANG on the client and server match. They should be 
the same type or be of a type that can be converted.

➤ Consult with the database administrator on this issue.
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44
Troubleshooting Starting Load Tests

This chapter provides information on troubleshooting related to starting 
load tests.

This chapter includes:

 ➤  Timeslot Issue - No Available Load Generators (Error -2147219273) 
on page 668

 ➤  Timeslot Issue - No Available Controllers (Error -2147219274) on page 669

 ➤  Failed to Launch Controller (Error -2147220032) on page 670

 ➤  Controller Cannot Connect to Database (Error -2147219979) on page 671

 ➤  Not Enough Disk Space on Controller (Error -2147220152) on page 671

 ➤  Browser Stuck While Initializing Load Test on page 672

 ➤  Failure to Initialize Load Test on page 673

 ➤  License Issue -Concurrent Runs on page 673

 ➤  License Issue – Concurrent Users (Error -2147219264) on page 674

 ➤  Unable to Run Load Test that Is Already Active on page 674

 ➤  Cannot Initialize Load Test (Error -2147219790) on page 675

 ➤  Session Activation Fails on page 676

 ➤  License Manager Component Cannot Be Instantiated on page 677

 ➤  Unable to Instantiate License Manager Component - HTTPS (SSL) 
on page 677

 ➤  Cannot Run Load Test on Controller - Non-Admin System User on page 678

 ➤  Cannot Run Load Test Over Secure Channels on page 678
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 ➤  Cannot Run Load Test on Controller with Windows XP –  Non-Admin System 
User on page 679

 ➤  Cannot Run Load Test with UNIX Load Generator on page 680

Timeslot Issue - No Available Load Generators 
(Error -2147219273)

Error message: Could not reserve timeslot. There are no available load 
generators.

Troubleshooting

 1 On the User Site Hosts page (Project > Hosts), check whether any load 
generator hosts appear and make sure that their status is operational. 

If no load generators appear, or if they have a status other than operational, 
contact your administrator.

 2 If operational load generators appear on the Hosts page, check on the User 
Site Timeslots page (Project > Timeslots) to see when the load generators are 
available. 

If the load generators are not available during the desired timeslot, try to 
reorganize the timeslots so that the necessary resources are available for your 
load test. 

Before you reorganize the timeslots, you should look at all the tests that you 
have scheduled in your system and consider the following factors:

➤ timeslot utilization. Some tests may have more timeslots reserved than is 
necessary, or there may be timeslots that have been reserved for no 
reason. 

➤ test importance. Less important tests can be moved to different timeslots 
to make space available for the more important tests.

➤ irrelevant tests. Check whether there are tests scheduled that are no 
longer relevant and can be removed from the timeslot schedule.
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Note: On the Administration Site Hosts page (Resources > Hosts), your 
administrator can enable the Controller host to also act as an additional 
load generator. In general, this is not recommended practice and is only 
appropriate for load tests that have a very small number of Vusers.

Timeslot Issue - No Available Controllers 
(Error -2147219274)

Error message: Could not reserve timeslot. There is no available Controller.

Troubleshooting

 1 On the User Site Hosts page (Project > Hosts), check whether any Controller 
hosts appear and make sure that their status is operational. 

If no Controllers appear, or if they have a status other than operational, 
contact your administrator.

 2 If operational Controllers appear on the Hosts page, check on the User Site 
Timeslots page (Project > Timeslots) to see when the Controllers are 
available. 

If the Controllers are not available during the desired timeslot, try to 
reorganize the timeslots so that you can make the necessary resources 
available for your load test. 

Before you reorganize the timeslots, you should look at all the tests that you 
have scheduled in your system and consider the following factors:

➤ timeslot utilization. Some tests may have more timeslots reserved than is 
necessary, or there may be timeslots that have been reserved for no 
reason. 

➤ test importance. Less important tests can be moved to different timeslots 
to make space available for the more important tests.

➤ irrelevant tests. Check whether there are tests scheduled that are no 
longer relevant and can be removed from the timeslot schedule.
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 3 If the Controller machine is also designated as a data processor, the 
Controller may not be available due to a failed analysis or publish operation 
in a previous test. 

If an analysis/publish operation fails, the machine on which this action was 
performed remains allocated to the analysis/publish action, and the 
machine cannot be used as a Controller.

If this is the case, you need to cancel the allocation to the specified 
machine(s) as follows:

 a In the Test Runs page (Site Management > Test Runs), check which runs 
are being analyzed or published. In the case of publishing, this might be 
a few runs.

 b Click Deallocate Hosts in the Test Runs page. The Deallocate Hosts dialog 
box opens.

 c Select Deallocate Analysis host and click OK. Repeat this procedure for 
each test run from which you want to deallocate hosts.

Failed to Launch Controller (Error -2147220032)

Error message: Failed to launch the Controller. 

The above error message also includes more details about the specific 
problem with the Controller license.

Troubleshooting

Contact your administrator to verify why there is problem with the 
Controller license. You can view and update license information on the 
Administration Site License page (System Configuration > License). 

For more information about licenses, see the section about configuring and 
viewing license information in the HP Performance Center Administrator 
Guide.
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Controller Cannot Connect to Database 
(Error -2147219979)

Error message: Controller cannot connect to database. Contact your 
administrator to remove the Controller from the host list and add it again to 
reset configuration. 

Troubleshooting

When you receive this error, it usually means that something changed on 
the Controller host machine. This could be due to someone reformatting or 
reinstalling the Controller. 

Your administrator needs to reset the Controller configuration by removing 
the Controller from the Administration Site Hosts page (Resources > Hosts) 
and then adding it again.

Not Enough Disk Space on Controller (Error -2147220152)

Error message: Not enough disk space left on Controller machine system 
disk 'C:\'.

Troubleshooting

You need to make disk space available on the Controller host machine. For 
more information about the host system requirements, see the section about 
system component requirements in the HP Performance Center System 
Configuration and Installation Guide.
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Browser Stuck While Initializing Load Test

Problem description: During the initialization of a load test, the browser 
gets stuck.

Troubleshooting

 1 Restart your test as follows:

 a Close your browser.

 b Open your browser again and log in to the Performance Center User Site.

 c Start the test again

 2 If your browser gets stuck again, restart the relevant host machines as 
follows:

 a Close the Performance Center User Site. 

 b Restart the host machines (load generators and Controllers) that you are 
using in this test.

 c Open the Performance Center User Site, log in, and start the test again.

 3 If your browser gets stuck again, check with your administrator if there are 
any problems with the utility server that could be causing these issues.

 4 If you are still experiencing problems, contact Customer Support (http://
www.hp.com/go/hpsoftwaresupport) for assistance. 

http://www.hp.com/go/hpsoftwaresupport
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Failure to Initialize Load Test

Problem description: When trying to run a load test, the test fails to 
initialize.

Troubleshooting

 1 Start the test again.

 2 If initialization still fails, restart the relevant Controller host machines as 
follows:

 a Close the Performance Center User Site. 

 b Restart the Controller host machines that you are using in this test.

 c Open the Performance Center User Site, log in, and start the test again.

 3 If initialization still fails, try to assign a different Controller host (if 
available) to your test. 

If this solves the problem, contact Customer Support (http://www.hp.com/go/
hpsoftwaresupport) to check why the test did not work with the original 
Controller host.

 4 If you are still experiencing problems, contact Customer Support for 
assistance. 

 License Issue -Concurrent Runs

Error message: Your Performance Center license does not support the 
number of concurrent runs. 

Troubleshooting

Since you have exceeded the overall number of concurrent runs supported 
by your Performance Center license, you must do one of the following: 

➤ Ask your administrator to rearrange the scheduling of the load tests to 
make sure that you are not exceeding the overall number of concurrent 
runs supported by your license. 

➤ Upgrade your Performance Center license to enable support of more 
concurrent runs.

http://www.hp.com/go/hpsoftwaresupport
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License Issue – Concurrent Users (Error -2147219264)

Error message: Your Performance Center license does not support the 
number of concurrent users. 

Troubleshooting

Since you have exceeded the overall number of concurrent users supported 
by your Performance Center license, you must do one of the following: 

➤ Ask your administrator to rearrange the number of Vusers that are being 
used concurrently in all the projects so that some Vusers can be made 
available for your test.

➤ Reduce the number of Vusers for your test.

➤ Upgrade your Performance Center license to enable support of more 
Vusers.

Unable to Run Load Test that Is Already Active

Error message: Unable to create new load test run. There is already an 
identical active load test.

Troubleshooting

If a load test is running, you cannot run the same load test (with identical 
settings) concurrently. As a workaround, you can copy the settings of the 
test that you want to run and change the name. 

If there are enough host resources to run both tests concurrently, you should 
be able to run the new test.

Note: You copy a test on the Load Tests configuration page (Load Tests > 
Manage) of the Performance Center User Site. For more information about 
copying load tests, see the section about copying a load test in the HP 
Performance Center User Guide.



Chapter 44 • Troubleshooting Starting Load Tests

675

Cannot Initialize Load Test (Error -2147219790)

Problem description: You start the load test and get an error that the load 
test cannot be initialized.

This problem can occur for any of the following reasons:

➤ Scripts Are Inaccessible

➤ Unable to Instantiate 'OrchidResourceDB' Component

Scripts Are Inaccessible 
The scripts are inaccessible so the load test fails to initiate.

Error message: Cannot access the load test scripts. Please check load test 
definitions.

Troubleshooting

The script may be inaccessible for any of the following reasons:

➤ The script was deleted.

➤ The script was moved to a different directory. 

➤ There is a network problem preventing access to the script.

➤ Security/permissions issues could be preventing access to the script 
directory. 
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Unable to Instantiate 'OrchidResourceDB' Component
The load test fails to start. When it reaches step "searching for controller," 
get the following error:

In the Administration Site, the Event Log displays an error which ends with 
" RunFixer: Unknown error 0x800A000D] Type mismatch ."

Troubleshooting

 1 Log in to the specific Controller machine that failed.

 2 In the Services window, make sure the "DataCollectionAgent" service is 
running.

Session Activation Fails

Error message: Session activation failed. Reported from method: 
‘SA:AllocResourcesAndStartSes’; Session ID: #; Reason: 

Troubleshooting

 1 Verify that there is network connectivity between the host and the Web 
server. The latency should be less than 20 ms to and from all Performance 
Center machines, excluding the load generators.

 2 Check the Event Viewer administrative tool on both the Web server and 
Controller machines (Start > Settings > Control Panel > Administrative 
Tools > Event Viewer).

 Failed to initialize load test!    
 Error: Unable to run load test.2147219790Details: Activation attempt [1]: Unable to 
instantiate 'OrchidResourceDB' component; Activation attempt [2]: Unable to instantiate 
'OrchidResourceDB' component; Activation attempt [3]: Unable to instantiate 
'OrchidResourceDB' component  
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License Manager Component Cannot Be Instantiated

Error message: Cannot run the load test. Unable to instantiate License 
Manager component.

Troubleshooting

If you receive the above error, remove the PCIMkipper process and perform 
an IIS reset.

Unable to Instantiate License Manager Component - HTTPS 
(SSL)

Problem Description: When trying to run a load test you get the following 
error: Cannot run the Load Test. Unable to instantiate License Manager 
component.

Troubleshooting

You may get this error after configuring your server to work with HTTPS 
(SSL). 

 1 On the Utility Server, open the IIS Manager (Start > Control Panel >  
Administrative Tools  >  Internet Information Services).

 2 In the WebSites/Default Web Site directory, right-click PCWS and click 
Properties.

 3 On the Directory Security tab, under Secure Communication, click Edit.

 4 Make sure that Require Secure Channel SSL is not selected.

 5 Click OK.

 6 Reset IIS.
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Cannot Run Load Test on Controller - Non-Admin System 
User

Problem description: When the system user is a non-administrative user, if 
you try to run load test on a Controller for the first time, the load test does 
not run.

Troubleshooting

Before running load tests on a Controller for the first time, you must log on 
to the host machine with a user that has administrator privileges, open the 
Controller manually, and then close the Controller. The next time you try to 
run a load test on the Controller, the load test should run successfully.

To open the Controller manually:

 1 From the command line, run wlrun. The Controller opens.

 2 Close the Controller.

Cannot Run Load Test Over Secure Channels

Problem description: When you try to run a load test over secure channels,  
the load test cannot initialize because cannot connect to Controller or load 
generator.

Troubleshooting

Verify that the load test cannot run due to a security mismatch by trying to 
run the same load test with the same hosts from a local Controller. 

If a Security Key Mismatch error is displayed in the error log, then the keys 
do not match, and you need to align the security keys on all the machines.
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Load Test Run Fails. Load Generator Status Change to 
Resource Failure

Problem description: When trying to run a load test over secure channels, 
the load test fails to run and the load generator status changes to Resource 
Failure.

Troubleshooting

When trying to run a load test over secure channels, if the security keys on 
the Controller and load generator do not match the load test run fails, and 
the status of the load generators changes to Resource Failure.  To re-enable 
the load generators, you must manually reset the status on each affected 
load generator to Operational. 

Cannot Run Load Test on Controller with Windows XP – 
Non-Admin System User

Problem description: If the system user is a non-administrative user, you 
cannot run a load test on a Controller host in a Windows XP environment.

Troubleshooting

Workaround: Add the system user to the machine’s COM security settings.

To add the system user to the COM security settings:

 1 Select Start > Run, and type dcomcnfg. The Components Services window 
opens.

 2 Under Console Root\Component Services\Computers, right-click My 
Computer and select Properties.

 3 In the My Computer Properties dialog box, click the COM Security tab.

 4 Under Access Permissions, click Edit Default, and add the system user with 
full access to the default security.
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 5 Under Launch and Activation Permissions, click Edit Default, and add the 
system user with full access to the default security.

 6 In the My Computer Properties dialog box, click OK.

Cannot Run Load Test with UNIX Load Generator

Error message: Failed to initialize load test.

Troubleshooting

If Performance Center cannot connect the load generator to the Controller, 
manually change the wlrun7.ini file as follows:

 1 Open the wlrun7.ini file in a text editor.

 2 Change HostUnixDontUseRSH from 0 to 1.

 3 Try to rerun the test.
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45
Troubleshooting Running Load Tests

This chapter provides information on troubleshooting problems related to 
running load tests.

This chapter includes:

 ➤  Data Processor Error When Publishing Load Test on page 682

 ➤  Load Test Seems to Run, But Is Not Actually Running on page 682

 ➤  Load Test Does Not Run All Vuser Groups on page 683

 ➤  Vuser Group Does Not Start Running on page 683

 ➤  Load Test Does Not Stop Running on page 684

 ➤  User Site is Sluggish During a Load Test on page 684

 ➤  Online Graphs Stop Displaying During a Load Test on page 684

 ➤  Transaction Response Time Graph Not Showing Correct  Time Interval 
on page 685

 ➤  New Vusers Stop Initiating During a Load Test on page 686

 ➤  Failed to Run Load Test - Scripts Created with .NET Add-On on page 687

 ➤  Vusers Are Stuck in Initialization on page 688

 ➤  Vuser Replay Fails on page 689

 ➤  Connection to Database Timed Out on page 693

 ➤  Orchid Monitor Error on page 694

 ➤  Cannot Run Load Test with Non-Admin User on page 694

 ➤  SiteScope Server Fails to Retrieve Data from Hosts/Servers on page 695

 ➤  Failure to Run Load Test on page 696
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Data Processor Error When Publishing Load Test

Problem description: When trying to publish a load test from a pool with no 
data processor, an error link appears by the test run in the Load Tests page.

Troubleshooting:

 1 In the Administrator Site, add a data processor to the pool assigned to the 
project.

 2 In the User Site, on the Load Test Results page’s Results vs. Targets tab, click 
Publish. This cancels the publishing process.

 3 Republish the results. The error message disappears.

Load Test Seems to Run, But Is Not Actually Running

Problem description: You are unable to run a load test. The Performance 
Center error message states that a test is currently running, but no tests are 
actually being run.

Troubleshooting

 1 Verify whether a load test is actually running on the target Performance 
Center Controller host. 

 2 If no test is actively running, reset the host state using the Performance 
Center Administration Site, as follows:

 a From the Performance Center left menu, select Site Management > 
Test Runs. The Test Runs page opens.

 b Select the relevant run from the test runs table.

 c In the test runs toolbar, click the Fast Recovery button. 

This cleans the state of hosts in the database, and makes the problematic 
host available for future load tests. If the host is in Resource Failure state 
and cannot be used in your load test, see “Troubleshooting Hosts and 
Servers” on page 721.
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Load Test Does Not Run All Vuser Groups

Problem description: Performance Center did not run all the Vuser groups 
defined in the load test.

Troubleshooting

Performance Center supports running up to 47 Vuser groups in a load test 
run.

Vuser Group Does Not Start Running

Problem description: The Vuser group in the load test does not start 
running.

Troubleshooting

This problem occurs if a Vuser group is scheduled to run after a Vuser group 
that is set to run indefinitely.

If Group A is set to run indefinitely, and Group B is scheduled to run after 
Group A, then Group B will run only if you do one of the following:

➤ Stop Group A manually

➤ Add a Stop Vusers action to Group A’s schedule

➤ Modify Group B’s Start Group action to start running after a specified 
amount of time
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Load Test Does Not Stop Running

Problem description: Vusers in the load test do not stop running.

Troubleshooting

If a load test schedule does not have a Stop Vusers action, the load test does 
not stop running. 

Possible causes:

➤ The Stop Vusers action was deleted

➤ With load tests scheduled to run indefinitely in Performance Center 
versions 8.1 or earlier, during migration no Stop Vusers action is created, 
since the Vusers are not meant to stop running

Solution: Check the Actions defined in the Actions grid of the load test’s 
schedule. If no Stop Vusers action is defined, the schedule continues to run 
indefinitely. To stop running the load test, define a Stop Vusers action in the 
load test schedule.

User Site is Sluggish During a Load Test

Problem description: The Controller machine may be over-utilized.

Troubleshooting

See “New Vusers Stop Initiating During a Load Test” below.

Online Graphs Stop Displaying During a Load Test

Problem description: The Controller machine may be over-utilized.

Troubleshooting

See “New Vusers Stop Initiating During a Load Test” on page 686.
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Transaction Response Time Graph Not Showing Correct 
Time Interval

Problem description: When running a scenario, the Transaction Response 
Time graph displays the whole load test duration, instead of the time 
interval it is configured to display. 

For example, in the illustration below, the graph is configured to display the 
last three minutes, but it still displays the whole load test duration.

Troubleshooting

This occurs if transactions selected in the graph legend did not run during 
the configured time interval. 

In the above example, the vuser_init_transaction finished running at the 
beginning of the run, but it is selected in the graph legend so it is still being 
displayed. 
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To display the correct time interval on the Transaction Response Time 
graph, ensure that transactions that did not run during the configured time 
interval are not selected in the legend. 

New Vusers Stop Initiating During a Load Test

Problem description: During a load test, new Vusers stop initiating.

Troubleshooting

The Controller machine may be over-utilized.

 1 Make sure that you are not running any Vusers on the Controller machine.

 2 Check that the machine is responsive and CPU utilization on the Controller 
machine during a load test is below 100%.

 3 Disable any software that may interfere with the Performance Center 
Controller, file server, or Web server. This includes any auditing or virus 
scanning software.
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 4 If CPU utilization is high, check whether:

➤ the online.exe process is consuming excessive CPU. If it is, this means 
that you might have too many active remote viewing sessions (for 
example, many people are watching the load test from different 
browsers). To fix this problem, either decrease the frequency at which the 
load test viewing sessions are refreshed (from each individual client 
browser), or decrease the number of concurrent viewing sessions for the 
current or problematic load test.

➤ the wlrun.exe process is consuming excessive CPU. If it is, check whether 
your load test is:

➤ producing many error messages. If it is, reduce the number of error 
messages by resolving the reasons for the error messages.

➤ producing many logging messages (for the Controller). If it is, disable 
or reduce the logging level, or avoid using log statements (such as 
lr_message) that send messages to the Controller’s output window.

➤ running scripts without any think times, and thus producing a lot of 
data that is sent back to the Controller.

If CPU consumption cannot be reduced for the load test, consider upgrading 
your Controller hardware.

Failed to Run Load Test - Scripts Created with .NET Add-On

Problem description: Running scripts with protocols such as vbNet (VB.NET 
Template) , CsNet (C#.NET Template), VcNet (C++.NET Template) that were 
created with the .NET add-on (visual studio 2003 or 2005) fails.

Troubleshooting

This problem is related to .NET security definitions with the use of a UNC 
path (see http://social.msdn.microsoft.com/forums/en-US/winformssetup/thread/
f1b4f239-4c53-43a4-89b2-31c1d666ccac/).

http://social.msdn.microsoft.com/forums/en-US/winformssetup/thread/f1b4f239-4c53-43a4-89b2-31c1d666ccac/
http://social.msdn.microsoft.com/forums/en-US/winformssetup/thread/f1b4f239-4c53-43a4-89b2-31c1d666ccac/


Chapter 45 • Troubleshooting Running Load Tests

688

In Performance Center, scripts are stored on the File Server. When running 
Vusers from Performance Center, the host machine accesses Vuser scripts 
stored on the File Server using UNC paths.

To run a load test with these scripts, run the following command from the 
command line on the host machine:

Vusers Are Stuck in Initialization

Problem description: Vusers are stuck in initialization, or never run at all. 
This can occur if you made modifications to a script and overwrote the 
existing script in Performance Center. Although you uploaded the script, 
the new run-time logic of the script is not updated for the load tests that see 
the script.

When the load test is run with the updated script, a pop-up window is 
displayed in wlrun.exe on the Controller. To verify this, run wlrun.exe on 
the Controller as an interactive user (see “Option 3: Launch wlrun.exe 
manually from the Controller host machine” on page 725 for configuration 
details).

Example: A load test named TestLoadTest refers to a script named Test that 
contains four sections: vuser_init, action1, action2, and vuser_end. If you 
modify the Test script so that it includes only three sections—vuser_init, 
action3, and vuser_end—and overwrite the previous Test script by 
uploading the modified script to Performance Center, the Vusers will not 
run when you run TestLoadTest. This is due to the fact that the old script’s 
run-time logic remains and the load test still “thinks” that there are two 
actions sections, action1 and action2, as opposed to the one action section 
in the updated script, action3. 

 %windir%\Microsoft.NET\Framework\v2.0.50727\caspol -m -cg LocalIntranet_Zone 
-allcode FullTrust 
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Troubleshooting

Option 1:

 1 When modifications are made to a script, change the name of the script by 
adding a version number to it. For example, TestScript_1 can be changed to 
TestScript_2. This way, when you upload the updated script, the current 
script remains, and the load test will still run.

 2 Create a new load test, and add the new version of the script to it.

Option 2:

When modifications are made to a script, remove the script from the load 
test, then add it to the load test again.

Note: Option 1 is recommended, as it enables you to keep track of your 
script and load test configuration changes.

Vuser Replay Fails

Problem description: Vusers are not picking up the correct environment 
settings and replay fails.

Troubleshooting

Option 1: Check the environment settings and software installation

The load generator machines on which the test is running must have the 
correct software installed and the proper environment variables set for the 
user.

For Microsoft Media Player:

 1 Log in to the load generator as the Performance Center system user and run 
Windows Media Player Install for Windows Media.

 2 Check the System environment variable Path to make sure that the 
Windows Media Player path is set correctly. Reboot, if necessary, for the 
correct settings to take effect.
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 3 On the load generator machine, use VuGen to run the script and test it.

For Java:

 1 Log in to the load generator machine as the Performance Center system 
user.

 2 Make sure that the Path environment variable for both User and System do 
not have an instance of Java Virtual Machine. Performance Center retrieves 
the JVM information from the registry.

 3 If the script replays on the VuGen machine on which the script was created, 
copy the machine’s CLASSPATH environment variable and place it in the 
System environment variable area of the load generator machine.

 4 On the load generator machine, run a simple script using VuGen to get the 
environment variable settings. Add the following lines to verify that the 
environment variables are set correctly:

Note: Make sure that you add the protocol definition char* getenv(char*); at 
the top of the script file.

For Citrix:

 1 Make sure that the Citrix client is installed on the load generator machine.

 2 Run the script through VuGen on the load generator machine.

For Databases:

Make sure that you have the appropriate database client installed on the 
load generator machine, and the appropriate settings in the System Path 
environment variable.

char *env;
env = getenv(“PATH”);
lr_output_message(“%s”,env);
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For Tuxedo:

 1 Make sure that the Tuxedo client is installed on the load generator machine.

 2 Verify that the following environment variables are set under System:

➤ Path. Add the tuxedo\bin directory to this variable.

➤ TUXDIR. The root directory of the TUXEDO installation. It is called 
ROOTDIR in TUXEDO 4.2 and earlier versions of TUXEDO. This 
environment variable is mandatory on the NT platform (For example: 
TUXDIR=D:\PSHr755\tuxedo).

➤ NLSPATH. Contains sub-directories to support the localization of system 
messages, along with message catalogs for the default locale (U.S. 
English). This environment variable is also mandatory on the NT 
platform (For example: NLSPATH=$TUXDIR\locale\c).

➤ WSNADDR. The address of the TUXEDO server (may need to be set). In 
pre-TUXEDO 6.3 versions this is in hex—for example, 
0x0002ffffc7cb4ebd. The 0002 indicates the IP, ffff indicates the port 
number, and cbcb4ebd indicates the IP address of the machine that 
contains the server. TUXEDO 6.3 also allows a more mnemonic way of 
indicating the server’s address. This environment variable is mandatory 
on the NT platform (For example: WSNADDR=199.35.108.119:7000).

➤ ULOGPFX. Prefix for the TUXEDO log file (may need to be set). The name 
of the log file includes the current date represented as a six-digit 
number—for example, 081797 for August 17, 1997. The ULOGPFX can 
contain a directory name as well as part of the file name itself (For 
example: ULOGPFX=/u/markn/ul).

Note: Make sure that you add the protocol definition char* getenv(char*); 
at the top of the script file.
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Option 2: Configure the Controller to work as an interactive user

Running a GUI script in Performance Center may cause HP WinRunner or 
HP QuickTest Professional to crash due to the configuration of 
Wlrun.Engine. To rectify this situation, configure the Controller to work as 
an interactive user.

To configure the Controller to work as an interactive user:

 1 Make sure the wlrun process is not running on the machine.

 2 Select Start > Run and type dcomcnfg.

 3 Press ENTER to display the list of DCOM applications.

 4 In the displayed application list, right-click wlrun.LrEngine and select 
Properties. 

 5 In the Identity tab, select The interactive user.

 6 Click OK twice to close both dialog boxes.

 7 Log in to the machine in the Performance Center environment as the 
system user. This user, which is installed with Performance Center, is 
displayed in the General Settings page of the Administration Site.
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Connection to Database Timed Out 

Error Message: The connection to database timed out.

Problem description: The load test cannot run. Performance Center runs 
slowly when configured with Oracle 9i or 10g server/client and an error may 
be displayed in the Administration Site stating that the connection to 
database timed out.

Troubleshooting

 1 Make sure that you are accessing the database through TNSNAMES and not 
ONAMES, which can lead to a noticeable and ever-increasing time delay 
connecting to the database. This time delay does not exist if TNSNAMES is 
used. 

To use TNSNAMES, change its priority within the SQLNET.ORA file by 
editing the <Oracle installation directory>\network\admin\sqlnet.ora file 
and setting the NAMES.DIRECTORY_PATH as follows: 

Note that TNSNAMES must be the first entry in the DIRECTORY_PATH.

 2 Comment out the line SQLNET.AUTHENTICATION_SERVICES= (NTS) within 
the <Oracle installation directory>\network\admin\sqlnet.ora file located 
on the database server machine.

 3 Validate connection performance to the Performance Center database. Run 
the TcQA_CheckDatabaseConnection.vbs script (available as a download 
from the Customer Support Web site Knowledge Base, ID39475) to quantify 
the performance of the connection to the Performance Center database. 
Make sure that the connect times are constant and low.

NAMES.DIRECTORY_PATH = (TNSNAMES,ONAMES)

http://support.mercury.com/
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The following is an example of a sample output:

Orchid Monitor Error

Problem description: Error from Orchid monitor in Error Window during 
the run.

Troubleshooting

The Windows Remore Registry Service should be running on the host 
machine.

 1 Select Start > Programs > Administrator Tools > Services to open the services 
window.

 2 Search for the Remote Registry Service

 3 Make sure the service’s status is Started and is set to Automatic.

Cannot Run Load Test with Non-Admin User

Problem description: You cannot run a load test with a non-administrative 
system user, or after a user is changed.

Troubleshooting

 1 Verify that all the required services are running.

 2 Try to run alagentservice and magentservice using the following 
commands:

Database Connection String: Provider=SQLOLEDB.1;User 
ID=OrchidUser;PWD=orchid;Initial Catalog=MI_LRDB;Data 
Source=samurai\mssqla;QuotedID=No Statistics:
Attempt #1: Connect= 1 secs,  Query= 2 secs
Attempt #2: Connect= 1 secs,  Query= 1 secs
Attempt #3: Connect= 2 secs,  Query= 1 secs
Attempt #4: Connect= 2 secs,  Query= 1 secs
Attempt #5: Connect= 2 secs,  Query= 1 secs
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➤ alagentservice

where username and password are those of the Performance Center 
system user.

➤ magentservice

where username and password are those of the Performance Center 
system user.

 3 If the load test fails in the first step, check the LRFS folder. If there is a 
problem configuring the LRFS folder, try restarting the machine. 

 4 Check the identity of the COM objects, especially OrchidActiveSession and 
wlrun.lrengine. The identity should be the Performance Center system user.

SiteScope Server Fails to Retrieve Data from Hosts/Servers

Problem description: If you change the system user to a non-administrative 
user and then enable SiteScope on any of the Performance Center servers or 
hosts, SiteScope cannot retrieve all required data.

Troubleshooting

Manually configure an administrative user on the SiteScope server so that it 
has permissions to monitor the server/hosts machines and retrieve all the 
required data.

%installation folder%\al_agent\bin\alagentservice.exe -remove 

%installation folder%\al_agent\bin\alagentservice.exe -install username password 

%installation folder%\launch_service\bin\magentservice.exe -remove 

%installation folder%\launch_service\bin\magentservice.exe -install username 
password
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To configure an administrative user on the SiteScope server:

 1 In your browser, type the URL for SiteScope as follows:

where sitescope_server is the name of your SiteScope server.

 2 At the top of the SiteScope page, click SiteScope.

 3 Click Remote Windows.

 4 From the list, select the relevant machine and click Edit.

 5 In the Login and Password fields, type the login name and password of a 
system user with administrative privileges.

 6 Click Update.

 Failure to Run Load Test

Problem description: The load test fails to run. This may occur as a result of 
problems with the .NET Framework installation.

Troubleshooting

Repair the .NET Framework installation as follows:

 1 Select Start > Run. 

 2 Type the following command:

http://<sitescope_server>:8888/sitescope

c:\WINDOWS\Microsoft.NET\Framework\v2.0.50727\aspnet_regiis.exe -i
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46
Troubleshooting WAN Emulation

This chapter provides information on troubleshooting problems related to 
WAN Emulation.

This chapter includes:

 ➤  WAN Emulation Is Already Running on page 697

 ➤  Duplicate Monitor Graphs with Empty Counters Appear on page 698

 ➤  Load Test is Stuck in init Phase on page 698

 ➤  Cannot Run WAN Emulation on Load Generator That Is Also  the Controller 
on page 699

 ➤  User Site Gets Stuck when Starting Load Test Configured  with WAN 
Emulation on page 699

WAN Emulation Is Already Running

Problem description. If you kill the LR_Bridge.exe or magentproc.exe 
processes on a load generator to stop a load test, the next time you define 
WAN Emulation settings and run a load test on that load generator, you will 
receive a message that WAN Emulation is already running on it.  

Troubleshooting

➤ When you kill the processes on a load generator to stop the load test, you 
must manually terminate the WAN Emulation as well. If you do not 
manually stop the WAN Emulation and later try to run another load test on 
the same load generator, the load generator will still be emulated without 
you being aware of it. We strongly recommend that you manually terminate 
the WAN Emulation to prevent this scenario.
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Duplicate Monitor Graphs with Empty Counters Appear

Problem Description. A duplicate of the Windows Resources monitor 
appears with empty counters.

Troubleshooting

If you manually add metrics in addition to those that are automatically 
added, you will see a duplicate of the Windows Resources monitor with 
empty counters representing the manually added metrics.

Load Test is Stuck in init Phase

Problem description. Load Test is stuck in the init phase.

Troubleshooting

➤ If you try to run a load test with the WAN Emulation but the 3rd party 
software is not installed on the load generator, then the load test might get 
stuck in the init phase. In this case, check the 3rd party software error 
message and consult the relevant 3rd party software installation 
documentation.

➤ If you are working with the WAN Emulator in professional mode, and you 
specify a location for the .ntx file on a machine where there are no 
Performance Center User privileges, when you try to run the load test it will 
get stuck during the init phase. 

When working in professional mode, make sure that .ntx file is located on a 
machine that has Performance Center User privileges.
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Cannot Run WAN Emulation on Load Generator That Is Also 
the Controller

Problem description. You receive an error message that you cannot run 
WAN Emulation on a load generator that is also the Controller. 

Troubleshooting

➤ Make sure that the option to allow running Vusers on the Controller in the 
project is disabled.

User Site Gets Stuck when Starting Load Test Configured 
with WAN Emulation

Problem description. You configure a load test to run with WAN Emulation, 
but the User Site gets stuck when you start the load test run.

Troubleshooting

➤ Restart the Controller.
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47
Troubleshooting Autostart

This chapter provides information on troubleshooting errors related to 
autostarting load tests.

This chapter includes:

 ➤  License Validation Failed on page 702

 ➤  Timeslot Validation Failed on page 702

 ➤  Load Test is Already Active on page 703

 ➤  Load Test Exceeded Timeslot on page 704

 ➤  Cannot Instantiate Session Activator Component on page 705

 ➤  Cannot Activate Load Test Run on page 705
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License Validation Failed

Error Message: License Validation Failed.

Troubleshooting

Each load test’s activation is validated against the Performance Center 
license limitations for the number of Vusers, machines, and concurrent 
runs, as well as project limitations and the license’s expiration date.

➤ Check if the Performance Center license or the project settings were 
modified. If they have been modified, reschedule the load test according to 
the new settings.

➤ Check if the Performance Center license has expired.

Timeslot Validation Failed

Error message: Timeslot validation failed. Please make sure that timeslot 
duration is at least 20 minutes.

Troubleshooting

Reserve a new timeslot for the load test that has at least 20 minutes 
available.
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Load Test is Already Active

Error Message: There is already a run executing for this load test.

Troubleshooting

A load test can have one of the following states: Ready, Running, Stopping, 
Collating Results, or Creating Analysis Data. Each of these states is 
considered an Active state. A load test can only have one Active state at any 
one time. If you try to run a load test that already has an Active state, you 
will receive the above message.

If the current state is Ready, Running, or Stopping, reset the load test using 
the HP Performance Center Administration site as follows:

 a From the Performance Center left menu, select 
Site Management > Test Runs. The Test Runs page opens.

 b Select the relevant run from the test runs table.

 c In the test runs toolbar, click the Fast Recovery button. 

This cleans the state of the load test and makes the host available for future 
load tests.

If the current state is Collating Results, use the fast recovery feature as 
described above, and then deactivate the collator process as follows:

 a On the Administrator Site, select Site Management > Test Runs. The Test 
Runs page opens.

 b Select the relevant run from the test runs table.

 c In the test runs toolbar, click the Deactivate collator process button. The 
Deactivate Collator dialog box opens.

 d Click OK to confirm that you want to deactivate the collator process. A 
dialog box opens confirming that the process was deactivated.

 e Click Close to close the dialog box.
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If the current Active state is Creating Analysis Data, use the fast recovery 
feature as described above, and then kill the process to free up more 
resources as follows: 

 a On the User site, select Project > Hosts. The Hosts page opens.

 b In the Hosts table, click the relevant host. The Host Details page opens.

 c In the Host Details page, select the processes tab.

 d In the relevant process’s Kill column, click Kill Process.

Note: The Creating Analysis Data process is very CPU and I/O intensive. 
Killing this process should be considered only in the event you have not 
been able to resolve the problem in any other way.

Load Test Exceeded Timeslot

Error Message: Load test <test name> exceeded its timeslot. Executing run 
failed to stop in a timely manner.

Troubleshooting

This usually occurs when you reserve consecutive autostart timeslots that 
share resources, or where the first defined load test is very CPU and/or I/O 
intensive and/or has a large number of Vusers scheduled to run at the same 
time. This can cause the first load test to overrun its timeslot and as a result 
the second load test will not run.

When reserving consecutive autostart timeslots:

➤ Make sure that you leave a suitable time interval between the timeslots.

➤ Do not select the Collate and Analyze Results or Collate Only post run 
analysis options for the first timeslot.
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Cannot Instantiate Session Activator Component

Error Message: Unable to instantiate Session Activator Component.

Troubleshooting

This is an indication of an internal error.

➤ Reset the User Site and/or the Utility and/or the Host Machine.

➤ If that does not resolve the problem, contact HP Support.

Cannot Activate Load Test Run

Error Message: Unable to activate and start load test run.

Troubleshooting

➤ Check Session Activator Errors:

➤ Run the load test manually to try resolve issues that arise.

➤ When reserving the timeslot, do not select Manual machine selection. 
Select Automatic instead.

➤ Check the load test for run time settings errors. 
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48
Troubleshooting Post Load Test

This chapter provides information on troubleshooting issues that may arise 
after running a load test.

This chapter includes:

 ➤  Cannot Find Data Processor to Publish Load Test Results on page 707

 ➤  Failure to Launch Online Analysis on page 708

Cannot Find Data Processor to Publish Load Test Results

Problem description: When trying to publish load test results to the 
Dashboard, you get an error that Performance Center cannot find a data 
processor.

Troubleshooting

 1 Log on to the Performance Center Administration Site and edit the host so 
that it also functions as a data processor. (For more information, see the HP 
Performance Center Administrator Guide.)

 2 In the User Site, refresh the Dashboard page.

 3 If Performance Center still cannot find the data processor, unpublish the 
results and republish them.
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Failure to Launch Online Analysis

Problem description: Performance Center cannot launch online Analysis 
when the Controller does not have access to the Utility Server. The run 
initialization fails.

Troubleshooting

➤ Check the DNS settings to make sure you can ping the Utility Server from 
the Controller.

➤ In the case of an Oracle database, make sure the tnsnames.ora is defined 
properly.

Cannot Export Trend View Information to CSV Format

Problem description. Performance Center fails to export the information 
contained in a trend report’s trend view to CSV format.

Troubleshooting

Check your Internet Explorer settings as follows:

 1 On your machine, select Tools > Internet Options.

 2 Select the Security tab.

 3 Click Custom Level.

 4 Under Downloads, make sure that the Automatic Prompting for File 
Downloads setting is set to Enable. 



709

49
Troubleshooting Accessing the 
Performance Center Sites

This chapter provides information on troubleshooting Web-related 
problems.

This chapter includes:

 ➤  Login Fails on page 709

 ➤  User Site Does Not Exist After Initial Configuration on page 711

 ➤  Unable to Log In to the Administration/User Site on page 712

 ➤  Administration Site Page Cannot Be Displayed on page 713

 ➤  Cannot Connect to Administration or User Site on page 714

Login Fails

Logging in to Performance Center fails in the following cases:

➤ “New Users Cannot Log In to Performance Center” on page 710

➤ “Cannot Log In to Performance Center with Any User or Administrator 
Account” on page 710
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New Users Cannot Log In to Performance Center
Problem description: New users cannot log in to Performance Center. Get 
the following error: The system could not retrieve your personal 
information. Please contact your administrator.

Troubleshooting

This usually happens after upgrading the database.

Make sure that the Default project exists in Performance Center and is 
enabled.

 1 Open the database, and locate the Companies table.

 2 Make sure that for Default project, state is set to 1.

If not, run the following line on the database:

Cannot Log In to Performance Center with Any User or 
Administrator Account
Problem description: You cannot log in to Performance Center with any 
user or administrator account.

Troubleshooting

 1 Make sure that you type the correct user name and password. The password 
is case-sensitive. The default administrator account is Admin, Admin.

 2 There may be a problem with the encryption and decryption of the 
password.

➤ Open Documents And Settings\All Users\Application 
Data\Microsoft\Crypto\RSA\MachineKeys and delete the entry that 
begins with f9416f003254e610da1f9bad8e4c383_.

➤ Restart IIS. Select Start > Programs > Administrative Tools > Services. 
Select IIS Admin Service and click Restart Service.

update MI_LRDB.companies set state=1 where companyID=1
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 3 Make sure that both the Administration Site and the User Site are configured 
to run with the same account credentials as the Performance Center Web 
services virtual directories. For more information about troubleshooting 
Web services, see the relevant section in the HP Performance Center 
Administrator Guide.

 4 Check that you are able to connect to the database server from the Utility 
Server and the Web Server. Download the TcIN_AdoDBTester.exe utility 
from the HP Software Support site’s Self-solve Knowledge Search  (http://
support.openview.hp.com/selfsolve/documents) (ID: 39475).

 5  Make sure that the maximum number of connections to the database server 
has not been exceeded. Run Perfmon.exe or the database server’s 
management tool to verify the number of connections. You should contact 
your database administrator if you need further assistance.

User Site Does Not Exist After Initial Configuration

Error message: ‘Page Not Found’ (displayed in browser).

Problem description: After the initial configuration of Performance Center 
(using http://<servername>/admin/initialfs.htm), the Performance Center User 
Site is created through the Server Configuration page in the Administration 
Site (System Configuration > Server Configuration). In this case, after the 
User Site (http://<servername>/LoadTest) has been created, it does not exist 
on the Performance Center server.

http://support.openview.hp.com/selfsolve/documents/
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Troubleshooting

If the Performance Center Web server was corrupted or reinstalled, launch 
Internet Service Manager and check if the LoadTest virtual directory is 
defined.

 1 If LoadTest is defined, but points to the wrong directory, delete the LoadTest 
virtual directory and continue with the following step.

If LoadTest is not defined, log in to the Performance Center Administration 
Site and check if an entry exists for User Site Servers on the Server 
Configuration page (under System Configuration > Server Configuration). If 
the name of the server is not displayed under User Site Servers, add it and 
save your changes. Try to log in to the User Site (http://<servername>/
loadtest).

 2 From the User Site machine, connect to the database or user schema using 
Microsoft SQL, Oracle Enterprise Manager, or any SQL client and check the 
Web Server entry in the GlobalData table of the MI_LRDB tablespace/
database. If the Web Server entry contains the name of the server on which 
you want to install the Performance Center User Site, remove the server 
name.

 3 Log in to the Performance Center Administration Site and define User Site 
Servers on the Server Configuration page (under System 
Configuration > Server Configuration).

Unable to Log In to the Administration/User Site

Problem description: You are unable to log in to the Administration Site or 
the User Site. The system appears to “spin.”

Troubleshooting

 1 (IIS 5 only) Make sure that both the Administration Site and the User Site are 
set to Application Protection level High (isolated) in the Internet Services 
Manager. For more information, see “Option 1 (IIS 5 only): Set the 
Application Protection level to High (isolated)” on page 762.
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 2 Make sure that the permissions level for the IWAM_<SERVER> user is set 
correctly. For more information, see “Option 2: Set the Correct Permissions 
Level for the IWAM_<SERVER> user” on page 763.

 3 Make sure that the IWAM password for the IIS account is synced. If this is 
the first time you are logging in after installing Performance Center, the 
installation might have been corrupted due to IIS configuration problems. 
This can happen when installing a Windows service pack and/or updates 
before IIS is installed. In this case IIS is not updated (this is a Microsoft 
limitation). For more information, see the section about “Error: Method ~ of 
object ~ Failed During Installation” in the HP Performance Center 
Troubleshooting Guide.

Administration Site Page Cannot Be Displayed

Problem description: You receive an error message indicating that the 
Administration Site page cannot be displayed, or the Administration Site is 
not displayed correctly.

Troubleshooting

➤ If the Administration Site is not displaying correctly, recreate the 
Administration Site by running <Performance Center installation 
directory>\bin\AdminInstaller.exe1

➤ If you receive an error that the page cannot be displayed:

 a Close the current browser. Relaunch the browser and try to open the 
Administration Site again.

 b Select Tools > Internet Options from the menu. In the General tab, click 
Settings. In the Check for newer versions of stored pages section, make 
sure that the Every visit to the page option is selected.

 c Clear the browser cache and cookies.

 d If the problem is still not resolved, try to open the Administration Site 
from a different machine.

 e Reset IIS by choosing Start > Programs > Administrative Tools > Services, 
locating IIS Admin Service, and clicking Restart Service.
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Cannot Connect to Administration or User Site

Problem description: When trying to connect to the Administration or User 
Site Web servers, you receive a Service unavailable or You are not authorized 
to view this page error message.

Troubleshooting

 1 Verify that the Administration Site virtual directory user exists.

 2 Verify that the user has all the required policies.

 3 Verify that the application pool is not locked. If it is, consult the event 
viewer for an explanation.

 4 Verify that the security policy configuration of the customer domain is 
compatible with the the configuration of your Performance Center 
environment. 
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50
Troubleshooting Terminal Sessions

This chapter provides information on troubleshooting problems related to 
terminal sessions.

This chapter includes:

 ➤  Unable to Create Terminal Sessions on the Load Generator on page 716

 ➤  Controller and Load Generator Cannot Communicate on page 718

 ➤  Running a GUI Script in HP Performance Center Causes  HP WinRunner or 
HP QuickTest Professional to Crash on page 718

 ➤  Unable to Set Terminal Services for a Machine Name Added  as an IP Address/
Domain Name on page 719
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Unable to Create Terminal Sessions on the Load Generator

Error message: Cannot create terminal sessions on the load generator. There 
might be a problem with logon credentials.

Troubleshooting

 1 Verify that the correct terminal server login settings are selected. For 
information about verifying the settings, see “Configuring Terminal Services 
Logon Settings” on page 235.

 2 If you encounter a network connection error stating that the user is not 
mapped to the drive on the terminal server machine (see graphic below), 
create a separate terminal services profile for each user that is used to log in 
to a terminal server session. For more information, see the Microsoft 
Terminal Services documentation (http://technet2.microsoft.com/
windowsserver/en/technologies/featured/termserv/default.mspx). 

 3 Verify that the correct Client Settings are selected:

 a Select Start > Programs > Administrative Tools > Terminal Services 
Configuration > RDP-TCP. Right-click RDP-TCP, and select Properties to 
open the RDP-TCP Properties dialog box.

 b In the RDP-TCP Properties dialog box, select the Client Settings tab.
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 c Make sure that Use connection settings from user settings is disabled.

 4 If the run fails to create terminal services, open the terminal services from a 
specific host and make sure there are no pop-up messages when you log in 
as the Performance Center user. By default, the Performance Center user is a 
local user, MI_LRDB, unless the system user was changed from the General 
Settings page of the Administration site (System Configuration > General 
Settings > Change User).
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Controller and Load Generator Cannot Communicate

Problem description: There is no connection between the Controller and 
the load generator on the terminal server.

Troubleshooting

 1 Verify that the terminal server is installed correctly.

 2 Verify that there are active sessions on the Terminal Services Manager 
(Start > Programs > Administrative Tools > Terminal Services Manager).

 3 If you are using an existing terminal session, verify that the Performance 
Center agent icon appears in the terminal server’s system tray. This indicates 
that the agent is running.

 4 Make sure that the Performance Center user has Create Global Object 
privileges when running a terminal server session on a Windows Server 
2003, Windows XP SP2, or Windows 2000 Server SP4 machine. Add the 
Performance Center Administrators group (or the group to which the 
Performance Center user belongs) to the Create Global Object privilege, 
under Local Security Policies\Users Rights on the terminal server machine.

Running a GUI Script in HP Performance Center Causes 
HP WinRunner or HP QuickTest Professional to Crash

Problem description: The DCOM configuration of Wlrun.Engine causes HP 
WinRunner or HP QuickTest Professional to crash while running a GUI 
script in Performance Center.

Troubleshooting

Workaround: Configure the Controller to work as an interactive user.

 1 Make sure that the wlrun process is not running on the machine.

 2 Select Run from the Windows Start menu and type dcomcnfg.

 3 Press ENTER to display the list of DCOM applications.
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 4 In the displayed application list, right-click wlrun.LrEngine and select 
Properties. 

 5 In the Identity tab of the dialog box, select The interactive user.

 6 Click OK twice to close both dialog boxes.

 7 Log in to the machine in the Performance Center environment as the 
system user. This user, which is installed with Performance Center, is 
displayed in the General Settings page of the Administration Site.

Unable to Set Terminal Services for a Machine Name Added 
as an IP Address/Domain Name

Problem description: When your environment is configured with a local 
user (in the General Settings page of the Administration Site), you cannot 
set terminal services for a machine name that was added as an IP address or 
a domain name (for example, 127.0.0.1, localhost.hp.com).

Troubleshooting

Workaround: Delete the host from the Hosts page of the Administration 
Site, and add the host machine again using the host name only.
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51
Troubleshooting Hosts and Servers

This chapter provides information on troubleshooting host-related 
problems.

This chapter includes:

 ➤  Host in Resource Failure on page 722

 ➤  Unable to Add a Load Generator Due to High Latency on page 728

 ➤  Problems Changing SiteScope Server in Administration Site on page 729

 ➤  SiteScope Server Fails to Monitor the MS-SQL Database on page 730

 ➤  Failure to Add Host on page 731

 ➤  Failure to Reboot Host from Administration Site on page 733

 ➤  Not Enough Server Storage Available on page 734
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Host in Resource Failure

Problem description: The host is in Resource Failure status.

Troubleshooting

Option 1: Check the host connections

Check the connections between your project’s hosts and the machines 
within your system using the Check Hosts operation in the Hosts page of 
the Administration Site (Resources > Hosts > Check Hosts) or User Site 
(Project > Hosts > Check Hosts).

➤ If Ping to Host fails:

➤ Make sure the host is up and running, and is connected to the network. 
Check the routing table (netstat –r) and make sure that requests to this 
host are properly routed.

➤ Make sure that the host’s IP address can be properly resolved.

➤ Verify that the ping to the target host from the Performance Center Web 
server, utility server, and database is below 20 ms.
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➤ If your firewalls or hosts ignore ICMP requests (pings), use HTTP requests 
to validate response times from the host to the Web server (a simple 
LoadRunner web_url(…) request to http://<server>/loadtest/). 
Alternatively, open a browser and type http://<server>/loadtest in the 
address field.

➤ If the file server fails:

➤ Make sure that the host can ping the file server.

➤ Make sure that the Performance Center system user has access to LRFS 
share on the file server. You can verify this in any of the following ways:

➤ In the command line, execute the following: 

➤ Log in to the host machine as the Performance Center system user, and 
in the command line, execute the following: 

If the above operation fails, check the error message and resolve the 
problem. Contact your Windows administrator for assistance.

➤ Make sure that the security settings on LRFS share allow the HP 
Performance Center system user full control.

➤ Make sure that the Performance Center system user can create, update, 
and delete files from LRFS share.

➤ Make sure that the Performance Center Web server can launch 
applications on the host. For more information, see “Troubleshooting 
Web Service Connectivity” on page 749.

net use \\fileserver\LRFS / user: 
<Performance_Center_user><Performance_Center_user_password>

% net use \\fileserver\LRFS
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➤ If the database fails:

➤ Check the <HP Performance Center>/bin/globals.ini file and make sure 
that the connection string is correct for the database you are using.

➤ See the troubleshooting for “Login to Oracle Database Server Hangs” on 
page 762.

➤ Verify ADODB connectivity to the database as described in “Login to 
Database Server Fails” on page 764.

Option 2: Check the Performance Center version

Make sure that the version of Performance Center service pack level and 
feature pack level on all your host and server machines are the same as those 
on the Performance Center Web and Utility servers. That is, all Performance 
Center hosts and servers MUST be at the same service pack and feature pack 
level.

Check the registry entry under 
[HKEY_LOCAL_MACHINE\SOFTWARE\Mercury 
Interactive\LoadRunner\CurrentVersion] for the following variables:

➤ Major

➤ Minor

➤ ServicePack

Note: Any patches applied to one machine must be applied to all machines 
if and when applicable.
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Option 3: Launch wlrun.exe manually from the Controller host machine

If the host check succeeds, but the host is still not operational, launch the 
Controller manually from the Controller host machine as follows:

 1 Log in to the host machine.

 2 Configure the wlrun.LrEngine application to run as an interactive user: 

➤ Launch dcomcnfg.exe.

➤ In the Application tab, select wlrun.LrEngine from the list of DCOM 
applications.

➤ Click Properties to view the properties for wlrun.LrEngine.

➤ In the Identity tab, set the user account to The interactive user.

➤ Click OK and close the DCOMCNFG window.

Note: When you are finished with this step, set wlrun.LrEngine back to 
its original identity. By default, this is This User with the Performance 
Center user name and password. If you used a different identity, restore 
it.

 3 Launch the Controller (wlrun.exe) from the <HP Performance Center>/bin 
directory (on the Controller host).

 4 If an error message is displayed during the startup of the Controller, resolve 
the error message before continuing. For Performance Center to utilize the 
Controller properly, no error messages should be displayed during startup.
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 5 Create a new, simple load test and reference the scripts from the LRFS share 
(on the Performance Center file server). Run the load test with one or two 
users to verify that the Controller works.

Note: Scripts uploaded to the Performance Center LRFS reside in the 
\\fileserver\LRFS\<ProjectID>\Scripts directory. To obtain the <ProjectID>, 
select User Management > Projects.

The following is an example path to the USR file for a script named MyTest: 
\\myserver\LRFS\2\Scripts\MyTest\MyTest.usr

 6 Close the Controller (wlrun.exe).

 7 From the Performance Center User Site, launch a simple load test.

➤ Check whether the following processes are displayed in the Task Manager 
on the Controller host:

➤ OrchidActiveSession.exe OR ORCHID~1.exe

➤ WLRUN.EXE

➤ Check whether the Controller is displaying a dialog box that requires 
user input before the Controller can proceed with the load test. Address 
the reasons for the dialog box being displayed, and make sure that no 
dialog boxes are displayed when re-running the load test from 
Performance Center.

Examples of dialog boxes that may be displayed include License Has 
Expired, Monitor Not Licensed, and Host is Over-Utilized.

If you are unsure how to resolve the problem indicated in the dialog box, 
contact the Customer Support Web site (http://www.hp.com/go/
hpsoftwaresupport) for assistance. 

http://www.hp.com/go/hpsoftwaresupport
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Note: When you are finished with this step, set wlrun.LrEngine back to 
its original identity. By default, this is This User with the Performance 
Center user name and password. If you used a different identity, restore 
it. 

Option 4: Reinstall Performance Center host on the host machine

If all of the above steps fail to resolve the problem, reinstall the Performance 
Center host on the host machine.

 1 Uninstall Performance Center (Start > Settings > Control Panel > Add/
Remove Programs). (This is really the Performance Center host.)

 2 Delete HKEY_LOCAL_MACHINE\SOFTWARE\Mercury Interactive from the 
registry.

 3 Clean the Performance Center machine, as described in the section about 
cleaning Performance Center machines in the HP Performance Center System 
Configuration and Installation Guide.

 4 Re-install the Performance Center host. For more information, see the HP 
Performance Center System Configuration and Installation Guide. Make sure that 
you install the same version of Performance Center as is installed on your 
Web server.

Note: Do not install an Performance Center server (such as a Utility Server, 
Web Server, or File Server) on the same machine as the Performance Center 
host (such as a data processor, Controller, or load generator).
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Unable to Add a Load Generator Due to High Latency 

Problem description: You are unable to add a load generator host due to 
high network latency or the network policy.

You may have a problem adding a host to the Performance Center 
Administration Site as a load generator if the host has a ping time greater 
than 50 ms. This applies only to hosts added as load generators.

Troubleshooting

 1 Create a temporary host location over a firewall.

 a On the Host Locations page, click Add Host Location.

 b In the Host Location field, type TempOverFirewall.

 c Set Located over Firewall to Yes. (By using the Located over Firewall 
option, many checks that are performed on host machines will not be 
performed.)

 d Click OK.

 2 Add a new host to the temporary location.

 a On the Hosts page, click Add Host.

 b In the Name field, type add.

 c In the Purpose field, select Load Generator.

 d From the Location list, select TempOverFirewall.

 e From the Host Pool list, select the correct host pool.

 f Click Save, and then click OK to confirm.

 g Select the host that was added from the host list.

 h Change the location to the correct location. (Placing the host in the over 
firewall location was done just to bypass some checking that 
Performance Center does when adding host machines.)

 i Click OK. In the next two message boxes that are displayed, click OK.

 3 Repeat Step 2 for all load generators that have high network latency.
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Problems Changing SiteScope Server in Administration Site

Problem description: You are unable to change the SiteScope server details 
on the Server Configuration page in the Administration Site (System 
Configuration > Server Configuration). When you type a new SiteScope 
server in the SiteScope Server box and click Save, you receive one of the 
following error messages:

➤ Service unavailable

➤ An unspecified error occurred while processing your request. Try to 
refresh your browser or to open another browser instance. 

Troubleshooting

 1 On the Server Configuration page (System Configuration > Server 
Configuration), clear the contents of the SiteScope Server box and click 
Save.

 2 In the SiteScope Server box, type the name of the new SiteScope server and 
click Save.

Note: As a result of this action, Performance Center host or server groups 
may have been created on the new SiteScope server. We recommend that 
you remove these groups from the SiteScope server.

 3 Re-enable SiteScope monitoring on the relevant Performance Center hosts 
and servers.

➤ To enable SiteScope monitoring for a host, open the Hosts page 
(Resources > Hosts), and click the relevant host. In the Properties tab, 
click Edit and select Enable SiteScope Monitoring.

➤ To enable SiteScope monitoring for a server, open the Servers page 
(Resources > Servers), and click the relevant server. In the Properties tab, 
click Edit and select Enable SiteScope Monitoring.

 4 Reconfigure the SiteScope alert settings on the Alerts Configuration page 
(System Configuration > Alerts Configuration).
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SiteScope Server Fails to Monitor the MS-SQL Database

When using a SiteScope server to monitor a Performance Center farm 
working with Microsoft SQL Server 2005, SiteScope fails to monitor the 
database service.

Troubleshooting

This problem is caused due to a discrepancy in the service names between 
the Microsoft SQL Server 2000 and Microsoft SQL Server 2005. By default, 
Performance Center is configured with the service name of Microsoft SQL 
Server 2000.  

 1 If SiteScope was already added to monitor the Performance Center farm, and 
was enabled to monitor the database server (from the Administrator Site > 
Servers page), disable SiteScope from monitoring the database server.

 2 Change the SQL Server’s service name in Performance Center by running 
the following SQL statement on the Performance Center database:

 3 Re-enable SiteScope to monitor the database server.

UPDATE SiSMonitors SET Instance='SQL Server (MSSQLSERVER)' WHERE 
Instance='MSSQLSERVER'
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Failure to Add Host

Problem description: Add host fails. 

This may occur as a result of any of the following problems:

➤ Cannot Add Host as a Performance Center Host

➤ Performance Center Incorrectly Asks for Administrator Account

➤ System User Passwords Do Not Match

➤ .NET Framework

➤ Oracle Database Connection

Cannot Add Host as a Performance Center Host
Problem description: When trying to add a host, you receive an error stating 
that HP Performance Center cannot identify the host as an Performance 
Center host.

Troubleshooting

Verify that the ManagmentUtil.exe COM object is defined as the 
Performance Center system user.

Performance Center Incorrectly Asks for Administrator 
Account 
Problem description: Failure to add hosts is often mistakenly accompanied 
by a request for administrator account credentials.

Troubleshooting

 1 Make sure the Default Web Site directory in IIS is defined with port 80 and 
IP address is set to (All Unassigned).

 2 Make sure that IIS is configured properly.

➤ IIS 5.0.x: In the Default Web Site > PCWS folder’s Properties,  make sure 
that Application Protection is set to High.
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➤ IIS 6.0.x: 

➤ Make sure that Application Pools > PCWSAppPool exists. If not, create 
it with default options.

➤ In the Default Web Site > PCWS folder’s Properties, make sure that the 
application pool selected is PCWSAppPool.

➤ In the Web Service Extensions, make sure that the following are 
allowed:

Active Server Pages;  ASP.NET v2.0.50727; Server Side Includes

If any of them are not allowed, allow them and reset IIS.

 3 Make sure the ServerManagerWS Web Service is available (see “Testing Web 
Service Connectivity” on page 750).

System User Passwords Do Not Match
The Performance Center system user credentials on the new host machine 
must be the same as those of the Performance Center system user on the rest 
of the Performance Center system. 

If the system user exists on the host with a different password, Performance 
Center will not add the host to the system. Before attempting to add a host, 
Make sure that the credentials match.

.NET Framework
There may be a problem with the .NET Framework installation. 

Repair the .NET Framework installation as follows:

 1 Select Start > Run. 

 2 Type the following command:

c:\WINDOWS\Microsoft.NET\Framework\v2.0.50727\aspnet_regiis.exe -i



Chapter 51 • Troubleshooting Hosts and Servers

733

Oracle Database Connection
If you are working with Oracle, this problem might be related to the Oracle 
database connection.

Verify that the following connection works from the host server machine:

If the command fails, check the TNS entry on the host machine (in the 
<Oracle_client installation directory>\network\admin\tnsnames.ora file). 
This should be the same as the TNS entry on the database server (in the 
<Oracle_server installation directory>\network\admin\tnsnames.ora file).

If the TNS entry is different to that of the database server, you need to copy 
the TNS entry from the database server to the host.

Failure to Reboot Host from Administration Site

Problem description: When a host is rebooted from the Hosts page of the 
Administration Site, the host has been rebooted, but the host state is not 
updated accordingly.

Troubleshooting

Reset IIS as follows:

 1 Select Start > Run.

 2 Type iisreset.

 3 Press Enter.

% sqlplus <username>/<password>@<connect_string>
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Not Enough Server Storage Available

Problem description: The following error message appears in the Analysis 
results and Performance Center logs (<Performance Center 
installation>\orchidtmp\LTLogger\ANALYS~1\log.txt) on the host 
machine:

"Not enough server storage is available to process this command."

Troubleshooting

This error occurs when the value of the IRPStackSize entry in the machine’s 
registry is too low.

Important: The following procedure contains steps that instruct you how to 
modify the registry. Serious problems might occur if you modify the registry 
incorrectly. Therefore, make sure that you follow each step carefully. For 
added protection, back up the registry before you modify it. Then, you can 
restore the registry if a problem occurs. For more information about how to 
back up and restore the registry, see the following article in the Microsoft 
Knowledge Base: 322756 (http://support.microsoft.com/kb/322756/)  How 
to back up and restore the registry in Windows.

To increase the value of the IRPStackSize registry entry:

 1 Select Start > Run, type regedit, and click OK.

 2 Locate the following registry subkey:

HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\LanmanServer\Para
meters

http://support.microsoft.com/kb/322756/
http://support.microsoft.com/kb/322756/
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 3 If the IRPStackSize entry is not present in this subkey:

 a From the Edit menu, select New > DWORD Value.

 b Type IRPStackSize, and press ENTER. 

Note: Type IRPStackSize exactly as it appears. The value name is case 
sensitive.

 4 Select IRPStackSize and, from the Edit menu, select Modify.

 5 In the Data Value box, type a higher value, and click OK.

Values may range from 0x1 to 0xC. These values are equivalent to 1 to 12 in 
decimal notation.

If the problem persists after you have completed this procedure,  gradually 
increase the value of IRPStackSize until you find the minimum value that 
resolves the problem. Using a value that is higher than necessary might 
waste system resources. 

Other factors can also lead to this error message. If problems persist after 
you have used all the valid values for IRPStackSize, restore IRPStackSize to its 
original value, and seek another explanation for the error
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52
Troubleshooting Monitors

This chapter provides information on troubleshooting problems related to 
Performance Center monitors.

This chapter includes:

 ➤  Cannot Create a Monitor on page 737

 ➤  Cannot Save Measurements on page 739

 ➤  Port Required for J2EE Monitor Is Already Taken on page 740

 ➤  J2EE Monitor Initialization Errors on page 741

 ➤  Cannot Save SiteScope Monitors with Many Counters on page 741

Cannot Create a Monitor

Problem description: You are unable to create a specific monitor.

Troubleshooting

 1 Make sure that the user trying to access the machine to monitor exists on 
this machine and has proper privileges. Usually IUSR_METRO will be the 
user attempting to monitor.

For example, if you add the Windows Resources monitor, the user 
IUSR_METRO must exist on the machine to be monitored and must have 
proper access rights.
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 2 Some monitors require certain clients to reside on the Utility Server and the 
Controller.

➤ For BroadVision, JDK must be installed.

➤ For WebLogic, JDK and the weblogic.jar file must be present.

➤ For Oracle, the Oracle Client must be installed.

➤ For DB2, the DB2 administrative client must be installed. (OS390 is not 
supported.)

 3 Make sure the agent required for a particular monitor is running on the 
machine that you want to monitor.

 4 For COM+, make sure that the COM+ probe is running on the machine that 
you want to monitor.

 5 Some monitors require access to a particular URL, from both the 
Performance Center utility server and the Controller, for monitoring 
purposes.

➤ For Apache, this URL is: http://<server>:<port>/server-status:auto

➤ For Websphere 4.x & 5.x, this URL is: http://<server>:<port>/wasPerftool/
ervlet/perfservlet
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Cannot Save Measurements

Problem description: During configuration of a monitor, after you select the 
measurements that you want to monitor and you click Save, instead of 
saving the monitor, Performance Center goes back to the Choose Monitor 
page. 

Troubleshooting

This problem usually occurs when you select a large number of 
measurements. To resolve this issue, you need to increase the value of the 
AspMaxRequestEntityAllowed property in the IIS metabase. This property 
specifies the maximum number of bytes allowed in the entity body of an 
ASP request.

Note: For more information about the AspMaxRequestEntityAllowed 
property, see the Microsoft Terminal Services documentation: http://
www.microsoft.com/technet/prodtechnol/WindowsServer2003/Library/IIS/
a6401b5e-c902-4035-90aa-ee46c270d357.mspx?mfr=true, or http://
support.microsoft.com/kb/327659

To increase the value of the AspMaxRequestEntityAllowed property:

 1 Run the following command from the command line:

where <IIS_installation_drive> is the hard disk where IIS is installed.

 2 To view the current value of the AspMaxRequestEntityAllowed property, run 
the following command:

cd <IIS_installation_drive>:\inetpub\adminscripts.

cscript adsutil.vbs get w3svc/ASPMaxRequestEntityAllowed.

http://www.microsoft.com/technet/prodtechnol/WindowsServer2003/Library/IIS/a6401b5e-c902-4035-90aa-ee46c270d357.mspx?mfr=true
http://www.microsoft.com/technet/prodtechnol/WindowsServer2003/Library/IIS/a6401b5e-c902-4035-90aa-ee46c270d357.mspx?mfr=true
http://www.microsoft.com/technet/prodtechnol/WindowsServer2003/Library/IIS/a6401b5e-c902-4035-90aa-ee46c270d357.mspx?mfr=true
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 3 To increase the value of the AspMaxRequestEntityAllowed property, run the 
following command:

where <maximum value> is the maximum value, in bytes, that you want to 
set for the AspMaxRequestEntityAllowed property.

 4 Run the following command:

 5 To verify that the value of the AspMaxRequestEntityAllowed property has 
changed, run the following command again:

Note: If you are still not able to save the measurements in the monitor 
profile, increase the value of the AspMaxRequestEntityAllowed property 
further. 

For more information about this issue, see the Microsoft support Web site: 
http://support.microsoft.com/kb/327659

Port Required for J2EE Monitor Is Already Taken

Problem description: The J2EE monitor communicates with Performance 
Center, by default, using port 2004 and this port is already taken.

Troubleshooting

Select another port as follows:

 1 On the application server machine, open the <J2EE Monitor installation 
directory>\dat\monitor.properties file and change the port number 
specified for the webserver.monitor.port property.

cscript adsutil.vbs set w3svc/ASPMaxRequestEntityAllowed <maximum value>.

iisreset.

cscript adsutil.vbs get w3svc/ASPMaxRequestEntityAllowed.

http://support.microsoft.com/kb/327659
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 2 On the Performance Center host machine, open the <Performance Center 
installation directory>\dat\monitors\xmlmonitorshared.ini file and change 
the port number specified in mon_j2ee section under the DefaultPort key.

J2EE Monitor Initialization Errors

Problem description: You are receiving application server initialization 
errors, such as UnsupportedClassVersionError, NoSuchMethodError, or 
NoClassDefFoundError. 

Troubleshooting

There might be a conflict between the JDK version specified using the J2EE 
Monitor Initializer, and the actual JDK version used in the application server 
launch.

Make sure that you selected the correct JDK that is currently being used by 
the application server. Note that if you switched the application server to 
work with a different JDK, you must run the J2EE Monitor Initializer again.

Cannot Save SiteScope Monitors with Many Counters

Problem description: You get an error when trying to save a SiteScope 
monitor profile where the monitor has many counters. 

Troubleshooting

This error occurs when there are more than 160 counters on the SiteScope 
monitor. The error occurs because the value of the IIS parameter, 
ASPMaxRequestEntityAllowed, which defines the maximum size of the Asp 
page body section, is not high enough. To solve this error, increase the value 
of the parameter.

To increase the value of the IIS parameter:

 1 Log in to the User Site server machine.

 2 On the Command line, change the directory to the IIS installation directory, 
C:\Inetpub>\AdminScripts.
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 3 Run the following commands from the user server and from the utility

 a Check the current parameter value.

 b Set a higher value for the parameter:

 c Check that the parameter value was updated.

cscript adsutil.vbs get w3svc/ASPMaxRequestEntityAllowed

cscript adsutil.vbs set w3svc/ASPMaxRequestEntityAllowed 8000000

cscript adsutil.vbs get w3svc/ASPMaxRequestEntityAllowed
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53
Troubleshooting Web Problems

This chapter provides information on troubleshooting Web-related 
problems.

This chapter includes:

 ➤  HTTP 500.x – Internal Server Error on page 743

 ➤  Cannot Find Server or DNS Error on page 746

 ➤  Maintenance Service Causes IIS Resets on page 747

 ➤  HTTP/1.1 100 Continue Randomly Appears on page 747

 ➤  Internet Explorer Closes When Selecting Script For Vuser Group on page 748

HTTP 500.x – Internal Server Error

Error message: The page cannot be displayed (HTTP 500.x Internal Server 
Error).
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Troubleshooting

 1 Reset IIS by choosing Start > Programs > Administrative Tools > Services, 
locating IIS Admin Service, and clicking Restart Service.

 2 (IIS 5 only) If you cannot restart IIS, reboot the machine.

Make sure that both the Administrator Site and the User Site are set to 
Application Protection level High (isolated) in the Internet Services 
Manager. To set the protection level, see “Option 1 (IIS 5 only): Set the 
Application Protection level to High (isolated)” on page 762.

 3 Make sure that the anti-virus software is not checking the Performance 
Center installation directory and sub-directories and thereby causing the 
error. In addition, make sure that the anti-virus program is not checking the 
file server directory (generally LRFS).

 4 If you are still receiving an error, perform the following steps to see a more 
detailed error:

On the client machine:

 a Open Internet Explorer. 

 b Select Tools > Internet Options. 

 c Click the Advanced tab. 

 d Under the Browsing section, deselect Show Friendly HTTP Error 
Messages.

On the server machine:

 a Select Start > Programs > Administrative Tools > Internet Information 
Services Manager to open the IIS manager.

 b Expand Web Sites.

 c Select Default Web Site.

 d Select the virtual directory relevant to the server’s purpose: Admin for 
Administration Site Server, Loadtest for User Site Server.

 e Right click the selected directory and click Properties. The <directory> 
Properties dialog box opens.

 f Click Configuration. The Application Configuration dialog box opens.
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 g Click the Debugging tab.

 h Select Send detailed ASP error messages to client.

 i Click OK to close the Application Configuration dialog box.

 j Click OK to close the <directory> Properties dialog box.

 k Restart IIS by right clicking the server’s name in the tree. Select All tasks > 
Restart IIS.

At this point you should have a different, more detailed error message. 
Try to address the problem indicated in the message, or contact HP 
Customer Support with this message and all information related to the 
problem.
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Cannot Find Server or DNS Error

Error message: The page cannot be displayed (Cannot find server or DNS 
Error).

Troubleshooting

 1 Make sure that you entered the correct URL address.

 2 Verify that you have access to the Web server.

➤ Use the ping command if you do not have a firewall blocking ICMP 
requests to your Web servers.

➤ From a command prompt, execute: ping <Web server>

➤ From a command prompt, execute: ping <IP Address of Web server>
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 3 On the Web server, verify that IIS is up and running:

 a Select Start > Programs > Administrative Tools > Services.

 b Make sure that IIS Admin Service is Started and that Startup type is set to 
Automatic.

 c Make sure that World Wide Web Publishing Service is Started and that 
Startup type is set to Automatic.

 4 Reset IIS by choosing Start > Programs > Administrative Tools > Services, 
locating IIS Admin Service, and clicking Restart Service.

Maintenance Service Causes IIS Resets

Problem description: IIS is reset every 10 minutes by the maintenance 
service. The maintenance service log shows that the HTTP call to 
MemorySize.asp had a timeout (60 sec.) and after three retries, the service 
reset IIS (as it was designed to do).

Troubleshooting

Make sure that the Utility Server is not configured to work through a proxy 
that might block the HTTP call. To disable the proxy setting, search the 
registry for the key ProxyEnable in the Internet Setting folders and set this 
key to zero.

HTTP/1.1 100 Continue Randomly Appears

Problem description: The message HTTP/1.1 100 Continue randomly 
appears in the middle of a response stream.

Troubleshooting

If you installed the User Site server or Administration Site server on a 
Windows Server 2003 SP1 machine, download the Microsoft patch from the 
the Microsoft Support site (http://support.microsoft.com/kb/898708). This 
patch addresses a known Microsoft issue, when running IIS 6.0 on a 
Windows Server 2003 machine.

http://support.microsoft.com/kb/898708
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Internet Explorer Closes When Selecting Script For Vuser 
Group

Problem description: When trying to select a script for a new Vuser group, 
Internet Explorer closes.

Troubleshooting

When you are designing Vuser groups, there must always be at least one 
available script in the Scripts list. If you try to select a script and the list is 
empty, it triggers a known defect in IE7 [version 0.5730.13CO], causing the 
browser to close.

Make sure that at least one Vuser script has been uploaded to the current 
project. For more information on uploading Vuser scripts to Performance 
Center, see Chapter 7, “Managing Vuser Scripts.”
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Troubleshooting Web Services

This chapter provides information on troubleshooting Web service-related 
issues.

This chapter includes:

 ➤  Troubleshooting Web Service Connectivity on page 749

 ➤  Testing Web Service Connectivity on page 750

Troubleshooting Web Service Connectivity

This section provides troubleshooting for Web service connectivity issues. 

Important: The following troubleshooting tips apply to the Web service 
requester agent machine.

After each troubleshooting attempt described below, you can test your Web 
service connectivity using the test described in “Testing Web Service 
Connectivity” on page 750.

To troubleshoot Web service connectivity:

 1 Verify that the PCWS virtual directory exists in IIS.

 2 If you are using IIS 6, verify that the ASP.NET V2.0 extension was installed 
and allowed in IIS.

 3 If you are using IIS 6, verify that the PCWSAppPool application pool is not 
locked. If it is locked, you can consult the event viewer for an explanation. 
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 4 If you are using IIS 5, grant full access permission for 
IWAM_<Machine_name> in the <Windows directory>\temp directory.

 5 Verify that the Performance Center system user exists on the machine.

 6 Verify that the following policies are defined for the Performance Center 
system user:

➤ Batch logon rights

➤ Service logon rights

➤ Access this computer from the network

Testing Web Service Connectivity

After you troubleshoot Web service connectivity, you can test your Web 
service connectivity by trying to access the Performance Center ConfigWS 
Web services on the requester agent machine.

To test Web service connectivity:

 1 On the requester agent machine, type the following URL: 

 2 In the Enter Network Password box, type your Performance Center system 
user login details.

http://<provider agent machine>/PCWS/ConfigWS.asmx
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The ConfigWS Web service page opens. 

Note: If this page does not open, there is still a problem with the Web 
service connectivity and you should continue to troubleshoot this issue.

 3 Click the IsAvailable operation.
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 4 On the IsAvailable operation page, click Invoke.

If this action returns a value of True, the Web service connectivity is 
operational.
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55
Troubleshooting System Identity

This chapter provides information on troubleshooting system 
identity-related issues.

This chapter includes:

 ➤  Administrator Account Requested on page 754

 ➤  Error in Adding Permissions to Folder/Registry on page 754

 ➤  Identity References Cannot Be Translated on page 755

 ➤  Server/Host Configuration Problems on page 755

 ➤  Admin Tasks Take a Long Time/Time-Out/ ThreadAbortException 
on page 756

 ➤  Conflicting Credentials when Changing Users on page 757

 ➤  Oracle Database – Cannot Change System User to  Non-Admin User 
on page 757

 ➤  Remote Management Agent Service Disabled After  Changing System User 
on page 758

 ➤  Load Generator Standalone Limitations on page 759
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Administrator Account Requested

Problem description: An administrator account is requested even if the 
Performance Center system user is an administrator.

Troubleshooting

 1 Verify that you can access the Web service using the browser. 

 2 Verify that the system user exists on the machine.

 3 Check whether the ASP.NET V2.0 extension was installed and allowed in IIS. 

 4 Verify that you have the PCWS virtual directory.

Error in Adding Permissions to Folder/Registry

Problem description: You receive an error when adding permissions to one 
of the file/folders or registry keys. 

Troubleshooting

 1 Try to reconfigure the use case again (by clicking the Reconfigure button in 
the System Identity utility).

 2 Reboot the machine and click the Reconfigure button in the System Identity 
utility. 

 3 Clean out all the unrecognized users from the folder/registry. 
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Identity References Cannot Be Translated

Error message: Some or all identity references could not be translated.

Problem description: You receive the above error in trying to configure the 
system. 

Troubleshooting

 1 Verify that the configuration user is not the same user with which you are 
logged in to the system. If you are logged in to the system with the 
configuration user, log off and then log in again with a different user. 

 2 Reset IIS on the machine on which you received the error.

Server/Host Configuration Problems

Error message: System.Web.Services.Protocols.SoapException: Server was 
unable to process request. Unable to generate a temporary class.

Problem description: This error can occur when trying to configure a server 
or host using the System Identity utililty. 

Troubleshooting

Grant full access permission for the IWAM_<Machine_name> user in the 
<Windows directory>\temp directory.
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Admin Tasks Take a Long Time/Time-Out/
ThreadAbortException

Problem description: In the following cases, a time-out event or 
ThreadAbort exception occurs or the action takes a long time:

➤ The system user is a non-administrative user (lockdown) and you try to 
add a host.

➤ The system user is an administrative user and you try to a change it to a  
non-administrative (lockdown) user. 

Troubleshooting

Click Reconfigure to configure the system user again. 

If the problem persists:
In “lock-down mode,” permissions are granted to specific directories, files, 
and registry keys that Performance Center requires in order to run. Check 
the Security tab of these resources for deleted users/groups (SIDs). These 
deleted SIDs increase the time it takes to perform tasks such as granting 
permissions to a resource. To reduce the performance time for these tasks, 
clean out all the deleted SIDs. 

If the problem still persists, you need to configure the system user manually. 
For details, see the section about configuring the Performance Center system 
user manually in the HP Performance Center Administrator Guide.
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Conflicting Credentials when Changing Users

Error message: The credentials supplied conflict with an existing set of 
credentials.

Problem description: This error can occur when using the System Identity 
utility to change the system user. 

Troubleshooting

Verify that the configuration user is not the same user with which you are 
logged in to the system. If you are logged on to the system with the 
configuration user, log off and then log on again with a different user. 

Note: This problem may be caused due to a Microsoft limitation. For more 
information, see the Microsoft TechNet Web site (http://www.microsoft.com/
technet/prodtechnol/windows2000serv/reskit/w2000Msgs/3860.mspx?mfr=true).

Oracle Database – Cannot Change System User to 
Non-Admin User

Problem description: When working with an Oracle database, you cannot 
change the system user to a non-administrative system user.

Troubleshooting

Before changing the system user to a non-administrative user, you need to 
disable the Oracle Client’s SQLNET Authentication Services option on each 
of the Performance Center servers and hosts. 

http://www.microsoft.com/technet/prodtechnol/windows2000serv/reskit/w2000Msgs/3860.mspx?mfr=true
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To disable the SQLNET Authentication Services option:

 1 Open the <Oracle installation directory>\network\admin\sqlnet.ora file 
and locate the following line:

 2 At the beginning of this line, insert a # symbol.

 3 Save the file.

Remote Management Agent Service Disabled After 
Changing System User

Problem description: After you change the system user to a 
non-administrative system user, the Remote Management Agent service is 
disabled.

Troubleshooting

You need to remove the service and restart it with the new Performance 
Center system user’s credentials. 

 1 Restart the machine.

 2 Run the Remote Management Agent service using the following command:

where username and password are those of the Performance Center system 
user.

SQLNET.AUTHENTICATION_SERVICES = (NTS)

%installation folder%\al_agent\bin\alagentservice.exe -remove 

%installation folder%\al_agent\bin\alagentservice.exe -install username password 
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Load Generator Standalone Limitations

This section specifies a number of scenarios of changing the system user, 
and the load generator standalone limitations associated with each scenario.

Scenario 1

➤ You changed the system user for all servers and hosts in the Performance 
Center environment.

➤ You did not add the changed user manually to Load Generator machine.

➤ The default Performance Center system user, IUSR_METRO, exists on the 
Load Generator machine. 

Scenario 2

➤ You changed the system user for all servers and hosts in the Performance 
Center environment.

➤ You added the changed user manually to the Load Generator machine.

➤ The default Performance Center system user, IUSR_METRO, exists on the 
Load Generator machine. 

Feature Availibilty

Sitescope monitoring Works with IUSR_METRO credentials

Default load test monitoring Does not work

Remote management 
(reboot and install patch)

Works with IUSR_METRO credentials (type 
username and password upon request)

Feature Availibilty

Sitescope monitoring Works with IUSR_METRO credentials

Default load test monitoring Works with changed user credentials

Remote management
(reboot and install patch)

Works with IUSR_METRO credentials (type 
username and password upon request)
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Scenario 3

➤ You changed the system user for all servers and hosts in the Performance 
Center environment.

➤ You added the changed user manually to the Load Generator machine.

➤ You removed the default Performance Center system user, IUSR_METRO, 
from the Load Generator machine. 

Feature Availibilty

Sitescope monitoring Does not work

Default load test monitoring Works with changed user credentials

Remote management

(reboot and install patch)

Does not work

Workaround: Remove service and reinstall 
service with changed user credentials. For 
details, see “Remote Management Agent 
Service Disabled After  Changing System User” 
on page 758.
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56
Troubleshooting Databases

This chapter provides information on troubleshooting problems that occur 
with database in the Performance Center system.

This chapter includes:

 ➤  Login to Oracle Database Server Hangs on page 762

 ➤  Login to Database Server Fails on page 764

 ➤  Database/User Schema Creation Fails on page 766

 ➤  Warning Message Received During MS-QL Database Migration on page 767

 ➤  Conflict Warnings Received During Database Migration on page 767
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Login to Oracle Database Server Hangs

Error message: Trying to log on to database server.

Troubleshooting

➤ Option 1 (IIS 5 only): Set the Application Protection level to High (isolated)

Make sure that the Application Protection level is set to High (isolated) in 
the Internet Services Manager in both the Administration Site and User Site. 

To set the application protection level: 

 1 Select Start > Programs > Administrative Tools > Internet Services Manager. 
The Internet Information Services dialog box opens.

 2 In the Tree directory, expand Default Web Site and right-click Admin. Click 
Properties to open the Admin Properties dialog box.

 3 Click the Virtual Directory tab.
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 4 In the Application Protection box, select High (Isolated).

 5 Repeat steps 2 through 4 for the User Site. In step 2, right-click LoadTest 
instead of Admin.

Option 2: Set the Correct Permissions Level for the IWAM_<SERVER> user

Problems with logging on might be caused by a permissions level problem 
with the IWAM_<SERVER> user. By default, this account is set to the Guest 
permissions level. However, the IWAM_<SERVER> user must have read/
execute privileges on the Oracle home directory and all of its sub-directories.

To set the correct permissions level: 

 1 In Windows Explorer, right-click the Oracle home directory and select 
Properties.

 2 Click the Security tab.

 3 Click Add and add the IWAM_<SERVER> user.

 4 Check Read & Execute.

 5 Click OK.
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Login to Database Server Fails

Error message: Operation terminated. Error description: Login to the 
database server failed. Check if user name and password are correct.

Troubleshooting

 1 Verify that the database server host name, type, user name, and password 
are correct. Consult your database administrator if you are unsure.

 2 Check whether you can connect to the database server from the 
Administration Site server using the command line SQL client:

➤ For MS SQL Server:

For example:

If your Microsoft SQL Server is configured with integrated security, make 
sure that the Microsoft SQL Server has an operating system account for 
IUSR_METRO (password: MIOrchid#1), and is allowed access to the 
database. IUSR_METRO is the default account under which the 
Performance Center Web server runs.

➤ For Oracle Server:

For example:

If the above command fails, check your TNS entry in the <Oracle 
installation directory>\network\admin\tnsnames.ora file.

% osql –U <username> -P <password> -S <serverID>

% osql –U sa –P manager –S DBSERVER\LRTCDB

% sqlplus <username>/<password>@<connect_string>

% sqlplus system/manager@LRTCORA
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An example of a TNS entry is shown below:

 3 Test the ADODB connectivity to the database:

 a Download the TcIN_AdoDBTester.exe utility from the HP Software 
Support site’s Self-solve Knowledge Search  (http://
support.openview.hp.com/selfsolve/documents) (ID: 39475).

 b Run the utility to test the ADODB connectivity to the database.

➤ Update the username, password, and server fields in the connection 
string:

For MS SQL Server, use the Provider=SQLOLEDB.1;… connection 
string.

For Oracle Server, use the Provider=MSAORA.1;… connection string.

➤ Set a valid SQL statement (based on current database tables).

➤ Execute the statement and check the response. If an error occurs, 
address the error message appropriately.

 4 If you are working with Oracle Server, check that Oracle Client is installed 
properly:

 a Check whether the ORACLE_HOME registry entry under 
[HKEY_LOCAL_MACHINE\Software\Oracle] is correct. It should be 
pointing to the Oracle Client installation.

 b Remove SQLPLUS.EXE from the <Performance Center installation 
directory>\DB directory.

 5 Verify that the version of MDAC is at least 2.8 SP1.

LRTCORA =
(DESCRIPTION =
      (ADDRESS_LIST =
      (ADDRESS = (PROTOCOL = TCP)(HOST = TCDBSERVER)(PORT 1521))
      )
(CONNECT_DATA =
            (SERVICE_NAME =LRTCORA)
)

)

http://support.openview.hp.com/selfsolve/documents/
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 6 Verify that the database or user schema was actually created by checking 
whether the db_results.txt file exists in the %temp% directory of the 
Administration Site server. Note that this file is available only after system 
configuration. In addition, you can check whether the MI_LRDB database or 
user schema exists by logging in to the database/user schema.

Note: If you are able to log on to the User Site after system configuration, 
the database or user schema was most likely created properly.

Database/User Schema Creation Fails

Problem description: You cannot create a Performance Center database or 
user schema.

Troubleshooting

Try to create the database or user schema by running the SQL files located in 
the DbSetup directory of the Administration Site server.

➤ For MS SQL Server, run TestCenter.sql to create the database and 
InitDefinitions.sql to initialize the tables.

➤ For Oracle Server, run TC_oracle.sql to create the user schema and 
InitDataOracle.sql to initialize the tables.
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Warning Message Received During MS-QL Database 
Migration

Problem description: The following warning message appears in the log file 
<DB_Migration_directory>\PC_V9_1.log when performing an MS-QL 
database migration:

Troubleshooting

This message is related to a size limit that is related to the Project Options. 
Since this size limit will not be utilized, you can disregard this message.

Conflict Warnings Received During Database Migration

Problem description: The following messages might appear in the log file 
<DB_Migration_directory>\PC_V9_0.log when performing a database 
migration:

Troubleshooting

These messages appear when performing database migration of Performance 
Center 8.14 and earlier. These warnings relate to features that are no longer 
relevant in the current version of Performance Center. You can disregard 
these messages.

Warning: The table 'Companies' has been created but its maximum row size (8227) 
exceeds the maximum number of bytes per row (8060). INSERT or UPDATE of a row in 
this table will fail if the resulting row length exceeds 8060 bytes.

DELETE statement conflicted with COLUMN REFERENCE constraint 
'FK_ResultTransactions_RunPublishedResults'.
The conflict occurred in database 'MI_LRDB', table 'DashboardResultTransactions', 
column 'RunResultId'.

DELETE statement conflicted with COLUMN REFERENCE constraint 
'FK_GoalTransactions_TestGoals'. 
The conflict occurred in database 'MI_LRDB', table 'DashboardGoalTransactions', 
column 'TestGoalId'.
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Glossary

This document lists terminology that is used throughout HP Performance 
Center.

Administration Site

The Administration Site provides overall resource management and 
technical supervision of the system. The administrator performs 
functions such as assigning user privileges, creating projects, and 
managing resource usage through the Administration Web site.

Agent

See Performance Center Agent.

alert

A notification that HP Performance Center sends to make designated 
users aware of performance issues. Alerts are sent by e-mail.

Analysis

An HP tool for viewing performance analysis data in reports and 
graphs. 

Analysis Integration

Standalone Analysis integrates with Performance Center to let you 
quickly and easily analyze data collected during a Performance Center 
run. Load test data can be analyzed off-line by connecting to 
Performance Center from Standalone Analysis and downloading 
result and session files. After analyzing the data, you can upload the 
session files and reports to Performance Center. 
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authentication

A process that enables access to resources. To authorize access to 
resources, applications first need to authenticate the source of the 
request. Authentication is the process by which the identity of a 
subject is verified, and must be performed in a secure fashion. 
Authentication typically involves the subject demonstrating some 
form of evidence to prove its identity. Such evidence may be a 
password, fingerprint, or signed data using a private key.

Autostart

A feature that starts a load test run automatically. An Autostart test 
automatically begins the run at the start of the timeslot it is associated 
with.

availability

The percentage of time that a business process, monitored 
infrastructure component, or service is up and running.

business process

A series of steps typically performed in applications, which are 
emulated using scripts recorded with HP recording tools and run by 
the HP Performance Center host machines. For example, load 
generators run scripts that describe the activity that is to be monitored 
on the end-user machines. A script consists of transactions—an action 
or a set of actions that you are interested in measuring. By combining 
several transactions, you can define a business process to provide you 
with data for a complete activity.

CA

Certification Authority – A trusted third-party organization or 
company that issues digital certificates used to create digital 
signatures and public-private key pairs.

certificate

A stream of bytes that represent a signed authorization from a trusted 
source that is used to perform an SSL encryption.
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Citrix Agent

An agent installed on the server machine that enhances VuGen’s 
capabilities in identifying Citrix client objects.

Collation

At the conclusion of the test run, the load generators send the results 
back to the Controller. The Controller merges all the load generator 
results into a single package in a process called "collation".

Command Line

Using the Command Line interface, you can pass arguments to 
instruct the Controller how to behave. This enables you to configure 
load test settings without having to manually define them using the 
UI.

Container

A Performance Center object that contains Performance Center 
resources, assets, and other Performance Center containers. 

Controller

A machine that is used to design and manage a load test. During a 
test, the Controller issues instructions to the load generators 
including which scripts to run, how many Vusers to run per script, 
and Start Vuser timing. At the conclusion of the test run, the 
Controller collates the results. There is only one Controller per load 
test.

Dashboard 

The HP Performance Center Project Dashboard provides an overview 
of your project's status, as well as the drill-down capability to view 
individual load test performance. The status and performance data are 
relative to the target criteria you establish for your application.

Data Processor

A Data Processor machine is used for publishing information to the 
Project Dashboard. Although it is possible to set a machine as a 
Controller and a Data Processor, it is not recommended. 
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Database Server

The database server forms the infrastructure for persistent data within 
Performance Center. The database server holds information on users, 
projects, host information, and load tests. 

Diagnostics

Performance Center's diagnostics modules provide monitors that 
trace, time, and troubleshoot individual transactions that rapidly 
identify and pinpoint performance problems in J2EE, .NET, Siebel, 
Oracle, and SAP environments. These monitors help you to maximize 
business process performance, scalability, and efficiency.

EJB

Enterprise JavaBeans™ – A component architecture for the 
development and deployment of object-oriented, distributed, 
enterprise-level applications. Applications written using the Enterprise 
JavaBeans architecture are scalable, transactional, and secure. 

File Server

The file server forms the infrastructure for persistent data within 
Performance Center. The file server holds the test scripts and test 
results.

granularity

Determines how many measurement samples the HP Performance 
Center displays in reports. By default, reports are limited to a 
maximum of 31 samples. Thus, for example, if you select the Day time 
range and the minutes granularity, since there are 1,440 minutes in a 
day and a maximum of 31 samples on a graph, the granularity ranges 
from every 47 minutes (1440/31=46.4, rounded up to 47) to every 59 
minutes (above 59 minutes, you use the hour granularity unit).

Additional examples:

If you select the Day time range and a granularity of every 1 hour, HP 
Performance Center displays the report using 24 samples 
(1 hour x 24 = 1 day).

If you select the Month time range and a granularity of every 1 week, 
HP Performance Center displays the report using 4 samples 
(1 week x 4 = 1 month). 
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GUI Vuser

GUI Vusers operate graphical user interface (GUI) applications. These 
applications can run in a Microsoft Windows environment. Each GUI 
Vuser that you develop emulates a real user by submitting input to, 
and receiving output from, GUI applications. GUI Vusers are created 
using HP’s GUI testing tools: HP WinRunner (for Microsoft Windows 
applications) and HP QuickTest Professional (for Web applications). 
You can run only a single GUI Vuser on a Windows-based load 
generator. Use terminal sessions to run multiple GUI Vusers.

host

A machine which can be used to control or run Vusers, and process 
collected data. Each host machine can be designated as a Controller, 
load generator, or Data Processor.

Host Checkup Service

The Host Checkup Service detects hosts in the resource failure status 
and recovers them (if possible) to the operational status.

Host License

The HP Performance Center license which is automatically installed 
on the hosts as you add them to the system.

ICF

Windows Firewall, previously known as Internet Connection Firewall 
or ICF. See Personal Firewall.

IIS Maintenance Services

IIS Maintenance Services verify that IIS is operational, performs IIS 
memory checks, and restarts IIS in case of memory leakage or if the 
specified memory limit is exceeded.

IIS Restart

Restarts IIS at a set time every day. Restarting IIS increases 
Performance Center stability and is highly recommended. IIS Restart 
does not affect running tests, and users can reconnect to tests and 
view progress.
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INF file

An information file that opens in the Snapshot Viewer, enabling you 
to view a snapshot of an error from the Vuser log. See also SOE file.

Initialization

The state of preparing Vusers and load generators for a load test run 
("Init"). Initializing Vusers before Start Vuser reduces CPU 
consumption and helps provide more realistic results. The length of 
the initialization state varies between Vusers.

IP address

A unique address that identifies a host on a network. It identifies a 
computer as a 32-bit address that is unique across a Transmission 
Control Protocol/Internet Protocol (TCP/IP) network. An IP address is 
usually represented in dotted-decimal notation, which depicts each 
octet (eight bits, or one byte) of an IP address as its decimal value and 
separates each octet with a period. For example, 172.16.255.255.

IP Spoofing

A feature that enables Vusers running on a single machine to be 
identified by many IP addresses. The server and router recognize the 
Vusers as coming from different machines and as a result, the testing 
environment is more realistic. 

J2EE

Java 2 Enterprise Edition – The J2EE platform manages the 
infrastructure and supports the Web services to enable development 
of secure, robust, and interoperable business applications.

J2EE application

Any deployable unit of J2EE functionality. This can be a single module 
or a group of modules packaged into an .ear file with a J2EE 
application deployment descriptor. J2EE applications are typically 
engineered to be distributed across multiple computing tiers.

JBoss

An Open Source, standards-compliant application server 
implemented in 100% pure Java that is based on the J2EE 
specification.
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JDBC

Java Database Connectivity – An industry standard for 
database-independent connectivity between the Java platform and a 
wide range of databases. The JDBC interface provides a call-level API 
for MS SQL-based access.

JNDI

Java Naming and Directory Interface – A standard extension to the 
Java platform, providing Java technology-enabled applications with a 
unified interface to multiple naming and directory services in the 
enterprise. 

JSP

Java Server Page™ – An extension to the Java servlet technology 
developed by Sun.

Layer

A layer is defined as the generic term given to signify J2EE resources 
that can be grouped together for meaningful analysis, and for display 
in the Diagnostics pages. Examples of layers: entity beans, servlets, 
JDBC, and so forth; classes that inherit from a common ancestor; 
components that adhere to a specific API; classes that provide a 
common service; and custom classes with a common significance.

load generator

A machine on which Vusers are run during a load test. There can be 
any number of load generators for a given load test. Load generators 
are configured inside a Host Pool with other load generators and at 
least one Controller.

Load Preview

Displays a graph of the load behavior you defined in the Scheduler. 
See also Scheduler.

measurement

A data unit that measures performance.
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HP Virtual User Generator

A tool for recording virtual user (Vuser) scripts. VuGen creates a Vuser 
script by recording the actions that you perform on a client 
application. When you run the recorded script, the resulting Vuser 
emulates the user activity between the client and server. Vuser scripts 
include functions that measure and record system performance 
during load-testing sessions. During a load test run, you can monitor 
application performance. 

monitor 

A component used by HP Performance Center to collect data.

Monitor Profile

The server resource monitoring settings for a load test that can be 
used by any test in your project. A monitor profile includes the type of 
monitors to run, the servers whose resources you want to monitor, 
and the measurements you want to monitor on each server. 

MI Listener

A component that serves as router between the Controller and the 
Performance Center Agent. The MI Listener receives data from the 
Performance Center Agent at regular intervals. During the course of 
the load test, the Controller solicits the data from the MI Listener to 
process as run-time data. 

Monitor Over Firewall machine

Used to monitor the servers that are located over a firewall. The 
Performance Center Agent runs on the Monitor Over Firewall 
machine and reports its information to the MI Listener either directly 
or through a proxy server, depending on the system configuration.

Monitor Server

The application under test (AUT) server that you are monitoring.
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Net use trust

To monitor the application under test (AUT), you must have a trust 
between the Utility server\Host and the AUT, otherwise you will not 
be able to take measurements and create a monitor profile. This trust 
is provided by the user supplying an administrator user name and 
password on the AUT.

node

In Dashboard, an entry in a hierarchical tree in the Dashboard, 
representing a group, subgroup, monitor, transaction, and so forth.

Patch

A modification or update to Performance Center that contains bug 
fixes or feature enhancements.

Performance Center Agent

The Performance Center Agent runs on the load generator machines 
and Monitor Over Firewall machines and enables communication 
between the Controller, load generators, Monitor Over Firewall 
machines and MI Listeners (in firewall configurations). The agent 
receives instructions from the Controller to initialize, run, pause, and 
stop Vusers. At the same time, the agent also relays data on the status 
of the Vusers back to the Controller. The Performance Center Agent 
also enables communication between the Controller and terminal 
sessions (if the agent is configured with terminal sessions enabled). 
See also Terminal Session.

Performance Center License

The Performance Center License—a function of your Vuser limit, 
concurrent runs limit, and expiry date—enables you to use the 
Performance Center. You receive the license key when you purchase 
Performance Center, and you type the license key in the 
Administration Site after installing all Performance Center 
components.
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Personal Firewall 

Windows Firewall, previously known as Internet Connection Firewall 
or ICF, is a built–in basic firewall included as a Windows 2000/
Windows XP networking feature. It is a protective boundary that 
monitors and restricts information that travels between your 
computer and a network or the Internet. Note: HP Performance 
Center supports Windows XP Service Pack 2 provided the firewall is 
turned off (the firewall is turned on by default).

Pop-up Blocker

When you install Windows 2003/XP SP2, Pop-up Blocker is turned on 
in Internet Explorer and set to the medium setting, which blocks most 
automatic pop-ups. If Pop-up Blocker blocks pop-up windows that 
you open deliberately in Performance Center by clicking a link, you 
should turn it off when using Performance Center.

Raw results

The raw results file contains the original raw analysis data which is 
automatically generated by Performance Center during a load test 
run. You cannot delete the raw results file.

Remote Management Agent

The Remote Management Agent enables you to manage remote 
machines from the Administration or User Site (for example, view 
login information, install patches, and reboot hosts/servers). The 
Remote Management Agent is automatically installed when 
performing a Performance Center Server or Host installation.

Rendezvous Points

Rendezvous points instruct Vusers to wait during test execution for 
multiple Vusers to arrive at a certain point, so that they may 
simultaneously perform a task. Rendezvous points are inserted into 
Vuser scripts to emulate heavy user load on the server. 

report

A presentation of data collected by the HP data collectors. HP 
Performance Center reports display a variety of data that enable you 
to track and analyze the performance of monitored applications and 
infrastructure components.
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Run-Time Settings

Settings that enable you to define the way that the script runs, and 
emulate different kinds of user activity. Run-time settings are applied 
to Vusers when a script is run using VuGen or the Controller.

Scheduler

A component that enables you to set the timing aspects of the load 
test run. You can set the start time, the duration of the load test or 
Vuser groups within the load test, and the initialization, start Vuser, 
and stop Vuser times.

script

The actions that a Vuser performs during the load test run are 
described in a Vuser script. An action or a set of actions that you want 
to measure are represented by a transaction. You record and save 
scripts in HP Performance Center recording tools, such as HP Virtual 
User Generator.

session data

Session data is automatically generated by Performance Center and 
displays information and layout settings for the active graphs. You 
can delete or overwrite the session data file.

SiteScope

An HP Performance Center data collector used for collecting 
performance data from network, application, database, and Web 
servers.

SiteScope measurement

A measured SiteScope value. Transaction time, database query time, 
and CPU utilization are all examples of SiteScope measurements.

SiteScope monitor

A set of configurations that enables the collection of data for one 
aspect of the monitored environment (for example, a specific type of 
server). A monitor reports a status of OK, warning, or error, based on 
criteria that you can control.
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Snapshot 

A graphical representation of the Web page, at the point when an 
error occurred during the load test run. If the Vuser log indicates that 
a step has a snapshot, you can view a snapshot of the error from the 
Vuser log, or download the snapshot and view the entire page/
individual frames in the Snapshot Viewer. You can also view an 
individual frame from an active run. See also Snapshot Viewer. 

Snapshot Viewer

The Snapshot Viewer enables you to view snapshot on error pages 
captured from Web Vusers during load test runs. This viewer displays 
snapshots from files of .SOE and .INF extension. The Snapshot Viewer 
can be downloaded from the Download page of the Performance 
Center User Site.

SOE file

A Snapshot On Error (.SOE) file is a GNU-Zipped file containing one 
or more snapshots represented by .INF files. Each snapshot can 
contain several frames and sub-frames, and can be viewed using the 
Snapshot Viewer. 

SSL

Secure Sockets Layer, the leading security protocol that encrypts and 
decrypts a message for online transmission and authentication.

Start Vuser

Settings that define how you start running Vusers within a load test.

Stop Vuser

Settings that define how you stop Vusers within a load test.

System User Account

Performance Center uses the system user to communicate between 
components and activate processes from components on a remote 
machine. The administrator can configure the system user for all 
servers and hosts in the Performance Center environment from the 
General Settings page.
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Terminal Session

A client session on a terminal server. A terminal server client can have 
multiple terminal sessions running simultaneously, thereby 
overcoming the limitation of being able to run only a single GUI 
Vuser on a Windows-based load generator. By opening a terminal 
session for each GUI Vuser, you can run multiple GUI Vusers on the 
same application. You can configure terminal sessions during load test 
configuration or at run time.

Timeslot

A timeslot is used to reserve the hosts and Vusers required to run a 
load test for your application. Reserving a timeslot sets aside resources 
to run a load test.

transaction

Any series of steps that an end user performs in an application, whose 
performance you want to monitor. Transactions are recorded using HP 
Virtual User Generator recording tools and saved in scripts. When 
replayed, transaction response time and availability data is collected. 
You view transaction performance data in HP Performance Center 
reports.

transaction breakdown

A function of HP Performance Center that enables transaction 
response time data to be broken down and viewed according to time 
spent on the network, server, and client.

transaction response time

The time it takes for a prerecorded transaction to be completed.

User Site

The User Site is the window used to design, execute, and monitor load 
tests. The users create tests, reserve resources, run tests, and receive 
analysis information through the User Site.
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User Status

User Status is used to determine user access to Performance Center. A 
user with Active status can log in to Performance Center. A user with 
Non-Active status cannot log in to Performance Center. User Status is 
displayed in the Personal Information and Users page of the Privilege 
Manager.

Utility Server

The Utility server provides a centralized location for specific 
information that can exist only once within the system. The License 
Manager, AutoRun schedules, and Monitor Profiles reside on the 
utility server.

Virtual Load Generator

A Virtual Load Generator is an automatically generated placeholder 
name for an actual load generator that will run the script. When 
creating a load test, you can select automatic or manual distribution 
of scripts to machines. If you select manual script distribution, you 
select the actual load generator that you want to assign to each virtual 
load generator at run time.

Virtual User Generator

A tool for recording virtual user (Vuser) scripts. The scripts are run by 
Business Process profiles to emulate end-user experience and monitor 
application performance.

Vusers

Performance Center replaces human users with virtual users or Vusers. 
When you run a load test, Vusers emulate the actions of human users 
working with your application. See also GUI Vuser.

VM

Virtual Machine – A "machine within a machine" that mimics a real 
Java processor, enabling Java bytecode to be executed as actions or 
operating system calls on any processor regardless of the operating 
system. 

Windows Firewall

See Personal Firewall.
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A

accept Server-Side compression 593
Accept-Language request header 592
accessing Performance Center 36
actions, See schedule actions
actual load generators 182
Adobe Reader 21
allocating

data processor hosts 76
load generators 75

analysis session files 419
Analysis, See LoadRunner Analysis
analyzing load test data 412
Application Component monitors 396
Application Deployment Solutions monitors 

395
assigning users to Performance 

Center/project containers 649
AUT configuration 588
authentication retry think time 595
automatic proxy configuration script 599
automatic transactions

enabling 561
transaction names 591

Autostart
best practices 100
overview 99
scheduling autostart load tests 98

B

basic schedule 173
benchmark load tests, creating 45
browser cache (Web, Wireless) 569
Browser Emulation settings 568
buffer size on network (Internet) 594

C

cache
check for newer versions 569
clear each iteration 570

changing
from one project to another 37
host display 59

Classpath, run-time settings 572
cloning a server 308
collating load test data 412
command line arguments 189
compression headers, requesting 593
concurrency settings, Web Services 588
connecting

LoadRunner Analysis to Performance 
Center 428

VuGen to Performance Center 140
connection attempts, modifying (RTE) 605
connection pooling 588
content check, limit errors 594
ContentCheck values in UTF-8 594
continuing on error, globally 560
Controller 30

running Vusers on 103
sending messages to (GUI) 276

copying a load test 228

D

dashboard
creating 45
drilldown data 43
publishing results 52
viewing 41, 47
wizard 46

Index
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data
load test 318
monitoring 318

data processor hosts, allocating 76
data sampling rate 283
Database Server Resource monitors 395
databases, troubleshooting 761
debug level 283
declare_rendezvous function 275
declare_transaction function 275
default report 423
defining target IP addresses 642
device name (RTE) 605
diagnostics 225, 499

configuring J2EE/.NET diagnostics 
541

configuring Oracle 11i diagnostics 
527

configuring SAP diagnostics 535
configuring Siebel DB diagnostics 519
configuring Siebel diagnostics 509
enabling 493
enabling Oracle 11i logging 527
enabling Siebel DB logging 520

disconnecting
LoadRunner Analysis from 

Performance Center 147, 430
VuGen from Performance Center 140

distributing load generators
automatically 181
manually 182
overview 180

distributing Vusers, relative distribution 186
DNS caching, Web 593
documentation updates 24
documentation, online 21
DOM memory allocation 597
download filter 578
downloading

Monitor over Firewall Agent 35
Snapshot Viewer 35
Standalone LoadRunner Analysis 34, 

428
Standalone VuGen 35
Vuser scripts 144, 190

DSL 609

duplicating
group schedule settings 209
load test 228
run-time settings 188

E

editing
monitor profile 114
run-time settings 187

end process, host 71
end_transaction function 275
ERP/CRM mediator 501
ERP/CRM Server Resource monitors 395
error handling, run-time setting 560
error matches, limiting 594
error_message function 275, 276
errors, generating snapshot on 560
Excel file, viewing 426
extended log option 555

F

failure to initialize 361
filtering

downloaded resources 578
scripts 127
trend reports 442
users 619

Firewall Server monitors 394
firewalls

adding measurements 309
monitors over 303
removing measurements 309

freezing online monitor graphs 404
full run-time trace 556
functional testing scripts

integrating into Performance Center 
265

See also GUI Vuser scripts
functions, GUI 275

G

Gateway settings (WAP) 580
get_host_name function 277
get_master_host_name function 277
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glossary 769
graphs, See online graphs
group schedules

copying settings 209
viewing 212

GUI functions 275
GUI Vuser scripts

creating in QuickTest 269
creating in WinRunner 271
integrating into Performance Center 

265
using GUI functions 275

H

history object, support for 597
hme0 device 298
host suffix, filtering by 578
hostid, IP address component 296
hosts

allocating 75
data processor 76
displaying on Hosts page 58
failure 76
fixing 76
load generator 75
load test runs 72
processes and resource usage 70
rebooting 73
status 60
viewing details 66

HP Diagnostics 541
HP Software Support Web site 23
HP Software Web site 23
HP, configuring IP addresses 299
HTML report 437
HTTP buffer size (Web) 594
HTTP recording mode, WAP 580

I

If-Modified-Since header, Web 569
initializing a load test 353

problems 361

integration
QuickTest into Performance Center 

269
WinRunner into Performance Center 

271
IP addresses

adding to load generator 293
class 296
configuring multiple 291
configuring on HP 299
configuring on Linux 299
configuring on Solaris 298
defining target IP addresses 642
enabling from the User Site 301
general project options 290
hostid 296
IP Wizard 294
load generator machine 293
netid 296
per process 290
per thread 290
submask 296
subnet masks 642
using 642

ISDN 609

J

J2EE/.NET Diagnostics module, setup 542
J2EE/.NET Diagnostics monitor 396
Java Performance monitor 395
Java virtual machine, run-time settings 586
Java Vusers

Classpath run-time settings 572
Java VM run-time settings 586

JMS, run-time settings 565

K

keep-alive connections, Web 592
Kerebros, authentication 595
kill process, hosts 71
Knowledge Base 23
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L

Linux, configuring IP addresses 299
load generator distribution

automatic 183
manual 183

load generators
actual 182
adding an IP address 293
configuration for WAN emulation 

256
distributing 180
multiple IP addresses 290
opening terminal sessions 185, 239
virtual 182

load generators, allocating 75
load test results

analyzing 420
collating 420
dowloading logs 420
files and reports 418
publishing to Dashboard 52
searching 51
viewing 47, 417
zip file 419

load test run
changing duration 381
changing monitor over firewall 

information 383
changing post-run analysis option 

385
changing refresh frequency 384
modifying load test schedule during 

run 202
modifying settings during 381
monitoring 317, 393
stopping 390
viewing 343

load test schedule
actions, See schedule actions
autostarting a load test 98
basic schedule 173
configuring during run 364
controlling during load test run 215
copying group schedule settings 209
managing 201
managing in schedule graph 214

modifying 202
modifying during run 364
real-world schedule 173
run modes 173
types 173
viewing 193

Load Test Scheduler 191
load test status

files and reports 418
viewing results 420

load tests
benchmark 45
changing start time 98
changing timeslot duration 98
configuring diagnostics settings 225
copying 228
diagnostics 493
filtering 48
host allocation 95
Load Tests page 47
modifying settings during run 381
post configuration 227
process 28
running 229, 317, 341
running GUI Vuser scripts 278
running indefinitely 199, 200
running QuickTest tests 278
running WinRunner tests 278
run-time settings 284
selecting monitor profiles 218
starting 353
timeout intervals 286
validating 227
viewing run results 417
viewing summary 167

LoadRunner Analysis
downloading standalone 428
integration with 427
viewing load test results 412

log cache size 556
Log run-time settings

disabling log 555
setting detail level 555

logging in to Performance Center 36
logging out of Performance Center 37
lr_whoami function (GUI Vusers) 275
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M

managing
host information 66
projects 640
user privilege assignments 649
user privileges 647

manual load generator distribution 183
manually releasing Vusers from a rendezvous 

251
mapped measurements

duplicating 487
measurement frequency, setting 310
memory allocation for DOM 597
memory management 597
messages, sending to Controller (GUI) 276
META refresh 594
Microsoft .NET Vuser scripts, run-time 

settings 588
Middleware Performance monitors 396
Miscellaneous run-time settings 560
MMS Vuser scripts, run-time settings 607
modifying user-role assignments 651
monitor options 281
Monitor Over Firewall machines

connecting 313, 383
disconnecting 313, 383

monitor profiles
creating for load test 219
deleting 117
duplicating 117
editing in load test 223
modifying profile during run 115, 386
Monitor Profiles page 110

monitor settings, configuring 109, 218
monitoring

load test data 318
load test run 317
vuser status 322

monitors over firewall
adding and removing measurements 

309
configuring measurement frequency 

310
configuring monitor settings 305

modifying information during run 
383

multiple IP addresses
allocating 290
enabling 290

multithreading 561

N

netid, IP address component 296
Network Delay Time graph 405

viewing segments 406
viewing subpaths 405

Network monitor 394
NTLM security 595

O

online documentation 21
online graphs 398

customizing online view 401
enabling for Web 590
freezing 404
Network Delay Time 405
sampling rate 283
sending transaction data 282
transaction data 282

online monitors
customizing view 401
debugging 283
Diagnotics data 407
displaying network delay data 405
freezing graphs 404
graph refresh frequency 404
optimizing view 399
viewing 397

online resources 23
options, project, See project options
Oracle 11i Diagnostics

enabling logging 527
setting diagnostics password 529

Output window 325
output_message function 275
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P

Pacing run-time settings 553
Performance Center

accessing 36
connecting (LoadRunner Analysis) 

428
connecting (VuGen) 140
Diagnostics, configuring load tests to 

use 543
disconnecting (LoadRunner Analysis) 

147, 430
disconnecting (VuGen) 147
downloading session and result files 

431
logging in 36
logging out 37
uploading reports 433
uploading session files 433

performance targets 46
persistent connections, Web 592
personal user details 617
pooling of connections 588
post-run analysis options

configuring 101
modifying during run 385

Pragma mode 573
preferences, run-time settings 590
Privilege Manager

accessing 648
assigning users to Performance 

Center/project containers 649
managing user privilege assignments 

649
modifying user-role assignments 651
overview 647
removing users from containers 652

processes
hosts 70
kill process (host) 71

product advantages 30
project dashboard

creating 45
publishing results 52
removing a test run from dashboard 

55

removing test results from dashboard 
54

setting performance targets 46
viewing results 47

project options
debug options 288
general options 290
monitor options 281
run-time settings 284
timeout intervals 286

projects
changing from one to another 37
creating 640
deleting 644
details 637
managing 640
modifying 644
selecting 37

proxy server, run-time settings 599

Q

QuickTest
integrating into Performance Center 

269
using QuickTest to create GUI scripts 

269

R

Radius
run-time settings (WAP) 603
support 603

raw result files 419
real-world schedule 173
rebooting hosts 73
refresh frequency, changing during run 384
refreshing online monitor graphs 404
relative distribution 186
removing users from containers 652
rendezvous points

about rendezvous points 243
attributes 245
manually releasing 251
overview 245
setting release policy 248
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setting timeout policy 248
viewing information releasing 249

report
HTML 437
summary 423
Word 438

reserving timeslots
Comments tab 91
Options tab 91
Timeslot Details tab 91

resource failure 76
results, load test run 417
roles

assigning 636
canned 628
filtering 628
Performance Center task permissions 

631
project-related task permissions 632
viewing 627

routing table 300
Run Logic run-time settings 551
running a load test 229, 317, 341
Run-Time monitor 394
run-time settings

.NET environment 588
Browser Emulation 568
Citrix Configuration 576
Citrix Timing 610
configuring 187
duplicating 188
editing 187
Gateway (WAP) 580
Log 555
Miscellaneous 560
MMS 607
Pacing 553
Preferences 590
Preferences - Advanced 591
Proxy (Internet prtcls) 599
Radius (WAP) 603
Run Logic 551
screen properties 597
Speed Simulation 608
Think Time 558

S

sampling rate 283
SAP Diagnostics

overview 535
setting up 536
supported environments 536

schedule actions
Actions grid 203
adding in grid 206
adding in schedule graph 214
deleting from grid 208
deleting from schedule graph 215
Duration action 199
editing in grid 208
grid toolbar 205
Initialize action 197
managing in Actions grid 205
managing in schedule graph 214
Start Group action 196
Start Vusers action 198
Stop Vusers action 200

schedule graph
adding schedule actions 214
deleting schedule actions 215
managing schedule actions 214
showing/hiding the legend 211
toolbar 211
viewing group schedules 212
viewing schedules 210

schedule, See load test schedule
Scheduler, See Load Test Scheduler
screen properties, run-time setting 597
scripts, See Vuser scripts
searching load test results 51
sending messages

GUI Vusers 276
server monitors

adding and removing measurements 
309

cloning a server 308
setting a measurement frequency 310

server routing table 300
service level agreements, See SLAs
session files 419
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Siebel DB Diagnostics
enabling logging 520
setting up 522

Siebel Diagnostics
configuring application server 510
copying files from application server 

to mediator 513
setting up 514
Web server inside a DMZ 512

SLAs
average transaction response time 151
errors per second 156
over whole run 161
per time interval 151
tracking period 160

snapshot on errors
information page 332
viewing from activity log 330
viewing from download 333

snapshots
generate on error 560
save replay snapshot locally 591

Solaris, configuring IP addresses 298
sorting

trend reports 442
users 619

Speed Simulation settings 608
Standalone LoadRunner Analysis 428
standard log option 555
start_transaction function (GUI) 275
starting load test 353

with reserved timeslot 354
without reserved timeslot 358

statements, adding in QuickTest 270
stopping, load test run 390
summary report 417, 423
system advantages 30
System Resouce monitors 394

T

targets, setting performance 46
terminal sessions

configuring logon settings 235
introduction 232
launching client session 236

running agent as process 238
setting up Performance Center agent 

on host 234
using in Performance Center 232

think time 558
threadabortexception 756
threshold for setTimeout, setInterval 596
timeout options 286
timeouts

Citrix connection 610
HTTP request 592
WAP connection 592

timeslots
checking availability 86
checking reserved timeslots (calendar 

and table views) 90
editing 104
freeing after a test 392
inventory 83
relationship to host allocation 95
reserving 91
running Vusers on Controller 89

Timing run-time setting, Citrix 610
transaction data 282
transaction information, viewing 42
Transaction monitor 394
transactions

automatic, for Web Vuser scripts 561
including in QuickTest scripts 269
Web Vusers 561

trend reports
adding load test runs to report 451
adding trend views to tab 460
comparison methods 475
components 440
creating 445
creating mapped measurements 485
custom measurement mapping 481
customizing tabs 459
duplicating 449
filtering and sorting 442
main page 441
measurement acronyms 488
selecting measurements to trend 466
setting thresholds 478
templates 447
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trend views 463
understanding trend view 

information 470
viewing 449

trend views 463
Troubleshooting and Knowledge Base 23
troubleshooting databases 761

U

updates, documentation 24
uploading reports

HTML 433
Word 433

uploading session files
to Performance Center 433
to the file system 433

uploading Vuser scripts
from Vugen to the Vuser scripts page 

141
using the Vuser scripts page 130

URL-based script generator link 134
URL-based Vuser script 134
user management 613
user privileges 647
user roles

assigning 636
canned 628
filtering 628
Performance Center task permissions 

631
project-related task permissions 632
viewing 627

user_data_point function 275
user-agent browser emulation 568
users

creating 620
deleting 622
editing details 622
information 616

UTF-8 conversion, in run-time settings 593

V

validating a load test 227
verification checks, Web 590

viewing
diagnostics results 507
load test results 417
load test run trends 439
load test summary 167
load test transaction information 42
personal information 617
project dashboard 41
rendezvous information 249
reports for scheduled tests 335
scheduled tests 335
snapshots on errors 330
Vuser scripts 190

virtual load generators 182
virtual machine settings 565
VM run-time settings, Web Services 565
Vuser functions, GUI 275
Vuser groups

assigning load generators 180
creating 177
modifying during load test 375

Vuser Log page 332
Vuser monitors, running over firewall 303
Vuser scripts

about 29
copying 136
creating URL-based 134
downloading 190
editing 146
modifying during run 389
modifying VuGen script 146
obtaining GUI Vuser information 277
viewing 190, 389

Vuser status 322
Vuser types, GUI 272
Vusers

distributing using relative distribution 
186

running on Controller 103

W

WAN emulation
best practices 263
configuring 256
emulated locations 259
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excluding Hosts 261
excluding machines 261
limitations 258, 262
load generator limitations 258
monitoring 261
setting up 256
typical network settings 259

Web (Click and Script)
general options 595
history options 597
memory management 597
Navigator properties 597
timers 596

Web Application Server Resource monitors 
395

Web page breakdown, enabling 498
Web Resource monitors 394
Web Server Resource monitors 395
Web Vusers, multiple IP addresses 290
WinInet engine (Internet protocols) 591
WinRunner

integrating into Performance Center 
271

using to create GUI scripts 272
Word report 438
workload

configuration overview 171
types of 175

Z

zlib headers 593
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